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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information.
» To send comments on articles in the WebSphere Application Server Information Center
1. Display the article in your Web browser and scroll to the end of the article.

2. Click on the Feedback link at the bottom of the article, and a separate window containing an e-mail
form appears.

3. Fill out the e-mail form as instructed, and click on Submit feedback .

* To send comments on PDF books, you can e-mail your comments to: wasdoc@us.ibm.com or fax
them to 919-254-0206.

Be sure to include the document name and number, the WebSphere Application Server version you are
using, and, if applicable, the specific page, table, or figure number on which you are commenting.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information
in any way it believes appropriate without incurring any obligation to you.
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Chapter 1. Overview and new features for developing and
deploying applications

Use the links provided in this topic to learn more about developing applications for deployment on this
product.

[“What is new for developers” on page 16|

This topic provides an overview of new and changed features of the programming model and
application serving environment as it pertains to development and test efforts.

[“Learn about WebSphere applications: Overview and new features”)|

This topic provides an overview of the programming model.

|“Accessing the Samples (Samples Gallery)” on page 11|

The Samples are a good way to become familiar with the programming model.

Learn about WebSphere applications: Overview and new features

Use the Learn about WebSphere applications section as a starting point to study the programing model,
encompassing the many parts used in and by various application types supported by the application
server.

The programming model for applications deployed on this product has the following aspects.
» Java specifications and other open standards for developing applications
* WebSphere programming model extensions to enhance application functionality

» Containers and services in the application server, used by deployed applications, and which sometimes
can be extended

The diagram shows a single application server installation. The parts pertaining to the programming model

are discussed here. Other parts comprise the product architecture, independent of the various application
types outlined by the programming model.

© Copyright IBM Corp. 2006 1
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The Web container is the part of the application server in which Web application components run.
Web applications are comprised of one or more related servlets, JavaServer Pages technology
(JSP files), and Hyper Text Markup Language (HTML) files that you can manage as a unit.
Combined, they perform a business logic function.

The Web container processes servlets, JSP files, and other types of server-side includes. Each
application server runtime has one logical Web container, which can be modified, but not created
or removed. Each Web container provides the following.

Web container transport chains
Requests are directed to the Web container using the Web container inbound transport
chain. The chain consists of a TCP inbound channel that provides the connection to the
network, an HTTP inbound channel that serves HTTP requests, a Web container channel
over which requests for servlets and JSP files are sent to the Web container for
processing.

Developing and deploying applications



Servlet processing
When handling servlets, the Web container creates a request object and a response
object, then invokes the servlet service method. The Web container invokes the servlet's
destroy method when appropriate and unloads the servlet, after which the JVM performs
garbage collection.

Servlets can perform such tasks as supporting dynamic Web page content, providing
database access, serving multiple clients at one time, and filtering data.

JSP files enable the separation of the HTML code from the business logic in Web pages.
IBM extensions to the JSP specification make it easy for HTML authors to add the power
of Java technology to Web pages, without being experts in Java programming.

HTML and other static content processing
Requests for HTML and other static content that are directed to the Web container are
served by the Web container inbound chain. However, in most cases, using an external
Web server and Web server plug-in as a front end to the Web container is more
appropriate for a production environment.

Session management
Support is provided for the javax.servlet.http.HttpSession interface as described in the
Servlet application programming interface (API) specification.

An HTTP session is a series of requests to a servlet, originating from the same user at the
same browser. Sessions allow applications running in a Web container to keep track of
individual users. For example, many Web applications allow users to dynamically collect
data as they move through the site, based on a series of selections on pages they visit.
Where the user goes next, or what the site displays next, might depend on what the user
has chosen previously from the site. To maintain this data, the application stores it in a
"session.”

SIP applications and their container

SIP applications are Java programs that use at least one Session Initiation Protocol (SIP)
servlet. SIP is used to establish, modify, and terminate multimedia IP sessions including IP
telephony, presence, and instant messaging.

Portlet applications and their container

Portlet applications are special reusable Java servlets that appear as defined regions on
portal pages. Portlets provide access to many different applications, services, and Web
content.

EJB applications run in the EJB container

The EJB container provides all of the runtime services needed to deploy and manage enterprise
beans. It is a server process that handles requests for both session and entity beans.

Enterprise beans are Java components that typically implement the business logic of J2EE
applications, as well as accessing data. The enterprise beans, packaged in EJB modules, installed
in an application server do not communicate directly with the server. Instead, the EJB container is
an interface between EJB components and the application server. Together, the container and the
server provide the enterprise bean runtime environment.

The container provides many low-level services, including threading and transaction support. From
an administrative perspective, the container handles data access for the contained beans. A single
container can host more than one EJB Java archive (JAR) file.

Client applications and other types of clients

In a client-server environment, clients communicate with applications running on the server. Client
applications or application clients generally refers to clients implemented according to a particular set of
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Java specifications, and which run in the client container of a J2EE-compliant application server. Other
clients in the WebSphere Application Server environment include clients implemented as Web applications
(Web clients), clients of Web services programs (Web services clients), and clients of the product systems
administration (administrative clients).

Client applications and their container
The client container is installed separately from the application server, on the client machine. It
enables the client to run applications in an EJB-compatible J2EE environment. The diagram shows
a Java client running in the client container.

This product provides a convenient |“IaunchCIient tool” on page 321| for starting the application
client, along with its client container runtime.

Depending on the source of technical information, client applications sometimes are called
application clients. In this documentation, the two terms are synonymous.

Web clients, known also as web browser clients
The diagram shows a Web browser client, which can be known simply as a Web client, making a
request to the Web container of the application server. A Web client or Web browser client runs in
a Web browser, and typically is a Web application.

Web services clients
Web services clients are yet another kind of client that might exist in your application serving
environment. The diagram does not depict a Web services client. The Web services information
includes information about this type of client.

Administrative clients
The diagram shows two kinds of administrative clients: a scripting client and the administrative
console that is the graphical user interface (GUI) for administering this product. Both are accessing
parts of the systems administration infrastructure. In the sense that they are basically the same for
whatever kind of applications you are deploying on the server, administrative clients are part of the
product architecture. However, because many of these clients are programs you create, they are
discussed as part of the programming model for completeness.

Web services

Web services
The diagram shows the Web services engine, part of the Web services support in the application
server runtime. Web services are self-contained, modular applications that can be described,
published, located, and invoked over a network. They implement a services oriented architecture
(SOA), which supports the connecting or sharing of resources and data in a flexible and
standardized manner. Services are described and organized to support their dynamic, automated
discovery and reuse.

The product acts as both a Web services provider and as a requestor. As a provider, it hosts Web
services that are published for use by clients. As a requester, it hosts applications that invoke Web
services from other locations. The diagram shows the Web services engine in this capacity,
contacting a Web services provider or gateway.

Data access, messaging, and J2EE resources

Data access resources
Connection management for access to enterprise information systems (EIS) in the application
server is based on the J2EE Connector Architecture (JCA) specification. The diagram shows JCA
services helping an application to access a database in which the application retrieves and
persists data.

The connection between the enterprise application and the EIS is done through the use of
ElIS-provided resource adapters, which are plugged into the application server. The architecture
specifies the connection management, transaction management, and security contracts between
the application server and EIS.
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The Connection Manager (not shown) in the application server pools and manages connections. It
is capable of managing connections obtained through both resource adapters defined by the JCA
specification and data sources defined by the JDBC 2.0 Extensions specification.

JDBC resources (JDBC providers and data sources) are a type of J2EE resource used by
applications to access data. Although data access is a broader subject than that of JDBC
resources, this information often groups data access under the heading of J2EE resources for
simplicity.

JCA resource adapters are another type of J2EE resource used by applications. The JCA defines
the standard architecture for connecting the J2EE platform to heterogeneous EIS. Imagine an
ERP, mainframe transaction processing, database systems, and legacy applications not written in
the Java programming language.

The JCA resource adapter is a system-level software driver supplied by EIS vendors or other
third-party vendors. It provides the connectivity between J2EE application servers or clients and an
EIS. To use a resource adapter, install the resource adapter code and create configurations that
use that adapter. The product provides a predefined relational resource adapter for your use.

Messaging resources and messaging engines
JMS support enables applications to exchange messages asynchronously with other JMS clients
by using JMS destinations (queues or topics). Applications can use message-driven beans to
automatically to automatically retrieve messages from JMS destinations and JCA endpoints without
explicitly polling for messages.

For inbound non-JMS requests, message-driven beans use a Java Connector Architecture (JCA)
1.5 resource adapter written for that purpose. For JMS messaging, message-driven beans can use
a JCA-based messaging provider such as the default messaging provider that is part of
WebSphere Application Server.

The messaging engine supports the following types of message providers.

Default messaging provider (service integration bus)
The default messaging provider uses the service integration bus for transport. The default
message provider provides point-to-point functions, as well as publish and subscribe
functions. Within this provider, you define JMS connection factories and destinations that
correspond to service integration bus destinations.

WebSphere MQ provider
You can use WebSphere MQ as the external JMS provider. The application server
provides the JMS client classes and administration interface, while WebSphere MQ
provides the queue-based messaging system.

Generic JMS provider
You can use another messaging provider as long as it implements the ASF component of
the JMS 1.0.2 specification. JMS resources for this provider cannot be configured using
the administrative console.

transition: Version 6 replaces the Version 5 concept of a JMS server with a messaging engine
built into the application server, offering the various kinds of providers mentioned
previously. The Version 5 messaging provider is offered for configuring resources for
use with Version 5 embedded messaging. You also can use the Version 5 default
messaging provider with a service integration bus.

EJB 2.1 introduces an ActivationSpec for connecting message-driven beans to
destinations. For compatibility with Version 5, you still can configure JMS
message-driven beans (EJB 2.0) against a listener port. For those message-driven
beans, the message listener service provides a listener manager that controls and
monitors one or more JMS listeners, each of which monitors a JMS destination on
behalf of a deployed message-driven bean.
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Service integration bus

The service integration bus provides a unified communication infrastructure for messaging and
service-oriented applications. The service integration bus is a JMS provider that provides reliable
message transport and uses intermediary logic to adapt message flow intelligently into the
network. It supports the attachment of Web services requestors and providers. Its capabilities are
fully integrated into product architecture, including the security, system administration, monitoring,
and problem determination subsystems.

The service integration bus is often referred to as just a bus. When used to host JMS applications,
it is often referred to as a messaging bus. It consists of the following parts (not shown at this level
of detail in the diagram).

Bus members
Application servers added to the bus.

Messaging engine
The component that manages bus resources. It provides a connection point for clients to
produce or from where to consume messages.

Destinations
The place within the bus to which applications attach to exchange messages. Destinations
can represent Web services endpoints, messaging point-to-point queues, or messaging
publish and subscribe topics. Destinations are created on a bus and hosted on a
messaging engine.

Message store
Each messaging engine uses a set of tables in a supported data store (such as a JDBC
database) to hold information such as messages, subscription information, and transaction
states.

Through the service integration bus Web services enablement, you can:

* Make an internal service that is already available at a service destination available as a Web
service.

* Make an external Web service available at a service destination.

* Use the Web Services Gateway to map an existing service, either an internal service or an
external Web service, to a new Web service that appears to be provided by the gateway.

Mail, URLs, and other J2EE resources

6

The following kinds of J2EE resources are used by applications deployed on a J2EE-compliant
application server.

JDBC resources and other technology for data access (previously discussed)
» JCA resource adapters (previously discussed)

* JMS resources and other messaging support (previously discussed)

» JavaMail support, for applications to send Internet mail

The JavaMail APIs provide a platform and protocol-independent framework for building
Java-based mail client applications. The APIs require service providers, known as protocol
providers, to interact with mail servers that run on the appropriate protocols.

A mail provider encapsulates a collection of protocol providers, including Simple Mail Transfer
Protocol (SMTP) for sending mail; Post Office Protocol (POP) for receiving mail; and Internet
Message Access Protocol (IMAP) as another option for receiving mail. To use another protocaol,
you must install the appropriate service provider for the protocol.

JavaMail requires not only service providers, but also the JavaBeans Activation Framework
(JAF), as the underlying framework to handle complex data types that are not plain text, such
as Multipurpose Internet Mail Extensions (MIME), URL pages, and file attachments.

* URLs, for describing logical locations
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URL providers implement the functionality for a particular URL protocol, such as HTTP, enabling
communication between the application and a URL resource that is served by a particular
protocol. A default URL provider is included for use by any URL resource with protocols based
on the supported Java 2 Standard Edition specification, such as HTTP, FTP, or File. You also
can plug in your own URL providers that implement additional protocols.

* Resource environment entries, for mapping logical names to physical names

The java:comp/env environment provides a single mechanism by which both the JNDI name
space objects and local application environment objects can be looked up. The product provides
numerous local environment entries by default.

The J2EE specification also provides a mechanism for defining customer environment entries by
defining entries in the standard deployment descriptor of an application. The J2EE specification
uses the following methods to separate the definition of the resource environment entry from the
application.

— Requiring the application server to provide a mechanism for defining separate administrative
objects that encapsulate a resource environment entry. The administrative objects are
accessible using JNDI in the application server local name space (java:comp/env).

— Specifying the administrative object’'s JINDI lookup name and expected returned object type.
This specification is performed in the aforementioned resource environment entry in the
deployment descriptor.

The product supports the use of resource environment entries with the following administrative
concepts.

— A resource environment entry defines the binding target (JNDI name), factory class, and
return object type (via the link to a referenceable) of the resource environment entry.

— A referenceable defines the class name of the factory that returns object instances
implementing a Java interface.

— A resource environment provider groups together the referenceable, resource environment
entries and any required custom properties.

Security

Security programming model and infrastructure
The product provides security infrastructure and mechanisms to protect sensitive J2EE resources
and administrative resources and to address enterprise end-to-end security requirements on
authentication, resource access control, data integrity, confidentiality, privacy, and secure
interoperability.

Security infrastructure and mechanisms protect Java 2 Platform, Enterprise Edition (J2EE)
resources and administrative resources, addressing your enterprise security requirements. In turn,
the security infrastructure of this product works with the existing security infrastructure of your
multiple-tier enterprise computing framework. Based on open architecture, the product provides
many plug-in points to integrate with enterprise software components to provide end-to-end
security.

The security infrastructure involves both a programming model and elements of the product
architecture that are independent of the application type.

Additional services for use by applications

Naming and directory
Each application server provides a naming service that in turn provides a Java Naming and
Directory Interface (JNDI) name space. The service is used to register resources hosted on the
application server. The JNDI implementation is built on top of a Common Object Request Broker
Architecture (CORBA) naming service (CosNaming).

JNDI provides the client-side access to haming and presents the programming model used by
application developers. CosNaming provides the server-side implementation and is where its name
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space is actually stored. JNDI essentially provides a client-side wrapper of the name space stored
in CosNaming, and interacts with the CosNaming server on behalf of the client.

Clients of the application server use the naming architecture to obtain references to objects related
to those applications. The objects are bound into a mostly hierarchical structure called the name
space. It consists of a set of name bindings, each one of which is a name relative to a specific
context and the object bound with that name. The name space can be accessed and manipulated
through a name server.

This product provides the following naming and directory features.

» Distributed name space, for additional scalability

» Transient and persistent partitions, for binding at various scopes

* Federated name space structure across multiple servers

» Configured bindings for defining bindings bound by the system at server startup

» Support for CORBA Interoperable Naming Service (INS) object URLs

Note that with the addition of virtual member manager to provide federated repository support for
product security, the product now offers more extensive and sophisticated identity management
capabilities than ever before, especially in combination with other WebSphere and Tivoli products.

Object Request Broker (ORB)

The product uses an ORB to manage interaction between client applications and server
applications, as well as among product components. An ORB uses IIOP to enable clients to make
requests and receive requests from servers in a network distributed environment.

The ORB provides a framework for clients to locate objects in the network and call operations on
those objects as though the remote objects were located in the same running process as the
client, providing location transparency.

Although not shown in the diagram, one place in which the ORB comes into play is where the
client container is contacting the EJB container on behalf of a Java client.

Transactions

8

Part of the application server is the transaction service. The product provides advanced
transactional capabilities to help application developers avoid custom coding. It provides support
for the many challenges related to integrating existing software assets with a J2EE environment.
These measures include ActivitySessions (described below).

Applications running on the server can use transactions to coordinate multiple updates to
resources as one unit of work such that all or none of the updates are made permanent.
Transactions are started and ended by applications or the container in which the applications are
deployed.

The application server is a transaction manager that supports coordination of resource managers
and participates in distributed global transactions with other compliant transaction managers.

The server can be configured to interact with databases, JMS queues, and JCA connectors
through their local transaction support when distributed transaction support is not required.
How applications use transactions depends on the type of application, for example:

* A session bean either can manage its transactions itself, or delegate the management of
transactions to the container.

* Entity beans use container-managed transactions.
* Web components, such as servlets, use bean-managed transactions.

The product handles transactions with the following components.

« A transaction manager supports the enlistment of recoverable XAResources and ensures each
resource is driven to a consistent outcome, either at the end of a transaction, or after a failure
and restart of the application server.
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* A container manages the enlistment of XAResources on behalf of deployed applications when it
performs updates to transactional resource managers such as databases. Optionally, the
container can control the demarcation of transactions for EJB applications that have enterprise
beans configured for container-managed transactions.

* An API handles bean-managed enterprise beans and servlets, allowing such application
components to control the demarcation of their own transactions.

WebSphere extensions

WebSphere programming model extensions are the programming model benefits you gain by purchasing
this product. They represent leading edge technology to enhance application capability and performance,
and make programming and deployment faster and more productive.

In addition, now your applications can use the Eclipse extension framework. Your applications are
extensible as soon as you define an extension point and provide the extension processing code for the
extensible area of the application. You can also plug an application into another extensible application by
defining an extension that adheres to the target extension point requirements. The extension point can find
the newly added extension dynamically and the new function is seamlessly integrated in the existing
application. It works on a cross Java 2 Platform, Enterprise Edition (J2EE) module basis. The application
extension registry uses the Eclipse plug-in descriptor format and application programming interfaces (APIs)
as the standard extensibility mechanism for WebSphere applications. Developers that build WebSphere
application modules can use WebSphere Application Server extensions to implement Eclipse tools and to
provide plug-in modules to contribute functionality such as actions, tasks, menu items, and links at
predefined extension points in the WebSphere application. For more information about this feature, see
[‘Application extension registry” on page 88

The various WebSphere programming model extensions, and the corresponding application services that
support them in the application server runtime, can be considered in three groups: Business Object Model
extensions, Business Process Model extensions, and extensions for producing Next Generation
Applications.

Extensions pertaining to the Business Object Model

Business object model extensions operate with business objects, such as enterprise bean (EJB)
applications.

Application profiling
Application profiling is a WebSphere extension for defining strategies to dynamically control
concurrency, prefetch, and read-ahead.

Application profiling and access intent provide a flexible method to fine-tune application
performance for enterprise beans without impacting source code. Different enterprise beans, and
even different methods in one enterprise bean, can have their own intent to access resources.
Profiling the components based on their access intent increases performance in the application
server runtime.

Dynamic query
Dynamic query is a WebSphere programming extension for unprecedented application flexibility. It
lets you dynamically build and submit queries that select, sort, join, and perform calculations on
application data at runtime. Dynamic Query service provides the ability to pass in and process EJB
query language queries at runtime, eliminating the need to hard-code required queries into
deployment descriptors during application development.

Dynamic query improves enterprise beans by enabling the client to run custom queries on EJB
components during runtime. Until now, EJB lookups and field mappings were implemented at
development time and required further development or reassembly in order to be changed.
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Dynamic cache
The dynamic cache service improves performance by caching the output of servlets, commands,
and JSP files. This service within the application server intercepts calls to cacheable objects and
either stores the output of the object or serves the content of the object from the dynamic cache.

Because J2EE applications have high read-write ratios and can tolerate small degrees of latency
in the currency of their data, the dynamic cache can create opportunity for significant gains in
server response time, throughput, and scalability.

Features include cache replication among clusters, cache disk offload, Edge side include caching,
and external caching - the ability to control caches outside of the application server, such as that
of your Web server.

Extensions pertaining to the Business Process Model

Business process model extensions provide process, workflow functionality, and services for the
application server. Use them in conjunction with business integration capabilities.

ActivitySessions
ActivitySessions are a WebSphere extension for reducing the complexity of dealing with
commitment rules and limitations associated with one-phase commit resources.

ActivitySessions provide the ability to extend the scope of multiple local transactions, and to group
them. This enables them to be committed based on deployment criteria or through explicit program
logic.

Web services
Web services are self-contained, modular applications that can be described, published, located,
and invoked over a network. They implement a services oriented architecture (SOA), which
supports the connecting or sharing of resources and data in a very flexible and standardized
manner. Services are described and organized to support their dynamic, automated discovery and
reuse.

Extensions for creating next generation applications

Next generation applications can be used in applications that need the specific extensions. These enable
next generation development by leveraging the latest innovations that build on today’s J2EE standards.
This provides greater control over application development, execution, and performance than was ever
possible before.

Asynchronous beans
Asynchronous beans offer performance enhancements for resource-intensive tasks by enabling
single tasks to run as multiple tasks. Asynchronous scheduling facilities can also be used to
process parallel processing requests in "batch mode” at a designated time. The product provides
full support for asynchronous execution and invocation of threads and components within the
application server. The application server provides execution and security context for the
components, making them an integral part of the application.

Startup beans
Startup beans allow the automatic execution of business logic when the application server starts or
stops. For example, they might be used to pre-fill application-specific caches, initialize
application-level connection pools, or perform other application-specific initialization and
termination procedures.

Object pools
Object pools provide an effective means of improving application performance at runtime, by
allowing multiple instances of objects to be reused. This reuse reduces the overhead associated
with instantiating, initializing, and garbage-collecting the objects. Creating an object pool allows an
application to obtain an instance of a Java object and return the instance to the pool when it has
finished using it.
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Internationalization

The internationalization service is a WebSphere extension for improving developer productivity. It
allows you to automatically recognize the time zone and location information of the calling client,
so that your application can act appropriately. The technology enables you to deliver each user,
around the world, the right date and time information, the appropriate currencies and languages,
and the correct date and decimal formats.

Scheduler

The scheduler service is a WebSphere programming extension responsible for starting actions at
specific times or intervals. It helps minimize IT costs and increase application speed and
responsiveness by maximizing utilization of existing computing resources. The scheduler service
provides the ability to process workloads using parallel processing, set specific transactions as
high priority, and schedule less time-sensitive tasks to process during low traffic off-hours.

Work areas

Work areas are a WebSphere extension for improving developer productivity. Work areas provide
a capability much like that of "global variables.” They provide a solution for passing and
propagating contextual information between application components.

Work areas enable efficient sharing of information across a distributed application. For example,
you might want to add profile information as each customer enters your application. By placing this
information in a work area, it will be available throughout your application, eliminating the need to

hand-code a solution or to read and write information to a database.

To delve deeper into learning about any of the extensions, see [Chapter 18, “Learn about WebSphere|
[programming extensions,” on page 1119

Accessing the Samples (Samples Gallery)

The Samples Gallery offers a set of Samples that demonstrate common enterprise application tasks. The

Gallery also contains descriptions of where to find additional Samples and coding examples.

You can upgrade the Samples Gallery, including the server samples and client samples. For detailed
information, refer to |lapp_server_root/samples/readme.html.

Quick start - Accessing the Samples Gallery

Your application server must be running. The Samples must be installed.

B On Windows systems, click (for example) Start > Programs > IBM WebSphere > Application Server
v6.1 > Profiles > profile_name > Samples Gallery.

BT On Windows systems, click (for example) Start > Programs > IBM WebSphere > Application Server
v6.0 > Profiles > profile_name > Samples Gallery.

In the following examples, hostname is a variable.
- Windows | http://hostname:9080/WSsamples

http://hostname:9080/WSsamples

Client Samples: install_root/samples/index.html (local file system)

The Samples are for demonstration purposes only. See the following limitations for details.
First time here? Read the following information. A little setup is involved.

Samples Gallery
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+ [Samples Gallery contents|
« [Installing and accessing the Samples Gallery|
« [Changing the Samples Gallery port number and troubleshooting

Client Samples Gallery
« [Client Samples Gallery contents|
* |Installing and viewing the Client Samples GaIIeM

General information
« |Limitations of the Samples|
« |Additional Samples and examples]

Samples Gallery contents

The Samples Gallery includes the following materials:

Plants by WebSphere application
This application demonstrates several Java 2 Platform, Enterprise Edition (J2EE) functions, using
an online store that specializes in plant and garden tool sales.

Faces Client Tutorial - Sample Portfolio
Sample Portfolio is a sample application that demonstrates the use of faces client components.
The Hello world sample demonstrates how the faces client framework keeps a data model
consistent in the browser.

Technology Samples
These Samples demonstrate various core components in J2EE applications.

Web Services Samples
These Samples demonstrate J2EE beans and JavaBeans components that are available as Web
services.

Service Data Objects (SDO) Sample
This Sample demonstrates data access to a relational database through Service Data Objects
(SDO) and Java DataBase Connectivity (JDBC) Mediator technologies.

JACL scripts
These scripts enable you to configure resources and install the Sample applications.

Programming model extensions Samples in the Samples Gallery
These Samples demonstrate WebSphere programming model extension features such as dynamic
query service, work area service, internationalization service, ActivitySessions service, application
profiling, Java Transaction API (JTA) extensions, asynchronous beans, and scheduler.

Installing and accessing the Samples Gallery

Follow these steps to install and configure the Samples Gallery.
1. Install the product.
Select to install the Application Server Samples package.
The Samples are installed in the|app_server_roof{samples directory.
2. Start the application server.
3. Access the Samples Gallery.

The Plants by WebSphere application is installed on the application server by default. That is, you
need not deploy the PlantsByWebSphere.ear file onto the application server. This application is listed
as an installed Sample in the Samples Gallery.

Try it out! See the [quick start instructions on this pagel
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If you have difficulty accessing the Samples Gallery, [check the port number|
4. Install additional Samples.
Additional Samples are initially listed as installable Samples in the Samples Gallery.

To deploy them to the application server, use the install script in the [app_server_roofsamples/samples/
bin directory. See the Samples Gallery for more detailed instructions.

For information about configuring security for Samples, see the Samples Gallery.
Changing the Samples Gallery port number and troubleshooting

If you are unable to access the Samples Gallery, verify the following items.
» Verify that the application server is running.

» Verify that the samples are installed. In the administrative console, expand Applications and click
Enterprise applications. Confirm that the Samples Gallery is listed as an installed application.

If the Samples Gallery is not listed as an installed application:
— Create a new profile using the default profile template.
* Verify the port number.
The default port is 9080, which is the default value of the HTTP transport of the application server. If the
Samples Web address fails, confirm the port number.

BT You can change the port number in the Properties window by clicking Start > Programs >
IBM WebSphere > Application Server Network Deployment v6.0 > profiles > profile_name >
Samples Gallery.

* You must specify a Samples password when using the manageprofiles command to create a profile for
which administrative security is enabled. Otherwise, you will be allowed to create the profile
successfully, but when you run the application server containing the Samples, exceptions and failures
will be thrown to the server system out log.

Client Samples Gallery contents

The Client Samples Gallery demonstrates the following clients.
» J2EE application client

+ Java thin client

* Applet client

* ActiveX to EJB Bridge client

Installing and viewing the Client Samples Gallery

To view the Client Samples Gallery, install the WebSphere Application Server client on a distributed
machine.

See |“Instal|ing Application Client for WebSphere Application Server” on page 314| for more information.

Access the Client Samples Gallery on your local file system at |app_server_rood’samples/samples/
index.html.

Limitations of the Samples
* The Samples are for demonstration purposes only.

The code that is provided is not intended to run in a secured production environment. The Samples
support Java 2 Security, therefore the Samples implement policy-based access control that checks for
permissions on protected system resources, such as file I/O. The Samples also support administrative
security.
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Additional Samples and examples

IBM Telephone Directory
The IBM Telephone Directory business application is shipped separately from WebSphere
Application Server. For information about obtaining and using the IBM Telephone Directory
application, see |IBM Telephone Directory V5.2| in the e-business and Web serving topic of the
iSeries Information Center.

Samples on developerWorks
Additional WebSphere Application Server Samples are available on |WebSphere deveIoperWorksl

Samples in the Rational Web Developer tool
Express users can find Samples with the Rational Web Developer tool that is part of Express.

Samples in tutorials
Many WebSphere Application Server tutorials rely on Sample code. To find tutorials that
demonstrate specific technologies, browse the links in Tutorials.

Examples in the product documentation
The product documentation contains many code snippets and examples. To locate these examples
easily, see the developer examples in the Reference section of the information center navigation
for the product edition that you are using.

Java Samples on the Sun Microsystems Web site
Although they do not showcase the capabilities added by purchasing WebSphere Application
Server, the Samples on the Web site demonstrate the basic functionality of various

technologies.

Web resources for learning

This topic familiarizes you with the many Web sites containing technical information for understanding and
using your WebSphere Application Server product. A wealth of online information is available to
complement the product documentation.

Choose an area of interest.

« [Learning and education|

+ [Developer resources|

« [Architect, planner, installer, and administrator resources
« [Partner resources|

[Redbooks, white papers, and documentation|

* [Troubleshooting and support]

Also, throughout the documentation, you will find additional resources for learning pages, each focused on
a specific technology, such as Web services. The pages provide links to particular documents of interest.

Learning and education
IBM Education Assistant]

Find tutorials, multimedia demonstrations, and presentations for WebSphere servers and Rational
development tools.

[Training and certification|

It's easy to learn about WebSphere® software. IBM has several educational options available to
you. From classroom courses to onsite assistance and Internet-based training, if you're ready to
learn, we're ready to teach.
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Developer resources

[developerWorks - WebSphere Application Server zone|

Use this page to search for information, download software including trial code and fixes, learn
about the application server, and find support and migration information.

[Samples Gallery| (locally installed)

The Samples Gallery is a locally installable application that offers a set of Samples that
demonstrate common Web application tasks.

Architect, planner, installer, and administrator resources

|Detai|ed system requirements pagﬁ

These pages describe the minimum product levels you should have installed before opening a
problem report with the WebSphere Application Server support team.

[Patterns for e-business|

Patterns for e-business are a group of reusable assets that can help speed the process of
developing Web-based applications. The Patterns leverage the experience of IBM architects to
create solutions quickly, whether for a small local business or a large multinational enterprise.
Partner resources
PartnerWorld

Find product, business, and technical inforamtion. The PartnerWorld program is designed to offer
IBM Business Partners benefits, technical support, education, marketing campaigns, sales tools
and more to help you grow your business and drive profits.

Redbooks, white papers, and documentation

[Redbooks - WebSphere|

Find Redbooks pertaining to WebSphere, including the newest, latest, and most popular Redbooks
and Redpapers in draft and published form.

This link performs a query for white papers that are relevant to WebSphere Application Server.

Library page;

A new, improved Web page for finding product documentation, including the online information
center, documentation plug-ins for offline viewing with the WebSphere help system, and PDF
books. This page links to a variety of other kinds of product information, such as WebSphere
Redbooks.

Troubleshooting and support

WebSphere Application Server - Support

This page provides a convenient starting point for querying technical documents, solving problems,
downloading fixes, planning, learning, and communicating.

IBM Support has documents and tools that can save you time gathering information needed to
resolve problems as described in Troubleshooting help from IBM. Before opening a problem
report, see the Support page:

. |http://www.ibm.com/software/webservers/appserv/was/support/|

[Support - Recent updates|

This document lists valuable resources and newly created content.
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http://www.ibm.com/developerworks/patterns/
http://www.ibm.com/partnerworld/pwhome.nsf/weblook/index.html
http://www.redbooks.ibm.com/redbooks.nsf/portals/Websphere
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http://www-306.ibm.com/software/webservers/appserv/was/library/index.html
http://www.ibm.com/software/webservers/appserv/was/support/
http://www.ibm.com/support/docview.wss?rs=180&context=SSEQTP&uid=swg21173515

[Support - Resource reference list

This document is an introduction to available documentation and educational resources.

[Support - Quick links|

This document provides a reference of direct links to available documentation and educational
resources.

Notes

* The WebSphere Application Server product documentation found in the information center and PDF
books documents supported configurations. Many of the above sites could contain information that
describes unsupported configurations.

» Information residing on non-IBM sites is provided for your convenience. Its technical accuracy is
controlled by the owner of the site. Use the information at your own risk.

What is new for developers

This version contains many new and changed features for application developers.

New in Version 6.1! indicates new features or changes implemented at the Version 6.1 level. Unmarked items are
Version 6.0 improvements that apply also to Version 6.1, which should interest anyone migrating to Version 6.1 from
Version 5.x.

Deprecated and removed features describes features that are being replaced or removed in this or future
releases.

Web services

Web services This product has been a leader in advocating support for Web services standards that
allow more automated, less hand-coded cross-platform computing. Standards support
includes WS-Security, which authenticates communications between web services, and
WS-Transactions, which is designed to assure that Web Services transactions are
consistently delivered. Additionally, the product supports the WS-I Basic Profile 1.1 for
development of interoperable Web services supporting the integration of Web services
solutions.

See ['Implementing Web services applications” on page 361,
WS-Transaction affinity, New in Version 6.1! The implementation in this product version removes 6.0 limitations
routing, and authorization to provide Web services the same level of distributed transaction support as enterprise
beans using CORBA:

* WS-AT contexts use virtual host names and can span firewalls

* Application requests with WS-AT contexts can place transactional affinity constraints
on client-side workload management.

e WS-AT protocol messages can be secured.

This product implements a standards-based solution to allow Web services on disparate
systems to take part in global transactions with ACID properties. Transactions can span
between JTA and J2EE and WS-AT/Web services domains in a seamless manner,
requiring no additional programming.

Web services on disparate systems can take part in a compensation model in which
compensational scopes span J2EE components and WS-BA/Web services domains in
a seamless manner, requiring no additional programming. Applications distributed
between WebSphere Application Server and other vendor solutions, for example
Microsoft .NET, can take part in the same global transaction.

See ['Web Services Atomic Transaction support in WebSphere Application Server” on|

lpage 1101]
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WS-Notification support —
‘pub/sub for Web services”

WS-Addressing support --
"protocol independent
interoperability for Web
services"

Enterprise beans can be
invoked from a Web services
client using RMI-110P

New in Version 6.1! The WS-Notification v1.3 specifications have been added to the
WebSphere programming model. Informally described as ‘pub/sub for web services,’
this family of specifications define web service message exchanges (such as an
application interface) to enable web service applications to utilize the ‘publish and
subscribe’ messaging pattern. Traditionally, publish and subscribe messaging is used in
message oriented middle ware scenarios to implement a one-to-many distribution
pattern.

In the publish and subscribe pattern a producing application inserts (publishes) a
message (event notification) into the messaging system, having marked it with a topic
that indicates the subject area of the message. Consuming applications that have
subscribed to the topic and have the appropriate authority, receive an independent copy
of the message that was published by the producing application.

WS-Noatification also allows interchange of event notification between WS-Notification
applications and other clients of the service integration bus. By exploiting other service
integration bus functionality, you can use this function to interchange messages with
other IBM publish and subscribe brokers such as Event Broker or Message Broker.

For more information, search the information center for the text: tjwsn_ep

New in Version 6.1! The product offers support and interoperability with the latest
WS-Addressing specifications from W3C, while maintaining interoperability with the
pre-W3C specification. This family of specifications provides transport-neutral
mechanisms to address Web services and to facilitate end-to-end addressing.

This product version provides a programming interface to support referencing and
targeting of Web service endpoints that represent WS-Resource instances, as defined
by the WS-Resource Framework specification. Additionally, this version introduces a
programming interface to allow programmers to create, reason about and manipulate
WS-Addressing artifacts. Programmers can specify the WS-Addressing Message
Addressing Properties for outbound messages and also acquire WS-Addressing
Message Properties from the incoming message at the receiving endpoint.

See[‘Web Services Addressing support” on page 473

WebSphere Application Server Version 6.0.x supports directly accessing an enterprise
JavaBean (EJB) as a Web service, as an alternative to using HTTP or Java Message
Service (JMS) to transport requests between the server and the client.

Java API for XML-based Remote Procedure Call (JAX-RPC) is the Java standard API
for invoking Web services through remote procedure calls. A transport is used by a
programming language to communicate over the Internet. You can invoke Web services
using protocols with the transport such as SOAP and Remote Method Invocation (RMI).

With Version 6.0.x, you can use Remote Method Invocation over Internet Inter-ORB
Protocol (RMI-IIOP) with JAX-RPC to support non-SOAP bindings. Using RMI-IIOP with
JAX-RPC enables WebSphere Java clients to invoke enterprise beans using a WSDL
file and the JAX-RPC programming model instead of using the standard J2EE
programming model. When a Web service is implemented by an EJB, multiprotocol
JAX-RPC permits the Web service invocation path to be optimized for WebSphere Java
clients.

Using the RMI/IIOP protocol instead of a SOAP- based protocol yields better
performance and enables you to get support for client transactions, which are not
standard for Web services. Benefits include -- XML processing is not required to send
and receive messages; Java serialization is used instead. The client JAX-RPC call can
participate in a user transaction, which is not the case when SOAP is used.

For more information, refer to ['Using WSDL EJB bindings to invoke an EJB from a Web|
[services client” on page 434
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New extensions to the
JSR-101 and JSR-109
programming models

Updates to options used by
the emitter tools Java2WSDL
and WSDL2Java

Additional HTTP transport
properties for Web services
applications

WebSphere Application Server Version 6.0.x provides extensions to the Java
Specification Request JSR-101 and JSR-109 client programming models. These
extensions include the following:

* The REQUEST_TRANSPORT_PROPERTIES property and
RESPONSE_TRANSPORT_PROPERTIES property can be added to a Java API for
XML-based RPC (JAX-RPC) client Stub to enable a Web services client to send or
retrieve HTTP transport headers.

* Implementation-specific support for javax.xml.rpc.ServiceFactory.loadService() as
described by the JSR-101 and JAX-RPC specifications. The loadService methods
create an instance of the generated service implementation class in an
implementation-specific manner. The loadService methods are new for JAX-RPC 1.1
and include three public.javax.xml.rpc.Service loadService signatures.

For more information, refer to ['Extensions to the JAX-RPC and Web Services for J2EE|
[programming models” on page 394

The Java2WSDL command maps a Java class to a Web Services Description
Language (WSDL) file by following the Java API for XML-based remote procedure call
(JAX-RPC) 1.1 specification. The Java2WSDL command accepts a Java class as input
and produces a WSDL file that represents the input class. If a file exists at the output
location, it is overwritten. The WSDL file that is generated by the Java2WSDL
command contains WSDL and XML schema constructs that are automatically derived
from the input class. You can override these default values with command-line
arguments. The Java2WSDL command is protocol independent; when you run the
Java2WSDL command, you can specify command-line options that generate both
SOAP and non-SOAP protocol bindings in the WSDL file. For each binding that can be
generated, the Java2WSDL command has a binding generator to generate the WSDL
for that binding.

New option: Use the -bindingTypes option of the Java2WSDL command to create a
WSDL file that contains non-SOAP protocol bindings. The -bindingTypes option
specifies the binding types to be written to the output of the WSDL document. Review
the Java2WSDL article for more information on using the -bindingTypes option.

The WSDL2Java command is run against a Web Services Description Language
(WSDL) file to create Java APIs and deployment descriptor templates. A WSDL file
describes a Web service. The Java API for XML-based remote procedure call
(JAX-RPC) 1.1 specification defines a Java APl mapping that interacts with the Web
service. The Java Specification Requirements (JSR) 109 1.1 specification defines
deployment descriptors that deploy a Web service in a Java 2 Platform Enterprise
Edition (J2EE) environment. The WSDL2Java command is run against the WSDL file to
create Java APIs and deployment descriptor templates according to these
specifications.

For more information, refer to ['Java2WSDL command” on page 410|and ['WSDL2Javg
[command” on page 414

JVM custom properties are available to manage the connection pool for Web services
HTTP outbound connections. Establishing a connection is an expensive operation.
Connection pooling improves performance by avoiding the overhead of creating and
disconnecting connections. When an application invokes a Web service over an HTTP
transport, the HTTP outbound connector for the Web service locates and uses an
existing connection from a pool of connections. When the response is received, the
connector returns the connection to the connection pool for reuse. The overhead to
create and disconnect the connection is avoided.

See [‘Configuring additional HTTP transport properties using the JVM custom property|
[panel in the administrative console” on page 424
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Additions to the programming model

J2EE 1.4 support

WebSphere extensions

Portlet application support
(JSR 168)

Real time collaboration
features in applications (JSR
116)

Java 5 Software
Development Kit (SDK)

Reliable World Type and
Devanagari font availability

Added serialVersionUID
(SUID) to handle imposing
explicit version control for
serialized classes

J2EE 1.4 specification support is the basis of this product’'s programming model. It
enables you to take advantage of the latest Java technology, as described in Java 2
Platform, Enterprise Edition (J2EE) specification.

Several more WebSphere extensions are now available in this product edition. As a
starting point for learning about each extension, see [Chapter 18, “Learn about|
|[webSphere programming extensions,” on page 1119.|See also the WebSphere
extensions section in[‘Learn about WebSphere applications: Overview and new|
[features” on page 1.|

New in Version 6.1! Developers can write portlets, in addition to servlets.
Administrators can configure, manage, and run portlet applications. Users can access
the portlets with URLS, as they do servlets.

New in Version 6.1! The application programming model has been extended to include
Session Initiation Protocol (SIP) servlet applications. Developers can write SIP
applications, which are Java programs that use at least one Session Initiation Protocol
(SIP) servlet. SIP is used to establish, modify, and terminate multimedia IP sessions
including IP telephony, presence, and instant messaging.

An IETF standard, the SIP protocol (JSR 116) supports clients registration, presence
management, and media session negotiation. Media sessions can include such diverse
media as text chat, IP audio/video, application sharing, and electronic whiteboards.
Applications are growing rapidly, from telecoms and wireless providers, call centers,
pervasive computing, and Customer Relationship Management (CRM). The SIP proxy
can route SIP or HTTP with enterprise class availability.

New in Version 6.1! Developers can use many new API libraries, including generics,
auto boxing of primitives, annotations, and enumerated types.

New in Version 6.1! The World Type fonts and Devanagari font are available as an
e-fix from the product Support site. This is to help mitigate the variance in font coverage
among Linux distributions, especially the Asian language versions.

Classes implementing the Serializable interface have added serialVersionUID (SUID) to
impose explicit version control for Java serialization. A serialVersionUID identifies the
unique original class version for which a class is capable of writing streams and also
from which that class can be read.

best-practices: As you develop your applications, it is recommended that your classes
implementing the Serializable interface use serialVersionUID (SUID) to impose explicit
version control for Java serialization.
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IBM JSF widget library for
improved Web pages

Java Server Faces (JSF) 1.1
support

New in Version 6.1! IBM JSF Widget Library (JWL) is provided as an optional library in
WAS. Applications can use the library when it is included in the Shared Library path.
FacesClient Framework enabled Web pages are able to sustain longer interactions with
the end user without requiring roundtrips back to the server. By creating what effectively
is an MVC (Model View Controller) model inside the page, a developer is able to define
a working set and a set of controls that dynamically bind to that data. The user can
then interact with the working data set, using those controls, and until a roundtrip back
to the server is really necessary (for example, to submit data), the user benefits from
response times and a freedom to interact with the page that is uncommon in regular
Web pages.

For an enterprise that deploys FacesClient Framework enabled Web pages, in addition
to increased user satisfaction due to a more interactive and more responsive
application, it also benefits in other areas such as lower consumption of server-side
resources. Because of the lower amount of roundtrips, and smaller page size relatively
speaking, the enterprise is able to scale its server infrastructure and bandwidth further,
accommodating more users in the current setup. Applications overall are simpler to
develop and maintain. By enabling an MVC-like model on the page, the FacesClient
Framework enables a development model based on standards such as JSF (Java
Server Faces).

See [‘JavaServer Faces widget library (JWL)" on page 80|

New in Version 6.1! Version 6.1 introduces the ability to use JSF 1.1 (JSR 127) in your
Java-based Web applications without including the JSF runtime libraries in your
application, meaning you can produce smaller applications. The JSF 1.1 DTD will be
provided as part of the application server runtime. The JSF specification provides
migration instructions and does not list any deprecations. Your JSF 1.0 applications will
continue to run without modification.

See[JavaServer Faces” on page 76

Data access resources

Service Data Objects (SDO)

Easier programming of
disconnected data objects

As |Introduction to Service Data Objects| explains, the SDO framework makes the J2EE
data programming model simpler, so you can focus on the business logic of your
applications.

See[‘Data access with Service DataObjects” on page 725.|

New in Version 6.1! An enhanced EJB Service Data Object (SDO) Mediator simplifies
the programming model. Current techniques for implementing a disconnected data
objects involve a combination of copy helper objects, session beans and EJB access
beans. Using the EJB mediator reduces the amount of programming. Dynamic data
objects provide flexibility and eliminate the need to define copy helper type objects.
Increased performance can be achieved with optimized queries and having the EJB
mediator read and write directly to the data store, bypassing the need to activate EJB
instances. In addition, the EJB Mediator allows the EJB entity bean programming model
and the EJB query language to provide services that can send or receive SDOs.

See [‘Enterprise JavaBeans Data Mediator Service” on page 741.|
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Cloudscape 10.1.x database New in Version 6.1! WebSphere Application Server supports Cloudscape v10.1.x as a

support test and development database. The new Cloudscape is a pure Java database server.
The code base, which the open source community calls Derby, is a product of the
Apache Software Foundation (ASF) open source relational database project.
Cloudscape 10.1.x highlights include:

* com.ibm.db2j.* becomes org.apache.derby.*:

« org.apache.derby.drda contains the networkServerControl to manipulate the
NetworkServer process

e org.apache.derby.jdbc contains the JDBC classes

e org.apache.derby.tools contains the tools like ij and sysinfo dblook
« db2j.properties file becomes derby.properties

* db2j.system.home becomes derby.system.home

* db2j.drda.* becomes derby.drda.*

See the Cloudscape section of ibm.com: |http://www-306.ibm.com/software/datal

cloudscape

Messaging resources

Easier to configure access to New in Version 6.1! The service integration bus offers improved, easier to configure

WebSphere MQ queues from connectivity to WebSphere MQ software. An application connected to the bus now can

the service integration bus read messages directly from any z/OS WMQ queue, reducing your need to repeat MQ
configuration details.

Version 6.0 did not allow pulling messages directly from MQ queues, which could only
be configured as “foreign destinations.” In this version, a bus destination can act as a
proxy for a z/OS WMQ Queue. JMS applications (including those using message driven
beans) can access WMQ queues through such destinations. Requests to both send
and receive messages against a destination that is acting as a proxy are delegated to
the Queue Manager of the MQ queue, using MQ client protocols including XA flows.
This capability enables queue access to be coordinated as part of a global transaction
running in WebSphere Application Server.

As a starting point, see Learn about WebSphere applications > Service integration
in the WebSphere Application Server information center navigation.

Flexibility in storage options New in Version 6.1! Storage options now include using the file system instead of a
relational database. The message store component of a service integration bus
messaging engine can be configured to use the file system for persistent storage as an
alternative to using a relational database. New messaging engines are configured with
a file-system-based message store by default. Options are provided in the console
wizard and related scripting commands to specify directories and storage file sizes.
Options also exist to select a relational-database-based message store.

As a starting point, see Learn about WebSphere applications > Service integration
in the WebSphere Application Server information center navigation.

Improved development and assembly tools
Easier deployment Deploying applications has never been easier -- particularly redeploying updated

applications or modules.
administrators.
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Rational Web Developer
(RWD)

Updates to the Application
Server Toolkit

WebSphere Express
includes Rational Web
Developer improvements

Rational Web Developer (RWD) is included with Express, and has several
improvements of its own. To save time and trouble for developers who build
applications with WebSphere Application Server, Version 6.0.x includes a new
wizards-based, drag-and-drop environment that automates the most common and
tedious steps of application development and deployment. By eliminating hand coding,
developers can significantly reduce the number of programming steps previously
needed to build an application. These features also allow developers to build and test
applications once and deploy them across many disparate systems.

Note that RWD is supported only on Linux and Windows operating systems.
The Application Server Toolkit has new capability:

The server editor now has an option to optimize a WebSphere Application Server
v6.x server for testing and developing. This option can reduce the startup time of the
server. For details on the Optimize server for testing and developing check box,
see Reducing the startup time for WebSphere Application Server v6.0 in the online
help.

For EJB 2.x container managed persistence (CMP) entity beans, you can now use a
partial operation to specify how you want to update the persistent attributes of the
CMP bean to the database. Use the UPDATE_ONLY option for the partial operation
to limit updates to the database to only persistent attributes of the CMP bean that
have been modified. You can specify the partial operation as a persistent option at
the bean-level in the access intent policy configured for the bean. For details on how
to use the Partial Operation check box, see Partial operation for container managed
persistence in the online help.

You can now specify Derby v10 as a valid database vendor backend ID when
generating EJB deployment code. See The ejbdeploy command in the online help.

You can now specify the -dbvendor option for a mapped JAR file. In releases
previous to v6.0.2, if the -dbvendor option is specified for mapped JAR files, the
database vendor specification is ignored. Specifying the database vendor in the
ejbdeploy command is used for generating new top-down maps. If omitted, then the
ejbdeploy command uses a default value: DB2UDB_V81. For 2.x CMP beans, multiple
mappings to different database vendors are supported. 1.1 CMP beans can only be
mapped once. For details on the -dbvendor option, see the online help.

See

To save time and trouble for application developers, the product include a new
wizards-based, drag-and-drop environment that automates the most common and
tedious steps of application development and deployment. By eliminating hand coding,
developers can significantly reduce the number of programming steps previously
needed to build an application. These features also allow developers to build and test
applications once and deploy them across many disparate systems.

Assembly tools

WebSphere Application Server supports two tools that you can use to develop, assemble, and deploy
J2EE modules: Application Server Toolkit (AST) and Rational Application Developer. These tools are
referred to in this information center as the assembly tools.

The AST is available in your WebSphere Application Server CD-ROM package. Rational Application
Developer is available only on a trial basis in the WebSphere Application Server CD-ROM package.

The assembly feature of the AST and Rational Application Developer products runs on Windows and Linux
Intel platforms. Users of WebSphere Application Server on other platforms must assemble their modules
using an assembly tool installed on Windows or Linux Intel platforms. To install an assembly tool, follow
instructions available with the tool.
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Although this information center refers to the AST and Rational Application Developer products as the
assembly tools, you can use the products to do more than assemble modules. Rational Application
Developer is an integrated development environment that provides development, testing, assembly and
deployment capabilities. However, topics on application assembly in this information center focus on
assembling J2EE modules using the J2EE Perspective of the assembly tools. Each assembly tool provides
extensive online documentation; the topics on application assembly in this information center supplement
that documentation. The Application Server Toolkit information center is available with this information
center.

Enterprise (J2EE) applications

Enterprise applications (or J2EE applications) are applications that conform to the Java 2 Platform,
Enterprise Edition, specification.

Enterprise applications can consist of the following:

» Zero or more EJB modules (packaged in JAR files)

» Zero or more Web modules (packaged in WAR files)

» Zero or more connector modules (packaged in RAR files)

» Zero or more Session Initiation Protocol (SIP) modules (packaged in SAR files)

» Zero or more application client modules

» Additional JAR files containing dependent classes or other components required by the application
* Any combination of the above

A J2EE application is represented by, and packaged in, an enterprise archive (EAR) file.

Service Data Objects: Resources for learning

Use the following links to find relevant supplemental information about the service data object and various
other functions that can be used with it. The information resides on IBM and non-IBM Internet sites, whose
sponsors control the technical accuracy of the information.

These links are provided for convenience. Often, the information is not specific to this product but is useful
all or in part for understanding the product. When possible, links are provided to technical papers and
Redbooks that supplement the broad coverage of the release documentation with in-depth examinations of
particular product areas.

Service Data Objects

For an introduction to Service Data Objects, refer to:
« [Introduction to Service Data Objectq

For an overview of the Service Data Objects specification, refer to:
« |Specifications: Service Data Objects|

A good place to start to learn about the Eclipse Modeling Framework is:
+ |[EMF Eclipse Modeling Framework|

Information about XSD to SDO/EMF mapping for Version 6 can be found at:
XML Schema to Ecore Mapping|

Web application presentation layer technologies

For a brief overview of JavaServer Faces, refer to:

* |IBM Faces Component Catalog
» Java Sun J2EE 1.4 tutorial
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Good places to start to learn about JavaServer Pages Standard Tag Library are:
« [JavaServer Pages Standard Tag Library|
 [A JSTL primer, Part 1: The expression languagel
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Chapter 2. Designing applications

This topic highlights Web sites and other ideas for finding best practices for designing WebSphere
applications, particularly in the realm of WebSphere extensions to the Java 2 Platform, Enterprise Edition
(J2EE) specification.

When designing WebSphere applications, follow the example set by the|Samples, Refer to the code in the
Samples Gallery that is available with the product. In particular, the Samples Gallery highlights new and
WebSphere-specific aspects of the programming model.

Use the following links to find relevant supplemental information about designing WebSphere applications.
The information resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy
of the information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

Web resources for learning
The top 10 (more or less) J2EE best practices|

The authors, who are IBM consultants and performance experts, describe this document in the following
way: Over the last five years, a lot has been written about J2EE best practices. There now are probably
10 or more books along with dozens of articles that provide insight into how J2EE applications should
be written. In fact, there are so many resources, often with contradictory recommendations, navigating
the maze has become an obstacle to adopting J2EE itself. To provide some simple guidance for
customers entering this maze, we set out to compile the following "top 10" list of what we feel are the
most important best practices for J2EE.

[IBM Patterns for e-Business|

Patterns for e-business are a group of reusable assets that can help speed the process of developing
Web-based applications. The patterns leverage the experience of IBM architects to create solutions
quickly, whether for a small local business or a large multinational enterprise.

[WebSphere Best Practices and Performance Considerations|

This document is older (2001), but its focus on the fundamentals of Web and Enterprise JavaBeans
(EJB) application programming helps it stand the test of time.

[Best practices for using XSLT in WebSphere Application Server applications|

The author states: In this article | explore the reasons why some WebSphere Application Server
applications use XSL for HTML production instead of JavaServer Pages (JSP) files. | will compare the
performance of XSLT for HTML/XHTML production against JSP files and browser formatting. | will then
provide guidance on how to improve XSLT performance in WebSphere Application Server should you
decide to go this route. While this article focuses on the use of XSLT for the production of HTML, the
performance best practices are directly applicable to other WebSphere Application Server uses of XSLT,
such as XML-to-XML transformations and XML-to-text transformations.

[Rational on developerWorks|

This page provides quick links to technical resources and best practices for Rational software. Browse
information by product or by technology. Find resources for learning, support, and developer
communities.

+ [developerWorks site|

developerWorks is IBM’s technical resource for developers, providing a wide range of tools, code, and
education on DB2, eServer, Lotus, Rational, Tivoli, and WebSphere as well as on open standards
technology such as Web services, Wireless, Linux, XML, Java technologies, and more. By providing
focused and relevant technical information for developers, developerWorks offers choices you can apply
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to building and deploying applications across heterogeneous systems. Using developerWorks, you can
take full advantage of open standards and the IBM Software Development Platform in an on demand
world.

+ [Resource reference list

WebSphere Application Server has a large amount of existing documentation. Use the following user
communities and other non-IBM sites that gather knowledge about using WebSphere products as a
guideline to find the documentation that you require.

— http://www.websphere-world.com/

— http://www.websphere.org/

— http://www.webspherepro.com/wphome/
— http://lwww.sys-con.com/websphere/

— http://lwebsphereadvisor.com/

See also the documentation for the type of application that you are developing, such as Web applications,
EJB applications, Web services applications, or applications that use messaging. Many sections contain
Web resources for learning topics that bring attention to specific documents that become available.

Reference: Generated APl documentation

The generated APl documentation provides the details of the supported WebSphere Application Server
application programming interfaces (APIs).

The generated APl documentation is available in the information center table of contents:

* Reference > Developer > APl documentation for developing J2EE applications to deploy on the
application server

» Reference > Administrator > APl documentation for extending the administrative infrastructure

To open the information center table of contents to the location of this reference information, click the
Show in Table of Contents button () on your information center border.

API documentation is organized by the package and class name, for easy lookup.
The API documentation is displayed in the content frame of the information center. If you would like more
room to view the API documentation, double-click the gray bar located above the content area. This will

expand the content area, while hiding the navigation area (the area containing the table of contents or
search results list). Double-click the gray bar again when you are ready to restore the navigation area.
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Chapter 3. Obtaining an integrated development environment
(IDE)

This topic describes obtaining an integrated development environment (IDE). Use Rational products from
IBM to design, construct, and manage changes to applications for deployment on your WebSphere
Application Server products.

* Use the launchpad to start the installation.
Rational Web Developer is included with your purchase of WebSphere Application Server-Express. You

can launch the Rational Web Developer installation from the Launch Pad application or by other means,
as described in this topic.

» See Planning to install WebSphere Application Server - Express for information about typical topologies
for Express and Rational Web Developer.

The topic includes ideas for how to incorporate the development environment and Express server into
your topology. The topic helps you decide such things as setting up a simple, single machine test
environment, or an integrated test environment.

See also Roadmap: Installing Rational Web Developer for instructions about installing the development
environment.

» Seel|Assembly tools|for a description of the Application Server Toolkit that is shipped with product.
* Refer to these Web resources for learning.

[Rational software pages on ibm.com|
Browse IBM’s portfolio of software for requirements analysis and tracking, application design
and construction, ensuring software quality, configuration and change management, and
development project management.

[Rational on developerWorks|
This page provides quick links to technical resources and best practices for Rational software.
Browse information by product or by technology. Find resources for learning, support, and
developer communities.

|[developerWorks main page]
This page is the entrance to IBM’s resource for developers.
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Chapter 4. Web applications

Task overview: Developing and deploying Web applications

A developer creates the files comprising a Web application, and then assembles the Web application
components into a Web module. Next, the deployer (typically the developer in a unit-testing environment
or the administrator in a production environment) installs the Web application on the server.

1. (Optional) Migrate existing Web applications to run in the new version of WebSphere Application
Server.

2. Design the Web application and develop its code artifacts: [Servlets| [JavaServer Pages (JSP) files| and
static files, as for example, images and Hyper Text Markup Language (HTML) files. See the |“Wek3|
[applications: Resources for learning” on page 66| topic for links to design documentation.

JavaServer Pages programming tips:

» Disable session state of JavaServer Pages files using <%@ page language="java"
contentType="text/htm1" session="false" %> instead of <%@ page language="java"
contentType="text/html" %>

* Replace setProperties calls in your JavaServer Pages files with direct calls to the appropriate setxxx
methods.

3. |Deve|op the Web application|, using WebSphere Application Server extensions to enhance its
functionality.

4. Assemble the Web application into a Web module using an jJassembly tool. Web module assembly
properties might include the ability to:

» Configure servlet page lists.

* Configure servlet filters.

* Serve servlets by class name.

* Enable file serving.

5. |Deploy the Web module or application module|that contains the Web application.

Following deployment, you might find it handy to use the [tool that enables batch compiling| of the JSP
files for quicker initial response times.

6. (Optional) Troubleshoot your Web application.

7. (Optional) Modify the default Web container configuration in the application server in which you
deployed the Web module or application module containing the Web application.

8. (Optional) [Manage the deployed Web application}

Web applications

A Web application is comprised of one or more related servlets, JavaServer Pages technology (JSP files),
and Hyper Text Markup Language (HTML) files that you can manage as a unit.

The files in a Web application are related in that they work together to perform a business logic function.
For example, one of the WebSphere Application Server samples is a|Simple Greeting|Web application.
This application, comprised of a servlet and Web pages, greets new users when they access the
application.

The Web application is a concept supported by the Java Servlet Specification. Web applications are
typically packaged as .war files.

web.xml file

The web.xml file provides configuration and deployment information for the Web components that
comprise a Web application. Examples of Web components are servlet parameters, servlet and
JavaServer Pages (JSP) definitions, and Uniform Resource Locators (URL) mappings.
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The Java Servlet 2.4 specification defines the web.xml deployment descriptor file in terms of an XML
schema document. For backwards compatibility of applications written to the Java Servlet 2.2
Specification, Web containers are also required to support the Java Servlet 2.2 specification. For
backwards compatibility of applications written to the Java Servlet 2.3 specification, Web containers are
also required to support the Java Servlet 2.3 specification.

If you use Rational Application Developer version 6 to create your portlets, you must remove the following
reference to the std-portlet.tid from the web.xml file:

<taglib id="PortletTLD">
<taglib-uri>http://java.sun.com/portlet</taglib-uri>
<taglib-Tlocation>/WEB-INF/t1d/std-portlet.t1d</taglib-location>
</taglib>

Location

The web.xml file must reside in the WEB-INF directory under the context of the hierarchy of directories that
exist for a Web application.

For example, if the application is client.war, then the web.xml file is placed in the install_root/client
war/WEB-INF directory.

Usage notes
* |Is this file read-only?

No
* s this file updated by a product component?

This file is updated by the Application Server Toolkit.
» If so, what triggers its update?

The Application Server Toolkit updates the web.xml file when you assemble Web components into a
Web module, or when you modify the properties of the Web components or the Web module.
* How and when are the contents of this file used?

WebSphere Application Server functions use information in this file during the configuration and
deployment phases of Web application development.

Sample file entry

<?xml version="1.0" encoding="UTF-8"?>
<web-app id="WebApp_9" version="2.4" xmlins="http://java.sun.com/xml/ns/j2ee"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://java.sun.com/xml/ns/j2ee http://java.sun.com/xml/ns/j2ee/web-app_2_4.xsd">
<display-name>Serviet 2.4 application</display-name>
<filter>
<filter-name>ServletMappedDoFilter_Filter</filter-name>
<filter-class>tests.Filter.DoFilter Filter</filter-class>
<init-param>
<param-name>attribute</param-name>
<param-value>tests.Filter.DoFilter_Filter.SERVLET_MAPPED</param-value>
</init-param>
</filter>
<filter-mapping>
<filter-name>ServletMappedDoFilter Filter</filter-name>
<url-patter>/DoFilterTest</url-pattern>
<dispatcher>REQUEST</dispatcher>
</filter-mapping>
<filter-mapping>
<filter-name>ServletMappedDoFilter Filter</filter-name>
<url-patter>/IncludedServiet</url-pattern>
<dispatcher>INCLUDE</dispatcher>
</filter-mapping>
<filter-mapping>
<filter-name>ServletMappedDoFilter Filter</filter-name>
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<url-patter>ForwardedServlet</url-pattern>
<dispatcher>FORWARD</dispatcher>

</filter-mapping>

<listener>
<listener-class>tests.ContextListener</listener-class>

</listener>

<listener>
<listener-class>tests.ServletRequestListener.RequestListener</listener-class>

</listener>

<servlet>
<servlet-name>welcome</servlet-name>
<servlet-class>WelcomeServlet</servlet-class>

</servlet>

<servlet>
<servlet-name>ServietErrorPage</servlet-name>
<servlet-class>tests.Error.ServietErrorPage</serviet-class>

</servlet>

<servlet>
<servlet-name>IncludedServlet</servlet-name>
<servlet-class>tests.Filter.IncludedServlet</servlet-class>

</servlet>

<servlet>
<servlet-name>ForwardedServiet</servlet-name>
<servlet-class>tests.Filter.ForwardedServiet</serviet-class>

</servlet>

<servlet-mapping>
<servlet-name>welcome</servlet-name>
<url-pattern>/hello.welcome</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>ServietErrorPage</servlet-name>
<url-pattern>/ServietErrorPage</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>IncludedServlet</servlet-name>
<url-pattern>/IncludedServiet</url-pattern>

</servlet-mapping>

<servlet-mapping>
<servlet-name>ForwardedServiet</servlet-name>
<url-pattern>/ForwardedServiet</url-pattern>

</servlet-mapping>

<welcome-file-Tist>
<welcome-file>hello.welcome</welcome-file>

</welcome-file-list>

<error-page>
<exception-type>java.lang.ArrayIndexOutOfBoundsException</exception-type>
<location>/ServietErrorPage</location>

</error-page>

</web-app>

Default Application

WebSphere Application Server provides a default configuration that allows administrators to easily verify
that the Application Server is running. When the product is installed, it includes an application server called
server1 and an enterprise application called Default Application.

Default Application contains a Web module called DefaultWebApplication and an enterprise bean Java
archive (JAR) file called Increment. The Default Application provides a number of servlets, described
below. These servlets are available in the product.

For additional code examples, visit the Samples Gallery. Learn how to locate and install the Samples
Gallery by viewing the [Samples Gallery| reference page.
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Snoop servlet

Use the Snoop servlet to retrieve information about a servlet request. This servlet returns the following
information:

* Servlet initialization parameters

» Servlet context initialization parameters

* URL invocation request parameters

» Preferred client locale

» Context path

» User principal

* Request headers and their values

* Request parameter names and their values
* HTTPS protocol information

» Servlet request attributes and their values

* HTTP session information

» Session attributes and their values

The Snoop servlet includes security configuration so that when WebSphere Security is enabled, clients
must supply a user ID and password to initiate the servlet.

The URL for the Snoop servlet is: http://Tocalhost:9080/snoop/.

HelloHTML serviet

Use the HelloHTML pervasive servlet to exercise the PageList support provided by the WebSphere Web
container. This servlet extends the PageListServlet, which provides APIs that allow servlets to call other
Web resources by name or, when using the Client Type detection support, by type.

You can invoke the Hello servlet from an HTML browser, speech client, or most Wireless Application
Protocol (WAP) enabled browsers using the URL: http://1ocalhost:9080/Hel10oHTML. jsp.

transition: The PageList Servlet custom extension is deprecated in WebSphere Application Server
Version 6.1 and will be removed in a future release. Re-architect your legacy applications to
use javax.servlet.filter classes instead of com.ibm.servlet classes. Starting from the Servlet 2.3
specification, javax.servlet.filter classes you can intercept requests and examine responses.
You can also use javax.servlet.filter classes to achieve chaining functionality, as well as
embellishing or truncating responses.

HitCount application

Use the HitCount demonstration application to demonstrate how to increment a counter using a variety of
methods, including:

* A servlet instance variable

* An HTTP session

* An enterprise bean

You can instruct the servlet to execute any of these methods within a transaction that you can commit or
roll back. If the transaction is committed, the counter is incremented. If the transaction is rolled back, the
counter is not incremented.

The enterprise bean method uses a container-managed persistence enterprise bean that persists the
counter value to a Cloudscape database. This enterprise bean is configured to use the Default
Datasource, which is set to the DefaultDB database.

When using the enterprise bean method, you can instruct the servlet to look up the enterprise bean, either
in the WebSphere global namespace, or in the namespace local to the application.
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The URL for the HitCount application is: http://Tocalhost:9080/HitCount.jsp.

Servlets

Servlets are Java programs that use the Java Servlet Application Programming Interface (API). You must
package servlets in a Web archive (WAR) file or Web module for deployment to the application server.
Servlets run on a Java-enabled Web server and extend the capabilities of a Web server, similar to the way
applets run on a browser and extend the capabilities of a browser.

Servlets can support dynamic Web page content, provide database access, serve multiple clients at one
time, and filter data.

For the purposes of WebSphere Application Server, discussions of servlets focus on Hyper Text Transfer
Protocol (HTTP) servlets, which serve Web-based clients.

With the introduction of Java Servlet 2.4 specification, you can define servlets as welcome files.
Non-servlet resources are served only when the FileServingEnabled attribute is set to true. Serving
welcome files is connected to serving static content, therefore fileServing enabled is set in the Web
module.

JavaServer Pages

JavaServer Pages (JSP) are application components coded to the JavaServer Pages Specification.
JavaServer Pages enable the separation of the Hypertext Markup Language (HTML) code from the
business logic in Web pages so that HTML programmers and Java programmers can more easily
collaborate in creating and maintaining pages.

JSP files support a division of roles:

HTML authors
Develop JSP files that access databases and reusable Java components, such as servlets and
beans.

Java programmers
Create the reusable Java components and provide the HTML authors with the component names
and attributes.

Database administrators
Provide the HTML authors with the name of the database access and table information.

WebSphere Application Server Version 6.1 supports the [JSP 2.0 specification| The sub-topics below
discuss WebSphere Application Server's JSP 2.0 implementation, focusing on configuration, tools and
extensions.

JSP class file generation

At runtime, the WebSphere Application Server JavaServer Pages (JSP) engine loads JSP class files from
either the WebSphere Application Server temp directory or a Web module’s WEB-INF/classes directory. The
WebSphere Application Server temp directory is typically WAS INSTALL ROOT/AppServer/profiles/default/
temp/node_name/server_name. The JSP engine first searches for a class file in the temp directory and then
it searches in the Web module’s WEB-INF/classes directory. Figure 1 shows the processing logic of the
JSP engine at runtime.
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Request for a JSP.

Is the class file found in
WebSphere Application Server
temp directory?

Is the class file found in
WEB-INF/classes

Is the class file outdated?

Yes
Y
Generate the class file
into WebSphere
Application Server P»| Load the class file.
temp directory.

T

The batch compiler supports the generation of class files in both the WebSphere Application Server temp
directory and a Web module’s WEB-INF/classes directory, depending on the type of batch compiler target.
In addition, the batch compiler enables the generation of class files into any directory on the filesystem,
outside of the target application. Generating class files into a Web module’s WEB-INF/classes directory
enables you to deploy the Web module as a self-contained Web archive (WAR) file, or a WAR file inside
an enterprise archive (EAR) file. The following table shows the batch compiler's behavior when compiling
class files.

ear.path or war.path supplied enterpriseApp.name supplied
compileToDir not supplied; The class files are compiled into the | The class files are compiled into the Web
compile ToWeblinf not Web module’s WEB-INF/classes module’s WEB-INF/classes directory.
supplied, or is true directory.
compileToDir not supplied; The class files are compiled into the | The class files are compiled into the
compileToWeblinf is false Web module’s WEB-INF/classes WebSphere Application Server temp directory,
directory. usually {WAS_R0OT}/profiles/profilename/temp
compileToDir is supplied; The class files are compiled into the | The class files are compiled into the directory
compile ToWeblinf not directory indicated by compileToDir. |indicated by compileToDir.
supplied, or is either true or
false

Packages and directories for generated .java and .class files

By default, the .java files for all JavaServer Pages (JSP) files are generated with the package statement,
package com.ibm._jsp;. The JSP engine’s class loader knows how to load JSP classes when they are all
in the same package. The .java files are located in the filesystem within a directory structure mirroring the
JSP source directory structure.

If the JSP engine configuration parameter useFullPackageNames is set to true, the .java files are
generated with the package statement
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Package _ibmjsp.<directory structure in which the jsp is Tocated>;

The usage of full package names enables the configuration of a JSP as a servlet in the web.xml file. See
['JSP class loading” on page 36| for more information. The table below gives examples of packages and
directory structures for generated .java and .class files.

Java package Location of .java or .class files in file
system
JSP file default useFullPackageNames=true |default useFullPackageNames=true
/myJsp.jsp com.ibm._jsp |_ibmjsp / /_ibmjsp
lispFiles/ com.ibm._jsp | _ibmjsp.jspFiles ljspFiles /_ibmjspl/jspFiles
jspOne.jsp
/dir with com.ibm._jsp | _ibmjsp.dir_20_with_20_spaces|/dir with |_ibmjsp/
spaces/jspTwo.jsp spaces dir_20_with_20_spaces

Generated .java files: When the JSP engine’s keepgenerated configuration parameter is set to true, the
.java file that is generated for JavaServer Pages (JSP) is retained. This file contains information that is
useful in debugging.

Dependency information

In the .java file, immediately following the class declaration, an array of dependent files is defined, if the
source JSP has any dependencies. There are three types of files that are tracked as dependencies:

1. Files that are statically included in the JSP
2. Tag files that are used by the JSP, but only tag files that are not in Java Archive (JAR) files
3. TLD files that are used by the JSP, but only TLDs that are not in JAR files

This array is always generated, but the JSP engine uses it, in determining whether a JSP needs to be
recompiled, only when the trackDependencies parameter is set to true.

In the example below, three JSP fragments, one TLD and one tag file are dependencies of the JSP
jspl.jsp. There are three parts to each array entry:

1. The path to the dependency, relative to the Web module’s context root. For example:
/dirl/fragl.jspf

2. The long value representing the time the file was last modified. For example: 1082407108000

3. The String representation of the long value. For example: Mon Apr 19 16:38:28 EDT 2004

public final class _jspl extends com.ibm.ws.jsp.runtime.HttpJspBase
implements com.ibm.ws.jsp.runtime.JspClassInformation {

private static String[] _jspx_dependants;

static {

_Jjspx_dependants = new String[5];

_Jjspx_dependants[0] "/Banner. jspf~1082407108000"Mon Apr 19 16:38:28 EDT 2004";
_Jspx_dependants[1] "/Footer.jspf~1077657462000~Tue Feb 24 16:17:42 EST 2004";
_Jspx_dependants[2] = "/dirl/fragl.jspf~1035396680000™ed Oct 23 14:11:20 EDT 2002";
_Jspx_dependants[3] "/utility.t1d”~1080069938000"Tue Mar 23 14:25:38 EST 2004";
_Jjspx_dependants[4] "/WEB-INF/tags/top.tag~1065440490000”™Mon Oct 06 07:41:30 EDT 2003";
}

Version, JSP engine options, and WEB.XML information

The generated .java source contains a comment that lists information about the file which is located at the
bottom of the generated file. This information includes:

* The date and time the .java file was generated
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* The version, build number and build date of the WebSphere Application Server on which the .java file

was generated

* The values of the JSP engine configuration parameters that were in effect when the file was generated
* The values of any <jsp-config> elements in the web.xm1 file that pertained to the source JSP file.

/*
AppSrvOl/i nstalledApps/MyCell/sampleApp.ear/examples.war/WEB-INF/classes/_ibmjsp/_jspl.java
was generated @ Wed May 03 10:05:56 EDT 2006IBM WebSphere Application Server - ND, 6.1.0.0

Build Number: 00441.04

Build Date: 05/01/06%x*%%kkkkkkkkkhkkkhhhhhhhrhkhhrhkhhhrhrhrhhhrhhrrhhrrrrrrk
The JSP engine configuration parameters were set as follows:

classDebugInfo = [false]

debugEnabled = [false]

deprecation = [false]

compileWithAssert = [false]

jdkSourceLevel = [13]disabledspRuntimeCompilation =[false]

extendedDocumentRoot = [nu11]

ieClassld = [c1sid:8AD9C840-044E-11D1-B3E9-00805F499D93]

keepGenerated = [true]

outputDir = [C:/WebSphere_6.0/AppServer/profiles/AppSrv0l/installedApps/MyCell/
sampleApp.ear/examples.war/WEB-INF/classes]

reloadEnabled = [true]

reloadEnabledSet = [true]

reloadInterval = [5000]

trackDependencies = [false]

usePageTagPool = [false]

useThreadTagPool = [true]

useImplicitTagLibs = [true]

verbose = [false]

looseLibMap = [nu11]

usedikes = [false]

useFullPackageNames = [true]

translationContextClass = [null]

extensionProcessorClass = [null]

javaEncoding = [UTF-8]

autoResponseEncoding = [false]

khkhkkhkkhkkhhkkhhkkhhkkhhhkhhhhhkhhhkhhhhhhdhhkhhhkhhhkdhhdrxhdxdhkhkdxkx
The following JSP Configuration Parameters were obtained from web.xml:

prelude Tist = [[]]

coda list = [[]]

elIgnored = [false]
pageEncoding = [null]
isXML = [false]
scriptingInvalid = [false]
*

/

JSP class loading
You can configure a JavaServer Pages (JSP) class to be loaded by either the JSP engine’s class loader or
by the Web module’s class loader.

By default, a JSP class is loaded by a unique instance of the JSP engine’s class loader. The JSP engine’s
class loader enables reloading at runtime of a JSP class when the JSP source or one of its dependents is
modified. This allows you to reload a single JSP class when necessary, without affecting any other loaded
JSP classes.

JSP classes are loaded by the Web module’s class loader under either of the following scenarios.
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1. 1. The JSP engine configuration parameter useFullPackageNames is set to true, and the JSP file is
configured as a servlet in the web.xml file using the <servlet-class> scenario in the table below.

2. 2. The JSP engine configuration parameters useFullPackageNames and
disableJspRuntimeCompilation are both set to true. In this case, you do not need to configure a JSP
file does as a servlet in the web.xm1 file.

Configuring JSP files as Servlets

You can configure a JSP file as a servlet in the web.xm1 file. There are two ways to do this. They are
described in the table below.

Before you configure a JSP file as a servlet, consider the following.

1. Reloading capability - If runtime reloading of JavaServer Pages files is desired, requests for
JavaServer Pages files must be handled by the JSP engine. The <servlet-class> scenario in the table
below disables runtime JSP file reloading, while the <jsp-file> scenario is compatible with reloading.

2. Reducing the number of class loaders - If you do not require runtime reloading of modified JSP pages
and you want to reduce the number of class loader instances, then you can use the <servlet-class>
scenario in the table below. Similarly, scenario 2 in section 1 above can be used without having to
configure a JSP file as a servlet.

Scenario Example compatible multiple class |useFullPackageNames
with runtime loaders used?
reloading

<jsp-file> <servlet> Yes Yes Can be true or false

<servlet-name>jspOne</servlet-
name>

<jsp-file>jspOne.jsp</jsp-file>

</servlet>

<servlet-class> <servlet> No No Must be true

<servlet-name>jspTwo</servlet-
name>

<servlet-class>_ibmjsp.jspTwo</
servlet-class>

</serviet>

The JSP batch compiler tool helps you configure JavaServer Pages files as servlets. When
useFullPackageNames is true, the JSP batch compiler generates <servlet> and <servlet-mapping>
elements for each JSP file that it successfully translates and compiles. The elements are written to a
web.xml fragment file named generated_web.xml which is located in the binaries WEB-INF directory of a
Web module processed by the JSP file batch compiler (this directory is located within the deployed
application’s ear file). You can copy and paste all or some of these elements into the web.xml file to
configure JavaServer Pages files as servlets.

Take note of the location of the web.xm1 that is used by the application server. The application specific
configuration is obtained from either the application binaries (the application’s ear file) or from the
configuration repository. If an application is deployed into WebSphere Application Server with the flag Use
Binary Configuration set to true, then the WEB-INF/web.xml file is looked for in a Web module’s binaries
directory, not in the configuration repository. Below are examples of these two locations.

* An example of a configuration repository directory is {WAS_ROOT}/profiles/profilename/config/cells/
cellname/applications/enterpriseappname/deployments/deployedname/webmodulename
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« An example of an application binaries directory is: {WAS_ROOT}/profiles/profilename/installedApps/
nodename /EnterpriseAppName/WebModuleName/

If the JSP batch compiler is executed on a pre-deployed application then the web.xm1 file is in the Web
module’s WEB-INF directory.

Configuring JSP run time reloading

JSP files can be translated and compiled at run time when the JSP file or its dependencies are modified.
This is known as JSP reloading. JSP reloading is enabled through the reloadEnabled JSP engine
parameter in the WEB-INF/1ibm-web-ext.xmi file:

<jspAttributes xmi:id="JSPAttribute 1" name="reloadEnabled" value="true"/>

The following table contains the recommended reload settings for production and development
environments.

Recommended settings

Configuration Attribute Production Environment Development Environment
reloadEnabled false true
reloadinterval n/a (ignored if reloadEnabled is approximately 5 seconds
false)
trackDependencies n/a (ignored if reloadEnabled is true Alternatively, set this to false to
false) improve response time if

dependencies are not changing

disableJspRuntimeCompilation true - Alternatively, set this to false if |false
JSP files are not pre-compiled and
therefore need to be compiled on
the first request.

If the reloadEnabled parameter is set to true, a JSP file is reloaded at run time if the JSP file and its class
file do not have the same timestamp. In addition, if trackDependencies is set to true then the JSP file is
reloaded if the timestamp of any of its dependencies has changed since the JSP class file was last
generated. If the reloadEnabled parameter is set to false, a JSP file is still compiled if necessary on the
first request to it unless the parameter disableJspRuntimeCompilation is true. For example, when
disabledspRuntimeCompilation is false and reloadEnabled is false, a JSP file is compiled on the first
request if the class file is outdated. It would not compiled on subsequent requests even if the JSP source
file is modified or the class file is deleted unless reloadEnabled is true

Reload interval

The reload interval is set through the reloadinterval JSP engine parameter:
<jspAttributes xmi:id="JSPAttribute_ 1" name="reloadInterval" value="5"/>

If reloading is enabled, the reloadinterval parameter value determines the delay between checks to see if
a JSP file is outdated. For example, if reloadInterval is 5, the JSP engine checks to see if a JSP file is
outdated only when the last such check was done more than five seconds prior to the current request for
the JSP file. Once the reloadinterval is exceeded, reload checking is performed and the reload interval
timer is reset to O for that JSP file. The larger the reloadinterval, the less frequently the JSP engine
checks for the need to reload a JSP file.

Dependency tracking
Dependency tracking is set through the trackDependencies JSP engine parameter:

<jspAttributes xmi:id="JSPAttribute_1" name="trackDependencies" value="true"/>
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If reloading is enabled, the trackDependencies parameter value determines whether the JSP engine
tracks modifications to the requested JSP file dependencies as well as to the JSP file itself. The three
types of dependencies tracked by the JSP engine are:

« files statically included in the JSP file
 tag files that are referenced in the JSP file (excluding tag files that are in JAR files)
* TLDs that are referenced in the JSP file (excluding TLDs that are in JAR files)

Dependency tracking information is always included in the generated class file even if trackDependencies
is false. The information is not used by the JSP engine or batch compiler unless the trackDependencies
parameter is true. This means that you can enable dependency tracking without having to recompile JSP
files.

For example, the toplevel.jsp file statically includes the footer.jspf file. When the toplevel.jsp file is
compiled, the path to the footer. jspf file and its timestamp are stored in the toplevel.jsp’s class file. As
a result, the footer. jspf file is modified and the toplevel.jsp file is requested. Now that the reload
interval for the toplevel.jsp file has been exceeded, the JSP engine compares the timestamp stored in
the class file with the footer. jspf file timestamp on disk. Because the timestamps are different, the
toplevel.jsp file is compiled, picking up the modification to the footer. jspf file. In order for dependency
tracking to work, the trackDependencies value must be set to true at the time a JSP file is requested at
run time or is processed by the batch compiler.

Disabling compilation

Disablement of run time compilation of JavaServer Pages is set via the disableJspRuntimeCompilation
JSP engine parameter:

<jspAttributes xmi:id="JSPAttribute 1" name="disabledspRuntimeCompilation" value="true"/>

If the disabledJspRuntimeCompilation parameter is set to true, the JSP engine at run time does not
translate and compile JSP files; the JSP engine loads only precompiled class files. JSP source files do not
need to be present in order for the class files to be loaded. With this option set to true, an application can
be installed without JSP source, but must have precompiled class files. There is a Web container custom
property of the same name that can be used to determine the behavior of all web modules installed in a
server. If both the Web container custom property and the JSP engine option are set, the JSP engine
option takes precedence. Setting the disableJspRuntimeCompilation parameter to true automatically
sets reloadEnabled to false.

Reload processing sequence

The processing sequence pertaining to JSP file reloading when trackDependencies is false is shown in
Figure 1.
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Figure 1. Reload processing sequence when trackDependencies is false.

When trackDependencies is true, the JSP engine does additional file system processing to determine if
any of a JSP file's dependencies have changed since the JSP file was last translated and compiled.
Figure 2 shows the additional processes that are performed on the 'No’ path of flow chart labeled "is JSP
class file outdated?”. You can see that the path taken when disableJspRuntimeCompilation is true is the

most efficient path.
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Figure 2. Additional reload processing performed when trackDependencies is true.

JSP reload options for Web modules settings
Use this panel to configure the class reloading of Web modules such as JavaServer Pages (JSP) files

To view this administrative console panel, click Applications > Enterprise Applications >
application_name > JSP reload options for Web modules. This panel is the same as the Provide JSP
reloading options for Web modules panel on the application installation and update wizards.

Web module:

Specifies the name of a JSP file in the application.

URI:

Specifies the location of the module relative to the root of the application (EAR file).

JSP enable class reloading:

Specifies whether to enable class reloading when JSP files are updated.

A Web container reloads JSP files only when the IBM extension jspReloadingEnabled in the jspAttributes
of the ibm-web-ext.xmi file is set to true.

JSP reload interval in seconds:

Specifies the number of seconds to scan the application’s file system for updated JSP files. The default is
the value of the reloading interval attribute in the IBM extension (META-INF/ibm-application-ext.xmi) file
of the EAR file.

To enable reloading, specify a value greater than zero (for example, 1 to 2147483647). To disable
reloading, specify zero (0). The range is from 0 to 2147483647.

The reloading interval attribute takes effect only if class reloading is enabled.
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Disabling JavaServer Pages run time compilation

By default, the JavaServer Pages (JSP) engine translates a requested JSP file, compiles the . java file,
and loads the compiled servlet into the run time environment. You can change the JSP engine default
behaviour by indicating a JSP file should never be translated or compiled at run time, even when a .class
file does not exist.

If run time compilation is disabled, you must precompile the JSP files, which provides the following

advantages:

* Reduces compilation related disk operations.

* Minimizes disk storage requirements necessary for handling temporary . java files generated during a
run time compilation.

» Allows you to not include the JSP source files in the application.

» Allows verification that a JSP file compiled successfully before deploying and installing the application in
WebSphere Application Server.

You can disable run time JSP file compilation on a global or an individual Web application basis:
» To disable the translation and compilation of JSP files for all Web applications, set the Web container
custom property disabledspRuntimeCompilation to true.

Set this property through the Web container Custom properties panel in the administrative console. To
view this administrative console page, click:
Servers > Application servers > server_name > Web container settings >
Web container > Custom properties > property name

Valid values for this setting are true or false. If this property is set to true, then translation and
compilation of the JSP files is disabled at run time for all Web applications.

» To disable the translation and compilation of JSP files for a specific Web application, set the JSP engine
initialization parameter disableJspRuntimeCompilation to true. This setting, if enabled, determines the
run time behavior of the JSP engine and overrides the Web container custom property setting.

Set this parameter through the JavaServer Pages attribute assembly settings panel in the
[Chapter 21, “Assembling applications,” on page 1343

Valid values for this setting are true or false. If this parameter is set to true, then, for that specific Web
application, translation and compilation of the JSP files is disabled at run time, and the JSP engine only
loads precompiled files.

 If neither the Web container custom property nor the JSP parameter is set, the first request for a JSP
file results in the translation and compilation of the JSP file when the .class file does not exist or is
outdated. Subsequent requests for the file also result in translations and compilations, but only if the
following conditions are met:
— Translations are required because the .class file is outdated.
— Reloading is enabled for the Web module.
— Reload interval is exceeded.

If you disable run time compilation and a request arrives for a JSP file that does not have a matching
.class file, the JSP engine returns HTTP error 500 (Internal server error) to the browser. In this case, an
exception is written to the System Out (SYSOUT) and First Failure Data Capture (FFDC) logs.

If a JSP file has a matching .class file but that file is out of date, the JSP engine still loads the .class file
into memory.

Provide options to compile JavaServer Pages settings
Use this panel to specify options to be used by the JavaServer Pages (JSP) compiler.

This administrative console panel is a step in the application installation and update wizards. To view this
panel, you must select Precompile JavaServer Pages files on the Select Installation options panel.
Thus, to view this panel, click Applications > Install New Application > application_path > Show me all
installation options and parameters > Next > Next > Precompile JavaServer Pages files > Next >
Step: Provide options to compile JSPs.
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You can specify the JSP compiler options on this panel only when installing or updating an application that
contains Web modules. After the application is installed, you must edit the JSP engine configuration
parameters of a Web module’s WEB-INF/ibm-web-ext.xmi file to change its JSP compiler options.

Web module:

Specifies the name of a module within the application.

URI:

Specifies the location of the module relative to the root of the application (EAR file).
JSP class path:

Specifies a temporary class path for the JSP compiler to use when compiling JSP files during application
installation. This class path is not saved when the application installation is complete and is not used when
the application is running. This class path is used only to identify resources outside of the application
which are necessary for JSP compilation and which will be identified by other means (such as shared
libraries) after the application is installed. In network deployment configurations, this class path is specific
to the deployment manager machine.

To specify that multiple Web modules use the same class path:

1. In the list of Web modules, select the Select check box beside each Web module that you want to use
a particular class path.

2. Expand Apply Multiple Mappings.

3. Specify the desired class path.

4. Click Apply.

Use full package names:

Specifies whether the JSP engine generates and loads JSP classes using full package names.

When full package names are used, precompiled JSP class files can be configured as servlets in the
web.xml file, without having to use the jsp-file attribute. When full package names are not used, all JSP
classes are generated in the same package, which has the benefit of smaller file-system paths.

When the options useFullPackageNames and disableJspRuntimeCompilation are both true, a single class
loader is used to load all JSP classes, even if the JSP files are not configured as servlets in the web.xml
file.

This option is the same as the useFullPackageNames JSP engine parameter.

JDK source level:

Specifies the source level at which the Java compiler compiles JSP Java sources. Valid values are 13, 14,
and 15. The default value is 13, which specifies source level 1.3.

Disable JSP runtime compilation:

Specifies whether a JSP file should never be translated or compiled at run time, even when a .class file
does not exist.

When this option is set to true, the JSP engine does not translate and compile JSP files at run time; the
JSP engine loads only precompiled class files. JSP source files do not need to be present in order to load
class files. You can install an application without JSP source, but the application must have precompiled
class files.
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For a single Web application class loader to load all JSP classes, this compiler option and the Use full
package names option both must be set to true.

This option is the same as the disableJspRuntimeCompilation JSP engine parameter.

JSP batch compilation

As an IBM enhancement to JavaServer Pages (JSP) support, IBM WebSphere Application Server provides
a batch JSP compiler that allows JSP page compilation before application deployment. The batch compiler
validates the syntax of JSP pages, translates the JSP pages into Java source files, and compiles the Java
source files into Java servlet class files. The batch compiler also validates tag files and generates their
Java implementation classes.

Batch compilation of JSP pages in a predeployed application simplifies the deployment process and
improves the runtime performance of JSP page by eliminating first-request compilations. The batch
compiler also operates on enterprise applications that have been deployed into WebSphere Application
Server.

The JSP batch compiler works on Web modules that support Servlet 2.2 and up through Servlet 2.4 The
batch compiler works on JSP pages written to the JSP 2.0 specification or previous specifications back to
JSP 1.0. It recognizes a Servlet 2.4 deployment descriptor, web.xml, and can use any jsp-config elements
that it may contain. In a Servlet 2.3 (JSP 1.2) or Servlet 2.2 (JSP 1.1) deployment descriptor the batch
compiler recognizes and uses any taglib elements that the descriptor may contain.

Batch compiling makes the first request for a JSP page much faster because the JSP page is already
translated and compiled into a servlet. Batch compiling is also useful as a fast way to resynchronize all of
the JSP pages for an application.

The batch compiler supports the generation of class files in both the WebSphere Application Server temp
directory and a Web module’s WEB-INF/classes directory, depending on the type of batch compiler target.
In addition, the batch compiler enables generation of class files into any directory on the filesystem,
outside the target application. Generating class files into a Web module’s WEB-INF/classes directory
enables the Web module to be deployed as a self-contained WAR file, or a WAR inside an EAR.

Also, you can use shared libraries with the JSP batch complier. When you use the JSP batch compiler,
you must either add the JAR to the WAR in the <WEB-INF>/lib directory, or add the JAR to the JVM class
path to use shared libraries.

JSP batch compiler tool: The batch compiler validates the syntax of JSP pages, translates the JSP
pages into Java source files, and compiles the Java source files into Java Servlet class files. The batch
compiler also validates tag files and generates their Java implementation classes. Use this function to
batch compile your JSP files and thereby enable faster responses to the initial client requests for the JSP
files on your production Web server.

The batch compiler can be executed against compressed or expanded enterprise archive (EAR) files and
Web application archive (WAR) files, as well as enterprise applications and Web modules that have been
deployed into WebSphere Application Server. When the target is a deployed enterprise application, the
server does not need to be running to execute the batch compiler. If the batch compiler is executed while
the target sever is running, the server is not aware of an updated class file and does not load that class
file unless the enterprise application is restarted. When the target is a compressed EAR file or WAR file,
the batch compiler must expand it before executing.

Processing of Web modules
The batch compiler operates on one Web module at a time. If the target is either an EAR file or an

installed enterprise application that contains more than one Web module, the batch compiler operates on
each Web module individually. This is done because JSP pages are configured on a Web module basis,
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through the Web module’s web.xml deployment descriptor file. Within a Web module, the batch compiler
processes one directory at a time. It validates and translates each JSP page individually, and then invokes
the Java compiler for the entire group of generated Java sources files in that directory. If one JSP page
fails during the Java compilation phase, the Java compiler might not create class files for most or all of the
JSP pages that successfully compiled in that directory.

JSP file extensions

The batch compiler uses four things to determine what file extensions it should process:
1. Standard JSP file extensions
° *jsp
° *jspx
* *jsw
e *jsv
2. The url-pattern property of the jsp-property-group elements in the deployment descriptor file in Servlet
2.4 Web modules

3. The jsp.file.extensions JSP engine configuration parameter (for pre-Servlet 2.4 Web modules)
4. The batch compiler configuration parameter jsp.file.extensions

The standard extensions are always used by the batch compiler. If the Web module contains a Servlet 2.4
deployment descriptor, the batch compiler also processes any url-patterns found within the jsp-config
element. If the batch compiler target contains the JSP engine configuration parameter jsp.file.extensions,
then those extensions are also processed. If the batch compiler configuration parameter
jsp-file.extensions is present, the extensions given are also processed and will override the JSP engine
configuration parameter jsp.file.extensions.

It is a good idea to give JSP 'fragments’ an extension that is not processed by the batch compiler.
Statically-included fragments that do not stand alone generate translation or compilation errors if
processed. The JSP 2.0 Specification suggests that you use the extension . jspf for such files.

Batch compiler command

Both a Windows batch file, JspBatchCompiler.bat and UNIX shell script JspBatchCompiler.sh for running
the batch compiler from the command line are found in the {WAS_R0OO0T}/bin directory. An Ant task is also
available for executing the batch compiler using Ant. See the topic, Batch Compiler Ant Task for additional
information.

The batch compiler target is the only required parameter. The target is one of -ear.path, -war.path or
-enterpriseapp.name.

JspBatchCompiler -ear.path | -war.path | -enterpriseapp.name <name>
[-response.file <filename>]
[-webmodule.name <name>]

[-filename <jsp name | directory name>
[-recurse <true | false>]
[-config.root <path>]

[-cell.name <name>]

[-node.name <name>]

[-server.name <name>]

[-profileName <name>]

[-extractToDir <path>]

[-compileToDir <path>]
[-compileToWebInf <true | false>]
[-translate <true | false>]

[-compile <true | false>]
[-removeTempDir <true | false>]
[-forceCompilation <true | false>]
[-useFullPackageNames <true | false>]
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[-trackDependencies <true | false>]

[-createDebugClassfiles <true | false>]

[-keepgenerated <true | false>]

[-keepGeneratedclassfiles <true | false>]

[-usePageTagPool <true | false>]

[-useThreadTagPool <true | false>]

[-classloader.parentFirst <true | false>]
[-classloader.singleWarClassloader <true | false>]
[-additional.classpath <classpath to additional JAR files and classes>]

[-verbose <true | false>]

[-deprecation <true | false>]

[-javaEncoding <encoding>

[-jdkSourcelevel <13 | 14 | 15>]

[-compilerOptions <space-separated list of java compiler options>]

[-useJikes <true | false>]

[-jsp.file.extensions <file extensions to process>]

[-log.level <SEVERE | WARNING | INFO | CONFIG | FINE | FINER | FINEST | OFF>]

*xx See batchcompiler.properties.default in WAS _ROOT/bin for more information. #*x
**% See JspCBuild.xml in WAS_ROOT/bin for information about the public WebSphere Ant task JspC. ***

The batch compiler is aware of three groups of configuration parameters:
1. JSP engine configuration parameters for a Web module.
See the topic, JSP engine configuration parameters.
2. Batch compiler response file configuration parameters.
These are the parameters that are found in a batch compiler response file. See -response.file, below.
3. Batch compiler command line configuration parameters.
These are the parameters entered on the command line when running the batch compiler.

The batch compiler looks at all three groups of configuration parameters in order to determine which value
for a parameter is used when compiling JSP pages. When resolving the value for a given parameter, the
precedence is:

1. If the parameter is found on the command line, its value is used.

2. If the parameter is not found on the command line, the batch compiler looks for the parameter in a
response file named on the command line.

3. If no response file is named, or if the parameter is not found therein, the batch compiler looks for the
parameter in the Web module’s JSP engine configuration parameters.

If a configuration parameter is not found among these three groups, then a default value is used. The
default values for the configuration parameters are given below along with the description of the
parameters.

With one exception, these parameters are not case sensitive; -profileName is case sensitive. If the values
specified for these arguments are comprised of two or more words separated by spaces, you must add
quotation marks around the values.

The batch compiler does not create, or set the values of, equivalent JSP engine parameters. This means
that if a JSP page in a deployed Web module is modified and is recompiled by the JSP engine at run time,
the JSP engine’s configuration parameters will determine the engine’s behavior. For example, if you use
the batch compiler to compile a Web module and you use the -useFullPackageNames true option, the JSP
files will be compiled to support that option. But the JSP engine parameter useFullPackageNames must
also be set to true in order for the JSP runtime to be able to load the compiled JSP pages. If JSP pages
are modified in a deployed Web module, then the engine’s parameters should be set to the same values
used in batch compilation.

To use the JSP batch compiler, enter the following command on a single line at an operating system
command prompt.
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ear.path | war.path | enterpriseapp.name

Represents the full path to a single compressed or expanded enterprise application archive (EAR) file or

Web application archive (WAR) file, or the name of the deployed enterprise application that you want to

compile. For example:

— JspBatchCompiler -ear.path c:\myproject\sampleApp.ear

— JspBatchCompiler -war.path c:\myWars\examples.war

— JspBatchCompiler -enterpriseapp.name myEnterpriseApp -webmodule.name my.war -filename
aDir/main.jsp

response.file

Specifies the path to a file that contains configuration parameters used by the batch compiler. The
response.file is used only if it is given on the command line; it is ignored if it is present in a response
file.

In a default installation, the template response file, batchcompiler.properties.default, is found in the
{WAS_ROOT}/bin directory. Copy this template to create your own response files containing defaults for
the parameters in which you are interested. All the required and optional parameters (except
response.file) can be configured in a response file. For example: JspBatchCompiler -response.file
c:\myproject\batchc.props

Default : null
webmodule.name

Represents the name of the specific Web module that you want to batch compile. If this argument is not
set, all Web modules in the enterprise application are compiled. This parameter is used only when
ear.path or enterpriseapp.name is given. This parameter is useful when JSP pages in a specific Web
module within a deployed enterprise application need to be regenerated, because all shared library
dependencies are picked up.

Example: JspBatchCompiler -enterpriseApp.name sampleApp -webmodule.name myWebModule.war

Default: All Web modules in an EAR file or enterprise application are compiled if this parameter is not
given.

filename

Represents the name of a single JSP file that you want to compile. If this argument is not set, all files in
the Web module are compiled. Alternatively, if filename is set to the name of a directory, only the JSP
files in that directory and that directory’s child directories are complied. The name is relative to the
context root of the Web module.

Example 1: If you want to compile the file, myTest. jsp, and it is found in /subdir/myJSPs, you would
enter -filename /subdir/myJSPs/myTest.jsp.

Example 2: If you want to compile all JSP files in /subdir/myJSPs and its child directories, you would
enter -filename subdir/myJSPs.

Default: All JSP files in the Web module are compiled. Entering -filename / is equivalent to the
default.

recurse

Determines whether subdirectories beneath the target directory are processed. This parameter is used
only when the filename parameter is given. Set value to false to process only the directory named
filename parameter; and not its subdirectories.

Example: JspBatchCompiler -enterpriseApp.name sampleApp -filename /subdirl -recurse false.

Default: true; All directories beneath the target directory are processed.
config.root

Specifies the location of the WebSpehere Application Server configuration directory. This parameter is
used only when enterpriseapp.name is given.

Default: {WAS_ROOT}/profiles/profilename/config
cell.name

Specifies the name of the cell in which the application is deployed. This parameter is used only when
enterpriseapp.name is given.
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Default: The default is obtained from the profile script that is used. The symbolic name of this variable

is WAS_CELL.
¢« node.name

Specifies the name of the node in which the application is deployed. This parameter is used only when

enterpriseapp.name is given.

Default: The default is obtained from the profile script that is used. The symbolic name of this variable

is WAS_NODE.
* server.name

Represents the name of the server in which the application is deployed. This parameter is used only
when enterpriseapp.name is given.

Default: serverl
» profileName

Specifies the name of the profile you want to use. This parameter is used only when

enterpriseapp.name is given.

Example: JspBatchCompiler -enterpriseApp.name sampleApp -profileName AppServer-3

Default: The default profile is used. This is obtained from the file setupCmdLine script in the
install_root/bin directory. The symbolic name is DEFAULT_PROFILE_SCRIPT.

* extractToDir

Specifies the directory into which predeployed enterprise archive (EAR) files and Web application
archive (WAR) files will be extracted before the batch compiler operates on them. This parameter is
ignored when enterpriseapp.name is given. The extractToDir parameter is used as described in the

table below.

Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -extractToDir c:\myTempDir.

Use-case: You must extract a compressed archive before it is batch compiled. You can also extract an
expanded archive to a new directory as well. In both cases, extraction leaves the original archive
untouched, which may be useful while development is underway.

Default values:

Expanded archive

Compressed archive

extractToDir supplied

The batch compiler extracts the archive to extractToDir before operating on it.
If a file or directory of the same name as the archive already exists in the
extractToDir, the batch compiler removes the archive completely before
extracting that archive. If the batch compiler exits with no errors, it
compresses the archive in place in the extractToDir, even if the original EAR
file or WAR file was expanded. If errors are encountered during compilation,
the EAR file or WAR file is left in the expanded state even if the original EAR

file or WAR file was compressed.

extractToDir not supplied

The batch compiler operates on the
EAR file or WAR file in place (does
not extract it to another directory) and
the archive remains expanded after
the batch compiler finishes.

The batch compiler extracts the
archive to the directory returned by
the JVM property "java.io.tmpdir”. The
rest of the behavior described above,
when extractToDir is supplied, is the
same in this case.

The default is serverl.
» compileToDir

Specifies the directory into which JSP pages are translated into Java source files and compiled into
class files. This directory can be anywhere on the filesystem, but the batch compiler’'s default behavior
is usually adequate. The batch compiler’s behavior when compiling class files is described in the table

below

Example:: JspBatchCompiler -enterpriseApp.name sampleApp -compileToDir c:\myTargetDir
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Use-case: This parameter enables you to generate the Java and class files into a directory outside of
the target, which may be useful if you want to compare the newly generated files with their previous
versions which remain untouched within the target.

Default values:

ear.path or war.path supplied

enterpriseApp.name supplied

compileToDir not supplied;
compileToWeblnf not supplied, or is
true

The class files are compiled into the
Web module’s WEB-INF/classes
directory

The class files are compiled into the
Web module’s WEB-INF/classes
directory.

compileToDir not supplied;
compileToWeblnf is false

The class files are compiled into the
Web module’s WEB-INF/classes
directory.

The class files are compiled into the
WebSphere Application Server temp
directory (usually {WAS_ROOT}/temp).

compileToDir is supplied;
compileToWeblInf not supplied, or is

The class files are compiled into the
directory indicated by compileToDir.

The class files are compiled into the
directory indicated by compileToDir.

either true or false

* compileToWebInf

Specifies whether the target directory for the compiled JSP class files should be the Web module’s
WEB-INF/classes directory. This parameter is used only when enterpriseApp.name is given, and it is
overridden by compileToDir if compileToDir is given.

The batch compiler’'s default behavior is to compile to the Web module’s WEB-INF/classes directory. The
batch compiler’'s behavior when compiling class files is described in the table above.

Example: JspBatchCompiler -enterpriseApp.name sampleApp -compileToWeblnf false.

Use-case: Set this parameter to false when enterpriseApp.name is supplied and you want the class
files to be compiled to the WebSphere Application Server temp directory instead of the Web module’s
WEB-INF/classes directory. Recommendation: if this parameter is set to false, set forceCompilation to
true if there are any JSP class files in the WEB-INF/classes directory.

Default: true; see the table above.
» forceCompilation

Specifies whether the batch compiler is forced to recompile all JSP resources regardless or whether the
JSP page is outdated.

Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -forceCompilation true.

Use-case: Especially useful when creating an archive for deployment, to make sure all JSP classes are
up to date.

Default: false
* useFullPackageNames

Specifies whether the batch compiler generates full package names for JSP classes. The default is to
generate all JSP classes in the same package. The JSP engine’s class loader knows how to load JSP
classes when they are all in the same package. The default has the benefit of generating smaller
file-system paths. Full package names have the benefit of enabling the configuration of precompiled
JSP class files as servlets in the web.xml1 file without use of the jsp-file attribute, resulting in a single
class loader (the Web application’s class loader) being used to load all such JSP classes. Similarly,
when the JSP engine’s configuration attributes useFullPackageNames and
disableJspRuntimeCompilation are both true, a single class loader is used to load all JSP classes,
even if the JSP pages are not configured as servlets in the web.xm1 file.

When useFullPackageNames is set to true, the batch compiler generates a file called

generated web.xml in the Web module’s WEB-INF directory. This file contains servlet configuration
information for each JSP page that is successfully translated and compiled. The information can
optionally be copied into the Web module’s web.xm1 file so that the JSP pages are loaded as servlets by
the Web container. Note that if a JSP page is configured as a servlet in this way, no reloading of the
JSP page is done at run time if the JSP page is modified. This is because the JSP page is treated as a
regular servlet and requests for it do not pass through the JSP engine.

Example: JspBatchCompiler —enterpriseApp.name sampleApp —useFullPackageNames true
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Use-case: Enables JSP classes to be loaded by a single class loader.

Default: false
* removeTempDir

Specifies whether the Web module’s temp directory is removed. The batch compiler by default
generates JSP class files into a Web module’s WEB-INF/classes directory. JSP class files are generated
into the temp directory at run time if a JSP page is modified and JSP reloading is enabled. By batch
compiling all the JSP pages in a Web module and also removing the temp directory, disk resources are
preserved. You can only use the removeTempDir parameter when -enterpriseApp.name is given.

Example: JspBatchCompiler -enterpriseApp.name sampleApp -removeTempDir true.
Use-case: Free up disk space by clearing out a Web application’s temp directory.

Default: false
e translate

Specifies whether JSP pages are translated and compiled. Set translate to false if you do not want JSP
pages to be translated and compiled. You must use this option in conjunction with -removeTempDir to tell
the batch compiler to remove only the temp directory and to do no further processing.
Example: JspBatchCompiler -enterpriseApp.name sampleApp -translate false -removeTempDir true.
Use-case: Free up disk space by clearing out a Web application’s temp directory, without invoking JSP
processing.
Default: true

* compile
Specifies whether JSP pages go through the Java compilation phase. Set compile to false if you do not
want JSP pages to go through the Java compilation phase.
Example: JspBatchCompiler -enterpriseApp.name sampleApp -compile false
Use-case: If you only want JSP pages to be syntax-checked, set -compile to false. You can set
-keepgenerated to true if you want to see the . java files that are generated during the translation
phase.
Default: true

» trackDependencies
Specifies whether the batch compiler recompiles a JSP page when any of its dependencies have
changed, even if the JSP page itself has not changed. Tracking dependencies incurs a significant
runtime performance penalty because the JSP Engine checks the filesystem on every request to a JSP
page to see if any of its dependencies have changed. The dependencies tracked by WebSphere
Application Server are :
1. Files statically included in the JSP page
2. Tag files used by the JSP page (excluding tag files that are in JAR files)
3. TLD files used by the JSP page (excluding TLD files that are in JAR files)

Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -trackDependencies true.
Use-case: Useful in a development environment.

Default: false
» createDebugClassfiles

Specifies whether the batch compiler generates class files that contain SMAP information, as per JSR
45, Debugging support for Other Languages.

Example: JspBatchCompiler -enterpriseApp.name sampleApp -createDebugClassfiles true

Use-case: Use this parameter when you want to be able to debug JSP pages in your JSR 45-compliant
IDE.

Default: false
» keepgenerated

Specifies whether the batch compiler saves or erases the generated Java source files created during
the translation phase.
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If set to true, WebSphere Application Server saves the generated . java files used for compilation on
your server. By default, this argument is set to false and the .java files are erased after the class files
have compiled.

Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -keepgenerated true
Use-case: Use this parameter when you want to review the Java code generated by the batch compiler.

Default: false
keepGeneratedclassfiles

Specifies whether the batch compiler saves or erases the class files generated during the compilation of
Java source files.

Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -keepGeneratedclassfiles false
-keepgenerated false

Use-case: Set this parameter to false if you only want to see if there are any translation or compilation
errors in your JSP pages. If paired with -keepgenerated false, this parameter results in all generated
files being removed before the batch compiler completes.

Default: true
usePageTagPool

Enables or disables the reuse of custom tag handlers on an individual JSP page basis.
Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -usePageTagPool true
Use-case: Use this parameter to enable JSP-page-based reuse of tag handlers.

Default: false
useThreadTagPool

Enables or disables the reuse of custom tag handlers on a per request thread basis per Web module.
Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -useThreadTagPool true
Use-case: Use this parameter to enable Web module-based reuse of tag handlers.

Default: false

classloader.parentFirst

Specifies the search order for loading classes by instructing the batch compiler to search the parent
class loader prior to application class loader. This parameter is only used when ear.path or
enterpriseApp.name is given.

Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -classloader.parentFirst false
Use-case: Set this parameter to false when your Web module contains a JAR file that is also found in
the server lib directory, and you want your Web module’s JAR file to be picked up first.

Default: true

classloader.singleWarClassloader

Specifies whether to use one class loader per enterprise archive (EAR) file or one class loader per Web
application archive (WAR) file. Used only when ear.path or enterpriseApp.name is given.

Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -classloader.singleWarClassloader
true

Use-case: Set this parameter to true when a Web module depends on JAR files and classes in another
Web module in the same enterprise application.

Default: false; One class loader is created per WAR file with no visibility of classes in other Web
modules.

additional.classpath

Specifies additional class path entries to be used when parsing and compiling JSP pages. This
parameter is used only when war.path is given. When war.path is the target, WebSphere Shared
Libraries are not picked up by the batch compiler. Therefore, if your WAR file relies on, for example, a
JAR file that is configured in WebSphere Application Server as a shared library, then use this option to
point to that JAR file. In addition, if you give war.path and also use the -extractToDir parameter, then
any JAR files that are in the WAR file’s manifest class-path is not added to the class path (since the
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WAR file has now been extracted by itself outside the EAR file in which it resides). Use
-additional.classpath in this case to point to the necessary JAR files. Add the full path to needed
resources, separated by your system-dependent path separator.

Example: JspBatchCompiler -war.path c:\myproject\examples.war -additional.classpath
c:\myJars\someJar.jar;c:\myClasses

Use-case: Use this parameter to add to the class path JAR files and classes outside of your WAR file.
At run time, these same JAR files and classes have to be made available through the standard
WebSphere Application Server configuration mechanisms.

Default: null
¢ verbose

Specifies whether the batch compiler should generate verbose output while compiling the generated
sources.

Example: JspBatchCompiler -war.path c:\myproject\examples.war -verbose true

Use-case: Set this parameter to true when you want to see Java compiler class loading and other
messages.

Default: false

* deprecation
Indicates the compiler should generate deprecation warnings while compiling the generated sources.
Example: JspBatchCompiler -war.path c:\myproject\examples.war -deprecation true
Use-case: Set this parameter to true when you want to see Java compiler deprecation messages.
Default: false

* javaEncoding

Specifies the encoding that will be used when the .java file is generated, and when it is compiled by the
Java compiler. When -javaEncoding is set, that encoding is passed to the java compiler via the
-encoding argument. Note that encoding is not supported by Jikes.

Example: JspBatchCompiler -war.path c:\myproject\examples.war -javaEncoding Shift-JIS
Use-case: Set this parameter when the page encoding of your JSP pages is not UTF-8 compatible.
Default value: UTF-8.

» jdkSourcelevel

This is a new JSP engine parameter which was introduced in WebSphere Application Server version 6.1
to support JDK 5. This parameter should be used instead of the compileWithAssert parameter, although
compile WithAssert still works in version 6.1.

The default value for this parameter is 13. This parameter requires regeneration of Java source. The
following are jdkSourcelLevel paramater values:

— 13 (default) - This value will disable all new language features of JDK 1.4 and JDK 5.0.

— 14 - This value will enable the use of the assertion facility and will disable all new language features
of JDK 5.0.

— 15 - This value will enable the use of the assertion facility and all new language features of JDK 5.0.
Example: JspBatchCompiler -war.path c:\myproject\examples.war -jdkSourcelLevel 14

Use-case: Set this parameter when you want to enable or disable the language features of JDK 1.4
and JDK 5.0

Default value: 13

« compilerOptions
Specifies a list of strings to be passed on the Java compiler command. This is a space-separated list of
the form "argl arg2 argn”.

Example: JspBatchCompiler -war.path c:\myproject\examples.war -compilerOptions " -bootclasspath
<path>"
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Use-case: Use this parameter if you need Java compiler arguments other than verbose, deprecation

and Assert facility support.
Default: null
* usedikes

Specifies whether Jikes should be used for compiling Java sources. NOTE: Jikes is not shipped with

WebSphere Application Server.
Example: JspBatchCompiler -ear.path c:\myproject\sampleApp.ear -uselikes true

Use-case: Set this parameter to true in order for the batch compiler to use Jikes as the Java compiler.

Default value: false
+ jsp.file.extensions

Specifies the file extensions to be processed by the batch compiler. This is a semicolon- or
colon-separated list of the form "*.ext1;*.ext2:*.extn”. Note that this parameter is not necessary for

Servlet 2.4 Web applications because the url-pattern property of the jsp-property-group elements in the

deployment descriptor can be used to identify extensions that should be treated as JSP pages.
Example: JspBatchCompiler -enterpriseApp.name sampleApp -jsp.file.extensions *jspz;*.jspt

Use-case: Use this parameter to add additional extensions to the be processed by the batch compiler.

Default: null. See section, "JSP file extensions”, in this topic for additional information.
* log.level

Specifies the level of logging that is directed to the console during batch compilation. Values are
SEVERE | WARNING | INFO | CONFIG | FINE | FINER | FINEST | OFF

Example: JspBatchCompiler -enterpriseApp.name sampleApp -log.level FINEST

Use-case: Set this parameter higher or lower to control logging output. FINEST generates the most
output useful for debugging.

Default: CONFIG
Batch compiler ant task:
The ant task JspC exposes all the batch compiler configuration options. It executes the batch compiler

under the covers. It is backward compatible with the WebSphere Application Server 5.x version of the
JspC ant task. The following table lists all the ant task attribute and their batch compiler equivalents.

JspC attribute Equivalent batch complier parameter
earPath -ear.path

warPath -war.path

src -war.path

Same as warPath, for backward compatiblity

enterpriseAppName -enterpriseapp.name
responseFile -response.file
webmoduleName -webmodule.name
fileName -filename -config.root
configRoot -config.root
cellName -cell.name
nodeName -node.name
serverName -server.name
profileName -profileName
extractToDir -extractToDir
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compileToDir

same as compileToDir, for backward compatibility

-compileToDir -compileToDir

compileToWeblnf

-compileToWeblnf

compilerOptions

-compilerOptions

recurse

-recurse

removeTempDir

-removeTempDir

translate

-translate

compile

-compile

forceCompilation

-forceCompilation

useFullPackageNames

-useFullPackageNames

trackDependencies

-trackDependencies

createDebugClassfiles

-createDebugClassfiles

keepgenerated

-keepgenerated

keepGeneratedclassfiles

-keepGeneratedclassfiles

usePageTagPool

-usePageTagPool

useThreadTagPool

-useThreadTagPool

classloaderParentFirst

-classloader.parentFirst

classloaderSingleWarClassloader

-classloader.singleWarClassloader

additionalClasspath

-additional.classpath

classpath

same as additionalClasspath, for backward compatibility

-additional.classpath

verbose

-verbose

deprecation

-deprecation

javaEncoding

-javaEncoding

compileWithAssert

-compileWithAssert

useldikes

-uselikes

jspFileExtensions

-jsp.file.extensions

logLevel -log.level
wasHome none
Classpathref none
jdkSourcelLevel -jdkSourcelLevel

Below is an example of a build script with multiple targets, each with different attributes. The following

commands are used to execute the script:

On Windows:

ws_ant -Dwas.home=%WAS_HOME% -Dear.path=%EAR_PATH% -Dextract.dir=%EXTRACT_DIR%
ws_ant jspcZ2 -Dwas.home=%WAS_HOME% -Dapp.name=%APP_NAME% -Dwebmodule.name=%MOD_NAME%

ws_ant jspc3 -Dwas.home=%WAS_HOME% -Dapp.name=%APP_NAME% -Dwebmodule.name=%MOD_NAME% -Ddir.name=%DIR_NAME%

On UNIX or i5/0S:

ws_ant -Dwas.home=$WAS_HOME -Dear.path=$EAR_PATH -Dextract.dir=$EXTRACT_DIR
ws_ant jspc2 -Dwas.home=$WAS_HOME -Dapp.name=$APP_NAME -Dwebmodule.name=$MOD_NAME

ws_ant jspc3 -Dwas.home=$WAS HOME -Dapp.name=$APP_NAME -Dwebmodule.name=$MOD_NAME -Ddir.name=$DIR_NAME
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Example build.xml Using the JspC Task

<project name="JSP Precompile" default="jspcl" basedir=".">
<taskdef name="wsjspc" classname="com.ibm.websphere.ant.tasks.JspC"/>
<target name="jspcl" description="example using a path to an EAR, and extracting the EAR to a directory">
<wsjspc wasHome="${was.home}"
earpath="${ear.path}"
forcecompilation="true"
extractToDir="${extract.dir}"
useThreadTagPool="true"
keepgenerated="true"

/>
</target>
<target name="jspc2" description="example using an enterprise app and webmodule">
<wsjspc wasHome="${was.home}"
enterpriseAppName="${app.name}"
webmoduleName="${webmodule.name}"
removeTempDir="true"
forcecompilation="true"
keepgenerated="true"

/>
</target>
<target name="jspc3" description="example using an enterprise app, webmodule and specific directory">
<wsjspc wasHome="${was.home}"
enterpriseAppName="${app.name}"
webmoduleName="${webmodule.name}"
fileName="${dir.name}"
recurse="false"
forcecompilation="true"
keepgenerated="true"

/>
</target>
</project>

Batch compiler class path:

The batch compiler builds its class path as shown in the table below. When the batch compiler target is a

Web archive (WAR) file and war.path is supplied, the configuration additional.classpath parameter is used
to give extra class path information.

Batch compiler target

Location added to class path enterpriseapp.name ear.path war.path

WebSphere Application Server yes yes yes

JAR files and classes

JAR files listed in manifest class yes yes yes, when the target WAR is inside

path for a Web module an EAR and —extractToDir is not
used; otherwise, no.

Shared libraries yes no no

Web module JAR files and classes |yes yes yes

additional.classpath parameter to | no no yes

batch compiler

Global tag libraries

JavaServer Pages (JSP) tag libraries contain classes for common tasks such as processing forms and
accessing databases from JSP files.
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Tag libraries encapsulate, as simple tags, core functionality common to many Web applications. The Java
Standard Tag Library (JSTL) supports common programming tasks such as iteration and conditional
processing, and provides tags for:

* manipulating XML documents

* supporting internationalization

* using Structured Query Language (SQL)

Tag libraries also introduce the concept of an expression language to simplify page development, and
include a version of the JSP expression language.

A tag library has two parts - a Tag Library Descriptor (TLD) file and a Java archive (JAR) file.
tsx:dbconnect tag JavaServer Pages syntax (deprecated):

Use the <tsx:dbconnect> tag to specify information needed to make a connection to a database through
Java DataBase Connectivity (JDBC) or Open Database Connectivity (ODBC) technology.

Support for tsx tags in the JavaServer Pages (JSP) engine are deprecated in WebSphere Application
Server Version 6.0. Instead of using the tsx tags, you should use equivalent tags from the JavaServer
Pages Standard Tag Library (JSTL).

The <tsx:dbconnect> syntax does not establish the connection. Use the <tsx:dbquery> and <tsx:dbmodify>
syntax instead to reference a <tsx:dbconnect> tag in the same JavaServer Pages (JSP) file to establish
the connection.

When the JSP file compiles into a servlet, the Java processor adds the Java coding for the
<tsx:dbconnect> syntax to the servlet service() method, which means a new database connection is
created for each request for the JSP file.

This section describes the syntax of the <tsx:dbconnect> tag.

<tsx:dbconnect id="connection_id"
userid="db_user" passwd="user_password"
url="jdbc:subprotocol :database"
driver="database_driver_name"
jndiname="JNDI_context/logical_name">
</tsx:dbconnect>

where:

e id
Represents a required identifier. The scope is the JSP file. This identifier is referenced by the
connection attribute of a <tsx:dbquery> tag.

* userid

Represents an optional attribute that specifies a valid user ID for the database that you want to access.
Specify this attribute to add the attribute and its value to the request object.

Although the userid attribute is optional, you must provide the user ID. See |<tsx:userid> and
for an alternative to hard coding this information in the JSP file.
* passwd

Represents an optional attribute that specifies the user password for the userid attribute. (This attribute
is not optional if the userid attribute is specified.) If you specify this attribute, the attribute and its value
are added to the request object.

Although the passwd attribute is optional, you must provide the password. See |<tsx:userid> and|
|<tsx:passwd> for an alternative to hard coding this attribute in the JSP file.

e url and driver

Respresents a required attribute if you want to establish a database connection. You must provide the
URL and driver.
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The application server supports connection to JDBC databases and ODBC databases.

— For a JDBC database, the URL consists of the following colon-separated elements: jdbc, the
subprotocol name, and the name of the database to access. An example for a connection to the
Sample database included with IBM DB?2 is:
url="jdbc:db2:sample"
driver="com.ibm.db2.jdbc.app.DB2Driver"

— For an ODBC database, use the Sun JDBC-to-ODBC bridge driver included in their Java2 Software
Developers Kit (SDK) or another vendor’'s ODBC driver.

The url attribute specifies the location of the database. The driver attribute specifies the name of the
driver to use in establishing the database connection.

If the database is an ODBC database, you can use an ODBC driver or the Sun JDBC-to-ODBC
bridge. If you want to use an ODBC driver, refer to the driver documentation for instructions on
specifying the database location with the url attribute and the driver name.

If you use the bridge, the url syntax is jdbc:odbc:database. An example follows:

url="jdbc:odbc:autos"
driver="sun.jdbc.odbc.JdbcOdbcDriver"
Note: To enable the application server to access the ODBC database, use the ODBC Data Source
Administrator to add the ODBC data source to the System DSN configuration. To access the ODBC
Administrator, click the ODBC icon on the Windows NT Control Panel.
* jndiname
Represents an optional attribute that identifies a valid context in the application server Java Naming and
Directory Interface (JNDI) naming context and the logical name of the data source in that context. The
Web administrator configures the context using an administrative client such as the WebSphere
Administrative Console.

If you specify the jndiname attribute, the JSP processor ignores the driver and url attributes on the
<tsx:dbconnect> tag.

An empty element (such as <url></url>) is valid.
dbquery tag JavaServer Pages syntax (deprecated):

Use the <tsx:dbquery> tag to establish a connection to a database, submit database queries, and return
the results set.

Support for tsx tags in the JavaServer Pages (JSP) engine are deprecated in WebSphere Application
Server Version 6.0. Instead of using the tsx tags, you should use equivalent tags from the JavaServer
Pages Standard Tag Library (JSTL).

The <tsx:dbquery> tag does the following:

1. References a <tsx:dbconnect> tag in the same JavaServer Pages (JSP) file and uses the information
the tag provides to determine the database URL and driver. You can also obtain the user ID and
password from the <tsx:dbconnect> tag if those values are provided in the <tsx:dbconnect> tag.

2. Establishes a new connection

3. Retrieves and caches data in the results object.

4. Closes the connection and releases the connection resource.

This section describes the syntax of the <tsx:dbquery> tag.

<%-- SELECT commands and (optional) JSP syntax can be placed within the tsx:dbquery. --%>
<%-- Any other syntax, including HTML comments, are not valid. --%>

<tsx:dbquery id="query id" connection="connection_id" 1imit="value" >

</tsx:dbquery>

where:
* id
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Represents the identifier of this query. The scope is the JSP file. Use id to reference the query. For
example, from the <tsx:getProperty> tag, use id to display the query results.

The id is a tsx reference to the bean and can be used to retrieve the bean from the page contect. For
example, if id is named mySingleDBBean, instead of using:
— if (mySingleDBBean.getValue("UISEAM",0).startsWith("N"))

use:

— com.ibm.ws.webcontainer.jsp.tsx.db.QueryResults bean =
(com.ibm.ws.webcontainer.jsp.tsx.db.QueryResults)pageContext. findAttribute("mySingleDBBean”); if
(bean.getValue("UISEAM",0).startsWith("N")). . .

The bean properties are dynamic and the property names are the names of the columns in the results
set. If you want different column names, use the SQL keyword for specifying an alias on the SELECT
command. In the following example, the database table contains columns named FNAME and LNAME,
but the SELECT statement uses the AS keyword to map those column names to FirstName and
LastName in the results set:

Select FNAME, LNAME AS FirstName, LastName from Employee where FNAME='Jim'
connection

Represents the identifier of a <tsx:dbconnect> tag in this JSP file. The <tsx:dbconnect> tag provides the
database URL, driver name, and optionally, the user ID and password for the connection.

limit

Represents an optional attribute that constrains the maximum number of records returned by a query. If
this attribute is not specified, no limit is used. In such a case, the effective limit is determined by the
number of records and the system caching capability.

SELECT command and JSP syntax

Represents the only valid SQL command, SELECT. The <tsx:dbquery> tag must return a results set.
Refer to your database documentation for information about the SELECT command. See other articles
in this section for a description of JSP syntax for variable data and inline Java code.

dbmodify tag JavaServer Pages syntax (deprecated):

The <tsx:dbmodify> tag establishes a connection to a database and then adds records to a database
table.

Support for tsx tags in the JavaServer Pages (JSP) engine are deprecated in WebSphere Application
Server Version 6.0. Instead of using the tsx tags, you should use equivalent tags from the JavaServer
Pages Standard Tag Library (JSTL).

The <tsx:dbmodify> tag does the following:

1.

2.
3.
4

References a <tsx:dbconnect> tag in the same JavaServer Pages (JSP) file and uses the information
provided by that tag to determine the database URL and driver.

Note: You can also obtain the user ID and password from the <tsx:dbconnect> tag if those values are
provided in the <tsx:dbconnect> tag.

Establishes a new connection.

Updates a table in the database.

Closes the connection and releases the connection resource.

This section describes the syntax of the <tsx:dbmodify> tag.

<%-- Any valid database update commands can be placed within the DBMODIFY tag. -->
<%-- Any other syntax, including HTML comments, are not valid. -->

<tsx:dbmodify connection="connection_id">

</tsx:dbmodify>

where:

connection
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Represents the identifier of a <tsx:dbconnect> tag in this JSP file. The <tsx:dbconnect> tag provides the
database URL, driver name, and (optionally) the user ID and password for the connection.
» Database commands

Represents valid database commands. Refer to your database documentation for details
tsx:getProperty tag JavaServer Pages syntax and examples (deprecated):
The <tsx:getProperty> tag gets the value of a bean to display in a JavaServer Pages (JSP) file.

Support for tsx tags in the JavaServer Pages (JSP) engine are deprecated in WebSphere Application
Server Version 6.0. Instead of using the tsx tags, you should use equivalent tags from the JavaServer
Pages Standard Tag Library (JSTL).

This IBM extension of the Sun JSP <jsp:getProperty> tag implements all of the <jsp:getProperty> function
and adds the ability to introspect a database bean created using the IBM extension <tsx:dbquery> or
<tsx:dbmodify>.

Note: You cannot assign the value from this tag to a variable. The value, generated as output from this
tag, displays in the browser window.

This section describes the syntax of the <tsx:getProperty> tag:

<tsx:getProperty name="bean_name"
property="property name" />

where:
°* name

Represents the name of the bean declared by the id attribute of a <tsx:dbquery> syntax within the JSP

file. See for an explanation. The value of this attribute is case-sensitive.

* property
Represents the property of the bean to access for substitution. The value of the attribute is
case-sensitive and is the locale-independent name of the property.

Tag example:
<tsx:getProperty name="userProfile" property="username" />

tsx:userid and tsx:passwd tag JavaServer Pages syntax (deprecated):

With the <tsx:userid> and <tsx:passwd> tags, you do not have to hard code a user ID and password in the
<tsx:dbconnect> tag.

Support for tsx tags in the JavaServer Pages (JSP) engine are deprecated in WebSphere Application
Server Version 6.0. Instead of using the tsx tags, you should use equivalent tags from the JavaServer
Pages Standard Tag Library (JSTL).

Use the <tsx:userid> and <tsx:passwd> tags to accept user input for the values and then add that data to
the request object. You can access the request object with a JavaServer Pages (JSP) file, such as the
JSPEmployee.jsp example that requests the database connection.

You must use <tsx:userid> and <tsx:passwd> tags within a <tsx:dbconnect> tag.

This section describes the syntax of the <tsx:userid> and <tsx:passwd> tags.

<tsx:dbconnect id="connection_ id"
<font color="red"><userid></font>
<tsx:getProperty name="request" property=request.getParameter("userid") />
<font color="red"></userid></font>
<font color="red"><passwd></font>
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<tsx:getProperty name="request" property=request.getParameter("passwd") />
<font color="red"></passwd></font>
url="protocol :database_name:database table"
driver="JDBC_driver_name">
</tsx:dbconnect>

where:
* <tsx:getProperty>

Represents the syntax as a mechanism for embedding variable data.
* userid

Represents a reference to the request parameter that contains the user ID. You must add the parameter
to the request object that passes to this JSP file. You can set the attribute and its value in the request
object, using an HTML form or a URL query string to pass the user-specified request parameters.

* passwd

Represents a reference to the request parameter that contains the password. Add the parameter to the
request object that passes to this JSP file. You can set the attribute and its value in the request object,
using an HTML form or a URL query string, to pass user-specified values.

tsx:repeat tag JavaServer Pages syntax (deprecated):
The <tsx:getProperty> tag repeats a block of HTML tagging.

Support for tsx tags in the JavaServer Pages (JSP) engine are deprecated in WebSphere Application
Server Version 6.0. Instead of using the tsx tags, you should use equivalent tags from the JavaServer
Pages Standard Tag Library (JSTL).

Use the <tsx:repeat> syntax to iterate over a database query results set. The <tsx:repeat> syntax iterates
from the start value to the end value until one of the following conditions is met:

* The end value is reached.

* An exception is thrown.

If an exception of the types ArraylndexOutOfBoundsException or NoSuchElementException is created
before a block completes, output is written only for the iterations up to and not including the iteration
during which the exception was created. All other exceptions results in no output being written for that tag
instance.

This section describes the syntax of the <tsx:repeat> tag:

<tsx:repeat index="name" start="starting index" end="ending index">
</tsx:repeat>

where:
* index

Represents an optional hame used to identify the index of this repeat block. The scope of the index is
NESTED. Its type must be integer.
» start

Represents an optional starting index value for this repeat block. The default is 0.
* end

Represents an optional ending index value for this repeat block. The maximum value is 2,147,483,647.
If the value of the end attribute is less than the value of the start attribute, the end attribute is ignored.

Example: Combining tsx:repeat and tsx:getProperty JavaServer Pages tags (deprecated): Support
for tsx tags in the JavaServer Pages (JSP) engine are deprecated in WebSphere Application Server
Version 6.0. Instead of using the tsx tags, you should use equivalent tags from the JavaServer Pages
Standard Tag Library (JSTL).
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The following code snippet shows you how to code these tags:

<tsx:repeat>

<tr>
<td><tsx:getProperty name="empgs" property="EMPNO" />
<tsx:getProperty name="empgs" property="FIRSTNME" />
<tsx:getProperty name="empgs" property="WORKDEPT" />
<tsx:getProperty name="empgs" property="EDLEVEL" />
</td>

</tr>

</tsx:repeat>

Example: tsx:dbmodify tag syntax (deprecated): Support for tsx tags in the JavaServer Pages (JSP)
engine are deprecated in WebSphere Application Server Version 6.0. Instead of using the tsx tags, you
should use equivalent tags from the JavaServer Pages Standard Tag Library (JSTL).

In the following example, a new employee record is added to a database. The values of the fields are
based on user input from this JavaServer Pages (JSP) file and referenced in the database commands
using the <tsx:getProperty> tag.
<tsx:dbmodify connection="conn" >
insert into EMPLOYEE
(EMPNO, FIRSTNME ,MIDINIT, LASTNAME ,WORKDEPT,EDLEVEL)
values
('<tsx:getProperty name="request" property=request.getParameter("EMPNO") />',
'<tsx:getProperty name="request" property=request.getParameter("FIRSTNME") />',
'<tsx:getProperty name="request" property=request.getParameter("MIDINIT") />',
'<tsx:getProperty name="request" property=request.getParameter("LASTNAME") />',
'<tsx:getProperty name="request" property=request.getParameter("WORKDEPT") />',
<tsx:getProperty name="request" property=request.getParameter("EDLEVEL") />)
</tsx:dbmodify>

Example: Using tsx:repeat JavaServer Pages tag to iterate over a results set (deprecated): Support
for tsx tags in the JavaServer Pages (JSP) engine are deprecated in WebSphere Application Server
Version 6.0. Instead of using the tsx tags, you should use equivalent tags from the JavaServer Pages
Standard Tag Library (JSTL).

The <tsx:repeat> tag iterates over a results set. The results set is contained within a bean. The bean can
be a static bean, for example, a bean created by using the IBM WebSphere Studio database wizard, or a
dynamically generated bean, for example, a bean generated by the <tsx:dbquery> syntax. The following
table is a graphic representation of the contents of a bean called, myBean:

coll col2 col3
row0 friends Romans countrymen
rowl bacon lettuce tomato
row2 May June July

Some observations about the bean:

* The column names in the database table become the property names of the bean. The <tsx:dbquery>
section describes a technique for mapping the column names to different property names.

» The bean properties are indexed. For example, myBean.get (Col1(row2)) returns May.

* The query results are in the rows. The <tsx:repeat> tag iterates over the rows, beginning at the start
row.

The following table compares using the <tsx:repeat> tag to iterate over a static bean, versus a dynamically
generated bean:
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Static Bean Example

<tsx:repeat> Bean Example

myBean.class
// Code to get a connection

// Code to get the data
Select * from myTable;

// Code to close the connection

JSP file

<tsx:repeat index=abc>
<tsx:getProperty name="myBean"
property="coll(abc)" />
</tsx:repeat>

Notes:

* The bean (myBean.class) is a static bean.

* The method to access the bean properties is
myBean.get(property(index)).

* You can omit the property index, in which case the
index of the enclosing <tsx:repeat> tag is used. You
can also omit the index on the <tsx:repeat> tag.

* The <tsx:repeat> tag iterates over the bean properties
row by row, beginning with the start row.

JSP file

<tsx:dbconnect id="conn"
userid="alice"passwd="test"
url="jdbc:db2:sample"
driver="COM.ibm.db2.jdbc.app.DB2Driver">
</tsx:dbconnect >

<tsx:dbquery id="dynamic"
connection="conn" >
Select * from myTable;

</tsx:dbquery>

<tsx:repeat index=abc>
<tsx:getProperty name="dynamic"
property="coll(abc)" />
</tsx:repeat>

Notes:

* The bean (dynamic) is generated by the <tsx:dbquery>
tag and does not exist until the syntax executes.

* The method to access the bean properties is
dynamic.getValue("property”, index).

* You can omit the property index, in which case the
index of the enclosing <tsx:repeat> tag is used. You
can also omit the index on the <tsx:repeat> tag.

* The <tsx:repeat> tag syntax iterates over the bean
properties row by row, beginning with the start row.

Implicit and explicit indexing

Examples 1, 2, and 3 show how to use the <tsx:repeat> tag. The examples produce the same output if all
indexed properties have 300 or fewer elements. If there are more than 300 elements, Examples 1 and 2
display all elements, while Example 3 shows only the first 300 elements.

Example 1 shows implicit indexing with the default start and default end index. The bean with the smallest
number of indexed properties restricts the number of times the loop repeats.

<table>

<tsx:repeat>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="city" />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="address" />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="telephone" />
</tr></td>

</tsx:repeat>

</table>

Example 2 shows indexing, starting index, and ending index:

<table>
<tsx:repeat index=myIndex start=0 end=2147483647>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property=city(myIndex) />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property=address(myIndex) />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property=telephone(myIndex) />
</tr></td>
</tsx:repeat>
</table>
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Example 3 shows explicit indexing and ending index with implicit starting index. Although the index
attribute is specified, you can still implicitly index the indexed property city because the (myIndex) tag is
not required.
<table>
<tsx:repeat index=myIndex end=299>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="city" /t>
</tr></td>
<tr><td><tsx:getProperty name="servicelocationsQuery" property="address(myIndex)" />
</tr></td>
<tr><td><tsx:getProperty name="servicelLocationsQuery" property="telephone(myIndex)" />
</tr></td>
</tsx:repeat>
</table>

Nesting <tsx:repeat> blocks

You can nest <tsx:repeat> blocks. Each block is separately indexed. This capability is useful for
interleaving properties on two beans, or properties that have subproperties. In the example, two
<tsx:repeat> blocks are nested to display the list of songs on each compact disc in the user’s shopping
cart.
<tsx:repeat index=cdindex>
<hl><tsx:getProperty name="shoppingCart" property=cds.title /></hl>
<table>
<tsx:repeat>
<tr><td><tsx:getProperty name="shoppingCart" property=cds(cdindex).playlist />
</td></tr>
</tsx:repeat>
</table>
</tsx:repeat>

JavaServer Pages migration best practices and considerations

The standard JavaServer Pages (JSP) tags from JSP 1.1 such as jsp:include, jsp:useBean, and <% @
page %>, a will migrate successfully to JSP 2.0. However, there are several areas that must be
considered when migrating JavaServer Pages. This topic discusses the areas that you must consider
when migrating JavaServer Pages.

Classes from the unnamed or default package

As of JSP 2.0, referring to any classes from the unnamed or default package is not allowed. This can
result in a translation error on some containers, specifically those that run in a JDK 1.4 or greater
environment which will also break compatibility with some older JSP applications. However, as of JDK 1.4,
importing classes from the unnamed package is not valid. See Pava 2 Platform, Standard Edition Version|
[L.4.2 Compatibility with Previous Released for details. Therefore, for forwards compatibility, applications
must not rely on the unnamed package. This restriction also applies for all other cases where classes are
referenced, such as when specifying the class name for a tag in a Tag Library Descriptor (TLD) file.

Page encoding for JSP documents

There have been noticeable differences in internationalization behavior on some containers as a result of
ambiguity in the JSP 1.2 specification. However, steps were taken to minimize the impact on backwards
compatibility and overall, the internationalization abilities of JSP files have been greatly improved.

In JSP specification versions prior to JSP 2.0, JSP pages in XML syntax, JSP documents, and those in
standard syntax determined their page encoding in the same fashion, by examining the pageEncoding or
contentType attributes of their page directive, defaulting to ISO-8859-1 if neither was present.

As of JSP 2.0, the page encoding for JSP documents is determined as described in section 4.3.3 and
appendix F.1 of the XML specification, and the pageEncoding attribute of those pages is only checked to
make sure it is consistent with the page encoding determined as per the XML specification. As a result of
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this change, JSP documents that rely on their page encoding to be determined from their pageEncoding
attribute are no longer decoded correctly. These JSP documents must be changed to include an
appropriate XML encoding declaration.

Additionally, in JSP 1.2, page encodings are determined on translation unit basis whereas in JSP 2.0,
page encodings are determined on the basis of each file. Therefore, if the a.jsp file statically includes the
b.jsp file, and a page encoding is specified in the a.jsp file but not in the b.jsp file, in JSP 1.2 the encoding
for the a.jsp file is used for the b.jsp file, but in JSP 2.0, the default encoding is used for the b.jsp file.

web.xml file version

The JSP container uses the version of the web.xml file to determine whether you are running a JSP 1.2
application or a JSP 2.0 application. Various features can behave differently depending on the version of
the web.xml file. The following is a list of things JSP developers should be aware of when upgrading their
web.xml file from version Servlet 2.3 to version Servlet 2.4:

1. EL expressions are ignored by default in JSP 1.2 applications. When you upgrade a Web application to
JSP 2.0, EL expressions are interpreted by default. You can use the escape sequence \$ to escape EL
expressions that should not be interpreted by the container. Alternatively, you can use the isELIgnored
page directive attribute, or the <el-ignored> configuration element to deactivate EL for entire translation
units. Users of JSTL 1.0 must upgrade their taglib imports to the JSTL 1.1 uris or use the _rt versions
of the tags, for example, use c_rt instead of ¢ or fmt_rt instead of fmt.

2. Web applications that contain files with an extension of .jspx will have those files interpreted as JSP
documents, by default. You can use the JSP configuration element <is-xml> to treat .jspx files as
regular JSP pages, but there is no way to disassociate .jspx from the JSP container.

3. The escape sequence \$ was not reserved in JSP 1.2. The output for any template text or attribute
value that appeared as \$ in JSP 1.2 was \$, however, the output now is just $.

jsp:useBean tag

WebSphere Application Server version 5.1 and later enforces more strict adherence to the specification for
the jsp:useBean tag: with type and class attributes. Specifically, you should use the type attribute should
be used to specify a Java type that cannot be instantiated as a JavaBean. For example, a Java type that
is an abstract class, interface, or a class with no public no-args constructor. If the class attribute is used
for a Java type that cannot be instantiated as a JavaBean, the WebSphere Application Server JSP
container produces a unrecoverable translation error at translation time.

Generated packages for JSP classes

Any reliance on generated packages for JSP classes will result in non-portable JSP files. Packages for
generated classes are implementation-specific and therefore you should not rely on these packages.

JspServlet class

Any reliance on the existence of a JspServlet class will cause unrecoverable error problems. WebSphere
Application Server version 6.0 and later no longer uses a JspServlet class.

Web modules

A Web module represents a Web application. A Web module is created by assembling servlets,
JavaServer Pages (JSP) files, and static content such as Hypertext Markup Language (HTML) pages into
a single deployable unit. Web modules are stored in Web archive (WAR) files, which are standard Java
archive files.

A Web module contains:
* One or more servlets, JSP files, and HTML files.
* A deployment descriptor, stored in an Extensible Markup Language (XML ) file.
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The file, named web.xm1, declares the contents of the module. It contains information about the structure
and external dependencies of Web components in the module and describes how the components are
used at run time.

You can create Web modules as stand-alone applications, or you can combine Web modules with other
modules to create Java 2 Platform, Enterprise Edition (J2EE) applications. You install and run a Web
module in the Web container of an application server.

Troubleshooting tips for Web application deployment

Deployment of a Web application is successful if you can access the application by typing a Uniform
Resource Locator (URL) in a browser, or if you can access the application by following a link.

If you cannot access your application, follow these steps to eliminate some common errors that can occur
during migration or deployment.

Web module does not run in WebSphere Application Server Version 5.x or 6.x

Symptom Your Web module does not run when you migrate it to Version 5.x or 6.x

Problem In Version 4.x, the classpath setting that affected visibility was Module Visibility Mode.
In Versions 5.x and 6.x, you must use class loader policies to set visibility.

Recommended response Reassemble an existing module, or change the visibility settings in the class loader
policies.

See[‘Class loaders” on page 1349|and [Chapter 22, “Class loading,” on page 1349 for
more information.

Welcome page is not visible.

Symptom You cannot access an application with a Web path of:
/webapp/myapp
Problem The default welcome page for a Web application is assumed to be index.html. You

cannot access the default page of the myapp application unless it is named index.html.

Recommended response To identify a different welcome page, modify the properties of the Web module during
assembly. See the article [*Assembling Web applications” on page 81 for more
information.

HTML files are not found.

Symptom Your Web application ran successfully on prior versions, but now you encounter errors
that the welcome page (typically index.html), or referenced HTML files are not found:

Error 404: File not found: Banner.html
Error 404: File not found: HomeContent.html
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Problem For security and consistency reasons, Web application URLs are now case-sensitive on
all operating systems.

Suppose the content of the index page is as follows:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 5.0 Frameset//EN">

<HTML>

<TITLE>

Insurance Home Page

</TITLE>
<frameset rows="18,80">
<frame src="Banner.html" name="BannerFrame" SCROLLING=NO>
<frame src="HomeContent.html" name="HomeContentFrame">
</frameset>

</HTML>

However the actual file names in the \WebSphere\AppServer\installedApps\...
directory where the application is deployed are:
banner.html
homecontent.html

Recommended response To correct this problem, modify the index.html file to change the names Banner.html
and HomeContent.html to banner.html and homecontent.html to match the names of
the files in the deployed application.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Supporf page.

Web applications: Resources for learning

Use the following links to find relevant supplemental information about Web applications. The information
resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of the
information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

Programmlng model and decisions
J2EE BluePrints for Web applications|
« [Redbook on the design and implementation of Servlets, JSP files, and enterprise beans|

Programming instructions and examples

» |WebSphere Studio Application Developer Programming Guide
* |Sun’s Java " Tutorial on Servlets and JavaServer Pages

« |Web delivered samples in the Samples Gallery|

Programming specifications

- |Java 2 Software Develo%ment Kit (SDK)|
* |Servlet 2.4 Specification

« JavaServer Pages 2.0 Specification
- [Differences between JavaScript and ECMAScript

* |ISO 8859 Specification
[Java 2 Platform, Standard Edition (J2SE)|
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Developing servlets with WebSphere Application Server extensions

Several WebSphere Application Server extensions are provided for enhancing your servlets. This task
provides a summary of the extensions that you can utilize.

1. Review the supported specifications.
Create Java components, referring to the Servlet specifications from Sun Microsystems.
See [Resources for learning| for links to coding specifications and examples.

The application server includes its own packages that extend and add to the Java Servlet Application
Programming Interface (API). These extensions and additions make it easier to manage session
states, create personalized Web pages, generate better servlet error reports, and access databases.
Locate the APl documentation for the application server APIs in the install_root\web\apidocs
directory for a default installation.

All the public WebSphere Application Server APls are located in the com.ibm.websphere... packages.

2. Use your favorite integrated development environment (IDE), or a text editor, to develop or migrate
code artifacts that meet the specifications.

3. Test the code artifacts.

Assemble your code artifacts into a Web module using jassembly toolq as a prerequisite to deploying the
code to the application server.

Application life cycle listeners and events

With application life cycle listeners and events, which are now part of the Servlet API, you can notify
interested listeners when servlet contexts and sessions change. For example, you can notify users when
attributes change and if sessions or servlet contexts are created or destroyed.

The life cycle listeners give the application developer greater control over interactions with ServletContext
and HttpSession objects. Servlet context listeners manage resources at an application level. Session
listeners manage resources that are associated with a series of requests from a single client. Listeners are
available for life cycle events and for attribute modification events. The listener developer creates a class
that implements the javax listener interface, corresponding to the listener functionality that you want.

At application startup time, the container uses introspection to create an instance of your listener class and
registers it with the appropriate event generator.

When a servlet context is created, the contextlnitialized method of your listener class is invoked, which
creates the database connection for the servlets in your application to use if this context is for your
application. All servlet context listeners are notified of context initialization before any servlet in the Web
application is initialized.

When the servlet context is destroyed, your contextDestroyed method is invoked, which releases the
database connection, if this context is for your application. You must destroy all servlets before any servlet
context listeners are notified of context destruction.

Notifications to session listeners precedes notifications to context listeners.

Listener classes for servlet context and session changes

The following methods are defined as part of the javax.servlet.ServletContextListener interface:

» void contextlnitialized(ServletContextEvent)
Notification that the Web application is ready to process requests. Place code in this method to see if
the created context is for your Web application and if it is, allocate a database connection and store the
connection in the servlet context.

» void contextDestroyed(ServletContextEvent)
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Notification that the servlet context is about to shut down. Place code in this method to see if the
created context is for your Web application and if it is, close the database connection stored in the
servlet context.

The following methods are defined as part of the javax.servlet.ServietRequestListener interface:
e public void requestInitialized(ServietRequestEvent re)
— Notification that the request is about to come into scope

A request is defined as coming into scope when it is about to enter the first filter in the filter chain
that processes the request.
* public void requestDestroyed(ServletRequestEvent re)
— Notification that the request is about to go out of scope

A request is defined as going out of scope when it exits the last filter in its filter chain.

The following listener interfaces are defined as part of the javax.servlet package:
» ServletContextListener
» ServletContextAttributeListener

The following filter interface is defined as part of the javax.servlet package:
* FilterChain interface - methods: doFilter()

The following event classes are defined as part of the javax.servlet package:
» ServletContextEvent
* ServletContextAttributeEvent

The following interfaces are defined as part of the javax.servlet.http package:
» HttpSessionListener

* HttpSessionAttributeListener

* HttpSessionActivationListener

The following event class is defined as part of the javax.servlet.http package:
* HttpSessionEvent

Example: com.ibm.websphere.DBConnectionListener.java
The following example shows how to create a servlet context listener:
package com.ibm.websphere;

import java.io.*;
import javax.servlet.x;

public class DBConnectionListener implements ServletContextListener
{

// implement the required context init method

void contextInitialized(ServletContextEvent sce)

{

1

// implement the required context destroy method
void contextDestroyed(ServletContextEvent sce)

{
}
}

Servlet filtering

Serviet filtering provides a new type of object called a filter that can transform a request or modify a
response.
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You can chain filters together so that a group of filters can act on the input and output of a specified
resource or group of resources.

Filters typically include logging filters, image conversion filters, encryption filters, and Multipurpose Internet
Mail Extensions (MIME) type filters (functionally equivalent to the servlet chaining). Although filters are not
servlets, their life cycle is very similar.

Filters are handled in the following manner:

1. The Web container determines whether it needs to construct a FilterChain containing the
LoggingFilter for the requested resource.

The FilterChain begins with the invocation of the LoggingFilter and ends with the invocation of the
requested resource.

2. If other filters need to go in the chain, the Web container places them after the LoggingFilter and
before the requested resource.

3. The Web container then instantiates and initializes the LoggingFilter (if it was not done previously)
and invokes its doFilter(FilterConfig) method to start the chain.

4. The LoggingFilter preprocesses the request and response objects and then invokes the filter chain
doFilter(ServletRequest, ServletResponse) method.

This method passes the processing to the next resource in the chain, the requested resource.

5. Upon return from the filter chain doFilter(ServietRequest, ServletResponse) method, the
LoggingFilter performs post-processing on the request and response object before sending the
response back to the client.

transition: Java Specification 2.4 allows you to define a new <dispatcher> element in the deployment
descriptor with possible values such as REQUEST, FORWARD, INCLUDE, ERROR, instead of
invoking filters with RequestDispatcher.
For example:
<filter-mapping>
<filter-name>Logging Filter</filter-name>
<url-pattern>/products/*</url-pattern>
<dispatcher>FORWARD</dispatcher>
<dispatcher>REQUEST</dispatcher>
</filter-mapping>

This indicates that the filter should be applied to requests directly from the client as well as forward
requests. Adding the INCLUDE and ERROR values also indicates that the filter should additionally be
applied for included requests and <error-page> requests. If you do not specify any <dispatcher> elements,
then the default is REQUEST.

Initial parameters for servlets settings

Use this page to specify initial parameters that are passed to the init method of Web module servlet filters.
You can specify initial parameter values for servlets in Web modules during or after installation of an
application onto a WebSphere Application Server deployment target. The <param-value> values specified
in <init-param> statements in the web.xml file of Web modules are used by default.

To view this administrative console page, click Applications > Enterprise Applications >
application_name > Init parameters for servlets. This page is the same as the Init parameters for
servlets in each Web module panel on the application installation and update wizards.

Module

Specifies the name of a module in the application that you are installing or that you are viewing after
installation.

URI

Specifies the location of the module relative to the root of the application (EAR file).
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Servlet
Specifies a unique name for the servlet within the application.

A servlet is a Java program that uses the Java Servlet Application Programming Interface (API). You must
package servlets in a Web archive (WAR) file or Web module for deployment to an application server.
Servlets run on a Java-enabled Web server and extend the capabilities of a Web server, similar to the way
applets run on a browser and extend the capabilities of a browser.

Name
Specifies the name of the initial parameter passed to the init method of the Web module servlet filter.

The following example servlet filter statement in a web.xm1 file specifies an initial parameter name of
attribute:
<init-param>

<param-name>attribute</param-name>

<param-value>tests.Filter.DoFilter_ Filter.SERVLET _MAPPED</param-value>
</init-param>

Value
Specifies the value assigned to an initial parameter passed to the init method of the Web module servlet
filter.

The following example servlet filter statement in a web.xml file specifies an initial parameter value of
tests.Filter.DoFilter Filter.SERVLET MAPPED for the init parameter attribute:
<init-param>

<param-name>attribute</param-name>

<param-value>tests.Filter.DoFilter_Filter.SERVLET_MAPPED</param-value>
</init-param>

Description
Specifies information on the initial parameter.

Filter, FilterChain, FilterConfig classes for servlet filtering

The following interfaces are defined as part of the javax.servlet package:

» Filter interface - methods: doFilter, getFilterConfig, setFilterConfig

» FilterChain interface - methods: doFilter

» FilterConfig interface - methods: getFilterName, getlnitParameter, getinitParameterNames,
getServletContext

The following classes are defined as part of the javax.servlet.http package:
* HttpServletRequestWrapper - methods: See the [Servlet 2.4 Specification|
* HttpServletResponseWrapper - methods: See the[Servlet 2.4 Specification|

Example: com.ibm.websphere.LoggingFilter.java
The following example shows how to implement a filter:
package com.ibm.websphere;

import java.io.*;
import javax.servlet.x;

public class LoggingFilter implements Filter

{
File _loggingFile = null;

// implement the required init method
public void init(FilterConfig fc)

{
// create the logging file
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}

XXX

}

// implement the required doFilter method...this is where most of
the work is done
public void doFilter(ServlietRequest request,
ServletResponse response, FilterChain chain)
{
try
{
// add request info to the log file
synchronized(_TloggingFile)

XXX}

}

// pass the request on to the next resource in the chain
chain.doFilter(request, response);

}
catch (Throwable t)

{
}

// handle problem...
}

// implement the required destroy method
public void destroy()
{

// make sure logging file is closed
_loggingFile.close() s

Configuring page list servlet client configurations

Note: The PageList Servlet custom extension is deprecated in WebSphere Application Server Version 6.1

and will be removed in a future release. Re-architect your legacy applications to use
javax.servlet.filter classes instead of com.ibm.servlet classes. Starting from the Servlet 2.3
specification, javax.servlet.filter classes you can intercept requests and examine responses. You
can also use javax.servlet.filter classes to achieve chaining functionality, as well as embellishing or
truncating responses.

You can define PageListServlet configuration information in the IBM Web Extensions file. The IBM Web
Extensions file is created and stored in the Web Applications archive (WAR) file by an|assembly tool

To configure and implement page lists:
1. To configure page list information, use the Add Markup Language entry dialog of an assembly tool. On

the Servlets tab of a Web deployment descriptor editor, select a servlet and click Add under
WebSphere Extensions.

Add the callPage() method to your servlet to invoke a JavaServer Page (JSP) file in response to a
client request.

The PagelListServlet has a callPage() method that invokes a JSP file in response to the HTTP request
for a page in a page list. The callPage() method can be invoked in one of the following ways:

* callPage(String pageName, HttpServletRequest request, HttpServletResponse response)

where the method arguments are:
pageName

A page name defined in the PageListServlet configuration
request

The HttpServletRequest object
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response
The HttpServietResponse object
e callPage(String miName, String pageName, HttpServletRequest request, HttpServletResponse
response)

where the method arguments are:
mlName A markup language type
pageName
A page name defined in the PageListServlet configuration
request
The HttpServietRequest object
response
The HttpServletResponse object

3. Use the PagelList Servlet client type detection support to determine the markup language type a calling
client requires for the response.

Page lists

Page lists allow you to avoid hard-coding Uniform Resource Locators (URLS) in servlets and JSP files. A
page list specifies the location where a request is to be forwarded, but automatically customizes that
location depending on the MIME type of the servlet. Use these properties to specify a markup language
and an associated MIME type. For the given MIME type, you also specify a set of pages to invoke.

Note: The PagelList Servlet custom extension is deprecated in WebSphere Application Server Version 6.1
and will be removed in a future release. Re-architect your legacy applications to use
javax.servlet.filter classes instead of com.ibm.servlet classes. Starting from the Servlet 2.3
specification, javax.servlet.filter classes you can intercept requests and examine responses. You
can also use javax.servlet.filter classes to achieve chaining functionality, as well as embellishing or
truncating responses.

The following list of classes are deprecated:

» com.ibm.servlet.ClientList

» com.ibm.servlet.ClientListElement

» com.ibm.servlet. MLNotFoundException
* com.ibm.servlet.PageListServlet

= com.ibm.servlet.PageNotFoundException

WebSphere Application Server supplies the PageListServlet servlet, which you can use to call a
JavaServer Pages (JSP) file by name based on the configuration data in the cTient_types.xml file. This
file maps a JSP file to a Uniform Resource Identifier (URI). When the URI is invoked, it specifies another
JSP file in a Web module. This support allows you to access multiple URLs without hard-coding them in
your servlets.

You can also logically group page lists according to the markup language type, such as, Hypertext Markup
Language (HTML) or Wireless Markup Language (WML). This allows applications that use servlets to
extend the PageListServlet servlet, to call JSP files which return the proper markup-language type for the
client request. For example, a request that originates from a PDA device requires WML data. The
application server sends the request to a servlet that extends the PageListServlet servlet, and the servlet
calls a JSP file that returns a WML response.

Client type detection support

In addition to providing the page list mapping capability, the PageListServlet also provides Client Type
Detection support. A servlet determines the markup language type that a calling client needs in the
response, using the configuration information in the client_types.xml file.
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Client type detection support allows a servlet, extending the PageListServlet, to call an appropriate
JavaServer Pages (JSP) file. The servlet invokes the callPage method, which calls a JSP file based on
the markup-language type of the request.

The PagelList Servlet custom extension is deprecated in WebSphere Application Server Version 6.1 and
will be removed in a future release. Re-architect your legacy applications to use javax.servlet.filter classes
instead of com.ibm.servlet classes.

client_types.xml

The client_types.xml file provides client type detection support for servlets extending PageListServlet.
Using the configuration data in the client_types.xml file, servlets can determine the language type that
calling clients require for the response.

Note: The PageList Servlet custom extension is deprecated in WebSphere Application Server Version 6.1
and will be removed in a future release. Re-architect your legacy applications to use
javax.servlet.filter classes instead of com.ibm.servlet classes.

The client type detection support allows servlets to call appropriate JavaServer Pages (JSP) files with the
callPage method. Servlets select JSP files based on the markup-language type of the request.

Servlets must use the following version of the cal1Page method to determine the markup language type
required by the client:

callPage(String mIName, String pageName, HttpServletRequest request,
HttpServletResponse response)

where the arguments are:

* mIName - a markup language type

* pageName - a page name defined in the PageListServlet configuration
* request - the HttpServletRequest object

* response - the HttpServletResponse object

Review the [Extending the PageListServlet| code example to see how the callPage method is invoked by a
servlet.

In the example, the client type detection method, getMLTypeFromRequest (HttpServietRequestrequest),
provided by the PageListServlet, inspects the HttpServietRequest object request headers, and searches
for a match in the client_types.xml file.

The client type detection method does the following:

» Uses the input HttpServletRequest and the client_types.xml file, to check for a matching HTTP
request name and value.

* Returns the markup-language value configured for the <client-type> element, if a match is found.

* If multiple matches are found, this method returns the markup-language for the first <client-type>
element for which a match is found.

* If no match is found, returns the value of the markup-language for the default page defined in the
PageListServlet configuration.

Location
The client_types.xml file is located in the install root/properties directory.

Usage notes
* Is this file read-only?

No
* Is this file updated by a product component?

No
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* If so, what triggers its update?

This file is created and updated manually by users.
* How and when are the contents of this file used?

Servlets that extending the PageListServlet servlet use this file to determine the language type that
calling clients require for the response.

Sample file entry

<?xml version="1.0" >
<IDOCTYPE clients [
<!ELEMENT client-type (description, markup-language,request-header+)>
<!ELEMENT description (#PCDATA)>
<!ELEMENT markup-Tlanguage (#PCDATA)>
<!ELEMENT request-header (name, value)>
<!ELEMENT clients (client-type+)>
<!ELEMENT name (#PCDATA)>
<!ELEMENT value (#PCDATA)>]>
<clients>
<client-type>
<description>IBM Speech Client</description>
<markup-Tlanguage>VXML</markup-language>
<request-header>
<name>user-agent</name>
<value>IBM VoiceXML pre-release version 000303</value>
</request-header>
<request-header>
<name>accept</name>
<value>text/vxml</value>
</request-header>
</client-type>
<client-type>
<description>WML Browser</description>
<markup-language>WML</markup-Tanguage>
<request-header>
<name>accept</name>
<value>text/x-wap.wml</value>
</request-header>
<request-header>
<name>accept</name>
<value>text/vnd.wap.xml</value>
</request-header>
</client-type>
</clients>

Example: Extending PageListServiet

Note: The PagelList Servlet custom extension is deprecated in WebSphere Application Server Version 6.1
and will be removed in a future release. Re-architect your legacy applications to use
javax.servlet.filter classes instead of com.ibm.servlet classes. Starting from the Servlet 2.3
specification, javax.servlet.filter classes you can intercept requests and examine responses. You
can also use javax.servlet.filter classes to achieve chaining functionality, as well as embellishing or
truncating responses.

The following example shows how a servlet extends the PageListServlet class and determines the
markup-language type required by the client. The servlet then uses the callPage method to call an
appropriate JavaServer Pages (JSP) file. In this example, the JSP file that provides the correct
markup-language for the response is Hello.page.

public class HelloPervasiveServlet extends PagelistServlet implements Serializable

{
/*
* doGet -- Process incoming HTTP GET requests
*/
public void doGet(HttpServletRequest request, HttpServletResponse response)
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throws I0Exception, ServletException

{
// This is the name of the page to be called:
String pageName = "Hello.page";

// First check if the servlet was invoked with a queryString that contains
// a markup-language value.

// For example, if this is how the servilet is invoked:

// http://localhost/serviets/HeloPervasive?mlname=VXML

// then use the following method:

String miname= getMLNameFromRequest (request);

// 1f no markup language type is provided in the queryString,
// then try to determine the client
// Type from the request, and use the markup-language name configured in
// the client_types.xml file.
if (mIName == null)
{
mIName = getMLTypeFromRequest (request);

try
{

// Serve the request page.
callPage(miName, pageName, request, response);

catch (Exception e)

handleError(miName, request, response, e);

}
}

autoRequestEncoding and autoResponseEncoding

Starting with WebSphere Application Server Version 5, the Web container no longer automatically sets
request and response encodings, and response content types. Programmers are expected to set these
values using available methods in the Servlet 2.3 Specification or later. If programmers choose not to use
the character encoding methods, they can specify the autoRequestEncoding and autoResponseEncoding
extensions, which enable the application server to set the encoding values and content type.

The values of the autoRequestEncoding and autoResponseEncoding extensions are either true or false.
The default value for both extensions is false. If the value is false for both autoRequestEncoding and
autoResponseEncoding, then the request and response character encoding is set to the Servlet 2.3
Specification default, which is 1ISO-8859-1. Also, if the value is set to false for a response, the Web
container cannot set a response content type.

Use an|assembly tool|to change the default values for the autoRequestEncoding and
autoResponseEncoding extensions.

Review the autoRequestEncoding and autoResponseEncoding encoding examples for a description of Web
container behavior when these values are set to true.

Examples: autoRequestEncoding and autoResponseEncoding
encoding examples

The default value of the autoRequestEncoding and autoResponseEncoding extensions is false, which
means that both the request and response character encoding is set to the Servlet 2.3 Specification
default of 1ISO-8859-1. Different character encodings are possible if the client defines character encoding in
the request header, or if the code includes the setCharacterEncoding(String encoding) method. Also, If
the value is set to false for a response, the Web container cannot set a response content type.
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If the autoRequestEncoding value is set to true, and the client did not specify character encoding in the
request header, and the code does not include the setCharacterkEncoding(String encoding) method, the
Web container tries to determine the correct character encoding for the request parameters and data.

The Web container performs each step in the following list until a match is found:
* Looks at the character set (charset) in the Content-Type header.

» Attempts to map the servers locale to a character set using defined properties.
* Attempts to use the DEFAULT_CLIENT_ENCODING system property, if one is set.

» Uses the ISO-8859-1 character encoding as the default.

If the autoResponsetEncoding value is set to true, and the client did not specify character encoding in the

request header, and the code does not include the setCharacterkEncoding(String encoding) method, the

Web container does the following:

» Attempts to determine the response content type and character encoding from information in the
request header.

* Uses the 1SO-8859-1 character encoding as the default.

Developing Web applications

Design a Web application and the components that it needs.
For general Web application design information, see "Resources for learning.”

There are two basic approaches to selecting tools for developing Web applications:

* You can use one of the available integrated development environments (IDEs). IDE tools automatically
generate significant parts of the servlet and JavaServer Pages (JSP) code, and Hypertext Markup
Language (HTML) files. They also contain integrated tools for packaging and testing the Web
application components. The Rational Web Developer product, included with IBM WebSphere
Application Server Express, is the recommended IDE. For more information, see the documentation for
that product.

 If you decide to develop Web components without an IDE, you need at least an ASCII text editor. You
can also use tools available in the Java Software Development Kit (SDK) and in this product to
assemble, test, and deploy the Web application components.

The following steps support the second approach, development without an IDE.
1. If necessary, migrate any pre-existing code to the required version of the servlet and JSP specification.

2. Write and compile the components of the Web application. To access classes that were extended,
compile your code using the -classpath option on the javac compiler. This option allows you to
reference the j2ee.jar file in the product directory:

* <install_root>\1ib
BT For example, to compile a servlet for WebSphere Application Server on Windows, specify:
javac -classpath D:\Program Files\WebSphere\AppServer\lib\j2ee.jar MyServlet.java

3. (Optional) Disable JavaServer Pages (JSP) runtime compilation, if necessary.

|Assemble the application components in one or more Web modules.|

JavaServer Faces

JavaServer Faces (JSF) is a user interface framework or API that eases the development of Java based
Web applications. WebSphere Application Server version 6.1 supports JavaServer Faces 1.1 at a runtime
level, therefore using JSF reduces the size of the Web application since runtime binaries no longer need
to be included in your Web application.

The JSF runtime also :
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* Makes it easy to construct a user interface from a set of reusable user interface components
» Simplifies migration of application data to and from the user interface

* Helps manage user interface state across server requests

* Provides a simple model for wiring client-generated events to server-side application code

* Allows custom user interface components to be easily build and reused

The Rational Web Developer that comes with WebSphere Application Server Express includes
drag-and-drop tools that simplify building JSF applications.

The Sun JSF Reference Implementation provides the foundation of the code used for the JSF support in
WebSphere Application Server. However, some dependencies on Jakarta APIs have been removed and
replaced with Application Server specific solutions as a result of potential problems that may occur when
Open Source APIs are included in the Application Server runtime. For example, when included in the
Application Server runtime, these Open Source APIs are made available to all applications installed within
the Application Server, therefore bringing versioning, support and legal issues. The version of the JSF
runtime provided by the Application Server resides in the normal runtime library location and is available to
all Web applications that leverage JSF APIs. The loading of the JSF servlet works in the same manner as
if the runtime was packaged with the Web application.

The following open source dependencies are replaced with other APIs or in-house versions:
» Jakarta Commons BeanUtils

» Jakarta Commons Collections

» Jakarta Commons Digester

» Jakarta Commons Logging

* Mozilla Assert API

The JSF Specification requires JavaServer Pages Standard Tag Library (JSTL) as a dependency, therefore
the required version of the JSTL from Jakarta is made available in the Application Server runtime.

<<subsystem>>
Java Server Faces Runtime

Used for all
logging calls

Used to parse JSF
configuration files

<<subsystem>>

Jakarta Commons Logging <<subsystem>>

Jakarta Commons Digester

\ 4
<<subsystem>> <<subsystem>> <<subsystem>>
Jakarta Commons BeanUtils Jakarta Commons Collections Mozilla Assert
. . Contains a collection
All javabean utilitycalls for that is modifiable while Used to assert
ValueRefs and ModelRefs being iterated. This is used common parameters
for storing JSF Events. within JSF Runtime

Figure 3. Current external APl dependencies from the Sun based JSF runtime
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Figure 4. Replacement APIs

<<subsystem>>
Java Server Faces Runtime

<<subsystem>>
JDK 1.4 logging API . <<subsystem>>
\ JSF Configuration Parser
<<subsystem>>
JSF Utilities
Standard javax.logging API . A SAX Parser that loads configuration
supplied with JDK 1.4 . objects from the xml files found in the JSF
Web Application

A Utilities package that contains
classes to handle Assertion (FacesAssert),
Java Bean manipulation (FacesBeanUtils).

The specification related classes (javax.faces.*) for JSF and the IBM modified version of the JSF Sun
reference implementation are packaged in the Application Server runtime.

Typically Web applications that leverage this API/Framework embed the JSF API and implementation JAR
files within their WAR file. This is not required when these Web applications are deployed and run within
WebSphere Application Server. Only the removal of these jars along with any JSTL JAR files from the
WAR file is required.

If a Web application requires the use of its own version of JSF or JSTL embedded within it, you can
change the class loader mode of the Web application. By default this is set to PARENT_FIRST mode.
Changing this value to PARENT_LAST allows the Web application version of the JSF or JSTL classes to
load before the WebSphere Application Server.

FacesAssert class

The Sun Reference implementation uses a utility class from Mozilla to perform assertion style calls to
method parameters. The faces assert class provides equivalent functionality. The option of leveraging the
assertion functionality available in JDK 1.4 is not possible due to the requirement of providing JVM level
parameters to turn on assertion code support. The FacesAssert class only contains static method and has
no life cycle.

FacesAssert

+ notEmpty ( [in] str : String ) : boolean
+ nonNull ( [in] isNull : Object ) : boolean

+ wsAssert ( [in] message : String ) : boolean

+ wsAssert ([in] argument : boolean , [in] message : String ) : boolean
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FacesBeanUtils class

The FacesBeanUltils class provides static method replacements for methods used in the Jakarta Commons
BeanUtils API. The FacesBeanUltils class has no life cycle.

FacesBeanUltils

+ getProperty ( [in] bean : Object , [in] property : String ) : Object

+ getPropertyType ( [in] bean : Object , [in] property : String ) : Class

+ getSimpleProperty ( [in] bean : Object, [in] property : String , [in] value : Object )
+ getProperty ( [in] bean : Object , [in] property : String , [in] value : Object)

+ convertFromString ( [in] value : String, [in] valueClass : Class ) : Object

+ convert ([in] targetType : Class , [in] bean : String ) : Object

Faces configuration parser

The Sun Reference Implementation of JavaServer Faces use the Jakarta Commons Digester API to parse
Faces configuration files. An XML SAX based parser is provided for the Application Server . The Digester
code uses reflection code to perform its parsing. This has been found to be quite slow when large
configuration files are parsed. The FaceConfigParser class in the diagram below is custom written for the
Faces Configuration DTD and therefore parses large configuration files more quickly.
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Figure 5. Faces configuration parser

JavaServer Faces widget library (JWL)

FacesClient framework

JavaServer Faces widget library (JWL) is a IBM JSF-based Web widget library that integrates widgets
from a number of sources. It includes the JSF components from Rational Web Developer (RWD), with the
exception of the base JSF components which are already included in the Application Server runtime. This
includes the IBM extended JSF components and the extended Odyssey components.

JWL also extends JSF with client-side features for rich Browser-based experiences in the form of the
Odyssey Browser Framework (OBF).
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JWL Java archive files

JWL is packaged into two jar files, odc-jsf.jar and jsf-ibm.jar files, which are located in the
${WAS_HOME}NoptionalLibraries\IBM\jwI\2.0 directory.

To include JWL in your application, you can use the JWL shared library named JWLLIib, which is created
at install time. To assign the library to an application, see the article, Using installed optional packages.

Assembling Web applications

Assemble a Web module to contain servlets, JavaServer page (JSP) files, and related code artifacts.
(Group enterprise beans, client code, and resource adapter code in separate modules). After assembling a
Web module, you can install it as a standalone application or combine it with other modules into an
enterprise application.

This topic assumes that you have created and unit tested [Servlets, [JavaServer Pages| (JSP) files and
other Web components that you want to assemble in an [enterprise application and deploy onto an
application server.

Use the Application Server Toolkit (AST) or Rational Application Developer to assemble a
Web module in any of the following ways:

* Import an existing Web module (WAR file).

* Create a new Web module.

» Copy code artifacts (such as servlets) from one Web module into a new Web module.

Although you can input various properties for Web archives, available properties are specific to the Servlet,
JSP, and J2EE specification level.

1. Start an assembly tool.

2. If you have not done so already, configure the assembly tool for work on J2EE modules. Ensure that
J2EE and Web capabilities are enabled.

3. Migrate WAR files created with the Assembly Toolkit, Application Assembly Tool (AAT) or a different
tool to an assembly tool. To migrate files, import your WAR files to the assembly tool.

4. Create a new Web module.
5. Copy code artifacts (such as servlets) from one Web module into a new Web module.

A Web project is migrated or created. Files for the Web project are shown in the Project Explorer view
under Enterprise Applications and Web Projects.

You can now [deploy your Web project to an application server.

Web component security

A Web module consists of servlets, JavaServer Pages (JSP) files, server-side utility classes, static Web
content, which includes HTML, images, sound files, cascading style sheets (CSS), and client-side classes
or applets. You can use development tools such as Rational Application Developer to develop a Web
module and enforce security at the method level of each Web resource.

You can identify a Web resource by its URI pattern. A Web resource method can be any HTTP method
(GET, POST, DELETE, PUT, for example). You can group a set of URI patterns and a set of HTTP
methods together and assign this grouping a set of roles. When a Web resource method is secured by
associating a set of roles, grant a user at least one role in that set to access that method. You can exclude
anyone from accessing a set of Web resources by assigning an empty set of roles. A servlet or a
JavaServer Pages (JSP) file can run as different identities before invoking another enterprise bean
component. All the secured Web resources require the user to log in by using a configured login
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mechanism. Three types of Web login authentication mechanisms are available: basic authentication,
form-based authentication and client certificate-based authentication.

In WebSphere Application Server Version 6.1, a portlet resource that is part of a web module can also be
protected when it is accessed directly through URL. The protection is similar to other Web based
resources. For more information, see Portlet URL security.

For more detailed information on Web security, see the product architectural overview article.

Securing Web applications using an assembly tool

You can use three types of Web login authentication mechanisms to configure a Web application: basic
authentication, form-based authentication and client certificate-based authentication. Protect Web
resources in a Web application by assigning security roles to those resources.

To secure Web applications, determine the Web resources that need protecting and determine how to
protect them.

Note: This procedure might not match the steps that are required when using your jassembly tool, or
match the version of the assembly tool that you are using. You should follow the instructions for the
tool and version that you are using.

The following steps detail securing a Web application using an assembly tool:

1. In an assembly tool, import your Web archive (WAR) file or an application archive (EAR) file that
contains one or more Web modules.

For more information, see "Importing Web archive (WAR) files” and "Importing an enterprise
application EAR file” in the Application Server Toolkit documentation.

2. In the Project Explorer folder, locate your Web application.

3. Right-click the deployment descriptor and click Open With > Deployment Descriptor Editor. The
Deployment Descriptor window opens. To see online information about the editor, press F1 and click
the editor name. If you select a Web archive (WAR) file, a Web deployment descriptor editor opens. If
you select an enterprise application (EAR) file, an application deployment descriptor editor opens.

4. Create security roles either at the application level or at the Web module level. If a security role is
created at the Web module level, the role also displays in the application level. If a security role is
created at the application level, the role does not display in all of the Web modules. You can copy and
paste a security role at the application level to one or more Web module security roles.

* Create a role at a Web-module level. In a Web deployment descriptor editor, click the Security tab.
Under Security Roles, click Add.. Enter the security role name, describe the security role, and click
Finish.

* Create a role at the application level. In an application deployment descriptor editor, click the
Security tab. Under the list of security roles, click Add. In the Add Security Role wizard, name and
describe the security role and then click Finish.

5. Create security constraints. Security constraints are a mapping of one or more Web resources to a set
of roles.

a. On the Security tab of a Web deployment descriptor editor, click Security Constraints. On the

Security Constraints tab, you can do the following actions:
* Add or remove security constraints for specific security roles.
* Add or remove Web resources and their HTTP methods.
» Define which security roles are authorized to access the Web resources.
» Specify None, Integral, or Confidential constraints on user data.

None The application does not require transport guarantees.

Integral

Data cannot be changed in transit between the client and the server.
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Confidential
Data content cannot be observed while it is in transit.

Integral and Confidential usually require the use of SSL.
Under Security Constraints, click Add.
Under Constraint name, specify a display name for the security constraint and click Next.
Type a name and description for the Web resource collection.

Select one or more HTTP methods. The HTTP method options are: GET, PUT, HEAD, TRACE,
POST, DELETE, and OPTIONS.

Beside the Patterns field, click Add.

g. Specify a URL Pattern. For example, type - /*, *.jsp, /hello. Consult the Servlet specification
Version 2.4 for instructions on mapping URL patterns to servlets. The security runtime uses the
exact match first to map the incoming URL with URL patterns. If the exact match is not present, the
security runtime uses the longest match. The wild card (*.,*.jsp) URL pattern matching is used
last.

h. Click Finish.
i. Repeat these steps to create multiple security constraints.

Map security-role-ref and role-name elements to the role-link element. During the development of a
Web application, you can create the security-role-ref element. The security-role-ref element contains
only the role-name field. The role-name field contains the name of the role that is referenced in the
servlet or JavaServer Pages (JSP) code to determine if the caller is in a specified role. Because
security roles are created during the assembly stage, the developer uses a logical role name in the
Role-name field and provides enough description in the Description field for the assembler to map the
role actual. The Security-role-ref element is at the servlet level. A servlet or JavaServer Pages (JSP)
file can have zero or more security-role-ref elements.

a. Go to the References tab of a Web deployment descriptor editor. On the References tab, you can
add or remove the name of an enterprise bean reference to the deployment descriptor. You can
define five types of references on this tab:

» EJB reference

* Service reference

* Resource reference

* Message destination reference

» Security role reference

* Resource environment reference

Under the list of Enterprise JavaBeans (EJB) references, click Add.
Specify a name and a type for the reference in the Name and Ref Type fields.
Select either Enterprise Beans in the workplace or Enterprise Beans not in the workplace.

Optional: If you select Enterprise Beans not in the workplace, select the type of enterprise bean
in the Type field. You can specify either an entity bean or a session bean.

f. Optional: Click Browse to specify values for the local home and local interface in the Local home
and Local fields before you click Next.

g. Map every role-name that is used during development to the role using the previous steps. Every
role name that is used during development maps to the actual role.

Specify the RunAs identity for servlets and JSP files. The RunAs identity of a servlet is used to invoke
enterprise beans from within the servlet code. When enterprise beans are invoked, the RunAs identity
is passed to the enterprise bean for performing an authorization check on the enterprise beans. If the
RunAs identity is not specified, the client identity is propagated to the enterprise beans. The RunAs
identity is assigned at the servlet level.

a. On the Servlets tab of a Web deployment descriptor editor, under Servlets and JSP, click Add.
The Add Servlet or JSP wizard opens.

b. Specify the servlet or JavaServer Pages (JSP) file settings, including the name, initialization
parameters, and URL mappings and click Next.

® oo o
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c. Specify the class file destination.

d. Click Next to specify additional settings or click Finish.

e. Click Run As on the Servlets tab, select the security role and describe the role.

f. Specify a RunAs identity for each servlet and JSP file that is used by your Web application.

8. Configure the login mechanism for the Web module. This configured login mechanism applies to all the
servlets, JavaServer Pages (JSP) files and HTML resources in the Web module.

a. Click the Pages tab of a Web deployment descriptor editor and click Login. Select the required
authentication method. Available method values include: Unspecified, Basic, Digest, Form, and
Client-Cert.

b. Specify a realm name.

If you select the Form authentication method, select a login page and an error page Web address.
For example, you might use /1ogin.jsp or /error. jsp. The specified login and error pages are
present in the .war file.

d. Install the client certificate on the browser or Web client and place the client certificate in the server
trust keyring file, if ClientCert is selected.

9. Close the deployment descriptor editor and, when prompted, click Yes to save the changes.

After securing a Web application, the resulting Web archive (WAR) file contains security information in its
deployment descriptor. The Web module security information is stored in the web.xm1 file. When you work
in the Web deployment descriptor editor, you also can edit other deployment descriptors in the Web
project, including information on bindings and IBM extensions in the ibm-web-bnd.xmi and
ibm-web-ext.xmi files.

After using an assembly tool to secure a Web application, you can install the Web application using the
administrative console. During the Web application installation, complete the steps in Deploying secured
applications to finish securing the Web application.

Context parameters

A servlet context defines a server’s view of the Web application within which the servlet is running. The
context also allows a servlet to access resources available to it.

Using the context, a servlet can log events, obtain URL references to resources, and set and store
attributes that other servlets in the context can use. These properties declare a Web application’s
parameters for its context. They convey setup information, such as a webmaster’s e-mail address or the
name of a system that holds critical data.

Security constraints
Security constraints determine how Web content is to be protected.

These properties associate security constraints with one or more Web resource collections. A constraint

consists of a Web resource collection, an authorization constraint and a user data constraint.

* A Web resource collection is a set of resources (URL patterns) and HTTP methods on those resources.
All requests that contain a request path that matches the URL pattern described in the Web resource
collection are subject to the constraint. If no HTTP methods are specified, then the security constraint
applies to all HTTP methods.

* An authorization constraint is a set of roles that users must be granted in order to access the resources
described by the Web resource collection. If a user who requests access to a specified Uniform
Resource Identifier (URI) is not granted at least one of the roles specified in the authorization constraint,
the user is denied access to that resource.

» A user data constraint indicates that the transport layer of the client or server communications process
must satisfy the requirement of either guaranteeing content integrity (preventing tampering in transit) or
guaranteeing confidentiality (preventing reading while in transit).
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Security settings

Use the administrative console to modify the security settings for all applications. You can enable security
for applications by enabling the Enable application security option on the Secure administration,
applications, and infrastructure panel.

Note that:
* Global settings apply to existing and future applications and cannot be customized.
» Default settings apply only to future applications and can be customized.

The default settings are used as a template or starting point for configuring individual applications. The
administrator should still explicitly configure security settings for each application.

The following security settings are specified during application assembly:

Security role settings
When using the IAssemny Toolkit| at an application level (Enterprise Archive (EAR) file), security
roles are synchronized with the security roles defined for the embedded modules of the
application.

If a security role is manually added to the EAR file, it can be automatically removed when the file
is saved if an embedded module does not reference the role, or the role is in conflict with an
existing role. In this case, remove the manually added role, but then all roles with the same name
are removed.

The role is automatically added again when the file is saved if it is still referenced in an embedded
module file. If a duplicate role is added in an embedded module file, delete all roles with the same
name and manually read the correct role.

Security constraints
Security constraints declare how to protect Web content. These properties associate security
constraints with one or more Web resource collections. A constraint consists of a Web resource
collection, an authorization constraint, and a user data constraint.

Security constraints are set when configuring a Web application in the [Assembly Toolkit,

Security role references

Web application developers or Enterprise JavaBeans (EJB) providers must use a role-name in the code
when using the available programmatic security Java 2 Platform, Enterprise Edition (J2EE) application
programming interfaces (APIs) isUserInRole(String roleName) and isCallerinRole(String roleName).

The roles used in the deployed run-time environment might not be known until the Web application and
EJB components (for example, Web archive (WAR) files and ejb-jar.xml files) are assembled into an
enterprise archive (EAR) file. Therefore, the role names used in the Web application or EJB component
code are logical role names which the application assembler maps to the actual run-time environment
roles during application assembly. The security role references provide a level of indirection that insulate
Web application component and EJB developers from having to know the actual roles in the run-time
environment.

The definition of the logical roles and the mapping to the actual run-time environment roles are specified in
the security-role-ref element of both the Web application and the EJB JAR file deployment descriptors,
web.xml and ejb-jar.xml respectively. Use the assembly tools to define the role names and map them to
the actual run-time roles in the environment with the role-link element.

The following code sample is an example of a security-role-ref from an EJB ejb-jar.xml deployment
descriptor.

. <enterprise-beans>
. <entity>
<ejb-name>AardvarkPayroll</ejb-name>
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<ejb-class>com.aardvark.payroll.Payrol1Bean</ejb-class>

<security-role-ref>
<description>

This role should be assigned to the employees of the payroll department. Members of this role have
access to the payroll record of everyone. The role has been linked to the payroll-department role. This role
should be assigned to the employees of the payroll department. Members of this role have access to all
payroll records. The role has been linked to the payroll-department role.

</description> <role-name>payrolli</role-name>

<role-link>payroll-department</role-1ink>

</security-role-ref>

</entity>
</enterprise-beans>

In the previous example, the string payrol1, which appears in the <role-name> element, is what the EJB
provider uses as the argument to the isCallerinRole() API. The <role-link> element is what ties the logical
role to the actual role used in the run-time environment.

Note that for enterprise beans, the security-role-ref element must appear in the deployment descriptor
even if the logical role name is the same as the actual role name in the environment.

The rules Web application components are slightly different. If no security-role-ref element matching a
security-role element is declared, the container must default to checking the role-name element argument
against the list of security-role elements for the Web application. The isUserInRole method references the
list to determine whether the caller is mapped to a security role. The developer must be aware that the
use of this default mechanism can limit the flexibility in changing role names in the application without
having to recompile the servlet making the call.

See the EJB Version 2.0 and Servlet Version 2.3 specification in the Security: Resources for Learning
article for complete details on this specification.

Serviet mappings
A servlet mapping is a correspondence between a client request and a servlet.

Web containers use URL paths to map client requests to servlets, and follow the URL path-mapping rules
as specified in the Java Servlet specification. The container uses the URI from the request, minus the
context path, as the path to map to a servlet. The container chooses the longest matching available
context path from the list of Web applications that it hosts.

Serving of serviets by nhame or class name

This behavior is triggered by setting the serveServletsbyClassnameEnabled property within IBM
extensions.

The attribute is used to specify the enablement of the serving of servlets by name or classname

Example attributes:

invoker.patterns
This attribute allows you to specify the patterns that trigger invocation of the server component
and allows the serving of servlets by name or by class name. This value is a list separated by
either a space, colon, or semicolon.
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File serving

File serving allows a Web application to serve static file types, such as HTML. File-serving attributes are
used by the servlet that implements file-serving behavior.

This behavior is implemented by setting the fileservingenabled property to true when configuring the Web
module.

Example attributes:

bufferSize
Sets buffer size that is used for serving static files.

extendedDocumentRoot
Path that specifies the directory where static files are sent. Use this attribute in addition to the
contextRoot attribute.

file.serving.patterns.allow
Specifies that only files matching the specified pattern are served.

file.serving.patterns.deny
Specifies that files that match the specified file pattern are denied

Initialization parameters
Initialization parameters are sent to a servlet in its HttpConfig object when the servlet is first started.

Servlet caching

You can use dynamic caching to improve the performance of a servlet and JavaServer Pages (JSP) files
by serving requests from an in-memory cache. Cache entries contain the servlet's output and metadata.

Web components

A Web component is a servlet, JavaServer Pages (JSP) file, or HTML file. One or more Web components
make up a Web module.

Web property extensions

Web property extensions are IBM extensions to the standard deployment descriptors for Web applications.
These extensions include mime filtering and servlet caching.

Web resource collections

A Web resource collection defines a set of URL patterns (resources) and HTTP methods belonging to the
resource.

HTTP methods handle HTTP-based requests, such as GET, POST, PUT, and DELETE. A URL pattern is a

partial Uniform Resource Locator that acts as a template for matching the pattern with existing full URLs in
an attempt to find a valid file.

Welcome files
A Welcome file is an entry point file (for example, index.htm1) for a group of related HTML files.

Welcome files are located by using a group of partial URIs. The Web container uses the partial URIs to
find a valid file when the initial URI is not found.
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Defining an extension for the registry filter

The registry filter specifies if an extensions is applicable to all registry instances or to specified instances.
You must have an extensible application to define an extension for the registry filter.

Complete the following steps to filter out extensions for an application.

1. Define an extension for the registry filter extension point for a named registry instance in the plugin.xml
file.
<extension point="org.eclipse.extensionregistry.RegistryFilter">
<filter name="AdminConsolex"
class="com.ibm.ws.admin.AdminConsoleExtensionFilter"/>
</extension>
2. Add the filter implementation to the application by creating a class to implement the
com.ibm.workplace.extension.|ExtensionRegistryFilter interface.
package com.ibm.ws.admin;

import com.ibm.workplace.extension.IExtensionRegistryFilter;
public class AdminConsoleExtensionFilter implements IExtensionRegistryFilter {

}

3. The extensible application declares the registry hame by defining an extension for the Registrylnstance
extension point. This way, the registry can prepare an IExtensionRegistry instance and put it in JNDI in
advance.

<extension point="org.eclipse.extensionregistry.RegistryInstance">
<registry name="AdminConsole"/>

</extension>
4. The extensible application obtains a named instance of the registry to activate any associated filters:

InitialContext ic = new InitialContext();
String lookupName = "services/extensionregistry/AdminConsole";
IExtensionRegistry reg = (IExtensionRegistry)ic.lookup( TookupName );

Application extension registry

WebSphere Application Server has enabled the Eclipse extension framework for applications to use.
Applications become extensible as soon as they define an extension point and provide the extension
processing code for the extensible area of the application.

An application can be plugged in to another extensible application by defining an extension that adheres to
what the target extension point requires. The extension point can find the newly added extension
dynamically and the new function is seamlessly integrated in the existing application. It works on a cross
Java 2 Platform, Enterprise Edition (J2EE) module basis. The application extension registry uses the
Eclipse plug-in descriptor format and application programming interfaces (APIs) as the standard
extensibility mechanism for WebSphere applications. Developers that build WebSphere application
modules can use WebSphere Application Server extensions to implement their functionality to an
extensible application, which defines an extension point. This is done through the application extension
registry mechanism.

The architecture of extensible J2EE applications follow a modular design to add new functional modules or
to replace an existing module, particularly by those outside of its core development team. Each module is
a pluggable unit, or plug-in that is either deployed into the portal or removed from the J2EE application
using a deployment tool that is based upon standard J2EE and portal Web module deployment tooling. A
plug-in module describes where it is extensible and what capability it provides to other plug-ins in the
plugin.xml file. The plugin.xml manifest file can be created with a simple text editor or in Eclipse’s Plug-in
Development Environment (PDE), which provides a simplified view of the same underlying XML data.
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You can find additional information about the Eclipse Plug-in Architecture at|http://www.eclipse.org/articles/
[Article-Plug-in-architecture/plugin_architecture.htmi|

WebSphere Application Server implementations to the Eclipse model

Some minor differences exist in the WebSphere Application Server implementation of this architecture
because of platforms, specifically, Eclipse Workbench or Java 2 Platform, Enterprise Edition (J2EE). The
highlights of the WebSphere Application Server implementation include:

* Implementing all of the extension registry-related interfaces from Eclipse 3.1.
* The identical plugin.xml syntax, however, some attributes are not used, for example, <runtime>.

* The discovery and addition of plug-ins to the registry, when the containing J2EE module starts, and
plug-ins are dismissed and removed from the registry when the containing J2EE module stops.

» Access to an IExtensionRegistry object is through the Java Naming and Directory Interface (JNDI),
instead of by using the Platform.getExtensionRegistry method in the Eclipse Workbench.

« |Filtering| capability is available by providing a filter implementation and using a hamed registry instance
that finds and invokes the filter as necessary. See the API documentation for the
[[ExtensionRegistryFilter] interface for more details.

Available Eclipse 3.1 interfaces

The following Eclipse 3.1 interfaces are available on WebSphere Application Server:
+ [Extension registry AP||

+ [Extension point AP||

» |Extension API

+ [Configuration element AP|

[Registry change listener AP||

[Registry change event API|

[Extension delta AP||

* |Status API

The following interfaces are recognized and processed the same as in Eclipse:
+ [Executable extension API|
+ [Executable extension factory API|

Application extension registry filtering

The extension registry exposes the registry filter extension point. The registry filter removes elements
within the extension registry for client applications. Extensions that are attached to the registry filter
extension point and that also implement this interface are called as necessary when a client operates on a
named registry instance that matches the target specification.

You can create a filter extension for all registry instances or for named instances that are specified by the
extension. In the first case, the filter is applied to all instances of the extension registry, and all client
applications use the filter without requesting the filter. In the latter case, a client application must predefine
the registry name by defining an extension, called Registrylnstance, which is another extension point that
is exposed by the extension registry. After the registry name is defined, the client can obtain the named
registry instance and use that registry instance. The filter extension is invoked by the named registry
instance as necessary.

Registry filter API

Supported arguments include:
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org.eclipse.core.runtime.lExtension[]
doFilter(org.eclipse.core.runtime.lExtension[] extensions)

This code returns an array of IExtension objects that are included in the valid extension list.
Registry instance extension point

The extension registry exposes the Registrylnstance . The instance name is declared in the application’s
plugin.xml file, and the application requests an registry instance for that name at runtime.

plugin.xml file

A plug-in is described in an XML manifest file, called plugin.xml, which is part of the plug-in deployment
files. The manifest file tells the portal application’s runtime what it needs to know to register and activate
the plug-in. The manifest file essentially serves as the contract between the pluggable component and the
portal application’s runtime. Although the WebSphere Application Server plugin.xml closely follows the one
provided for the Eclipse workbench, it does diverge from the Eclipse workbench in several places as
outlined below.

Location

The plugin.xml file must reside in the WEB-INF directory under the context of the hierarchy of directories
that exist for a Web application or when included in the Web application archive file.. The plugin.xml file
must reside in the root directory when theplugin.xml file is placed in an Enterprise JavaBeans Java
archive (JAR) file or shared library JAR file. The extension registry service includes the plugin.xml file as
the participating components are loaded and started on the application server.

Usage notes
* s this file read-only?

No

* Is this file updated by a product component?
?2??

» If so, what triggers its update?

The Application Server Toolkit updates the web.xml file when you assemble Web components into a
Web module, or when you modify the properties of the Web components or the Web module.
* How and when are the contents of this file used?

WebSphere Application Server functions use information in this file during the configuration and
deployment phases of Web application development.

* The manifest markup definitions below make use of various naming tokens and identifiers. To eliminate
ambiguity, the following are productions rules for these naming conventions. In general, all identifiers
are case-sensitive.

SimpleToken := sequence of characters from ('a-z','A-Z','0-9")

ComposedToken := SimpleToken | (SimpleToken '.' ComposedToken)

PTugInId := ComposedToken

PTugInPrereq := PlugInld

ExtensionId := SimpleToken

ExtensionPointId := SimpleToken

ExtensionPointReference := ExtensionPointId | (PTugInId '.' ExtensionPointId)

Sample file entry
The entire plug-in manifest DTD is as follows. XML Schema is not used to define the manifest since the
current Eclipse tooling for plug-in's requires a DTD. The XML DTD construction rule element* means zero

or more occurrences of the element; element? means zero or one occurrence of the element; and
element+ means one or more occurrences of the element.
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<?xml encoding="US-ASCII"?>

<!ELEMENT plugin (requires?, extension-point*, extensionx)>
<IATTLIST plugin

name CDATA #IMPLIED

id CDATA #REQUIRED

version CDATA #REQUIRED

provider-name CDATA #IMPLIED
>
<!ELEMENT requires (import+)>
<!ELEMENT import EMPTY>
<IATTLIST import

plugin CDATA #REQUIRED

version CDATA #IMPLIED

match (exact | compatible | greaterOrEqual) #IMPLIED
>
<!ELEMENT extension-point EMPTY>
<IATTLIST extension-point

name CDATA #IMPLIED

id CDATA #REQUIRED

schema CDATA #IMPLIED
>
<!ELEMENT extension ANY>
<IATTLIST extension

point CDATA #REQUIRED

id CDATA #IMPLIED

name CDATA #IMPLIED

>

WebSphere Application Server differences

The plugin.xml file closely follows the pTlugin.xml file provided for the Eclipse workbench. However it
diverges within the following elements.

The plugin element
The plugin element provided in this manifest does not contain class attributes. The class attribute
is unnecessary since the plug-in mechanism does not require the plug-in developer to extend or
use any specific classes as is required by the Eclipse workbench. Also, the plugin element does
not contain a runtime element since standards such as J2EE that already define the location of
runtime libraries for the applications.

The import element
The requires element does not contain export attribute since J2EE modules are encouraged to be
self-contained to improve manageability. In addition to eliminating the export attribute, the match
attribute has an option for a greater than or equal to match for versions (greaterOrEqual).

The extension-point element
The extension-point element has the name attribute as optional since it has no real use in this
J2EE implementation.

you can find details regarding the plug-in manifest in the|EcIipse documentationl, under Platform Plug-In
Developer Guide>Other reference information>Plug-in manifest.

The following is an example of how adding a link to an existing page can be accomplished by an
extension point. The plug-in manifest of this plug-in declares an extension point (linkExtensionPoint) and
an extension to this extension point (linkExtension). The plug-in declaring the extension point does not
need to be the plug-in that implements the extension point. Another plug-in can also define an extension to
the link extension point in its plug-in manifest by including the contents of the <extension> and
</extension> tags in its manifest.

<?xml version="1.0"7>

<l--the plugin id is derived from the vendor domain name -->
<plugin
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id="com.ibm.ws.console.core"
version="1.0.0"
provider-name="IBM WebSphere">

<l--declaration of prerequisite plugins-->
<requires>
<import plugin="com.ibm.data" version="2.0.1" match="compatible"/>
<import plugin="com.ibm.resources" version="3.0" match="exact"/>
</requires>

<!l--declaration of link extension point -->
<extension-point
id="1inkExtensionPoint"
schema="/schemas/1inkSchema.xsd"/>

<!l--declaration of an extension to the link extension point -->
<extension
point="com.ibm.ws.console.core.linkExtensionPoint"
id="1inkExtension">

<link
label="Example.dispTlayName"
actionView="com.ibm.ws.console.servermanagement.forwardCmd.do?
forwardName=example.config.view&
lastPage=ApplicationServer.config.view">
</link>
</extension>
</plugin>

Tuning URL invocation cache

The URL invocation cache holds information for mapping request URLS to servlet resources. A cache of
the requested size is created for each worker thread that is available to process a request. The default
size of the invocation cache is 50. If more than 50 unique URLs are actively being used (each JavaServer
Page is a unique URL), you should increase the size of the invocation cache.

A larger cache uses more of the Java heap, so you might also need to increase the maximum Java heap
size. For example, if each cache entry requires 2KB, maximum thread size is set to 25, and the URL
invocation cache size is 100; then 5MB of Java heap are required.

The invocation cache is now Web container based instead of thread-based, and shared for all Web
container threads.

To change the size of the invocation cache:

1. In the administrative console, click Servers > Application servers and select the application server
you are tuning.

Click Process Definition under Additional Properties.
Click Java Virtual Machine under Additional Properties.
Click Custom Properties under Additional Properties.

Specify invocationCacheSize in the Name field and the size of the cache in the Value field. The
default size for the invocation cache is 500 entries. Since the invocation cache is no longer
thread-based, the invocation cache size specified by the user is multiplied by ten to provide similar
function from previous releases. For example, if you specify an invocation cache size of 50, the Web
container will create a cache size of 500.

6. Click Apply and then Save to save your changes.
7. Stop and restart the application server.

a s~ DN

The new cache size is used for the URL invocation cache.
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Task overview: Managing HTTP sessions

IBM WebSphere Application Server provides a service for managing HTTP sessions: Session Manager.
The key activities for session management are summarized below.

Before you begin these steps, make sure you are familiar with the programming model for accessing
HTTP session support in the applications following the Servlet 2.4 API.

1. Plan your approach to session management, which could include |session tracking and [session|
recovery

2. Create or modify your own applications to use session support to maintain sessions on behalf of Web
applications.

3. [Assemble your application.|

4. [Deploy your application)|

5. Ensure the administrator appropriately |configures session management| in the administrative domain.

6. Adjust configuration settings and perform otherltuning activitie§| for optimal use of sessions in your
environment.

Sessions

A session is a series of requests to a servlet, originating from the same user at the same browser.
Sessions allow applications running in a Web container to keep track of individual users.

For example, a servlet might use sessions to provide "shopping carts” to online shoppers. Suppose the
servlet is designed to record the items each shopper indicates he or she wants to purchase from the Web
site. It is important that the servlet be able to associate incoming requests with particular shoppers.
Otherwise, the servlet might mistakenly add Shopper_1’s choices to the cart of Shopper_2.

A servlet distinguishes users by their unique session IDs. The session ID arrives with each request. If the
user’s browser is cookie-enabled, the session ID is stored as a cookie. As an alternative, the session ID
can be conveyed to the servlet by URL rewriting, in which the session ID is appended to the URL of the
servlet or JavaServer Pages (JSP) file from which the user is making requests. For requests over HTTPS
or Secure Sockets Layer (SSL), Another alternative is to use SSL information to identify the session.

HTTP session migration

There are no programmatic changes required to migrate from version 5.x to version 6.x. This article
describes features that are available after migration.

Migration from Version 5.x

Note: In Version 5 and later, default write frequency mode is TIME_BASED_WRITES, which is different
from Version 4.0.x default mode of END_OF SERVICE.

When you migrate between releases of WebSphere Application Server Version 5.x and later and you are
using a database for session persistence, you can share the session database table between releases.
For example, if you are accessing applications that are on WebSphere Application Server version 5.x you
can share the session id with applications running on Version 6.x.

Session security support

You can integrate HTTP sessions and security in WebSphere Application Server. When security integration
is enabled in the session management facility and a session is accessed in a protected resource, you can
access that session only in protected resources from then on. You cannot mix secured and unsecured
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resources accessing sessions when security integration is turned on. Security integration in the session
management facility is not supported in form-based login with SWAM.

Note: SWAM is deprecated in WebSphere Application Server Version 6.1 and will be removed in a future

release.

Security integration rules for HTTP sessions

Only authenticated users can access sessions created in secured pages and are created under the
identity of the authenticated user. Only this authenticated user can access these sessions in other secured
pages. To protect these sessions from unauthorized users, you cannot access them from an unsecured

page.

Programmatic details and scenarios

WebSphere Application Server maintains the security of individual sessions.

An identity or user name, readable by the com.ibm.websphere.servlet.session.IBMSession interface, is
associated with a session. An unauthenticated identity is denoted by the user name anonymous.

WebSphere Application Server includes the
com.ibm.websphere.servlet.session.UnauthorizedSessionRequestException class, which is used when a
session is requested without the necessary credentials.

The session management facility uses the WebSphere Application Server security infrastructure to
determine the authenticated identity associated with a client HTTP request that either retrieves or creates
a session. WebSphere Application Server security determines identity using certificates, LPTA, and other

methods.

After obtaining the identity of the current request, the session management facility determines whether to
return the session requested using a getSession call.

The following table lists possible scenarios in which security integration is enabled with outcomes
dependent on whether the HTTP request is authenticated and whether a valid session ID and user name
was passed to the session management facility.

Unauthenticated HTTP request is
used to retrieve a session

HTTP request is authenticated, with
an identity of "FRED" used to
retrieve a session

No session ID was passed in for
this request, or the ID is for a
session that is no longer valid

A new session is created. The user
name is anonymous

A new session is created. The user
name is FRED

A session ID for a valid session is
passed in. The current session
user name is "anonymous”

The session is returned.

The session is returned. session
management changes the user name to
FRED

A session ID for a valid session is
passed in. The current session
user name is FRED

The session is not returned. An
UnauthorizedSessionRequestException
error is created*

The session is returned.

A session ID for a valid session is
passed in. The current session
user name is BOB

The session is not returned. An
UnauthorizedSessionRequestException
error is created*

The session is not returned. An
UnauthorizedSessionRequestException
error is created*

* A com.ibm.websphere.servlet.session.UnauthorizedSessionRequestException error is created to the

servlet.
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Session management support

WebSphere Application Server provides facilities, grouped under the heading Session Management, that
support the javax.servlet.http.HttpSession interface described in the Servlet API specification.

In accordance with the Servlet 2.3 API specification, the session management facility supports session
scoping by Web modules. Only servlets in the same Web module can access the data associated with a
particular session. Multiple requests from the same browser, each specifying a unique Web application,
result in multiple sessions with a shared session ID. You can invalidate any of the sessions that share a
session ID without affecting the other sessions.

You can configure a session timeout for each Web application. A Web application timeout value of 0 (the
default value) means that the invalidation timeout value from the session management facility is used.

When an HTTP client interacts with a servlet, the state information associated with a series of client

requests is represented as an HTTP session and identified by a session ID. Session management is

responsible for managing HTTP sessions, providing storage for session data, allocating session IDs, and

tracking the session ID associated with each client request through the use of cookies or URL rewriting

techniques. Session management can store session-related information in several ways:

* In application server memory (the default). This information cannot be shared with other application
servers.

* In a database. This storage option is known as database persistent sessions.

* In another WebSphere Application Server instance. This storage option is known as
memory-to-memory sessions.

The last two options are referred to as distributed sessions. Distributed sessions are essential for using
HTTP sessions for the failover facility. When an application server receives a request associated with a
session ID that it currently does not have in memory, it can obtain the required session state by accessing
the external store (database or memory-to-memory). If distributed session support is not enabled, an
application server cannot access session information for HTTP requests that are sent to servers other than
the one where the session was originally created. Session management implements caching optimizations
to minimize the overhead of accessing the external store, especially when consecutive requests are routed
to the same application server.

Storing session states in an external store also provides a degree of fault tolerance. If an application
server goes offline, the state of its current sessions is still available in the external store. This availability
enables other application servers to continue processing subsequent client requests associated with that
session.

Saving session states to an external location does not completely guarantee their preservation in case of a
server failure. For example, if a server fails while it is modifying the state of a session, some information is
lost and subsequent processing using that session can be affected. However, this situation represents a
very small period of time when there is a risk of losing session information.

The drawback to saving session states in an external store is that accessing the session state in an
external location can use valuable system resources. session management can improve system
performance by caching the session data at the server level. Multiple consecutive requests that are
directed to the same server can find the required state data in the cache, reducing the number of times
that the actual session state is accessed in external store and consequently reducing the overhead
associated with external location access.

Session tracking options

There are several options for session tracking, depending on what sort of tracking method you want to
use:

+ [Session tracking with cookies

+ [Session tracking with URL rewriting|
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« [Session tracking with Secure Sockets Layer (SSL) information|

Session tracking with cookies
Tracking sessions with cookies is the default. No special programming is required to track sessions with
cookies.

Session tracking with URL rewriting

An application that uses URL rewriting to track sessions must adhere to certain programming guidelines.
The application developer needs to do the following:

* Program servlets to encode URLs

* Supply a servlet or JavaServer Pages (JSP) file as an entry point to the application

Using URL rewriting also requires that you enable URL rewriting in the session management facility.

Note: In certain cases, clients cannot accept cookies. Therefore, you cannot use cookies as a session
tracking mechanism. Applications can use URL rewriting as a substitute.

Program session servlets to encode URLs

Depending on whether the servlet is returning URLSs to the browser or redirecting them, include either the
encodeURL method or the encodeRedirectURL method in the servlet code. Examples demonstrating what
to replace in your current servlet code follow.

Rewrite URLSs to return to the browser

Suppose you currently have this statement:

out.printin("<a href=\"/store/catalog\">catalog<a>");

Change the servlet to call the encodeURL method before sending the URL to the output stream:

out.printin("<a href=\"");
out.printin(response.encodeURL ("/store/catalog"));
out.printin("\">catalog</a>");

Rewrite URLSs to redirect

Suppose you currently have the following statement:
response.sendRedirect ("http://myhost/store/catalog");

Change the servlet to call the encodeRedirectURL method before sending the URL to the output stream:
response.sendRedirect (response.encodeRedirectURL ("http://myhost/store/catalog"));

The encodeURL method and encodeRedirectURL method are part of the HttpServletResponse object.
These calls check to see if URL rewriting is configured before encoding the URL. If it is not configured, the
calls return the original URL.

If both cookies and URL rewriting are enabled and the response.encodeURL method or
encodeRedirectURL method is called, the URL is encoded, even if the browser making the HTTP request
processed the session cookie.

You can also configure session support to enable protocol switch rewriting. When this option is enabled,
the product encodes the URL with the session ID for switching between HTTP and HTTPS protocols.

Supply a serviet or JSP file as an entry point

The entry point to an application, such as the initial screen presented, may not require the use of
sessions. However, if the application in general requires session support (meaning some part of it, such as
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a servlet, requires session support), then after a session is created, all URLs are encoded to perpetuate
the session ID for the servlet (or other application component) requiring the session support.

The following example shows how you can embed Java code within a JSP file:
<%

response.encodeURL ("/store/catalog");

0,
%>

Session tracking with SSL information
No special programming is required to track sessions with Secure Sockets Layer (SSL) information.

To use SSL information, turn on Enable SSL ID tracking in the session management property page.
Because the SSL session ID is negotiated between the Web browser and HTTP server, this ID cannot
survive an HTTP server failure. However, the failure of an application server does not affect the SSL
session ID if an external HTTP server is present between WebSphere Application Server and the browser.

SSL tracking is supported for the IBM HTTP Server and iPlanet Web servers only. You can control the
lifetime of an SSL session ID by configuring options in the Web server. For example, in the IBM HTTP
Server, set the configuration variable SSLV3TIMEOUT to provide an adequate lifetime for the SSL session
ID. An interval that is too short can cause a premature termination of a session. Also, some Web browsers
might have their own timers that affect the lifetime of the SSL session ID. These Web browsers may not
leave the SSL session ID active long enough to serve as a useful mechanism for session tracking. The
internal HTTP Server of WebSphere Application Server also supports SSL tracking.

When using the SSL session ID as the session tracking mechanism in a cloned environment, use either
cookies or URL rewriting to maintain session affinity. The cookie or rewritten URL contains session affinity
information that enables the Web server to properly route a session back to the same server for each
request.

Session recovery support

For session recovery support, WebSphere Application Server provides distributed session support in the
form of database sessions. Use session recovery support under the following conditions:

* When the user’s session data must be maintained across a server restart

* When the user’s session data is too valuable to lose through an unexpected server failure

All the attributes set in a session must implement java.io.Serializable if the session requires external
storage. In general, consider making all objects held by a session serialized, even if inmediate plans do
not call for session recovery support. If the Web site grows, and session recovery support becomes
necessary, the transition occurs transparently to the application if the sessions only hold serialized objects.
If not, a switch to session recovery support requires coding changes to make the session contents
serialized.

Clustered session support

A clustered environment supports load balancing, where the workload is distributed among the application
servers that compose the cluster. In a cluster environment, the same Web application must exist on each

of the servers that can access the session. You can accomplish this setup by installing an application onto
a cluster definition. Each of the servers in the group can then access the Web application

In a clustered environment, the session management facility requires an affinity mechanism so that all
requests for a particular session are directed to the same application server instance in the cluster. This
requirement conforms to the Servlet 2.3 specification in that multiple requests for a session cannot coexist
in multiple application servers. One such solution provided by IBM WebSphere Application Server is
session affinity in a cluster; this solution is available as part of the WebSphere Application Server plug-ins
for Web servers. It also provides for better performance because the sessions are cached in memory. In
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clustered environments other than WebSphere Application Server clusters, you must use an affinity
mechanism (for example, IBM WebSphere Edge Server affinity).

If one of the servers in the cluster fails, it is possible for the request to reroute to another server in the
cluster. If distributed sessions support is enabled, the new server can access session data from the
database or another WebSphere Application Server instance. You can retrieve the session data only if a
new server has access to an external location from which it can retrieve the session.

Session management tuning

WebSphere Application Server session support has features for tuning session performance and operating
characteristics, particularly when sessions are configured in a distributed environment. These options
support the administrator flexibility in determining the performance and failover characteristics for their

environment.

The table summarizes the features, including whether they apply to sessions tracked in memory, in a
database, with memory-to-memory replication, or all. Click a feature for details about the feature. Some
features are easily manipulated using administrative settings; others require code or database changes.

Feature or option

Goal

Applies to sessions in memory,
database, or memory-to-memory

Write frequency

Minimize database write operations.

Database and Memory-to-Memory

Session affinity

Access the session in the same
application server instance.

All

Multirow schema

Fully utilize database capacities.

Database

Base in-memory session pool size

Fully utilize system capacity without
overburdening system.

All

Write contents

Allow flexibility in determining what
session data to write

Database and Memory-to-Memory

Scheduled invalidation

Minimize contention between session
requests and invalidation of sessions
by the Session Management facility.
Minimize write operations to database
for updates to last access time only.

Database and Memory-to-Memory

Tablespace and row size

Increase efficiency of write operations
to database.

Database (DB2 only)

Base in-memory session pool size
The base in-memory session pool size number has different meanings, depending on session support

configuration:

* With in-memory sessions, session access is optimized for up to this number of sessions.

General memory requirements for the hardware system, and the usage characteristics of the e-business

site, determines the optimum value.

Note that increasing the base in-memory session pool size can necessitate increasing the heap sizes of
the Java processes for the corresponding WebSphere Application Servers.

Overflow in non-distributed sessions

By default, the number of sessions maintained in memory is specified by base in-memory session pool
size. If you do not wish to place a limit on the number of sessions maintained in memory and allow

overflow, set overflow to frue.
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Allowing an unlimited amount of sessions can potentially exhaust system memory and even allow for
system sabotage. Someone could write a malicious program that continually hits your site and creates
sessions, but ignores any cookies or encoded URLs and never utilizes the same session from one HTTP
request to the next.

When overflow is disallowed, the Session Management facility still returns a session with the
HttpServletRequest getSession(true) method when the memory limit is reached, and this is an invalid
session that is not saved.

With the WebSphere Application Server extension to HttpSession,
com.ibm.websphere.servlet.session.IBMSession, an isOverflow method returns frue if the session is such
an invalid session. An application can check this status and react accordingly.

Tuning parameter settings
Use this page to set tuning parameters for distributed sessions.

To view this administrative console page, click Servers > Application servers > server_name > Web
container settings > Session management > Distributed environment settings > Custom tuning

parameters.

Tuning level:

Specifies that the session management facility provides certain predefined settings that affect

performance.

Select one of these predefined settings or customize a setting. To customize a setting, select one of the

predefined settings that comes closest to the setting desired, click Custom settings, make your changes,

and then click OK.

Very high (optimize for performance)

Write frequency
Write interval
Write contents

Time based
300 seconds
Only updated attributes

Schedule sessions cleanup true

First time of day default 0

Second time of day default 2

High

Write frequency Time based

Write interval
Write contents
Schedule sessions cleanup

Medium

Write frequency
Write contents
Schedule sessions cleanup

Low (optimize for failover)

Write frequency

300 seconds
All session attributes
false

End of servlet service

Only updated attributes

false

End of servlet service
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Write contents All session attributes
Schedule sessions cleanup false

Custom settings

Write frequency default Time based

Write interval default 10 seconds

Write contents default All session attributes
Schedule sessions cleanup default false

Tuning parameter custom settings
Use this page to customize tuning parameters for distributed sessions.

To view this administrative console page, click Servers > Application servers > server_name Web
container settings > Session management > Distributed environment settings > Custom tuning
parameters > Custom settings.

Write frequency:

Specifies when the session is written to the persistent store.

End of serviet service A session writes to a database or another WebSphere
Application Server instance after the servlet completes
execution.

Manual update A programmatic sync on the IBMSession object is required

to write the session data to the database or another
WebSphere Application Server instance.

Time based Session data writes to the database or another
WebSphere Application Server instance based on the
specified Write interval value. Default: 10 seconds

Write contents:
Specifies whether updated attributes are only written to the external location or all of the session attributes

are written to the external location, regardless of whether or not they changed. The external location can
be either a database or another application server instance.

Only updated attributes Only updated attributes are written to the persistent store.
All session attribute All attributes are written to the persistent store.

Schedule sessions cleanup:

Specifies when to clean the invalid sessions from a database or another application server instance.
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Specify distributed sessions cleanup schedule Enables the scheduled invalidation process for cleaning
up the invalidated HTTP sessions from the external
location. Enable this option to reduce the number of
updates to a database or another application server
instance required to keep the HTTP sessions alive. When
this option is not enabled, the invalidator process runs
every few minutes to remove invalidated HTTP sessions.

When this option is enabled, specify the two hours of a
day for the process to clean up the invalidated sessions in
the external location. Specify the times when there is the
least activity in the application servers. An external
location can be either a database or another application
server instance.

First Time of Day (0 - 23) Indicates the first hour during which the invalidated
sessions are cleared from the external location. Specify
this value as a positive integer between 0 and 23. This
value is valid only when schedule invalidation is enabled.

Second Time of Day (0 - 23) Indicates the second hour during which the invalidated
sessions are cleared from the external location. Specify
this value as a positive integer between 0 and 23. This
value is valid only when schedule invalidation is enabled.

Best practices for using HTTP Sessions

best-practices: Browse the following recommendations for implementing HTTP sessions.
* Enable Security integration for securing HTTP sessions

HTTP sessions are identified by session IDs. A session ID is a pseudo-random number generated at the
runtime. Session hijacking is a known attack HTTP sessions and can be prevented if all the requests
going over the network are enforced to be over a secure connection (meaning, HTTPS). But not every
configuration in a customer environment enforces this constraint because of the performance impact of
SSL connections. Due to this relaxed mode, HTTP session is vulnerable to hijacking and because of
this vulnerability, WebSphere Application Server has the option to tightly integrate HTTP sessions and
WebSphere Application Server security. [Enable security]in WebSphere Application Server so that the
sessions are protected in a manner that only users who created the sessions are allowed to access
them.

* Release HttpSession objects using javax.servlet.http.HttpSession.invalidate() when finished.

HttpSession objects live inside the Web container until:

— The application explicitly and programmatically releases it using the
javax.servlet.http.HttpSession.invalidate method; quite often, programmatic invalidation is part of an
application logout function.

— WebSphere Application Server destroys the allocated HttpSession when it expires (default = 1800
seconds or 30 minutes). The WebSphere Application Server can only maintain a certain number of
HTTP sessions in memory based on session management settings. In case of distributed sessions,
when maximum cache limit is reached in memory, the session management facility removes the
least recently used (LRU) one from cache to make room for a session.

» Avoid trying to save and reuse the HitpSession object outside of each servlet or JSP file.

The HttpSession object is a function of the HttpRequest (you can get it only through the req.getSession
method), and a copy of it is valid only for the life of the service method of the servlet or JSP file. You
cannot cache the HttpSession object and refer to it outside the scope of a servlet or JSP file.

* Implement the java.io.Serializable interface when developing new objects to be stored in the
HTTP session.

Serializability of a class is enabled by the class implementing the java.io.Serializable interface.
Implementing the java.io.Serializable interface allows the object to properly serialize when using
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distributed sessions. Classes that do not implement this interface will not have their states serialized or
deserialized. Therefore, if a class does not implement the Serializable interface, the JVM cannot persist
its state into a database or into another JVM. All subtypes of a serializable class are serializable. An
example of this follows:

public class MyObject implements java.io.Serializable {...}

Make sure all instance variable objects that are not marked transient are serializable. You cannot cache
a non-serializable object.

In compliance with the Java Servlet specification, the distributed servlet container must create an
lllegalArgumentException for objects when the container cannot support the mechanism necessary for
migration of the session storing them. An exception is created only when you have selected
distributable.

* The HTTPSession API does not dictate transactional behavior for sessions.

Distributed HTTPSession support does not guarantee transactional integrity of an attribute in a failover
scenario or when session affinity is broken. Use transactional aware resources like enterprise Java
beans to guarantee the transaction integrity required by your application.

* Ensure the Java objects you add to a session are in the correct class path.

If you add Java objects to a session, place the class files for those objects in the correct class path (the
application class path if utilizing sharing across Web modules in an enterprise application, or the Web
module class path if using the Servlet 2.2-complaint session sharing) or in the directory containing other
servlets used in WebSphere Application Server. In the case of session clustering, this action applies to
every node in the cluster.

Because the HttpSession object is shared among servlets that the user might access, consider adopting
a site-wide naming convention to avoid conflicts.
» Avoid storing large object graphs in the HttpSession object.

In most applications each servlet only requires a fraction of the total session data. However, by storing
the data in the HttpSession object as one large object, an application forces WebSphere Application
Server to process all of it each time.

» Utilize Session Affinity to help achieve higher cache hits in the WebSphere Application Server.

WebSphere Application Server has functionality in the HTTP Server plug-in to help with session affinity.
The plug-in reads the cookie data (or encoded URL) from the browser and helps direct the request to
the appropriate application or clone based on the assigned session key. This functionality increases use
of the in-memory cache and reduces hits to the database or another WebSphere Application Server
instance

* Maximize use of session affinity and avoid breaking affinity.

Using session affinity properly can enhance the performance of the WebSphere Application Server.
Session affinity in the WebSphere Application Server environment is a way to maximize the in-memory
cache of session objects and reduce the amount of reads to the database or another WebSphere
Application Server instance. Session affinity works by caching the session objects in the server instance
of the application with which a user is interacting. If the application is deployed in multiple servers of a
server group, the application can direct the user to any one of the servers. If the users starts on serverl
and then comes in on server2 a little later, the server must write all of the session information to the
external location so that the server instance in which server2 is running can read the database. You can
avoid this database read using session affinity. With session affinity, the user starts on serverl for the
first request; then for every successive request, the user is directed back to serverl. Serverl has to
look only at the cache to get the session information; serverl never has to make a call to the session
database to get the information.

You can improve performance by not breaking session affinity. Some suggestions to help avoid breaking
session affinity are:
— Combine all Web applications into a single application server instance, if possible, and use modeling
or cloning to provide failover support.
— Create the session for the frame page, but do not create sessions for the pages within the frame
when using multi-frame JSP files. (See discussion later in this topic.)
* When using multi-framed pages, follow these guidelines:
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— Create a session in only one frame or before accessing any frame sets. For example, assuming
there is no session already associated with the browser and a user accesses a multi-framed JSP file,
the browser issues concurrent requests for the JSP files. Because the requests are not part of any
session, the JSP files end up creating multiple sessions and all of the cookies are sent back to the
browser. The browser honors only the last cookie that arrives. Therefore, only the client can retrieve
the session associated with the last cookie. Creating a session before accessing multi-framed pages
that utilize JSP files is recommended.

— By default, JSP files get a HTTPSession using request.getSession(true) method. So by default
JSP files create a new session if none exists for the client. Each JSP page in the browser is
requesting a new session, but only one session is used per browser instance. A developer can use
<% @ page session="false” %> to turn off the automatic session creation from the JSP files that do
not access the session. Then if the page needs access to the session information, the developer can
use <%HttpSession session = javax.servlet.http.HttpServletRequest.getSession(false); %> to
get the already existing session that was created by the original session creating JSP file. This
action helps prevent breaking session affinity on the initial loading of the frame pages.

— Update session data using only one frame. When using framesets, requests come into the HTTP
server concurrently. Modifying session data within only one frame so that session changes are not
overwritten by session changes in concurrent frameset is recommended.

— Avoid using multi-framed JSP files where the frames point to different Web applications. This action
results in losing the session created by another Web application because the JSESSIONID cookie
from the first Web application gets overwritten by the JSESSIONID created by the second Web
application.

Secure all of the pages (not just some) when applying security to serviets or JSP files that use

sessions with security integration enabled, .

When it comes to security and sessions, it is all or nothing. It does not make sense to protect access to
session state only part of the time. When security integration is enabled in the session management
facility, all resources from which a session is created or accessed must be either secured or unsecured.
You cannot mix secured and unsecured resources.

The problem with securing only a couple of pages is that sessions created in secured pages are
created under the identity of the authenticated user. Only the same user can access sessions in other
secured pages. To protect these sessions from use by unauthorized users, you cannot access these
sessions from an unsecured page. When a request from an unsecured page occurs, access is denied
and an UnauthorizedSessionRequestException error is created. (UnauthorizedSessionRequestException
is a runtime exception; it is logged for you.)

Use manual update and either the sync() method or time-based write in applications that read
session data, and update infrequently.

With END_OF_SERVICE as write frequency, when an application uses sessions and anytime data is
read from or written to that session, the LastAccess time field updates. If database sessions are used, a
new write to the database is produced. This activity is a performance hit that you can avoid using the
Manual Update option and having the record written back to the database only when data values
update, not on every read or write of the record.

To use manual update, turn it on in the session management service. (See the tables above for location
information.) Additionally, the application code must use the
com.ibm.websphere.servlet.session.IBMSession class instead of the generic HttpSession. Within the
IBMSession object there is a sync method. This method tells the WebSphere Application Server to write
the data in the session object to the database. This activity helps the developer to improve overall
performance by having the session information persist only when necessary.

Note: An alternative to using the manual updates is to utilize the timed updates to persist data at
different time intervals. This action provides similar results as the manual update scheme.
Implement the following suggestions to achieve high performance:
— If your applications do not change the session data frequently, use Manual Update and the sync
function (or timed interval update) to efficiently persist session information.
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— Keep the amount of data stored in the session as small as possible. With the ease of using sessions
to hold data, sometimes too much data is stored in the session objects. Determine a proper balance
of data storage and performance to effectively use sessions.

— If using database sessions, use a dedicated database for the session database. Avoid using the
application database. This helps to avoid contention for JDBC connections and allows for better
database performance.

— If using memory-to-memory sessions, employ partitioning (either group or single replica) as your
clusters grow in size and scaling decreases.

— Verify that you have the latest fix packs for the WebSphere Application Server.

Utilize the following tools to help monitor session performance.

— Run the com.ibm.servlet.personalization.sessiontracking.IBMTrackerDebug servlet. - To run this
servlet, you must have the servlet invoker running in the Web application you want to run this from.
Or, you can explicitly configure this servlet in the application you want to run.

— Use the WebSphere Application Server Resource Analyzer which comes with WebSphere Application
Server to monitor active sessions and statistics for the WebSphere Application Server environment.

— Use database tracking tools such as "Monitoring” in DB2. (See the respective documentation for the
database system used.)

HTTP session manager troubleshooting tips

This article provides troubleshooting tips for problems creating or using HTTP sessions with your Web
application hosted by WebSphere Application Server.

Here are some steps to take:

See HTTP session aren’t getting created or are getting dropped|to see if your specific problem is

discussed.

View the JVM logs for the application server which hosts the problem application:

— first, look at messages written while each application is starting. They will be written between the
following two messages:

Starting application: application

Application started: application

— Within this block, look for any errors or exceptions containing a package name of
com.ibm.ws.webcontainer.httpsession. If none are found, this is an indication that the session
manager started successfully.

— Error "SRVEOQ054E: An error occurred while loading session context and Web application”
indicates that SessionManager didn’t start properly for a given application.

— Look within the logs for any Session Manager related messages. These messages will be in the
format SESNxxxXE and SESNxxxxW for errors and warnings, respectively, where xxxx is a humber
identifying the precise error. Look up the extended error definitions in the Session Manager message
table.

See [Best practices for using HTTP Sessions|

To dynamically view the number of sessions as a Web application is running, enable performance

monitoring for HTTP sessions. This will give you an indication as to whether sessions are actually being

created.

To learn how to view the http session counters as the application runs, see Monitoring performance with

Tivoli Performance Viewer (formerly Resource Analyzer).

Alternatively, a special servlet can be invoked that displays the current configuration and statistics

related to session tracking. This servlet has all the counters that are in performance monitor tool and

has some additional counters.

— Servlet name: com.ibm.ws.webcontainer.httpsession.IBMTrackerDebug.

— It can be invoked from any Web module which is enabled to serve by class name. For example,
using default_app, http://localhost:9080/servliet/
com.ibm.ws.webcontainer.httpsession.IBMTrackerDebug.

— If you are viewing the module via the serve-by-class-name feature, be aware that it may be viewable
by anyone who can view the application. You may wish to map a specific, secured URL to the servlet
instead and disable the serve-servlets-by-classname feature.
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* Enable tracing for the HTTP Session Manager component:
— Use the trace specification com.ibm.ws.webcontainer.httpsession.*=all=enabled. Follow the
instructions for dumping and browsing the trace output to narrow the origin of the problem.
— If you are using persistent sessions based on memory replication, also enable trace for
com.ibm.ws.drs.*.
* If you are using database-based persistent sessions, look for problems related to the data source
the Session Manager relies on to keep session state information. For details on diagnosing database
related problems see Errors accessing a datasource or connection pool

Error message SRVE0O79E Servlet host not found after you define a port

Error message SRVEOO79E can occur after you define the port in WebContainer > HTTP Transports for a
server, indicating that you do not have the port defined in your virtual host definitions. To define the port,

1. On the administrative console, go to Environment > Virtual Hosts > default_host> Host Aliases> New
2. Define the new port on host "*”

The application server gets EC3 - 04130007 ABENDs

To prevent an EC3 - 04130007 abend from occuring on the application server, change the HTTP Output
timeout value. The custom property ConnectionResponse Timeout specifies the maximum number of
seconds the HTTP port for an individual server can wait when trying to read or write data. For instructions
on how to set ConnectionResponseTimeout, see HTTP transport custom properties.

If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the available online support (hints and tips, technotes, and fixes). If you don’t find your
problem listed there contact IBM support.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Supporf page.

Problems creating or using HTTP sessions

This article provides troubleshooting information related to creating or using Hypertext Transfer Protocol
(HTTP) sessions.

To view and update the session manager settings discussed here, use the administrative console. Select
the application server that hosts the problem application, then under Additional properties, select Web
Container, then Session manager.

What kind of problem are you having?

« [HTTP Sessions are not getting created, or are lost between requests.|

» |HTTP Sessions are not persistent (session data lost when application server restarts, or not shared|
across cluster).|

« [Session is shared across multiple browsers on same client machine

* [Session is not getting invalidated immediately after specified session timeout interval.l

» [Unwanted sessions are being created by JavaServer Pages.|

+ [Session data intended for one client is seen by another client.|

» |A ClassCastException error occurs during failover of a session that contains an Enterprise JavaBeans|
(EJB) reference.|

If your problem is not described here, or none of these steps fixes the problem:
+ Review ['HTTP session manager troubleshooting tips” on page 104 for general steps on debugging
session-manager related problems.
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Review [‘Task overview: Managing HTTP sessions” on page 93| for information on how to configure the
session manager, and best practices for using it.

Check to see if the problem has been identified and documented by looking at the available online
support (hints and tips, technotes, and fixes).

If you don't find your problem listed there contact IBM support.

HTTP sessions are not getting created, or are lost between requests

By default, the session manager uses cookies to store the session ID on the client between requests.
Unless you intend to avoid cookie-based session tracking, ensure that cookies are flowing between
WebSphere Application Server and the browser:

Make sure the Enable cookies check box is checked under the Session tracking Mechanism

property.

Make sure cookies are enabled on the browser you are testing from or from which your users are

accessing the application.

Check the Cookie domain specified on the SessionManager (to view the or update the cookie settings,

in the Session tracking mechanism->enable cookies property, click Modify).

— For example, if the cookie domain is set as ".myCom.com”, resources should be accessed using that
domain name. Example: http://www.myCom.com/myapp/serviet/sessionservlet.

— If the domain property is set, make sure it begins with a dot (.). Certain versions of Netscape do not
accept cookies if domain name doesn'’t start with a dot. Internet Explorer honors the domain with or
without a dot. For example, if the domain name is set to mycom.com, change it to .mycom.com so
that both Netscape and Internet Explorer honor the cookie.

Note: When the servers are on different hosts, ensure that session cookies flow to all the servers by
configuring a front-end router such as a Web server with the plug-in or setting the Cookie
domain.

Check the Cookie path specified on the SessionManager. Check whether the problem URL is

hierarchically below the Cookie path specified. If not correct the Cookie path.

If the Cookie maximum age property is set, ensure that the client (browser) machine’s date and time is

the same as the server’s, including the time zone. If the client and the server time difference is over the

"Cookie maximum age” then every access would be a new session, since the cookie will "expire” after

the access.

If you have multiple Web modules within an enterprise application that track sessions:

— If you want to have different session settings among Web modules in an enterprise application,
ensure that each Web module specifies a different cookie name or path, or

— If Web modules within an enterprise application use a common cookie name and path, ensure that
the HTTP session settings, such as Cookie maximum age, are the same for all Web modules.

Otherwise cookie behavior will be unpredictable, and will depend upon which application creates the

session. Note that this does not affect session data, which is maintained separately by Web module.

Check the cookie flow between browser and server:

1. On the browser, enable "cookie prompt”. Hit the servlet and make sure cookie is being prompted.
2. On the server, enable SessionManager trace. Enable tracing for the HTTP session manager
component, by using the trace specification "com.ibm.ws.webcontainer.httpsession.*=all=enabled”.
After trace is enabled, exercise your session-using servlet or jsp, then follow the instructions for
dumping and browsing the trace output .

Access the session servlet from the browser.

The browser will prompt for the cookie; note the jsessionid.

Reload the servlet, note down the cookie if a new cookie is sent.

Check the session trace and look for the session id and trace the request by the thread. Verify that
the session is stable across Web requests:

— Look for getliHttpsession(...) which is start of session request.

— Look for releaseSesson(..) which is end of servlet request.

If you are using URL rewriting instead of cookies:

— Ensure there are no static HTML pages on your application’s navigation path.

o0k w
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— Ensure that your servlets and JSP files are implementing URL rewriting correctly. For details and an
example see ['Session tracking options” on page 95.|
» If you are using SSL as your session tracking mechanism:
— Ensure that you have SSL enabled on your IBM HTTP Server or iPlanet HTTP server.
— Review ['Session tracking options” on page 95.|
» If you are in a clustered (multiple node) environment, ensure that you have |session persistencel
enabled.

HTTP Sessions are not persistent

If your HTTP sessions are not persistent, that is session data is lost when the application server restarts or
is not shared across the cluster:
* Check the data source.
* Check the session manager’s persistence settings properties:
— If you intend to take advantage of session persistence, verify that Persistence is set to Database.
— Persistence could also be set to Memory-to-Memory Replication.
— If you are using Database-based persistence:
- Check the JNDI name of the data source specified correctly on SessionManager.
- Specify correct userid and password for accessing the database.

Note that these settings have to be checked against the properties of an existing data source in
the administrative console. The session manager does not automatically create a session
database for you.

- The data source should be non-JTA, for example, non XA enabled.

- Check the JVM logs for appropriate database error messages.

- With DB2, for row sizes other than 4k make sure specified row size matches the DB2 page size.
Make sure tablespace name is specified correctly.

Session is shared across multiple browsers on same client machine

This behavior is browser-dependent. It varies between browser vendors, and also may change according
to whether a browser is launched as a new process or as a subprocess of an existing browser session (for
example by hitting Ctl-N on Windows).

The Cookie maximum age property of the session manager also affects this behavior, if cookies are used
as the session-tracking mechanism. If the maximum age is set to some positive value, all browser
instances share the cookies, which are persisted to file on the client for the specified maximum age time.

Session is not getting invalidated immediately after specified session timeout
interval

The SessionManager invalidation process thread runs every x seconds to invalidate any invalid sessions,
where x is determined based on the session timeout interval specified in the session manager properties.
For the default value of 30 minutes , x is around 300 seconds. In this case, it could take up to 5 minutes
(300 seconds) beyond the timeout threshold of 30 minutes for a particular session to become invalidated.

Unwanted sessions are being created by JavaServer Pages

As required by the JavaServer Pages (JSP) specification, JSP pages by default perform a
request.getSession(true), so that a session is created if none exists for the client. To prevent JSP pages
from creating a new session, set the session scope to false in the .jsp file using the page directive as
follows:

<% 0@page session="false" %>

Chapter 4. Web applicatons 107



Session data intended for one client is seen by another client

In rare situations, usually due to application errors, session data intended for one client might be seen by
another client. This situation is referred to as session data crossover. When the DebugSessionCrossover
custom property is set to true, code is enabled to detect and log instances of session data crossover.
Checks are performed to verify that only the session associated with the request is accessed or
referenced. Messages are logged if any discrepancies are detected. These messages provide a starting
point for debugging this problem. This additional checking is only performed when running on the
WebSphere-managed dispatch thread, not on any user-created threads.

For additional information on how to set this property, see article, Web container custom properties.

A ClassCastException error occurs during failover of a session that contains an
Enterprise JavaBeans (EJB) reference

If you run WebSphere® Application Server for z/ZOS® Version 6.0.1 and configure a session manager to
replicate EJB references, a session failover might trigger display of the following exception in the server
region job log:

java.lang.ClassCastException: cannot cast class
org.omg.stub.java.rmi. Remote_Stub to interface javax.ejb.EJBObject

The log also displays a null pointer exception. The problem results from the session outbound request,
where WebSphere Application Server for z/OS issued a CORBA::COMM_FAILURE exception with a
C9C21355 minor code. This behavior occurs because your application server contains all of the following
configurations:

1. SAF is both the local operating system, as well as the user registry
2. Attribute propagation is enabled
3. An unauthenticated user initiated the session outbound request

To correct this problem apply the APAR PK06777 fix to WebSphere Application Server for z/OS V6.0.1.
You can retain the previously mentioned server configurations.

IBM Support has documents and tools that can save you time gathering information needed to resolve
problems as described in Troubleshooting help from IBM. Before opening a problem report, see the
Support page:

« [http://www.ibm.com/software/webservers/appserviwas/support/|

HTTP sessions: Resources for learning

Use the following links to find relevant supplemental information about HTTP sessions. The information
resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of the
information.

These links are provided for convenience. Often, the information is not specific to the WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

View links to additional information about:
Programming model and decisions

* [Improving session persistence performance with DBZ|
« [Persistent client state HTTP cookies specification|

Programming instructions and examples
« [Java Servlet documentation, tutorials, and examples site|
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Programmlng specifications
Java Servlet 2.4 API specification download site]
« [J2EE 1.4 specification download site]

Developing session management in servlets

This information, combined with the coding example SessionSample.java, provides a programming model
for implementing sessions in your own servlets.

1. Get the HttpSession object.

To obtain a session, use the getSession() method of the javax.servlet.http.HttpServletRequest object in
the Java Servlet 2.3 API.

When you first obtain the HttpSession object, the Session Management facility uses one of three ways
to establish tracking of the session: cookies, URL rewriting, or Secure Sockets Layer (SSL)
information.

Assume the Session Management facility uses cookies. In such a case, the Session Management
facility creates a unique session ID and typically sends it back to the browser as a cookie. Each
subsequent request from this user (at the same browser) passes the cookie containing the session ID,
and the Session Management facility uses this ID to find the user’s existing HttpSession object.

In Step 1 of the code sample, the Boolean(create) is set to true so that the HttpSession object is
created if it does not already exist. (With the Servlet 2.3 API, the
javax.servlet.http.HttpServletRequest.getSession() method with no boolean defaults to true and
creates a session if one does not already exist for this user.)

2. Store and retrieve user-defined data in the session.

After a session is established, you can add and retrieve user-defined data to the session. The
HttpSession object has methods similar to those in java.util.Dictionary for adding, retrieving, and
removing arbitrary Java objects.

In Step 2 of the code sample, the servlet reads an integer object from the HttpSession, increments it,
and writes it back. You can use any name to identify values in the HttpSession object. The code
sample uses the name sessiontest.counter.

Because the HttpSession object is shared among servlets that the user might access, consider
adopting a site-wide naming convention to avoid conflicts.

3. (Optional) Output an HTML response page containing data from the HttpSession object.

4. Provide feedback to the user that an action has taken place during the session. You may want to pass
HTML code to the client browser indicating that an action has occurred. For example, in step 3 of the
code sample, the servlet generates a Web page that is returned to the user and displays the value of
the sessiontest.counter each time the user visits that Web page during the session.

5. (Optional) Notify Listeners. Objects stored in a session that implement the
javax.servlet.http.HttpSessionBindingListener interface are notified when the session is preparing to
end and become invalidated. This notice enables you to perform post-session processing, including
permanently saving the data changes made during the session to a database.

6. End the session. You can end a session:
* Automatically with the Session Management facility if a session is inactive for a specified time. The
administrators provide a way to specify the amount of time after which to invalidate a session.
» By coding the servlet to call the invalidate() method on the session object.

Example: SessionSample.java

import java.io.*;

import java.util.=*;

import javax.servlet.*;
import javax.servlet.http.=*;

public class SessionSample extends HttpServlet {
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public void doGet (HttpServletRequest request, HttpServletResponse response)
throws ServletException, IOException {

// Step 1: Get the Session object

boolean create = true;
HttpSession session = request.getSession(create);

// Step 2: Get the session data value

Integer ival = (Integer)

session.getAttribute ("sessiontest.counter");

if (ival == null) ival = new Integer (1);

else ival = new Integer (ival.intValue () + 1);
session.setAttribute ("sessiontest.counter", ival);

// Step 3: Output the page

response.setContentType("text/html");

PrintWriter out = response.getWriter();

out.printin("<htmi>");

out.printin("<head><title>Session Tracking Test</title></head>");
out.printin("<body>");

out.printin("<h1>Session Tracking Test</h1>");

out.printin ("You have hit this page " + ival + " times" + "<br>");
out.printin ("Your " + request.getHeader("Cookie"));
out.printin("</body></htm1>");

Assembling so that session data can be shared

In accordance with the Servlet 2.3 API specification, by default the Session Management facility supports
session scoping by Web module. Only servlets in the same Web module can access the data associated
with a particular session. WebSphere Application Server provides an option that you can use to extend the
scope of the session attributes to an enterprise application. Therefore, you can share session attributes
across all the Web modules in an enterprise application. This option is provided as an IBM extension.

Restriction: To use this option, you must install all the Web modules in the enterprise application on a
given server. You cannot split up Web modules in the enterprise application by servers. For example, with
an enterprise application containing two Web modules, you cannot use this option when one Web module
is installed on one server and second Web module is installed on a different server. In such split
installations, applications might share session attributes across Web modules using distributed sessions,
but session data integrity is lost when concurrent access to a session is made in different Web modules. It
also severely restricts use of some Session Management features, like TIME_BASED_WRITES. For
enterprise applications on which this option is enabled, the Session Management configuration on the Web
module inside the enterprise application is ignored. Then Session Management configuration defined on
enterprise application is used if Session Management is overwritten at the enterprise application level.
Otherwise, the Session Management configuration on the Web container is used.

Servlet APl Behavior
Note: If shared HttpSession context is turned on in an enterprise application, HttpSession listeners
defined in all the Web modules inside the enterprise application are invoked for session events. The

order of listener invocation is not guaranteed.

Do the following to share session data across Web modules in an enterprise application:
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Start an assembly tool. See "Starting WebSphere Application Server Toolkit” in the Application Server
Toolkit documentation for more information.

In the assembly tool, right-click the application (EAR file) you want to share and click Open With >
Deployment Descriptor Editor.

In the application deployment descriptor editor of the assembly tool, select Shared session context
under WebSphere Extensions. Make sure the class definition of attributes put into session are
available to all Web modules in the enterprise application. The shared session context does not fully
meet the requirements of the Specifications.

Save the application (EAR) file. In the assembly tool, after you close the application deployment
descriptor editor, confirm that you want to save changes made to the application.
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Chapter 5. Portlet applications

Task overview: Managing portlets

You can use this task to manage deployed portlet applications.

Before you begin this task, you must have a portlet application installed. See [‘Installing application files’]
on page 1362|for additional information.

You can complete the following steps to manage portlets.

* Render a portlet.
— Access a single portlet using [‘Portlet Uniform Resource Locator (URL) addressability” on page 120
— Access multiple portlets using [‘Portlet aggregation using JavaServer Pages” on page 114.|

» Change the location 0f|“P0rtIet preferences” on page 121.| By default, portlet preferences for each
portlet window are stored in a cookie. However, you can change the location of where to store portlet
preferences.

. |Disab|e URL addressability| By default, you can access a portlet through an Uniform Resource Locator
(URL), however, you can disable this feature.

» Enable portlet fragment caching. Portlet fragment caching is disabled by default.

Portlets

Portlets are reusable Web modules that provide access to Web-based content, applications, and other
resources. Portlets can run on WebSphere Application Server because it has an embedded JSR168
Portlet Container. You can assemble portlets into a larger portal page, with multiple instances of the same
portlet displaying different data for each user.

From a user’s perspective, a portlet is a window on a portal site that provides a specific service or
information, for example, a calendar or news feed. From an application development perspective, portlets
are pluggable Web modules that are designed to run inside a portlet container of any portal framework.
You can either create your own portlets or select portlets from a catalog of third-party portlets.

Each portlet on the page is responsible for providing its output in the form of markup fragments to be
integrated into the portal page. The portal is responsible for providing the markup surrounding each portlet.
In HTML, for example, the portal can provide markup that gives each portlet a title bar with minimize,
maximize, help, and edit icons.

You can also include portlets as fragments into servlets or JavaServer Pages files. This provides better
communication between portlets and the J2EE Web technologies provided by the application server.

If you use Rational Application Developer version 6 (RAD) to create your portlets, you must remove the
following reference to the std-portlet.tld from the web.xml file to run the portlets outside of RAD:

<taglib id="PortletTLD">
<taglib-uri>http://java.sun.com/portiet</taglib-uri>
<taglib-Tocation>/WEB-INF/t1d/std-portlet.t1d</taglib-location>
</taglib>

Also if you use RAD version 6 to create portlets, note that portlets created by using the Struts Portlet
Framework are not supported on WebSphere Application Server.

Portlet applications

If the portlet application is a valid Web application written to the Java Portlet API, the portlet application
can operate on both the Portal Server and the WebSphere Application Server without requiring any
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changes. A JSR 168 compliant portlet application must not use extended services provided by WebSphere
Portal to operate on the WebSphere Application Server.

Portlet container

The portlet container is the runtime environment for portlets using the JSR 168 Portlet Specification, in
which portlets are instantiated, used, and finally destroyed. The JSR 168 Portlet API provides standard
interfaces for portlets. Portlets based on this JSR 168 Portlet Specification are referred to as standard
portlets.

A simple portal framework is provided by the PortletServingServlet servlet. The PortletServingServlet
servlet registers itself for each Web application that contains portlets. You can use the
PortletServingServlet servlet to directly render a portlet into a full browser page by a URL request and
invoke each portlet by its context root and name. See |“Port|et Uniform Resource Locator (URL)|
|addressabi|ity” on page 120| for additional information. If you want to aggregate multiple portlets on the
page, you need to use the aggregation tag library. See the article |“Portlet aggregation using JavaServeri
for additional information. The PortletServingServlet servlet can be disabled in an extended portlet
deployment descriptor called the [ibm-portlet-ext.xmi file.

Remote request dispatcher support for portlets

The remote request dispatcher (RRD) support allows the invocation of portlets outside of the current Java
virtual machine (JVM) within an Network Deployment single core group environment. The request related
data is passed to the remote JVM where the portlet is invoked. The response is transmitted back and
processed on the local JVM. Thus it guarantees that URLs contained in the portlet markup are created
according to the local portal context.

Portlet container settings
Use this page to configure and manage the portlet container of this application server.

To view this administrative console page, click Servers > Application servers > server_name > Portlet
Container Settings > Portlet container.

Enable portlet fragment cache
Specifies whether to create a cached entry when a portlet is invoked, similar to servlet caching of the Web
container settings.

Portlet fragment caching requires that servlet caching is enabled. Therefore, enabling portlet fragment
caching automatically enables servlet caching. Disabling servlet caching automatically disables portlet
fragment caching.

Portlet aggregation using JavaServer Pages

The aggregation tag library generates a portlet aggregation framework to address one or more portlets on
one page If you write JavaServer Pages, you can aggregate multiple portlets on one page using the
aggregation tag library. This tag library does not provide full featured portal aggregation implementation,
but provides a good migration scenario if you already have aggregating servlets and JavaServer Pages
and want to switch to portlets.

To allow the customer to create a simple portal aggregation, the aggregation tag library also provides the
following features.

* Invoke a portlet’s action method

* Render multiple portlets on one page

* Provide links to change the portlet's mode or window state
» Display the portlet’s title
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* Retain the portlet cookie state

The aggregation tag library and JavaServer Pages that use the aggregation tag library will only work with
the WebSphere Application Server portlet container implementation because the protocol between the tags
and the container is not standardized.

The following diagram depicts how an HTML page would look like and what tags are used in order to
create the page. See |“Aggregation tag library attributes"| for information on the aggregation tag library
attributes.

<portlet:init portletURLPrefix="
http://localhost/hello/framework/"
portletURLSuffix="/something"

HTML Page — | portletURLQueryParams="p1=v1&p2=v2">

<table>

table <portlet:insert url="demo/weather"
/ contentVar="weather.content"

/’ titleVar="weather.title"/>
B=

—I—=@<portlet:state url="demo/weather" portletMode="view"
var="weather.view"/>
el v —@ <portlet:state url="demo/weather" portletMode="edit"
var="weather.edit"/>

/ |
o o-\¥
portlet portlet §\0<po sinsert ur_I="demo/_time"l contentVar="time.content"
\ titleVar="time.title"/>
content content \<por‘[let:state url="demo/time" mode="view"

column [of

title |v |

var="time.view"/>
<portlet:state url="demo/time" mode="edit"
var="time.edit"/>

<tr><td>{$weather.title}</td>
<td><a href="{$weather.view}">view</a></td>
<td><a href="{$weather.edit}">edit</a></td>
<td>{$time.title}</td>
<td><a href="{$time.view}">view</a></td>
<td><a href="{$time.edit}">edit</a></td>
</tr>

<tr><td colspan="3">
{$weather.content}
</td><td colspan="3">
{$time.content}
</td></tr>

</table>

</portlet:init>

When you use the aggregation tag library, you must set the portletUrlPrefix attribute of the init tag to the
aggregating application. You need to:
» Ensure that the portletUrlPrefix attribute is set to the following in the aggregator page.

"http://" + <server_address> + ":" + <server_port> + "/" + <aggregator context> + "/" <aggregator mapping>

+ Reference the aggregation JSP page within the web.xml file through a servlet mapping ending with /=*.
For example, /aggregation/*

When aggregating multiple portlets on a single page, special care must be used with the naming
conventions of form attribute names in your portlets. Because your portlets are all on the same page, they
all share the same HttpServletRequest. When one portlet is viewed the entire page is refreshed and form
data is re-posted. Therefore, if there are multiple portlets that are aggregated on a single page with the
same form attribute names, there could be logic corruption when form data is re-posted.

Aggregation tag library attributes
The aggregation tag library is used to aggregate multiple portlets on one page. This topic describes the
attributes within the aggregation tag library.
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Supported arguments include:

init

This tag initializes the portlet framework and has to be used in the beginning of the JSP. All other tags
described in this section are only valid in the body of this tag, therefore the init tag usually encloses
the whole body of a JSP. In case the current URL contains an action flag the action method of the
corresponding portlet is called. The state and insert tags are sub-tags of the init tag.

The init tag has the following attributes:

state

portletURLPrefix="<any string>"

This URL defines the prefix used for PortletURLs. Portlet URLs are created either by the state tag
or within a portlet's render method, which is called by using the insert tag. This is a required
attribute.

portletURLSuffix="<any string>"

This URL defines the suffix used for PortletURLSs. Portlet URLs are created either by the state tag or
within a portlet’'s render method, which is called by using the insert tag. This is attribute optional.

portletURLQueryParams="<any string>"

This URL defines the query parameters used for PortletURLs. Portlet URLs are created either by
the state tag or within a portlet’s render method, which is called by using the insert tag. This is
attribute optional.

The state tag creates a URL pointing to the given portlet using the given state. You can place this URL
either into a variable specified by the var attribute or you can write it directly to the output stream. This
tag is useful to create URLs for HTML buttons, images, and other items such that when the URL is
invoked, the state changes defined in the URL are applied to the given portlet.

The state tag has the following attributes:

url="<context>/<portlet-name>"

Identifies the portlet for this tag by using the context and portlet-name to address the portlet. This
attribute is required.

windowld="<any string>"
Defines the window ID for the portlet URL created by this tag. This is attribute optional.
var="<any string>"

If defined the URL is written into a variable with the given scope and name, not to the output
stream. This is attribute optional.

scope="page|request|session|application”
This attribute is only valid if the var attribute is specified. If defined, the URL is not written to the

output stream but a variable is created in the given scope with the given name. The default is page.
This is attribute optional.

portletMode="view|help|edit|<custom>"

This attribute sets the portlet mode.

portletWindowState="maximized|minimized|normal|<custom>"

This attribute sets the window state.

action="true/false”

This attribute defines whether this is an action URL. This is attribute optional. The default is false.

urlParam
Adds a render parameter to the newly created URL.

The urlParam tag has the following attributes:
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name="<any string>"
Indicates the name of the parameter. This is attribute required.
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* value="<any string>"
Indicates the value of the parameter. This is attribute required.

insert
This tag calls the render method of the portlet and retrieves the content as well as the title. You can
optionally place the content and title of the specified portlet into variables using the contentVar and
titteVar attributes.

The insert tag has the following attributes:

» url="<context>/<portlet-name>" (mandatory) Identifies the portlet for this tag by using the context
and portlet-name to address the portlet

This is attribute required.
* windowld="<any string>"

Defines the window ID of the portlet. This is attribute optional.
» contentVar="<any string>"

If defined, the portlet’s content is not written to the output stream but written into a variable with the
given scope and name. This is attribute optional.

* contentScope="page|request|session|application”

This attribute is only valid if the contentVar tag is used. If defined, the portlet’s content is written into
a variable with the given scope and name, not to the output stream. The default is page. This is
attribute optional.

* titleVar="<any string>"
If defined the portlet’s title is written into a variable with the given scope and name. If it is not
defined, the title is ignored and not written to the output stream. This is attribute optional.

* titleScope="page|request|session|application”
This attribute is only valid if titleVar tag is used. If defined, the portlet’s title is written into a variable

with the given scope and name, not to the output stream. The default is page. This is attribute
optional.

Example: Using the portlet aggregation tag library

You can use the aggregation tag library to aggregate multiple portlets to have multiple and different
content on one page. The library can be used by every JavaServer Pages (JSP) file that has been
included by a servlet.

To use the portlet aggregation tag library, you must declare the tag-lib at the top of the JSP file using, <%@
taglib uri="http://ibm.com/portiet/aggregation” prefix="portlet” %>, as in the following example.
The following JSP file example shows how to aggregate portlets on one page.

<%0 taglib uri="http://ibm.com/portlet/aggregation" prefix="portlet" %>
<%@ page isELIgnored="false" import="java.util.Enumeration"%>

<portlet:init portletURLPrefix="/dummy/portletTagTest/" portletURLSuffix="/more" portletURLQueryParams="pl=v1&p2=v2">

<portlet:insert url="worldclock/StdWorldClock" contentVar="worldclockcontent" titleVar="worldclocktitle"/>
<portlet:state url="worldclock/StdWorldClock" portletMode="view" var="worldclockview"
portletWindowState="maximized">
<portlet:urlParam name="namea" value="valuea"/>
<portlet:urlParam name="nameb" value="valueb"/>
</portlet:state>
<portlet:state url="worldclock/StdWorldClock" portletMode="edit" var="worldclockedit" portletWindowState="normal">
<portlet:urlParam name="namel" value="valuel"/>
<portlet:urlParam name="name2" value="value2"/>
</portlet:state>
<portlet:state url="worldclock/StdWorldClock" portletMode="view" var="worldclockmin"
portletWindowState="minimized">
<portlet:urlParam name="namemin" value="valuemin"/>
<portlet:urlParam name="namemin" value="valuemin"/>
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</portlet:state>

<portlet:insert url="worldclock/StdWorldClock" windowId="min" contentVar="simplecontent" titleVar="simpletitle"/>
<portlet:state url="worldclock/StdWorldClock" windowId="min" portletMode="view" var="simpleview"
portletWindowState="maximized">
<portlet:urlParam name="name3" value="value3"/>
<portlet:urlParam name="name4" value="value4"/>
<portlet:urlParam name="name5" value="value5"/>
<portlet:urlParam name="name5" value="valueba"/>
<portlet:urlParam name="name5" value="value5bh"/>
<portlet:urlParam name="name5" value="valuebc"/>
</portlet:state>
<portlet:state url="worldclock/StdWorldClock" windowId="min" portletMode="edit" var="simpleedit"
action="true" portletWindowState="normal">
<portlet:urlParam name="name6" value="value6"/>
<portlet:urlParam name="name6" value="value6z"/>
</portlet:state>
<portlet:state url="worldclock/StdWorldClock" windowId="min" portletMode="view" var="simplemin"
portletWindowState="minimized">
<portlet:urlParam name="namel" value="valuel"/>
<portlet:urlParam name="name2" value="value2"/>
</portlet:state>

<portlet:insert url="test/TestPortletl" contentVar="testcontent" titleVar="testtitle"/>
<portlet:state url="test/TestPortletl" portletMode="view" var="testview" portletWindowState="maximized"/>
<portlet:state url="test/TestPortletl" portletMode="edit" var="testedit" portletWindowState="maximized"/>

<l-- This table is the outtermost table for creating two-column portal layout -->
<TABLE border="0" CELLPADDING="3" CELLSPACING="8" WIDTH="100%">
<TR>

<TD VALIGN="top">
<l-- This table is the top portlet in the first column -->

<table border="0" width="100%" CELLPADDING="3" CELLSPACING="0" CLASS="portletTable" SUMMARY="portlet top left">
<tr><td class="portletTitle" NOWRAP>worldclock title:${worldclocktitle}</td>
<td CLASS="portletTitleControls" NOWRAP>
<a href="${worldclockview}">view</a>
<a href="${worldclockedit}">edit</a>
<a href="${worldclockmin}">minimize</a>
</td>
</tr>
<tr>
<td CLASS="portletBody" COLSPAN="2">
${worldclockcontent}
</td>
</tr>
</table>

<BR/>
<l-- This table is the bottom portlet in the first column -->

<table border="0" width="100%" CELLPADDING="3" CELLSPACING="0" CLASS="portletTable" SUMMARY="portlet bottom left">
<tr>
<td class="portletTitle" NOWRAP>test title:${testtitle}</td>
<td CLASS="portletTitleControls" NOWRAP>
<a href="${testview}">view</a>
<a href="§{testedit}">edit</a>
</td>
</tr>
<tr>
<td CLASS="portletBody" COLSPAN="2">
${testcontent}
</td>
</tr>
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</table>

</TD>

<TD VALIGN="top">

<l-- This table is the top portlet in the second column -->

<table border="0" width="100%" CELLPADDING="3" CELLSPACING="0" CLASS="portletTable" SUMMARY="portlet top right">
<tr>
<td class="portletTitle" NOWRAP>simple title:${simpletitle}</td>
<td CLASS="portletTitleControls" NOWRAP>
<a href="§{simpleview}">view</a>
<a href="§{simpleedit}">edit</a>
<a href="§{simplemin}">minimize</a>
</td>
</tr>
<tr>
<td CLASS="portletBody" COLSPAN="2">
${simplecontent}
</td>
</tr>
</table>

</TD>
</TR>
</table>

</portlet:init>

You can include the following formatting to the previous example JSP file immediately after declaring the
tag library.

<STYLE TYPE="TEXT/CSS">
BODY {
font-family:Verdana,sans-serif; font-size:70%

1

.portletTitle {
text-align: left;border-top: #000000 1px solid; border-bottom: #000000 1lpx solid; FONT-SIZE: 60.0%;
COLOR: #ffffff; FONT-FAMILY: Verdana, Arial, Helvetica, sans-serif; BACKGROUND-COLOR: #5495d5;

1

.portletTitleControls {
text-align: right;border-top: #000000 lpx solid; border-right: #000000 lpx solid; border-bottom: #000000
1px solid; FONT-SIZE: 60.0%; COLOR: #ffffff; FONT-FAMILY: Verdana, Arial, Helvetica, sans-serif;
BACKGROUND-COLOR: #5495d5;

1

.portletTitleControls A {
COLOR: #ffffff; text-decoration:none; border:#5495d5 1lpx solid;border-Teft:white lpx solid;
padding-left:0.5em; padding-right:0.5em;

.portletTitleControls A:hover {
COLOR: #ffffff; text-decoration:none; border-top:white lpx solid;
border-bottom:white 1lpx solid;border-right:white 1px solid;

1

.minimizeControl {
font-weight:bold; font-size:100%;

.portletTable {
border-Teft: gray lpx solid;
border-bottom: gray 1lpx solid;
border-right: gray lpx solid;
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.portletBody {
font-family:Verdana,sans-serif; font-size:70%
1

</STYLE>

Portlet Uniform Resource Locator (URL) addressability

You can request a portlet directly through a Uniform Resource Locator (URL) to display its content without
portal aggregation. The PortletServingServlet servlet registers each Web application that contains portlets.
It is similar to the FileServingServlet servlet of the Web container that serves resources. The
PortletServingServlet servlet allows you to directly render a portlet into a full browser page by a URL
request.

You can invoke each portlet by its context root and name with the URL mapping /<portlet-name> that is
created for each portlet. The context root and name has the following format:

http://<host>:<port>/<context-root>/<portlet-name>
For example, http://Tocalhost:9080/portiets/TestPortletl

The context root identifies the Web archive (WAR) file that contains the portlet. The portlet name uniquely
identifies the portlet with a portlet application of a WAR file. The DefaultDocumentFilter servlet only
supports HTML, UTF8 encoding and an extended URL form based on the basic URL form as shown
above.

You can only display one portlet at a time using the PortletServingServlet servlet. If you want to aggregate
multiple portlets on the page, you need to use the aggregation tag library. See the article|‘Portlet]
laggregation using JavaServer Pages” on page 114|for additional information.

Because a portlet only delivers fragment output whereas a servlet usually delivers document output, a
mechanism is introduced to convert the fragment into a document, called the PortletDocumentFilter filter.
By default, the PortletDocumentFilter filter only supports converting HTML. The conversion is implemented
using a servlet filter before the PortletServingServlet servlet is initiated to return the portlet's content inside
of a document. This default document servlet filter only applies to URL requests, not for includes or
forwards using the RequestDispatcher method. You can create servlet filters to support other markups
additional document servlet filters. See the article, ['Converting portlet fragments to an HTML document” on|

for additional information.

The PortletServingServlet servlet does not persist portlet preferences in a XML file or database. It places
the portlet preferences directly into a cookie to store the preferences persistently. See the article, [‘Portlet
[oreferences” on page 121 | for additional information on how to change this behavior.

Portlet URL syntax

You can add additional portal context such as portlet mode or window state. You can access the
PortletServingServlet servlet by using a URL mapping that has the following structure:

http://host:port/context/portlet-name [/portletwindow[/ver [/action] [/mode] [/state] [rparam][/?name]]]

Any differing URL structure results in a com.ibm.wsspi.portletcontainer.InvalidURLEXxception exception.
Empty strings are not permitted as parameter values and creates an InvalidURLException exception. The
following is a list of valid parameters:

http:// host:port/context/portlet-name
This is the minimum URL required to access a portlet. A default portlet window called ‘default’ is
created. The portlet-name variable is case-sensitive.

Iportletwindow
This parameter identifies the portlet window. You must set this parameter if you choose to add
more portal context information to the URL.
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Iver=major.minor
This optional parameter is used to define the version of the portlet API that is used. You must set
this parameter if you choose to add more portal context information to the URL. Only the version
'1.0" is allowed. Any differing version creates an InvalidURLException exception.

/action
This is a required parameter if you call the action method of the portlet. The action parameter
causes the action process of the portlet to be called. After the action has been completed, a
redirect is automatically issued to call the render process. To control the subsequent render
process, a document servlet filter can set a request attribute with name
‘com.ibm.websphere.portlet.action’ and value 'redirect’ to specify that the portlet serving servlet
directly returns after action without calling the render process.

I/mode=view | edit | help | custom-mode
This optional parameter defines the portlet mode that is used to render the portlet. The default
mode is ‘view'. The value is not case-sensitive, For example, ‘View’, ‘view’ or ‘VIEW’ results in the
same mode.

/state=normal | maximized | minimized | custom-state
This optional parameter defines the window state that is used to render the portlet. The default
state is ‘normal’. The value is not case-sensitive, For example, ‘Normal’, ‘normal’, or ‘NORMAL’
results in the same state.

* [ /rparam=name *[=value] ]
This optional parameter specifies render parameters for the portlet. Repeat this parameter chain to
provide more than one render parameter. For example, /rparam=invitation/
rparam=days=Monday=Tuesday

?name=value&name2=valuez ...
Query parameters may follow optionally. They are not explicitly supported by the portlet container,
but they do not invalidate the URL format.

The following list includes examples of valid URLSs:

 http:// localhost:9080/sample/WorldClock

* http:// localhost:9080/sample/WorldClock/myPortlet/ver=1.0/mode=edit/rparam=timezone=UTC

» http:// localhost:9080/sample/WorldClock/myPortlet/ver=1.0/action/state=maximized?timezone=UTC

Portlet preferences

Preferences are set by portlets to store customized information. By default, the PortletServingServlet
servlet stores the portlet preferences for each portlet window in a cookie. However, you can change the
location to store them in either a session, an .xml file, or a database.

Storing portlet preferences in cookies

The attributes of the cookie are defined as follows:

Path
contextlportlet-namel portletwindow

Name:
The name of the cookie has the fixed value of PortletPreferenceCookie.

Value
The value of the cookie contains a list of preferences by mapping to the following structure:

*['/" pref-name *['=' pref-value]]
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All preferences start with '/’ followed by the name of the preference. If the preference has one or more
values, the values follow the name separated by the '=" character. A null value is represented by the
string '#*10_NULL_O!*#. As an example, the cookie value may look like, /locations=raleigh=boeblingen/
regions=nc=bw

Customizing the portlet preferences storage

You can override how the cookie is handled to store preferences in a session, an .xml file or database. To
customize the storage, you must create a filter, servlet or JavaServer Pages file as new entry point that
wraps the request and response before calling the portlet. Examine the following example wrappers to
understand how to change the behavior of the PortletServingServlet to store the preferences in a session
instead of cookies.

The following is an example of how the main servlet manages the portlet invocation.

public class DispatchServiet extends HttpServlet
{

public void service(HttpServletRequest request, HttpServletResponse response) throws ServletException, I0Exception

{
response.setContentType("text/html");

// create wrappers to change preference storage
RequestProxy req = new RequestProxy(request);
ResponseProxy resp = new ResponseProxy(request, response);

// create url prefix to always return to this servlet
req.setAttribute("com.ibm.wsspi.portlet.url.prefix", urlPrefix);

// prepare portlet url
String portletPath = request.getPathInfo();

// include portlet using wrappers
RequestDispatcher rd = getServletContext().getRequestDispatcher(modifiedPortletPath);
rd.include(req, resp);
}

}

In the following example, the request wrapper changes the cookie handling to retrieve the preferences out
of the session.

public class RequestWrapper extends HttpServletRequestWrapper
{

public Cookie[] getCookies() {
Cookie[] cookies = (Cookie[]) session.getAttribute("SessionPreferences");
return cookies;

}

In the following example, the response wrapper changes the cookie handling to store the preferences in
the session:

public class ResponseProxy extends HttpServletResponseWrapper

{

public void addCookie(Cookie cookie) {
Cookie[] oldCookies = (Cookie[]) session.getAttribute("SessionPreferences");
int newPos = (oldCookies == null) ? 0 : oldCookies.length;
Cookie[] newCookies = new Cookie[newPos+1];
session.setAttribute("SessionPreferences", newCookies);

if (oldCookies != null) {
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System.arraycopy(oldCookies, 0, newCookies, 0, oldCookies.length);

}

newCookies[newPos] = cookie;

}

Portlet deployment descriptor extensions

Extensions for the portlet deployment descriptor are defined within a file called ibm-portlet-ext.xmi. This
deployment descriptor is an optional descriptor that you can use to configure WebSphere extensions for
the portlet application and its portlets. For example, you can disable the PortletServingServlet servlet for
the portlet application in the extended portlet deployment descriptor.

The ibm-portlet-ext.xmi extension file is loaded during application startup. If there are no extension files
specified with this setting, the portlet container’s default values are used.

The default for the portletServingEnabled attribute is true. The following is an example of how to configure
that a PortletServingServlet servlet is not created for any portlet on the portlet application.
<?xml version="1.0" encoding="UTF-8"?>
<portletappext:PortletApplicationExtension xmi:version="1.0"
xmins:xmi="http://www.omg.org/XMI"
xmlns:portletappext="portletapplicationext.xmi"
xmins:portletapplication="portletapplication.xmi"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmi:id="PortletApp_ID Ext"
portletServingEnabled="false">
<portletappext:portletApplication href="WEB-INF/portlet.xml#myPortletApp"/>
</portletappext:PortletApplicationExtension>

Converting portlet fragments to an HTML document

A portlet only delivers fragment output whereas a servlet typically delivers document output. However, you
can use the PortletServingServlet servlet, which is similar to the FileServingServlet servlet, to address
portlets like servlets. A default document servlet filter, the DefaultFilter filter, is applied to the
PortletServingServlet servlet to return the portlet's content inside of a document. This filter only applies to
requests, not to includes or forwards using the RequestDispatcher method. A servlet filter that is used to
embed the portlet's content into a document is called the document servlet filter. You can define additional
document servlet filters in a .xml file.

The FilterRequestHelper attribute within com.ibm.wsspi.portletcontainer.util is provided to assist the
document servlet filters in analyzing a request regarding filter chain and portlet information. It is used in
supporting dynamic portlet titles, as a marker for redirection for document servlet filters and to ensure that
document conversion is completed once.

Adding a new document servlet filter

The filter capability is a server feature, therefore all filters must be installed into the server to use the filter
capability of the server. The filters need to be available in any classes or library directory on a server level.
You must also register the filter in a plugin.xml file within the root of a Java archive (JAR) file. The
following is an example of how to register the filter in a plugin.xml file.

<?xml version="1.0" encoding="UTF-8"?>
<?eclipse version="3.0"?>
<plugin id="sample.plugin" name="Customer_Plugin" provider-name="Customer" version="1.0.0">
<extension point="com.ibm.ws.portletcontainer.portlet-document-filter-config">
<portlet-document-filter class-name="sample.filter.CustomFilter" order="200" />
</extension>
</plugin>
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Dynamic portlet titles

The PortletServingServlet servlet supports dynamic portlet titles by providing the dynamic title as a request
attribute, FilterRequestHelper.DYNAMIC_TITLE. This attribute returns the dynamic portlet title if it has
been set by the portlet, otherwise it returns the static portlet title of the portlet.xml file if defined.

The FilterRequestHelper is used to assist in controling of the dynamic portlet title. The following constant is
defined, DYNAMIC TITLE = 'javax.portlet.title'

The DefaultFilter uses this request attribute to set the document title while converting the fragment into a
document. If the filter wants to support browser caching or dynamic portlet titles, the complete portlet
content must be cached

Redirection for document servlet filters

A document servlet filter can set a marker as request attribute, FilterRequestHelper.REDIRECT. This
marker ensures that the portlet container returns to the document servlet filter after the portlet action has
been called prior to any render calls. The following constants are defined, REDIRECT =
"com.ibm.websphere.portlet.action” and REDIRECT VALUE = ’redirect’. The DefaultFilter uses this
request attribute to provide special cache handling for the portlet rendering call to support dynamic title.

Document conversion

The conversion of the portlet’'s fragment into a valid document must be completed only once. Therefore
each document servlet filter must ensure that the fragment has not yet been converted to a document
previously. If the document servlet filter converts the fragment to a document, the request attribute
FilterRequestHelper.DOCUMENT must be set to FilterRequestHelper.DOCUMENT_VALUE. This request
attribute marks whether the conversion still needs to be completed. The following constants are defined,
DOCUMENT = 'com.ibm.websphere.portlet.filter’ and DOCUMENT VALUE = ’document’. The DefaultFilter
uses this request attribute to check whether it should convert the fragment to an Hypertext Markup
Language (HTML) document. For example, this allows another document servlet filter in front to convert
the fragment into a valid Wireless Markup Language (WML) document instead.

Portlet and PortletApplication MBeans

The MBeans of type portlet and portletapplication provide information about a given portlet application and
its portlets. Through the MBean of type portletapplication, you can retrieve a list of names of all portlets
that belong to a portlet application. By querying the MBean of type portlet with a given portlet name, you
can retrieve portlet specific information from the MBean of type portlet.

Each MBean that corresponds to a portlet or portlet application is uniquely identifiable by its name. Portlet
applications are not required to have a hame set within the portlet.xml. Thus for MBeans of type
portletapplication, the Web module name concatenated with the string ”_portletapplication” has been
chosen as the MBean name. The name chosen for the MBean of type portlet is the name of the MBean of
type portletapplication the portlet belongs to, concatenated with the porlet name. A full stop separates the
preceding Web module name from the portlet name. For more information about the Portlet and
PortletApplication MBean types in the |Generated API documentationl The generated APl documentation is
available in the information center table of contents from the path, Reference > Administrator > API
documentation > MBean interfaces.

The following code is an example of how to invoke the MBean of type portletapplication for an application
with the name "Bookmark”.

String myPortletApplicationName = "Bookmark_war_portletapplication";
This name is composed by the Web module name concatenated with the substring " _portletapplication”

com.ibm.websphere.management.AdminService adminService =
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com. ibm.websphere.management.AdminServiceFactory.getAdminService();
javax.management.ObjectName on =
new ObjectName("WebSphere:type=PortletApplication,name=" + myPortletApplicationName + ",x");

Iterator onlter = adminService.queryNames(on, null).iterator();
while(onIter.hasNext())
{

on = (ObjectName)onIter.next();

}

String ctxRoot = (java.lang.String)adminService.getAttribute(on, "webApplicationContextRoot");

In the previous example, the MBeanServer is first queried for an MBean of type portletapplication. If this
query is successful, the attribute webApplicationContextRoot is retrieved on that MBean or the first MBean
that is found and the result is stored in the variable ctxRoot. This variable now contains the context root of
the Web application that contains the portlet application that was searched. For example, this may be
something like, "/bookmark”.

The next code example demonstrates how to invoke the MBean of type portlet for a portlet with the name
"BookmarkPortlet".

String myPortletName = "Bookmark war_portletapplication.BookmarkPortlet";

This name is composed by the name of the MBean of type portletapplication and

the portlet name, separated by a full stop because the same portlet name may
be used within different Web modules, but must be unique within the system.

com.ibm.websphere.management.AdminService adminService =

com. ibm.websphere.management.AdminServiceFactory.getAdminService();
javax.management.ObjectName on =

new ObjectName("WebSphere:type=Portlet,name=" + myPortletName + ",*");
Iterator iter = adminService.queryNames(on, null).iterator();

while(iter.hasNext())
{
on = (ObjectName)iter.next;

}

java.util.Locale Tocale = (java.util.Locale) adminService.getAttribute(on, "defaultLocale");

The locale returned by the method getAttribute method for the MBean is the default locale defined for this
portlet.
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Chapter 6. SIP applications

Providing real time collaboration with SIP applications

Follow these procedures for creating SIP applications and configuring the SIP container.

Session Initiation Protocol (SIP) is used to establish, modify, and terminate multimedia IP sessions
including IP telephony, presence, and instant messaging. A SIP application is a Java program that uses at
least one Session Initiation Protocol (SIP) servlet. A SIP servlet is a Java-based application component
that is managed by a SIP servlet container.

The servlet container is a part of an application server that provides the network services over which
requests and responses are received and sent. The servlet container decides which applications to invoke
and in what order. A servlet container also contains and manages a servlet through its lifecycle.

This topic is divided into the following subsections:

« Configure the SIP container: Information and instructions for configuring SIP container properties and
timers.

 |Developing SIP applications| Reference information for developers.
» |Deploying SIP applicationst Information for installing, starting, and stopping, your applications.

» Securing SIP applications: Instructions for enabling security providers and setting up a trust association
interceptor (TAI).

» Tracing a SIP container: Troubleshoot SIP applications through traces on the SIP container.

SIP applications

A SIP application is a Java program that uses at least one Session Initiation Protocol (SIP) servlet.

A SIP servlet is a Java-based application component that is managed by a SIP servlet container and that
performs SIP signaling. Like other Java-based components, servlets are platform-independent Java
classes that are compiled to platform-neutral bytecode that can be loaded dynamically into and run by a
Java-enabled SIP application server. Containers, sometimes called servlet engines, are server extensions
that handle servlet interactions. SIP servlets interact with clients by exchanging request and response
messages through the servlet container.

SIP is used to establish, modify, and terminate multimedia IP sessions including IP telephony, presence,
and instant messaging. "Presence” in this context refers to user status such as "Active,” "Away,” or "Do
not disturb.” The standard that defines a programming model for writing SIP-based servlet applications is

SR 116

SIP container

A SIP container is a Web application server component that invokes the Session Initiation Protocol (SIP)
action servlet and that interacts with the action servlet to process SIP requests.

The servlet container provides the network services over which requests and responses are received and
sent. It decides which applications to invoke and in what order. The container also contains and manages
servlets through their life cycle.

A SIP servlet container manages the network listener points on which it listens for incoming SIP traffic. A
listener point is a combination of transport protocol, IP address, and port number. The SIP specification
(JSR 116) requires all SIP elements to support both UDP and TCP, and optionally TLS, SCTP, and
potentially other transports.
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Developing SIP applications

This section explains how to develop a SIP application for WebSphere Application Server.

When you develop Session Initiation Protocol (SIP) applications, you should be aware of certain
considerations and of the SIP status codes.

Compliance with industry SIP standards
This product complies with various industry standards for the Session Initiation Protocol (SIP)

The standards bodies for these standards are as follows:

IETF Internet Engineering Task Force
JCP Java Community Process
3GPP Third Generation Partnership Project

SIP and SIP proxy

This product complies with the SIP standards of and shown in|Table 1
Table 1. Compliance with SIP and SIP proxy standards

Standard Body Description Support Notes
JCP SIP servlets API Full Application composition according
to the cascaded services model is
supported. Converged applications
are supported in environments
where session failover is disabled.
Note: application composition is
underspecified in JSR 116.
WebSphere Application Server's
SIP application composition
details can be found inm
application composition” on pagel|
133]
RFC 3261, IETF SIP core protocol Full Supersedes(SIP base
protocol). Backward compatible.
IETF Reliability of Full
provisional
responses SIP
RFC 3263 IETF Locating SIP Full
servers
RFC 3515 IETF SIP REFER Full
method

SIP presence server

SIP Server complies with the SIP presence server standards shown in|Table 2

Table 2. Compliance with SIP presence server standards

Standard Body Description Support | Notes
RFC 3265 |[IETF Specific event Full This is a base protocol for the presence server.

notification
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Table 2. Compliance with SIP presence server standards (continued)

Standard Body Description Support | Notes

IRFC 3842 |IETF Message waiting Partial This can be supported as part of the presence server as
indicator another event package.

IRFC 3856 |IETF Presence event Full This is a base protocol for the presence server.
package for SIP

IRFC 3863 |IETF Presence Information | Full
Data Format (PIDF)

|RFC 3903| IETF SIP extension for event | Full

| state publication

Other SIP applications

SIP Server complies with standards for other SIP applications as shown in 3GPP is the
[Generation Partnership Project]

Table 3. Compliance with standards for other SIP applications

Standard Body Description Support | Notes

IRFC 2976 |IETF The SIP INFO method | Full SIP Server contains no explicit support in SLSP or the
container for INFO methods, but an application is free to
implement and act upon them.

IRFC 3326 |IETF The Reason header Full This field enables a SIP container to indicate a reason
field for a given SIP message. The Reason header is moved

to the application for processing.

[RFC 3327 |IETF Extension (Path) Full 3GPP requires that registrar and location server
header field for applications implement and use the Path header.
registering nonadjacent
contacts

|IRFC 3428| |IETF SIP extension for Full MESSAGE methods extend SIP and are processed by
instant messaging the application.

IRFC 3455 |IETF Private header Full This is an informational RFC on 3GPP private headers.
extensions to SIP The container passes the headers to the application.

[RFC 3725 |IETF Best current practices | Full Applications running in the SIP container implement
for third-party call these practices.

control (3pcc)

Runtime considerations for SIP application developers

You should consider certain product runtime behaviors when you are writing Session Initiation Protocol
(SIP) applications.

Container may accept non-SIP URI schemes

The SIP container will not reject a message if it doesn't recognize the scheme in the request URI because
the container cannot know which URI schemes are supported by the applications. SIP elements may
support a request URI with a scheme other than sip or sips, for example, the pres: scheme has a
particular meaning for presence servers, but the container does not recognize it. It is up to the application
to determine whether to accept or to reject a specific scheme. SIP elements may translate non-SIP URIs
using any mechanism available, resulting in SIP URIs, SIPS URIs, or other schemes, like the tel URI
scheme of RFC 2806 [9].
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Invoking session listener events

SipSessionListener and SipApplicationSessionListener events are invoked only if an application requests
the corresponding session object. You do this by using in your application the method shown in|Table 4|

Table 4. Methods that invoke session listener events

Event Method
SipSessionListener getSession()
SipApplicationSessionListener getApplicationSession()

Session activation and passivation

During normal operation, this product never migrates a session from one server to another. Session
migration occurs only as a result of a server failure. Therefore the SipSessionActivationListener method’s
passivation callback is never invoked. However, the activation callback is invoked when a failure forces
session failover to a different server.

Developing a custom trust association interceptor

When you develop Session Initiation Protocol (SIP) applications, you can create a custom trust association
interceptor (TAI).

You may want to familiarize yourself with the general TAI information contained in the [Trust Associations|
documentation. Developing a SIP TAl is similar to developing any other custom interceptors used in trust
associations. In fact, a custom TAI for a SIP application is actually an extension of the trust association
interceptor model.

TAIl can be invoked by a SIP servlet request or a SIP servlet response. To implement a custom SIP TAl,
you need to write your own Java class.

1. Write a Java class that extends the com.ibm.wsspi.security.tai.BaseTrustAssociationInterceptor
class and implements the com.ibm.websphere.security.tai.SIPTrustAssociationInterceptor
interface. Those classes are defined in the WASProductDirlplugins/com.ibm.ws.sip.container_1.0.0.jar
file, where WASProductDir is the fully qualified path name of the directory in which WebSphere
Application Server is installed.

2. Declare the following Java methods:

public int initialize(Properties properties) throws WebTrustAssociationFailedException;
This is invoked before the first message is processed so that the implementation can allocate
any resources it needs. For example, it could establish a connection to a database.
WebTrustAssociationFailedException is defined in the WASProductDirlplugins/
com.ibm.ws.runtime_1.0.0.jar file. The value of the properties argument comes from the
Custom Properties set in|this steél

public void cleanup();
This is invoked when the TAI should free any resources it holds. For example, it could close a
connection to a database.

public boolean isTargetProtocolInterceptor(SipServlietMessage sipMsg) throws
WebTrustAssociationFailedException;
Your custom TAI should use this method to handle the sipMsg message. If the method returns
false, WebSphere ignores your TAI for sipMsg.

public TAIResult negotiateValidateandEstablishProtocolTrust (SipServletRequest req,
SipServletResponse resp) throws WebTrustAssociationFailedException;
This method returns a TAIResult that indicates the status of the message being processed and
a user ID or the unique ID for the user who is trying to authenticate. If authentication
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succeeds, the TAIResult should contain the status HttpServletResponse.SC_OK and a
principal. If authentication fails, the TAIResult should contain a return code of
HttpServletResponse.SC_UNAUTHORIZED (401), SC_FORBIDDEN (403), or
SC_PROXY_AUTHENTICATION_REQUIRED (407). The only indicates whether or not the
container should accept a message for further processing. To challenge an incoming request,
the TAl implementation must generate and send its own SipServletResponse containing a
challenge. The exception should be thrown for internal TAI errors. describes the
argument values and resultant actions for the negotiateValidateandEstablishProtocolTrust
method.

Table 5. Description of negotiateValidateandEstablishProtocol Trust arguments and actions

Argument or action For a SIP request For a SIP response

Value of req argument The incoming request Null

Value of resp argument Null The incoming response

Action for valid response Return TAIResult.status containing Return TAIResult.status containing
credentials SC_OK and a user ID or unique ID SC_OK and a user ID or unique 1D
Action for incorrect response Return the TAIResult with the 4xx Return the TAIResult with the 4xx status
credentials status

The sequence of events is as follows:

a. The SIP container maps initial requests to applications by using the rules in each
applications deployment descriptor; subsequent messages are mapped based on|JSR 116
mechanisms.

b. If any of the applications require security, the SIP container invokes any defined TAI
implementations for the message.

c. If the message passes security, the container invokes the corresponding applications.

Your TAI implementation can modify a SIP message, but the modified message will not be
usable within the request mapping process, because it finishes before the container invokes
the TAL

The com.ibm.wsspi.security.tai. TAIResult class, defined in the WASProductDirlplugins/
com.ibm.ws.runtime_1.0.0.jar file, has three static methods for creating a TAIResult. The
TAIResult create methods take an int type as the first parameter. WebSphere Application
Server expects the result to be a valid HTTP request return code and is interpreted as follows:

If the value is HitpServiletResponse.SC_OK, this response tells WebSphere Application Server
that the TAI has completed its negotiation. The response also tells WebSphere Application
Server use the information in the TAIResult to create a user identity.

The created TAIResults have the meanings shown in|Table 6

Table 6. Meanings of TAIResults

TAIResult Explanation
public static TAIResult create(int Indicates a status to WebSphere Application Server. The status should not
status); be SC_OK because the identity information is provided.

public static TAIResult create(int status, | Indicates a status to WebSphere Application Server and provides the user
String principal); ID or the unique ID for this user. WebSphere Application Server creates

credentials by querying the user registry.

public static TAIResult create(int status, | Indicates a status to WebSphere Application Server, the user ID or the
String principal, Subject subject); unique ID for the user, and a custom Subject. If the Subject contains a

Hashtable, the principal is ignored. The contents of the Subject becomes
part of the eventual user Subject.

public String getVersion();

This method returns the version number of the current TAl implementation.
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7.

public String getType();
This method’s return value is implementation-dependent.

Compile the implementation after you have implemented it. For example: /opt/WebSphere/AppServer/

java/bin/javac -classpath /opt/WebSphere/AppServer/plugins/com.ibm.ws.runtime 1.0.0.jar;/

opt/WebSphere/AppServer/1ib/j2ee.jar;/opt/WebSphere/AppServer/plugins/

com.ibm.ws.sip.container_1.0.0.jar myTAIImpl.java

a. For each server within a cluster, copy the class file to a location in the WebSphere class path
(preferably the WASProductDirlplugin/ directory).

b. Restart all the servers.

Delete the default WebSEAL interceptor in the administrative console and click New to add your
custom interceptor. Verify that the class name is dot-separated and appears in the class path.

Click the Custom Properties link to add additional properties that are required to initialize the custom
interceptor. These properties are passed to the initialize(Properties properties) method of your
implementation when it extends the
com.ibm.websphere.security.WebSphereBaseTrustAssociationInterceptor as described in the
previous step.

Save and synchronize (if applicable) the configuration.
Restart the servers for the custom interceptor to take effect.

Developing SIP applications that support PRACK

A SIP response to an INVITE request can be final (sent reliably) or provisional (typically not sent reliably).
For cases where you need to send a provisional response reliably, you can use the PRACK (Provisional
Response ACKnowledgement) method.

For you to be able to develop applications that support PRACK, the following criteria must be met:

The client that sends the INVITE request must put a 100rel tag in the Supported or the Require header
to indicate that the client supports PRACK.

The SIP servlet must respond by invoking the sendReliabily() method instead of the send() method to
send the response.

PRACK is described in the following standards:

RFC 3262 (“Reliability of Provisional Responses in the Session Initiation Protocol (SIP)”), which extends

RFC 3261 (“SIP: Session Initiation Protocol”), adding PRACK and the option tag 100rel.

Section 6.7.1 (“Reliable Provisional Responses”) of (“SIP Servlet API Version 1.0").

For an application acting as a proxy, do this:

— Make your application generate and send a reliable provisional response for any INVITE request that
has no tag in the To field.

For an application acting as a user agent client (UAC), do this:

— Make your application add the 100rel tag to outgoing INVITE requests. The option tag must appear
in either the Supported header or the Require header.

— Within your application’s doProvisionalResponse(...) method, prepare the application to create and
send PRACK requests for incoming reliable provisional responses. The application must create the
PRACK request on the response’s dialog through a SipSession.createRequest(...) method, and it
must set the RAck header according to RFC 3262 Section 7.2 (“RAck”).

— The application that acts as an UAC will not receive doPrack( ) methods. The UAC sends INVITE
and receives Reliable responses. When the UAC receives the Reliable response, it sends PRACK a
request to the UAS and receives a 200 OK on the PRACK so it should next implement doResponse(
) in order to receive it.

— Within your application’s doPrack(...) method, prepare the application to generate and send a final
response to an incoming PRACK request.

For an application acting as a user agent server (UAS), do this:
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— If an incoming INVITE request requires the 100rel tag, trying to send a 101-199 response unreliably
by using the send() method causes an Exception.

— Make the application declare a SipErrorListener to receive noPrackReceived() events when a reliable
provisional response is not acknowledged within 64*T1 seconds, where T1 is a SIP timer. Within the
noPrackReceived() event processing, the application should generate and send a 5xx error response
for the associated INVITE request per JSR 116 Section 6.7.1.

— Make the application have at most one outstanding, unacknowledged reliable provisional response.
Trying to send another one before the first's acknowledgement results in an Exception.

— Make sure that the application enforces the RFC 3262 offer/answer semantics surrounding PRACK
requests containing session descriptions. Specifically, a servlet must not send a 2xx final response if
any unacknowledged provisional responses contained a session description.

SIP application composition
Reference materials for the WebSphere Application Server implementation of JSR 116 standards

Application composition specification

The JSR 116 standard states in Section 2.4 that multiple applications may be invoked for the same SIP
request.

This standard requires that implementations must obey a cascaded services model, stating: “Triggering of
service applications on the same host, shall be performed in the same sequence as if triggering had
occurred on different hosts.” This means that responses will flow upstream, that they will hit applications in
the reverse order of their corresponding requests.

JSR 116 does not specify how to implement this when developing SIP applications, thus there are many
ways to comply with this standard.

Application composition in the WebSphere Application Server environment

Composition of the application depends on the deployed application order, and on the order of mapping
rules within the deployment descriptor of each application.

+ For an initial incoming request, the SIP container tries each potential rule in order. Upon finding the n
match, the container then invokes the corresponding servlet.

» If the servlet needs to proxy the request, the container re-scans the rules searching for additional
matches. Upon finding the (n+1)" match, the container invokes the corresponding servlet.

* Matching the request excludes any servlet in the same application as the previously invoked servlet. As
stated in the standards, no servlet will be invoked twice for the same SIP request.

Deploying SIP applications

Use the administrative console to customize your Session Initiation Protocol (SIP) application installation

When you deploy a Session Initiation Protocol (SIP) application, you can perform various tasks such as
installing, starting, stopping, upgrading, and uninstalling the application.

SIP applications are installed as Java 2 Platform Enterprise Edition (J2EE) applications. You can deploy a
SIP application from a graphical interface or from a command line.

Deploying SIP applications through the console

You can deploy a Session Initiation Protocol (SIP) application through the administrative console.
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SIP applications are deployed as Java 2 Platform Enterprise Edition (J2EE) applications. In order to
process requests, a virtual host must be defined when deploying the SIP application. If there is no virtual
host defined for the configured SIP container listen port, the installed application will be inaccessible.

1.

10.
11.

12.

13.

Open the administrative console.

In a browser, go to URL http://hostname:9090/admin, where hostname is the name of the host
computer. Enter the appropriate login information, and click OK.

In the left frame click Applications -~ Install New Application.

Browse and select a SAR file. Specify the context root, beginning with a slash (/), in the Context
Root field. For example, if your application is named ThisApplication, type /ThisApplication.

Click Next (under the Context Root field not beside the WebSphere Status title). If the SAR file has
been assembled correctly, the screen will still have the title “Preparing for the application installation”,
but the content will change. If an error message appears, check the contents of the SAR file; in
particular, verify the web.xml file contents, and try to reload the SAR file.

Click Next. If you see a screen indicating “Application Security Warnings”, click Continue.

The Install New Application screen should appear with “Step 1: Select application options”
highlighted. Select the options you need and click Next.

“Step 2: Map modules to servers” should appear highlighted now. You can choose the cluster or
server where you want to install the application’s modules.

« If you are installing the application in a stand-alone system, click Next.

» If you are installing the application in a clustered system, select
WebSphere:cell=cellname,cluster=cluster_name in the Clusters and Servers field, select the
check box beside the Web module that you want to install, and click Apply and Next.

Now “Step 3: Map virtual hosts for Web modules” should appear highlighted. To the right of the
application name there should be a drop-down labeled Virtual Host.

« If you are installing the application in a standalone system, set the value of the drop-down to
default_host, and click Next.

« If you are installing the application in a clustered system, set the value of the drop-down to the
name of the virtual host that was chosen during setup, and click Next.

Remember: You must define a virtual host for your configured SIP container listen port or else you
will not be able to access the application.

You should now see “Step 4: Summary” highlighted. In the right panel you will see a Summary of
installation options table that details your selected options and their values. If you need to change
an option, click Previous to return to the section where you can make your change. Click Finish to
install the application with your settings. The screen should display, Application appname_sar
installed successfully, where appname is the name of the application.

Click the Save to Master Configuration link. A Save to Master Configuration window appears.

In the Save to Master Configuration window, click Save. The application has now been saved in the
current configuration.

To confirm that the installation succeeded, in the left frame click Applications > Enterprise
Applications. The newly installed application should appear in the list of installed applications as
appname_sar.

To start the application so that it can service SIP requests, check the box beside appname_sar, and
click Start. You might also want to look at the logs for a successful startup message.

The application can service SIP requests now.

Deploying SIP applications through scripting

You can deploy a Session Initiation Protocol (SIP) application not only from the GUI but also from the
command line.

» Launch a scripting client. For more information, see AdminApp object for scripted administration.
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List applications.

Install standalone archive files. For more information about installation, see Installation options for the
AdminApp object.

Edit application configurations.
Uninstall applications.
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Chapter 7. EJB applications

Task overview: Using enterprise beans in applications

This article provides an overview of the tasks you must perform to use enterprise beans in a J2EE
application.

1. Design a J2EE application and the enterprise beans that it needs. For links to design information that
is specific to enterprise beans, see ['‘Data access: Resources for learning” on page 695}

2. |Develop any enterprise beans|that your application will use.

3. Prepare for assembly. For your EJB 2.x-compliant entity beans, |[decide on an appropriate access
intent polic

4. |Assemble the beans into one or more EJB modules|using one of the assembly tools. This process

includes setting security. For your EJB 2.x-compliant entity beans, you might also want to designate

container-managed persistence (CMP) sequence groupsl

5. JAssemble the modules into a J2EE applicatiod using the assembly tool.

6. For a given application server, update the EJB container configuration if needed for the application to
be deployed, and determine if you want to [batch commands| or [defer commands] for
container-managed persistence.

7. [Deploy the application|in an application server.

8. Test the modules.
* As needed, debug|prob|ems with the container|
+ Debug|access problems.

9. [Assemble the production application| using one of the assembly tools
10. Deploy the application to a production environment.
11. Manage the application:

a. Manage installed EJB modules. After an application has been installed, you can manage its EJB
modules individually through the Assembly Service Toolkit.

b. |[Manage other aspects of the J2EE application
12. [Update the module and redeploy it using one of the assembly tools.
13. Tune the performance of the application. See [Best practices for developing enterprise beans|

Enterprise beans

An enterprise bean is a Java component that can be combined with other resources to create J2EE
applications. There are three types of enterprise beans, entity beans, session beans, and message-driven
beans.

All beans reside in EJB containers, which provide an interface between the beans and the application
server on which they reside.

Entity beans store permanent data, so they require connections to a form of persistent storage. This
storage might be a database, an existing legacy application, a file, or another type of persistent storage.

Session beans typically contain the high-level and mid-level business logic for an application. Each method
on a session bean typically performs a particular high-level operation. For example, submitting an order or
transferring money between accounts. Session beans often invoke methods on entity beans in the course

of their business logic.

Session beans can be either stateful or stateless. A stateful bean instance is intended for use by a single
client during its lifetime, where the client performs a series of method calls that are related to each other in
time for that client. One example is a "shopping cart” where the client adds items to the cart over the
course of an online shopping session. In contrast, a stateless bean instance is typically used by many
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clients during its lifetime, so stateless beans are appropriate for business logic operations that can be
completed in the span of a single method invocation. Stateful beans should be used only where absolutely
necessary -- using stateless beans improves the ability to debug, maintain, and scale the application.

Message-driven beans enable asynchronous message servicing.

* The EJB container and a Java Message Service (JMS) provider work together to process messages.
When a message arrives from another application component through JMS, the EJB container forwards
it through an onMessage() call to a message-driven bean instance, which then processes the message.
In other respects, message-driven beans are similar to stateless session beans.

* The EJB container and a Java Connector Architecture (JCA) resource adapter work together to process
messages from an enterprise information system (EIS). When a message arrives from an EIS, the
resource adapter receives the message and forwards it to a message-driven bean, which then
processes the message. The message-driven bean is provided services such as transaction support by
the EJB container in the same way that other enterprise beans are provided service.

Beans that require data access use data sources, which are administrative resources that define pools of
connections to persistent storage mechanisms.

For more information about enterprise beans, see[‘Enterprise beans: Resources for learning” on page 139

EJB modules

An EJB module is used to assemble one or more enterprise beans into a single deployable unit. An EJB
module is stored in a standard Java archive (JAR) file.

An EJB module contains the following:

* One or more deployable enterprise beans.

* A deployment descriptor, stored in an Extensible Markup Language (XML) file. This file declares the
contents of the module, defines the structure and external dependencies of the beans in the module,
and describes how the beans are to be used at run time.

You can deploy an EJB module as a stand alone application, or combine it with other EJB modules or with
Web modules to create a J2EE application. An EJB module is installed and run in an enterprise bean
container.

For more information about EJB modules, see [‘Enterprise beans: Resources for learning” on page 139

EJB containers

An Enterprise JavaBeans (EJB) container provides a run-time environment for enterprise beans within the
application server. The container handles all aspects of an enterprise bean’s operation within the
application server and acts as an intermediary between the user-written business logic within the bean and
the rest of the application server environment.

One or more EJB modules, each containing one or more enterprise beans, can be installed in a single
container.

The EJB container provides many services to the enterprise bean, including the following:

* Beginning, committing, and rolling back transactions as necessary.

» Maintaining pools of enterprise bean instances ready for incoming requests and moving these instances
between the inactive pools and an active state, ensuring that threading conditions within the bean are
satisfied.

* Most importantly, automatically synchronizing data in an entity bean’s instance variables with
corresponding data items stored in persistent storage.
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By dynamically maintaining a set of active bean instances and synchronizing bean state with persistent
storage when beans are moved into and out of active state, the container makes it possible for an
application to manage many more bean instances than could otherwise simultaneously be held in the
application server's memory. In this respect, an EJB container provides services similar to virtual memory
within an operating system.

By default, an EJB container runs in the quick start mode. The EJB container startup logic delays the
loading and processing of all EJB types except Message Driven Beans (because they must exist before
messages are posted for them), Startup Beans (which must be processed at server startup time), and
those EJB types that you specify to initialize at server start. For more information about disabling quick
start for EJB types, see Changing enterprise bean types to initialize at application start time using the
Application Server Toolkit.

All other EJB initialization is delayed until the first use of the EJB type. When using Local Interfaces, the
first use is when you perform an InitialContext.lookup() method for the type. For Remote Interfaces, it is
when you call the first method on an EJB or its Home.

For more information about EJB containers, see [‘Enterprise beans: Resources for learning.’]

Enterprise beans: Resources for learning

Use the following links to find relevant supplemental information about enterprise beans. The information
resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of the
information.

These links are provided for convenience. Often, the information is not specific to this product but is useful
all or in part for understanding the product. When possible, links are provided to technical papers and
Redbooks that supplement the broad coverage of the release documentation with in-depth examinations of
particular product areas.

Planning, business scenarios, and IT architecture
« [Mastering Enterprise JavaBeans|

A comprehensive treatment of Enterprise JavaBeans (EJB) programming in nonprintable form (PDF).
One must be registered to download the PDF, but registration is free. Information about purchasing a
hardcopy is available on the Web site.

» Enterprise JavaBeans by Richard Monson-Haefel (O’'Reilly and Associates, Inc.: Third Edition, 2001)

Programming model and decisions
+ [Read all about EJB 2.0|

A comprehensive overview of the 2.0 specification that is still relevant to users of EJB 2.1.
« [The J2EE Tutoriall

This set of articles by Sun Microsystems covers several EJB-related topics, including the basic
programming models, persistence, and EJB Query Language.

Programming instructions and examples
. |WebSphere Application Server Development Best Practices for Performance and Scalability{

Programming practice for enterprise beans and other types of J2EE components.
» |Optimistic Locking in IBM WebSphere Application Server 4.0.2|

Examples of the effect of optimistic concurrency on application behavior. Although the paper is based on
a previous version of this product, the data access issues discussed in it are current.

This paper does not seem to be available directly by URL. To view this paper, visit the specified URL
and search on "optimistic locking”
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Programming specifications
« [Enterprise JavaBeans 2.1 Specification|

You can download the specification from this URL.
+ [Enterprise JavaBeans 3.0 Specification|

You can download the specification from this URL.
Java™ 2 Platform: Compatibility with Previous Releases|

This Sun Microsystems article includes both source and binary compatibility issues.

EJB method Invocation Queuing

Method invocations to enterprise beans are only queued for remote clients making the method call. An
example of a remote client is an enterprise Java bean (EJB) client running in a separate Java virtual
machine (JVM) (another address space) from the enterprise bean. In contrast, no queuing occurs if the
EJB client, either a servlet or another enterprise bean, is installed in the same JVM on which the EJB
method runs and on the same thread of execution as the EJB client.

Remote enterprise beans communicate by using the Remote Method Invocation over Internet Inter-ORB
Protocol (RMI-IIOP). Method invocations initiated over RMI-IIOP are processed by a server-side object
request broker (ORB). The thread pool acts as a queue for incoming requests. However, if a remote
method request is issued and there are no more available threads in the thread pool, a new thread is
created. After the method request completes the thread is destroyed. Therefore, when the ORB is used to
process remote method requests, the EJB container is an open queue, due to the use of unbounded
threads.

The following illustration depicts the two queuing options of enterprise beans.

EJB Queuing
Serviet Engine
Request queued , . Jv-
in the Servlet Engine  ,~ EJB Container
Threads .~ :
s 1
| ORB Thread Pool
S 7 - WebSphere
ervie -7 - Application Server
-~ Request
EJB Client queued
in the ORB
REMOTE Thread Pool
WebSphere
Application Server

The following are two tips for queueing enterprise beans:

* Analyze the calling patterns of the EJB client.
When configuring the thread pool, it is important to understand the calling patterns of the EJB client. If a
servlet is making a small number of calls to remote enterprise beans and each method call is relatively
quick, consider setting the number of threads in the ORB thread pool to a value lower than the Web
container thread pool size value.
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The degree to which the ORB thread pool value needs increasing is a function of the number of
simultaneous servlets, that is, clients, calling enterprise beans and the duration of each method call. If
the method calls are longer or the applications spend a lot of time in the ORB, consider making the
ORB thread pool size equal to the Web container size. If the servlet makes only short-lived or quick
calls to the ORB, servlets can potentially reuse the same ORB thread. In this case, the ORB thread
pool can be small, perhaps even one-half of the thread pool size setting of the Web container.
Monitor the percentage of configured threads in use.

Tivoli Performance Viewer shows a metric called percent maxed, which is used to determine how often
the configured threads are used. A value that is consistently in the double-digits, indicates a possible
bottleneck a the ORB. Increase the number of threads.

See also Queuing network

Enterprise bean and EJB container troubleshooting tips

If you are having problems starting an EJB container, or encounter error messages or exceptions that
appear to be generated on by an EJB container, follow these steps to resolve the problem:

Use the Administrative Console to verify that the application server which hosts the container is running.
Browse the JVM log files for the application server which hosts the container. Look for the message
server server_name open for e-business in the SystemOut.log . If it does not appear, or if you see the
message problems occurred during startup, browse the SystemErr.log for details.

Browse the system log files for the application server which hosts the container.

Enable tracing for the EJB Container component, by using the following trace specification
EJBContainer=all=enabled. Follow the instructions for dumping and browsing the trace output to narrow
the origin of the problem.
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If none of these steps solves the problem, check to see if the problem is identified and documented using
the links in Diagnosing and fixing problems: Resources for learning. If you do not see a problem that
resembles yours, or if the information provided does not solve your problem, contact IBM support for
further assistance.

For current information available from IBM Support on known problems and their resolution, see the IBM
Support page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the IBM Support page.

Error in client log: Missing jar file

The following error message appears in the client log file because a JAR file is missing from the classpath
on the client machine. The Object Request Broker (ORB) needs this file to unmarshal the nested
exception that is part of the EJB exception, returned by the server to the client application. For example, if
the EJB returns a DB2® JCC SQL exception nested inside of the EJB exception that it returns to the client,
the ORB is not able to unmarshal the nested exception if the db2jcc.jar file that contains the DB2 SQL
exception is not in the client classpath.

java.rmi.MarshalException: CORBA MARSHAL 0x4942f89a No; nested exception is:

org.omg.CORBA.MARSHAL: Unable to read value

from underlying bridge : Custom marshaling (4) Sender's class does not match
local class vmcid: 0x4942f000 minor code: 2202 completed: No*

To avoid this error, include the JAR file that contains the class for the nested exception that is returned in
the EJB exception.

Cannot access an enterprise bean from a serviet, a JSP file, a
stand-alone program, or another client
This article provides troubleshooting tips for problems related to accessing enterprise beans.

What kind of error are you seeing?

« javax.naming.NameNotFoundException: Name name not found in context "local” message when
access is attempted

« BeanNotReentrantException is thrown

« CSlITransactionRolledbackException / TransactionRolledbackException is thrown

+ Call fails, Stack trace beginning EJSContainer E Bean method threw exception [exception_name]
found in JVM log file.

+ Call fails, ObjectNotFoundException or ObjectNotFoundLocalException when accessing stateful
session EJB found in JVM log file.

* Attempt to start CMP EJB module fails with javax.naming.NameNotFoundException:
dataSourceName

« Transaction [tran ID] has timed out after 120 seconds error accessing EJB.

* Symptom: CNTR0001W: A Stateful SessionBean could not be passivated
+ Symptom: org.omg.CORBA.BAD_PARAM: Servant is not of the expected type. minor code:
4942F21E completed: No returned to client program when attempting to execute an EJB method

If the client is remote to the enterprise bean, which means, running in a different application server or as a
stand-alone client, browse the JVM logs of the application server hosting the enterprise bean as well as
log files of the client.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, perform these steps:
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1. If the problem appears to be name-service related, which means that you see a
NameNotFoundException, or a message ID beginning with NMSV, see these topics for more
information:

» Cannot look up an object hosted by WebSphere Application Server from a servlet, JSP file, or other
client
* Naming service troubleshooting tips

2. Check to see if the problem is identified and documented using the links in Diagnosing and fixing

problems: Resources for learning.

If you still cannot fix your problem, seeTroubleshooting help from IBM for further assistance.

ObjectNotFoundException or ObjectNotFoundLocalException when accessing
stateful session EJB

A possible cause of this problem is that the stateful session bean timed out and was removed by the
container. This event must be addressed in the code, according to the EJB 2.1 specification (available at
lhttp://java.sun.com/products/ejb/docs.html), section 7.6.2, Dealing with exceptions.

Stack trace beginning "EJSContainer E Bean method threw exception
[exception_name]” found in JVM log file

If the exception name indicates an exception thrown by an IBM class that begins with "com.ibm...”, then

search for the exception name within the information center, and in the online help as described below. If
"exception name” indicates an exception thrown by your application, contact the application developer to
determine the cause.

javax.naming.NameNotFoundException: Name name not found in context "local”

A possible reason for this exception is that the enterprise bean is not local (not running in the same Java
virtual machine [JVM] or application server) to the client JSP, servlet, Java application, or other enterprise
bean, yet the call is to a "local” interface method of the enterprise bean . If access worked in a
development environment but not when deployed to WebSphere Application Server, for example, it might
be that the enterprise bean and its client were in the same JVM in development, but are in separate
processes after deployment.

To resolve this problem, contact the developer of the enterprise bean and determine whether the client call
is to a method in the local interface for the enterprise bean. If so, have the client code changed to call a
remote interface method, or to promote the local method into the remote interface.

References to enterprise beans with local interfaces are bound in a name space local to the server
process with the URL scheme of 1ocal:. To obtain a dump of a server Tocal: name space, use the name
space dump utility described in the article "Name space dump utility for java:, Tocal: and server name
spaces.”

BeanNotReentrantException is thrown

This problem can occur because client code (typically a servlet or JSP file) is attempting to call the same
stateful SessionBean from two different client threads. This situation often results when an application
stores the reference to the stateful session bean in a static variable, uses a global (static) JSP variable to
refer to the stateful SessionBean reference, or stores the stateful SessionBean reference in the HTTP
session object. The application then has the client browser issue a new request to the servlet or JSP file
before the previous request has completed.

To resolve this problem, ask the developer of the client code to review the code for these conditions.
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CSITransactionRolledbackException / TransactionRolledbackException is thrown

An enterprise bean container creates these high-level exceptions to indicate that an enterprise bean call
could not successfully complete. When this exception is thrown, browse the JVM logs to determine the
underlying cause.

Some possible causes include:

* The enterprise bean might throw an exception that was not declared as part of its method signature.
The container is required to roll back the transaction in this case. Common causes of this situation are
where the enterprise bean or code that it calls creates a NullPointerException,
ArraylndexOutOfBoundsException, or other Java runtime exception, or where a BMP bean encounters a
JDBC error. The resolution is to investigate the enterprise bean code and resolve the underlying
exception, or to add the exception to the problem method signature.

» A transaction might attempt to do additional work after being placed in a "Marked Rol1back”,
"RoT1ingBack”, or "RolTedBack” state. Transactions cannot continue to do work after they are set to one
of these states. This situation occurs because the transaction has timed out which, often occurs
because of a database deadlock. Work with the application database management tools or
administrator to determine whether database transactions called by the enterprise bean are timing out.

» A transaction might fail on commit due to dangling work from local transactions. The local transaction
encounters some "dangling work” during commit. When a local transactions encounters an "unresolved
action” the default action is to "rollback”. You can adjust this action to "commit” in an assembly tool.
Open the enterprise bean . jar file (or the EAR file containing the enterprise bean) and select the
Session Beans or Entity Beans object in the component tree on the left. The Unresolved Action property
is on the IBM Extensions tab of the container properties.

Attempt to start EJB module fails with "javax.naming.NameNotFoundException
dataSourceName_CMP"exception

This problem can occur because:
* When the DataSource resource was configured, container managed persistence was not selected.

— To confirm this problem, in the administrative console, browse the properties of the data source given
in the NameNotFoundException. On the Configuration panel, look for a check box labeled Container
Managed Persistence.

— To correct this problem, select the check box for Container Managed Persistence.

» If container managed persistence is selected, it is possible that the CMP DataSource could not be
bound into the namespace.

— Look for additional naming warnings or errors in the status bar, and in the hosting application server
JVM logs. Check any further naming-exception problems that you find by looking at the topic Cannot
look up an object hosted by WebSphere Application Server from a servlet, JSP file, or other client.

Transaction [tran ID] has timed out after 120 seconds accessing an enterprise
bean

This error can occur when a client executes a transaction on a CMP or BMP enterprise bean.

* The default timeout value for enterprise bean transactions is 120 seconds. After this time, the
transaction times out and the connection closes.

 If the transaction legitimately takes longer than the specified timeout period, go to Manage Application
Servers > server_name, select the Transaction Service properties page, and look at the property
Total transaction lifetime timeout. Increase this value if necessary and save the configuration.

Symptom:CNTRO0001W: A Stateful SessionBean could not be passivated
This error can occur when a Connection object used in the bean is not closed or nulled out.

To confirm this is the problem, look for an exception stack in the JVM log for the EJB container that hosts
the enterprise bean, and looks similar to:
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[time EDT] <ThreadID> StatefulPassi W CNTROOOIW:

A Stateful SessionBean could not be passivated: StatefulBeanO

(BeanId (XXX#YYY.jar#Z77Z, <ThreadID>),

state = PASSIVATING) com.ibm.ejs.container.passivator.StatefulPassivator@<ThreadID>
java.io.NotSerializableException: com.ibm.ws.rsadapter.jdbc.WSJdbcConnection

at java.io.ObjectOutputStream.outputObject((Compiled Code))

at java.io.ObjectOutputStream.writeObject (ObjectOutputStream.java(Compiled Code))
at java.io.ObjectOutputStream.outputClassFields((Compiled Code))

at java.io.ObjectOutputStream.defaultWriteObject ((Compiled Code))

at java.io.ObjectOutputStream.outputObject((Compiled Code))

at java.io.ObjectOutputStream.writeObject (ObjectOutputStream.java(Compiled Code))
at com.ibm.ejs.container.passivator.StatefulPassivator.passivate((Compiled Code))

at com.ibm.ejs.container.StatefulBean0.passivate((Compiled Code)

at com.ibm.ejs.container.activator.StatefulASActivationStrategy.atUnitOfWorkEnd
((Compiled Code))

at com.ibm.ejs.container.activator.Activator.unitOfWorkEnd((Compiled Code))

at com.ibm.ejs.container.ContainerAS.afterCompletion((Compiled Code)

where XXX,YYY,ZZZ is the Bean's name, and <ThreadlD> is the thread ID for that run.

To correct this problem, the application must close all connections and set the reference to null for all
connections. Typically this activity is done in the ejbPassivate() method of the bean. See the enterprise
bean specification mandating this requirement, specifically section 7.4 in the EJB specification Version 2.1.
Also, note that the bean must have code to reacquire these connections when the bean is reactivated.
Otherwise, there are NullPointerExceptions when the application tries to reuse the connections.

Symptom: org.omg.CORBA.BAD_PARAM: Servant is not of the expected type.
minor code: 4942F21E completed: No

This error can be returned to a client program when the program attempts to execute an EJB method.

Typically this problem is caused by a mismatch between the interface definition and implementation of the
client and server installations, respectively.

Another possible cause is when an application server is set up to use a single class loading scheme. If an
application is uninstalled while the application server remains active, the classes of the uninstalled
application are still loaded in the application server. If you change the application, redeploy and reinstall it
on the application server, the previously loaded classes become back level. The back level classes cause
a code version mismatch between the client and the server.

To correct this problem:

1. Change the application server class loading scheme to multiple.

2. Stop and restart the application server and try the operation again.
3. Make sure the client and server code version are the same.

Developing enterprise beans

In selecting a tool for developing enterprise beans, there are two basic approaches, with or without an
IDE. The steps in this article explain development without an IDE.

Design a J2EE application and the enterprise beans that it needs.
* For general design information, see "Resources for learning.”
» Before developing entity beans with container-managed persistence (CMP), read "Concurrency control.”

There are two basic approaches to selecting tools for developing enterprise beans:

* You can use one of the available integrated development environments (IDEs). IDE tools automatically
generate significant parts of the enterprise bean code and contain integrated tools for packaging and
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testing enterprise beans. The IBM WebSphere Application Developer product is the recommended IDE.
For more information, see the documentation for that product.

» If you have decided to develop enterprise beans without an IDE, you need at least an ASCII text editor.
You can also use a Java development tool that does not support enterprise bean development. You can
then use tools available in the Java Software Development Kit (SDK) and in this product to assemble,
test, and deploy the beans.

The following steps primarily support the second approach, development without an IDE.

1. If necessary, |migrate any pre-existing code| to the required version of the Enterprise JavaBeans (EJB)
specification.

2. Write and compile the components of the enterprise bean.

* At a minimum, an EJB 1.1 session bean requires a bean class, a home interface, and a remote
interface. An EJB 1.1 entity bean requires a bean class, a primary-key class, a home interface, and
a remote interface.

* At a minimum, an EJB 2.x session bean requires a bean class, a home or local home interface, and
a remote or local interface. An EJB 2.x entity bean requires a bean class, a primary-key class, a
remote home or local home interface, and a remote or local interface. The types of interfaces go
together: If you implement a local interface, you must define a local home interface as well.

Note: Optionally, the primary-key class can be unknown. See|unknown primary-key class|for more
information.
* A message-driven bean requires only a bean class.

3. For each entity bean, complete work to handle persistence operations.
* Create a database schema for the entity bean’s persistent data.

— For entity beans with container-managed persistence (CMP), you must store the bean’s
persistent data in one of the supported databases. The Application Service Toolkit automatically
generates SQL code for creating database tables for CMP entity beans. If your CMP beans
require complex database mappings, it is recommended that you use the IBM Rational
Application Developer product to generate code for the database tables.

— For entity beans with bean-managed persistence (BMP), you can create the database and
database table by using the database tools or use an existing database and database table.

For more information on creating databases and database tables, consult your database
documentation.
+ (CMP entity beans for EJB 2.x only) [Define finder queries|with EJB Query Language (EJB QL).

With EJB QL, you define finders in terms of CMP fields and container-managed relationships, as

follows:

— Public finders are visible in the bean’s home interface. Implemented in the bean class, they
return only remote interfaces and collection types.

— Private finders, expressed as SELECT statements, are used only within the bean class. They can
return both local and remote interfaces, dependent values, other CMP field types, and collection
types.

* (CMP entity beans for EJB 1.1 only: an IBM extension) Create a finder helper interface for each

CMP entity bean that contains specialized finder methods (other than the findByPrimaryKey

method).

The following logic is required for each finder method (other than the findByPrimaryKey method)

contained in the home interface of an entity bean with CMP:

— The logic must be defined in a public interface named NameBeanFinderHelper, where Name is the
name of the enterprise bean (for example, AccountBeanFinderHelper).

— The logic must be contained in a String constant named findMethodName WhereClause, where
findMethodName is the name of the finder method. The String constant can contain zero or more
guestion marks (?) that are replaced from left to right with the value of the finder method’s
arguments when that method is called.

[Assemble the beans in one or more EJB modules |
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Developing read-only entity beans
In addition to the existing EJB caching options, you can develop read-only entity beans.

You are most likely to want to use it under the following conditions:

* Your application uses data that change relatively infrequently. An example might be a retailing
application that uses pricing data that only changes once a week or month.

* Your application can tolerate data that may be stale. The degree of “staleness” that the EJB container
allows is configurable by the user.

* The bean is coded in a thread-safe manner, so it can safely be invoked by multiple threads at once.

To use this function, you declare the bean type as read-only the same way you currently select the bean
caching options, through a selection list within the application assembly tooling (either WebSphere
Application Developer or the Application Server Toolkit).

1. Start your assembly tool.
2. Call up the parameter selection list as you normally do.
3. Set the Activate At parameter to ONCE. This is the same as for standard option A caching.

4. Set the Load At parameter to either INTERVAL, DAILY, or WEEKLY.

INTERVAL
causes the bean to be reloaded if a certain time interval has been exceeded since the last
time the bean was loaded.

DAILY causes the bean to be reloaded on the first business method invocation that occurs after a
specified time on the host computer’s local time-of-day clock.

WEEKLY
is similar to DAILY except it occurs once per week at a specified time.

5. Set the Reload Interval parameter to a nonnegative integer value. The meaning of this parameter
depends on whether the Load At parameter is INTERVAL, DAILY, or WEEKLY.

INTERVAL
the integer represents the number of minutes that can elapse (since the last time the bean was
loaded) before the EJB container reloads the bean’s state from persistent storage. A value of 0
is permissible and causes the container to never reload the state of the bean.

DAILY the integer represents an absolute time each day that the reload is performed after, expressed
in what is commonly called the 24-hour clock. That is, a whole number between 0000 and
2359, where 0000 represents midnight, 1200 represents noon, and 2359 represents one
minute before midnight. Any leading zeroes on this number are optional. In the case of
malformed values (for example, 1285), the resulting clock time is always computed by taking
the minutes value from the two least-significant digits and adding that to the hour value taken
from the digit or digits to the left of the two least-significant ones. Thus, a value of 1285 will be
interpreted as 1325 (85 minutes after 1200). Any values exceeding 2359, as well as negative
or nonnumeric values, are interpreted as 0000.

WEEKLY
the integer is encoded in the same manner as daily, except it must be five digits in length, the
first digit representing the day of the week. Sunday is encoded as 1 and Saturday is encoded
as 7. If the value is four digits or less, it is treated as if it were five digits long with the first digit
being 1.
Reloading is performed only in response to a business method invocation on the bean. When a
business method is invoked, the EJB container checks to see whether either the reload interval time
has expired or the absolute clock time for that day has passed (depending on whether INTERVAL,
DAILY, or WEEKLY was used). If so, the container reloads the bean state.

When a read-only entity bean is invoked within a global transaction and the reload interval expires
while the transaction is active, business method calls on the bean during that transaction continue to
see the non-reloaded state of the bean for the duration of that transaction. That is, a snapshot of the
bean state is effectively taken on the first business method invocation on that bean during a
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transaction, and that state continues to be in effect for that transaction until it completes. New
invocations on that bean performed in a different transaction after the reload see the reloaded state.

Example: read-only entity bean
A usage scenario and example for writing an EJB application that uses a read-only entity bean.

Usage Scenario

A customer has a database of catalog pricing and shipping rate information that is updated daily no later
than 10:00 PM local time (22:00 in 24-hour format). They want to write an EJB application that has
read-only access to this data. That is, this application never updates the pricing database. Updating is
done through some other application.

Example

The customer’s entity bean local interface might be:
public interface ItemCatalogData extends EJBLocalObject {

public int getItemPrice();
public int getShippingCost(int destinationCode);

}

The code in the stateless SessionBean method (assume it's a TxRequired) that invokes this EntityBean to
figure out the total cost including shipping, would look like:

// Some transactional steps occur prior to this point, such as removing the item from
// inventory, etc.
// Now obtain the price of this item and start to calculate the total cost to the purchaser

ItemCatalogData theltemData =
(ItemCatalogData) ItemCatalogDataHome.findByPrimaryKey(theCatalogNumber);

int totalcost = theltemData.getItemPrice();

/] ... some other processing, etc. in the interim
/] ...
/...

// Add the shipping costs
totalcost = totalcost + theltemData.getShippingCost(theDestinationPostalCode);

At application assembly time, the customer sets the EJB caching parameters for this bean as follows:
» ActivateAt = ONCE

* LoadAt = DAILY

* Reloadinterval = 2200

On the first call to the getltemPrice() method after 22:00 each night, the EJB container reloads the pricing
information from the database. If the clock strikes 22:00 between the call to getltemPrice() and
getShippingCost(), the getShippingCost() method still returns the value it had prior to any changes to the
database that might have occurred at 22:00, since the first method invocation in this transaction occurred
prior to 22:00. Thus, the item price and shipping cost used remain in sync with each other.

WebSphere extensions to the Enterprise JavaBeans specification

This article outlines extensions to the Enterprise JavaBeans (EJB) specification that IBM provides with this
product.
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Inheritance in enterprise beans

In the Java language, inheritance is the creation of a new class from an existing class or a new interface
from an existing interface. This product supports two forms of inheritance: standard class inheritance and
EJB inheritance.

In standard class inheritance, the home interface, remote interface, or enterprise bean class inherits
properties and methods from base classes that are not themselves enterprise bean classes or interfaces.

By contrast in enterprise bean inheritance, an enterprise bean inherits properties (such as
container-managed persistence (CMP) fields and container-managed relationship (CMR) fields), methods,
and method-level control descriptor attributes from another enterprise bean.

For more information, see the documentation for the IBM Rational Application Developer product.

Optimistic concurrency control for container-managed persistence

This product supports optimistic concurrency control of data access. See [‘Concurrency control” on page]

for more information.

Access intents for EJB persistence

This product supports the application of named data-access policies.

Sequence grouping for container-managed persistence

By designating CMP sequence groups for entity beans, you can [prevent certain types of database-related
from occurring during the run time of your EJB application. Within each group you specify the

order in which the beans update your relational database tables. See|[*Setting the run time for CMP|
lsequence groups” on page 187|for instructions.

Performance enhancements

Through the lifetime-in-cache settings, this product provides a way for you to improve performance for
beans that are only occasionally updated. For more information, see "Entity bean assembly settings.”

Some enterprise beans created with the IBM Rational Application Developer product can utilize
read-ahead for loading a bean and its related beans in a single database operation. An entire object graph
or any part of the graph can be preloaded by configuring a finder method to use read-ahead.

Assembly and deployment extensions

This product supports IBM extensions of assembly] and deployment options.

Best practices for developing enterprise beans

Use the following guidelines when designing and developing enterprise beans.

* Use a stateless session bean to act as the entry point for business logic. For more information about
using session facades, see "Resources for learning.”

» Entity beans should use container-managed persistence.

* In an Enterprise JavaBeans (EJB) Version 2.x environment, use local interfaces to improve
communication between enterprise beans in the same Java virtual machine.

Local calls avoid the overhead of RMI/IIOP and use pass-by-reference semantics instead of
pass-by-value. For each call, the caller and callee beans share the state of arguments. EJB 2.x beans
can have both a local and remote interface but more typically have one or the other.
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* For communicating with remote clients, provide remote and remote home interfaces. For communicating
with local clients like servlets, entity beans, and message-driven beans, provide local and local home
interfaces.

Batched commands for container managed persistence

From JDBC 2.0 on, PreparedStatement objects can maintain a list of commands that can be submitted
together as a batch. Instead of multiple database round trips, there is only one database round trip for all
the batched persistence requests.

You can enable the use of this feature for EJB container managed persistence. When you do, the run time
defers ejbStore/ejbCreate/ejpbRemove or the equivalent database persistence requests
(insert/update/delete) until they are needed. This can be at the end of the transaction, or when a flush is
needed for finders related to this EJB type. When the persistence operation finally happens, run time
accumulates the database requests and uses JDBC PreparedStatement batch operation to make a single
JDBC call for multiple rows of the same operation.

The WebSphere Application Server enables you to make the same settings using the Application Server
Toolkit (AST).

Deferred Create for container managed persistence

The specification for Enterprise JavaBeans (EJB) 2.x states that for Container Managed Persistence
(CMP) during the ejbCreate, the container can create the representation of the entity in the database
immediately, or defer it to a later time.

The WebSphere Application Server versions 5.0.2 and later enable you to take advantage of this
specification. You can turn this option on from the EJB CMP side. When you choose this option, the
runtime defers ejbCreate (or the equivalent database persistence request) until it is needed. This can be at
the end of the transaction, or when a flush is needed for finders related to this EJB type. By doing this you
can reduce two round trips for the newly created entity (insert and update) to one (insert).

The WebSphere Application Server enables you to make the same settings using the Application Server
Toolkit (AST).

Partial column updates for container managed persistence

Previously, the WebSphere Application Server implementation of the Container Managed Persistence
(CMP) bean method ejbStore always stored all of the persistent attributes of the CMP bean to the
database, even if only a subset of persistent attribute fields were changed. This needless performance
degradation is eliminated in this release of the product.

For Enterprise JavaBeans (EJB) 2.x CMP entity beans, you can use the partial update feature to specify
how you want to update the persistent attributes of the CMP bean to the database. This feature is
provided as a bean level persistence option, called PartialOperation, in the access intent policy configured
for the bean. PartialOperation has two possible values:
NONE Partial update is turned off. All of the persistent attributes of the CMP bean are stored to the
database. This is the default value.
UPDATE_ONLY
Specifies that updates to the database occur only for the persistent attributes of the CMP bean
that are changed.

For information on how to set partial update, see |"Setting partial update for container-managed persisteml
lbeans” on page 156

Affects on performance
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Performing partial updates increases performance in several ways:

* by reducing query execution time, since only a subset of the columns are in the query. Improvement is
higher for tables with many columns and indexes. When the table has many indexes only the indexes
affected by the updated columns need to be updated by the backend database.

* by reducing network i/o since there is less data to be transmitted.

* by saving any processing time for non-trivially mapped columns (if a column uses converters/
composers/transformations), by partially injecting the input record.

» by eliminating unnecessary firing of update triggers. If a CMP bean field is not changed, any trigger
depending only on the corresponding column is not fired.

Although partial update improves performance in general, it can adversely affect performance too.

» If you enable partial update for a bean for which your application modifies several different combinations
of columns during the same time span, then the prepared statement cache maximum for the connection
is reached very quickly. As a result, statement handles are evicted from the cache based on least recent
usage. This results in statements being prepared again and again, decreasing performance for all CMP
functions (not just limited to ejbStore()).

» Partial update query templates cached in the function set increase memory use. The increase is linear
relative to the number of fields in the CMP bean for which the partial update access intent option is
turned on.

* The PartialOperation persistent option, when used in combination with the Batch Update persistent
option, affects the performance of the batch update because now each partial query is different. There
is an execution time cost incurred for generating a partial update query string dynamically. Since query
fragments are stored for each column, the execution cost to assemble the query fragments is linear,
based on the number of CMP bean fields dirtied.

* There are condition checks for each CMP field (for example to inspect the dirty flags, to execute the
preparedStatement setXXX() calls, and so on).

Considerations for using partial update

The performance gains you hope to achieve should be weighed against the possible instances where

degradation can occur. You can use the following guidelines to help you make the decision.

» Partial update might not benefit an application that only involves a small table (few columns) with
simple data types and no update triggers. The cost to assemble the partial query dynamically would
probably outweigh the performance gain.

» Partial update is a benefit if there is a complex data type that is not updated often. An example of a
complex data type might be an employee bean with a “photo” CMP attribute mapped to a BLOB OR
VARGRAPHIC or similar complex backend type that is typically stored in a different location in the
database manager implementation.

» Partial Update might benefit if there are several VARCHAR type columns and only a very few of them
are updated typically.

» It is better not to use the partial operation if the application can randomly be updating different
combinations of columns and the number of assignable columns (non-key) is higher than five. This
generates many different partial queries and fills up the prepared statement cache quickly. But if the
bean does not have too many columns (four or less) and it has complex data types, then you might
consider turning partial update on, with the option of increasing the statement cache size to allow for the
increased number of queries. For information on increasing the statement cache size, refer to Data
source settings.

» Partial Update is beneficial when there are update triggers needed on a subset of columns.

» Partial Update is beneficial when the table has many columns and indexes and only a few indexes are
touched by a typical update.

Restrictions
By default, batch update of update queries is disabled for all CMP beans for which partial update is
enabled. In other words, partial update takes precedence over batch update. Batch update of delete and

insert queries is not affected.
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Batch update performance is affected when both batch update and partial update persistence options are
used on the same bean, because each partial query is different. You can use the JVM property
-Dcom.ibm.ws.pm.grouppartialupdate=true to group the similar partial update queries into a batch update.
Grouping of partial updates only helps when there are several partial queries with the same shape in a
transaction. Otherwise, grouping partial updates has the opposite affect on performance. Because this
setting is not on a bean level basis, you should be careful when turning it on. Because this affects all
beans that have both partial update and batch update on, you must make sure that batch update of partial
queries does indeed increase performance when viewed across all the beans for which both updates are
on.

So you should determine which situation gives the best performance for your application: batch update
only or partial update only or both (with grouppartialupdate flag set to true).

To set the JVM property:

1. Open the server.xml file.
2. Change the value of -Dcom.ibm.ws.pm.grouppartialupdate=true to
-Dcom. ibm.ws.pm.grouppartialupdate=false.

Explicit invalidation in the Persistence Manager cache

Container managed persistence (CMP) entity beans can be configured as long-lifetime beans. A
long-lifetime bean is one that is configured with Lifetime In Cache Usage equal to a value other than the
default OFF . A value other than OFF means that data for this bean is cached beyond the end of the
transaction in which the bean was obtained by a finder or other method. The Lifetime In Cache Usage and
Lifetime In Cache values control the basic length of time the cached data remains valid. When the
specified time runs out, the cached data is no longer valid. See the LifetimelnCache help sections of the
Assembly Service Toolkit (AST) for more details.

However, there is also an API that lets the client application code explicitly invalidate the cached data of a
bean on demand, superseding the basic lifetime of the cache data as controlled by the Lifetime In Cache
Usage and Lifetime In Cache settings. This is useful where an application that does not use CMP beans
modifies the data that underlies a CMP bean (for example, it updates a database table to which a CMP
bean is mapped). Such an application can inform WebSphere Application Server that any cached version
of this bean data is stale and no longer matches what is in the database. The data should be invalidated
(in essence, discarded). For CMP beans that cannot tolerate stale data, this is an important feature.

Because the PM Cache Invalidation mechanism does consume resources in exchange for its benefits, it is
not enabled by default. To enable it refer to[Setting Persistence Manager Cache Invalidation|.

Example: Explicit invalidation in the persistence manager cache:

The usage scenario for this feature begins with configuring one or more bean types to be long-lifetime
beans and configuring the necessary Java Message Service (JMS) resources, which is described below.
After this is done, the server is started.

Usage Scenario

The scenario continues as follows:

1. Assume that a CMP entity bean of type Department has been configured to be a long-lifetime bean.

2. Transaction 1 begins. Application code looks up Departments home and calls a finder method (such
as findByPrimaryKey("dept01"”) ). As this is the first finder to return Department dept01, a trip is made
to the database to obtain the data. Transaction 1 ends.

3. Transaction 2 begins. Application code calls findByPrimaryKey("dept01") again. Because this is not the
first finder to return Department dept01, we get a cache hit and no database trip is made. Transaction
2 ends. So far this is current WebSphere Application Server behavior for long-lifetime beans.
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4. Another application, which does not use the Department CMP bean, is executed. This application
might or might not be run on WebSphere Application Server; it could be a legacy application. The
application updates the database table that is mapped to the Department bean, altering the row for
dept01. For example, the budget column in the table (mapped to a Java double CMP attribute in the
Department bean) is changed from $10,000.00 to $50,000.00. This application was designed to
cooperate with WebSphere Application Server. After performing the update, the application sends an
invalidate request message to invalidate the (now incorrect) cached data for Department bean dept01.

5. Transaction 3 begins. Application code looks up Departments home and calls a finder method (such
as findByPrimaryKey(" dept01”) ). Because this is the first finder after Department dept01 is invalidated,
a new database trip is made to obtain the data. Transaction 3 ends.

Persistence Manager cache invalidation API

The PM cache invalidation API is in the form of a JMS message that the client sends to a specially named
JMS topic using a connection from a specifically named JMS TopicConnectionFactory. The JMS message
must be an ObjectMessage created by the client. The client code creates a PMCachelnvalidationRequest
object that describes the bean data to invalidate. Client code places the PMCachelnvalidationRequest
object in the ObjectMessage and publishes the ObjectMessage (for further details on the JMS objects and
terms used here, please see documentation).

The public class PMCachelnvalidationRequest is central to the API, so we include a portion of its code
here for illustration purposes (if you see any differences between this illustration and the actual class, the
class is to be considered correct):

packagecom. ibm.websphere.ejbpersistence;

[**

*An instance of this class represents a request to invalidate one or more
*CMP beans in the PM cache. When an invalidate occurs, cached data for this
*bean is removed from the cache; the next time an application tries to find
*this bean, a fresh copy of the bean data is obtained from the data store.
*

*The ability to invalidate a bean means that a CMP bean may be configured
*as a long-Tifetime bean and thus be cached across transactions for much
*greater performance on future attempts to find this bean. Yet when some
*outside mechanism updates the bean data, sending an invalidation request
*will remove stale data from the PM cache so applications do not behave falsely
*based on stale data.

*/

public class PMCacheInvalidationRequestimplementsSerializable{

[**
* Constructor used to invalidate a single bean
* @param beanHomeJNDIName the JNDI name of the bean home. This is the same value
* used to look up the bean home prior to calling findByPrimaryKey, for example.
* @param beanKey the primary key of the bean to be invalidated. The actual
* object type must be the primary key type for this bean type.
*
/
public PMCacheInvalidationRequest(String beanHomeJNDIName, Object beanKey)
throws IOException {

}

[x%

* Constructor used to invalidate a Collection of beans

@param beanHomeJNDIName java.lang.String the JNDI name of the bean home.
* This is the same value used to look up the bean home prior to calling

* findByPrimaryKey, for example.

* @param beanKeys a Collection of the primary keys of the beans to be

* invalidated. The actual type of each object in the Collection must be the
*

x/

*

primary key type for this bean type.
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public PMCacheInvalidationRequest(String beanHomeJNDIName, Collection beanKeys)
throws IOException {

[x%

* Constructor used to invalidate all beans of a given type

* @param beanHomeJNDIName java.lang.String the JNDI name of the bean home.
* This is the same value used to look up the bean home prior to calling

* findByPrimaryKey, for example.

*/

public PMCacheInvalidationRequest(String beanHomeJNDIName) {

)
}

If the client wants to perform the invalidation in a synchronous way, it can opt to receive an
acknowledgement JMS message when the invalidation is complete. To ask for an acknowledgement (ACK)
message, the client sets a Topic of its own choosing in the JMSReplyTo field of the ObjectMessage for the
invalidation request (see the Java Message Service documentation for further details). The client then
waits (using the receive() method of JMS) on receipt of the acknowledgement message before continuing
execution.

An ACK message enables the caller to insure there is not even a brief (seconds or less) window during
which PM cache data is stale. The sending of an acknowledgement for each request does, of course, take
a bit more time and so is recommended to be used only when needed.

The JMS resources used to make an invalidation request--topic connection factory, topic destination
(sometimes called just "topic”), and so forth--must be configured by the user (using the administrative
console or other method) if they want to use PM Cache Invalidation. In this way the user can chose
whichever JMS provider is preferred (as long as it supports pub-sub). The names that must be used for
these resources are defined as part of the APIl. These names are unique to the WebSphere Application
Server namespace to avoid name conflict with customer JMS resources.

The following are the names that must be used when the user configures the JMS resources (shown as
Java constants for clarity):
// The JINDI name of the topic connection factory
private static final String topicConnectionFactoryJNDIName = "com.ibm.websphere.ejbpersistence.InvalidateTCF";
// The JINDI name of the topic destination
private static final String topicDestinationJNDIName = "com.ibm.websphere.ejbpersistence.invalidate";
// The topic name (part of the topic destination)
private static final String topicString = "com.ibm.websphere.ejbpersistence.invalidate";

Other JMS configuration, such as bus name (required if you choose the default messaging JMS provider),
can use names you define. Also, the bus used by the invalidate JMS resources can be used by other
resources; the invalidate mechanism does not require exclusive use of a bus.

Here are examples of how these constants can be used in client code:

// Look up the topic connection factory...
InitialContext ic = new InitialContext();
TopicConnectionFactory topicConnectionFactory = (TopicConnectionFactory) ic.lookup(topicConnectionFactoryJNDIName);

// Look up the topic
Topic topic = (Topic) ic.lookup(topicDestinationJNDIName);

Note that IMS messages can be sent not only from J2EE application code (for example, a SessionBean
or BMP entity bean method) but also from non-J2EE applications if your chosen JMS provider allows for
this. For example, the IBM MQ Client product installed on a database server, which typically does not have
J2EE installed to create a topic connection and topic that are compatible with the topic connection factory
and topic destination you configure using the WebSphere Application Server administrative console.
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Setting the run time for batched commands with JVM arguments
This article explains how to set the run time for batched commands with JVM arguments.
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Open the administrative console.

Select Servers.

Select Application Servers.

Select the server you want to configure.

In the Additional Properties area, select Process Definition.

In the Additional Properties area, select Java Virtual Machine.

Update the Generic JVM arguments with -Dcom.ibm.ws.pm.batch=true.

Setting the run time for batched commands with the assembly tools
This article explains how to set the run time for batched commands using the Application Server Toolkit.

1.

© © N o u

10.

11.

Start an assembly tool. Refer to Starting WebSphere Application Server Toolkit in the Application
Server Toolkit documentation.

On the Project Explorer tab, click EJB Modules > project > ejpModule > META-INF > ejb-jar.xml
The EJB Deployment Descriptor window appears.

Select the Access tab. The Add Access Intent window appears. There are two areas of the panel that
deal with adding access intent:

» Default Access Intent for Entities 2.x (Bean Level)
* Access Intent for Entities 2.x (Method Level)

Select the Bean or Method level. Another access intent window appears where you can set the
properties you wish to use.

Use the dropdown list to select the Access intent name.

Optional: Enter a description.

Check the Persistence Option box.

Check the Deferred Operation box.

Use the dropdown list to select All for deferred operation. You must select All to use the batch option.

Check the Batch box. This operation uses the JDBC batch command to insert, update, or delete
rows in the database backend that this particular enterprise bean is connected to.

Select Finish.

Setting the run time for deferred create with JVM arguments

The specification for Enterprise JavaBeans (EJB) 2.x states that for Container Managed Persistence
(CMP) during the ejbCreate, the container can create the representation of the entity in the database
immediately, or defer it to a later time.

When you choose the defer option, the run time defers ejbCreate (or the equivalent database persistence
request) until it is needed. This can be at the end of the transaction, or when a flush is needed for finders
related to this EJB type. By doing this you can reduce two round trips for the newly created entity (insert
and update) to one (insert).
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Open the administrative console.

Select Servers.

Select Application Servers.

Select the server you want to configure.

In the Additional Properties area, select Process Definition.

In the Additional Properties area, select Java Virtual Machine.

Update the Generic JVM arguments with -Dcom.ibm.ws.pm.deferredcreate=true.
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Setting the run time for deferred commands with the assembly tools
To set the run time for deferred commands using the assembly tools, follow these steps.
1. Start the Application Server Toolkit.

2. On the Project Explorer tab, click EJB Modules > project > ejpbModule > META-INF > ejb-jar.xml
The EJB Deployment Descriptor window appears.

3. Select the Access tab. The Add Access Intent window appears. There are two areas of the panel that
deal with adding access intent:

« Default Access Intent for Entities 2.x (Bean Level)
* Access Intent for Entities 2.x (Method Level)

4. Select the Bean or Method level. Another access intent window appears where you can set the
properties you wish to use.

Use the dropdown list to select the Access intent name.

Optional: Enter a description.

Check the Persistence Option box.

Check the Deferred Operation box.

Use the dropdown list to select your choice for deferred operation. You have three options for
deferred operation:

NONE Nothing is deferred.

CREATE_ONLY
Only ejbCreate commands are deferred until the next ejbStore occurs to create row in
database.
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ALL All ejbCreate, ejbStore, and ejpRemove commands are deferred until a flush is needed,
which is either before a finder method or before transaction completion.

10. Select Finish.

Setting partial update for container-managed persistent beans

For Enterprise JavaBeans (EJB) 2.x CMP entity beans, you can use the partial update feature to specify
how you want to update the persistent attributes of the CMP bean to the database. This feature is
provided as a bean-level persistence option, called PartialOperation, in the access intent policy configured
for the bean.

1. Start the Application Server Toolkit.

2. Open the J2EE perspective to work with J2EE projects. Click Window > Open Perspective > Other >
J2EE.

3. Open the Project Explorer view. Click Window > Show View > Project Explorer.

4. Open the EJB Deployment Descriptor. Click EJB Projects > project > ejpModule > META-INF >
ejb-jar.xml. The Deployment Descriptor editor opens.

5. In the Deployment Descriptor editor, select the Access tab. The access page opens.

6. In the Default Access Intent for Entities 2.x (Bean Level) section of the access page, select the
bean for which you want to set partial operation. If an access intent has already been configured for
this bean, click on the Edit button to edit the access intent policy. Otherwise, click on the Add button
to add an access intent policy to the bean. This opens the Add access intent window.

7. Select the Persistence Option check box if it is not already checked.

8. Select the Partial Operation check box. Use the drop-down list next to the Partial Operation check
box to select your preference.
NONE Partial update is turned off. All of the persistent attributes of the CMP bean are stored to the
database. This is the default value.
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UPDATE_ONLY
Specifies that updates to the database occur only for the persistent attributes of the CMP bean
that are changed.

9. Select Finish.

Setting Persistence Manager Cache invalidation

To set Persistence Manager Cache invalidation, follow these steps.

Open the administrative console.

Select Servers.

Select Application Servers.

Select the server you want to configure.

In the Server Infrastructure area, select Java and Process Management.

Select Process Definition.

In the Additional Properties area, select Java Virtual Machine.

Update the Generic JVM arguments with -Dcom.ibm.ws.ejbpersistence.cacheinvalidation=true.
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Unknown primary-key class

When writing an entity bean for Enterprise JavaBeans Version 2.1, the minimum requirements usually
include a primary-key class. However, in some cases you might choose not to specify the primary-key
class for an entity bean with container-managed persistence (CMP).

Perhaps there is no obvious primary key, or you want to allow the deployer to select the primary key fields
at deployment time. The primary key type is usually derived from the type used by the database system
that stores the entity objects, and you might not know what this key is.

So, the unknown key type is actually a type chosen at deployment time, making it changeable each time
the bean is deployed. Your client code must deal with this key as type Object.

Currently, WebSphere Application Server supports top-down mapping and enables the deployer to choose
String keys generated at the application server. For an example of how to use this function, see the
Samples library.

Configuring a Timer Service
To configure a timer service, follow these steps.
1. Open the administrative console.

2. Click Servers >Application Servers > servername > EJB Container Settings > EJB timer service
settings. The Timer Service settings panel is displayed.

3. If you want to use the internal, or pre-configured, scheduler instance, click the Use internal EJB timer
service scheduler instance radio button. If you choose not to change the default settings, this
instance is associated with a Cloudscape database. If you choose to customize the pre-configured
instance:

a. To change the data source (you can use any supported database, such as DB2 or Oracle), enter
your Data source JNDI name.

Enter your chosen Data source alias.

Enter your chosen Table prefix if you want to have several server processes use the same
database, but different tables.

d. Enter a Poll interval value in milliseconds.
e. If you want more timers to execute concurrently, enter a new value for Number of timer threads.

For more information about the fields, see ['EJB Timer Service settings” on page 159
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5.
6.

If you want to configure your own scheduler instance instead of using the pre-configured internal one,
click the Use custom scheduler instance radio button. Some reasons you might want to use your
own instance are:

* to change scheduler service configuration options not available for customization on this panel

* to keep EJB Timer tasks in the same database tables as your other tasks

e you are running in a Clustered environment and want to have a single scheduler instance handle all
of the EJB Timers for the cluster. This way, an ejbTimer Task created on one cluster member can
execute on a different cluster member.

To use your own instance, you must:

a. Configure a scheduler instance through the Scheduler Service graphical user interface. See
[schedulers” on page 1278|for information on how to do this.

b. Select your Scheduler JNDI name from the list.
Click Apply.
Click OK.

Configuring a Timer Service for network deployment
Use this task to configure the Enterprise JavaBeans (EJB) Timer Service to be used across multiple
servers.

This is largely a question of using the same data source. The steps that follow assume that you have
already created a database instance (for example, DB2 or Oracle). From there, you must configure the
Timer Service to use that database.

There are two ways to configure the Timer Service to share the same database across multiple servers.
Choose either step 1 or 2.

1. Configure a scheduler instance for the cluster, then configure the Timer Service to use that

scheduler instance.

a. Configure a scheduler instance for the cluster. This creates for you a custom scheduler instance.
Next you need to configure the Timer Service to use that custom instance.

b. Open the administrative console.

Click Servers >Application Servers > servername > EJB Container Settings > EJB timer
service settings. The Timer Service settings panel appears.

d. Select the Use custom scheduler instance radio button.
e. Select your Scheduler JNDI name from the dropdown list.
f. Click Apply.

g. Click OK.

Configure the Timer Service default scheduler instance for each server to use the same data

source.

a. Select the Use internal EJB timer service scheduler instance radio button. To customize the
pre-configured instance:

b. To change the data source (you can use any supported database, such as DB2 or Oracle) select
your Data source JNDI name from the dropdown list. The default database listed cannot be
shared, because it is configured to be visible to one server only, and it uses the single server
version of Cloudscape, which can only be accessed by one server process at a time.

c. Enter your chosen Datasource Alias.

d. Enter your chosen Table Prefix if you want to have several server processes use the same
database, but different tables.

e. Enter a Poll Interval value in milliseconds. For more information about the fields, see
[Service settings” on page 159

f. Click Apply.

o
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g. Click OK.

h. Change all of your server processes to use the same database you chose from the Data source
JNDI name dropdown list earlier.

Example: Timer Service
This example shows the implementation of the ejbTimeout() method that is called when the scheduled
event occurs.

The ejbTimeout method can contain any code normally placed in a business method of the bean.
Method-level attributes such as fransaction or runAs can be associated with this method by the application
assembler. An instance of the Timer object that causes the method to fire is passed in as an argument to
ejbTimeout().

import javax.ejb.Timer;

import javax.ejb.TimedObject;

import javax.ejb.TimerService;

public class MyBean implements EntityBean, TimedObject {

// This method is called by the EJB container upon Timer expiration.
public void ejbTimeout(Timer theTimer) {

// Any code typically placed in an EJB method can be placed here.
String whyWasICalled = (String) Timer.getInfo():

System.out.printIn("I was called because of"+ whyWasICalled);
} // end of method ejbTimeout

In this section, a Timer is created that executes the ejbTimeout() method in 30 seconds. A simple string
object is passed in at Timer creation to identify the Timer.

// instance variable to hold the EJB context.
private EntityContext theEJBContext;

// This method is called by the EJB container upon bean creation.
public void setEntityContext(EntityContext theContext) {

// save the entity context passed in upon bean creation.
theEJBContext = theContext;

}

// This business method cause the ejbTimeout method to invoke in 30 seconds.
public void fireInThirtySeconds() throws EJBException {

TimerService theTimerService = theEJBContext.getTimerService();
String alLabel = "30SecondTimeout";
Timer theTimer = theTinmerService.createTimer (30000, alabel);

} // end of method fireInThirtySeconds

} // end of class MyBean

EJB Timer Service settings
Use this page to configure and manage the EJB Timer Service for a specific EJB container.

To view this administrative console page, click Servers >Application Servers > servername > EJB
Container Settings > EJB Timer Service Settings.

The two radio buttons that appear on this page offer you choices that are mutually exclusive.

Scheduler Type:
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Use Internal EJB Timer Service Scheduler Instance:

WebSphere Application Server provides an internal scheduler instance for use by the EJB Timer Service.
The internal scheduler instance is pre-configured for basic EJB Timer functionality, and provides limited
configuration settings for an EJB Timer Service. Clicking this button specifies that you want to use the
internal scheduler instance to manage your tasks. They are persisted to a Cloudscape database
associated with the server process. Selecting this choice locks out the Use Custom Scheduler Instance
option.

This is the default choice.
Use Custom Scheduler Instance:

You can perform a more advanced configuration for the EJB Timer Service by defining a custom scheduler
instance. Scheduler configuration provides more configuration options than the internal EJB Timer Service
pre-configured scheduler instance. You might want to define a custom scheduler instance when running in
a clustered environment, allowing all cluster members to run with a single scheduler instance. This
enables EJB Timers created on one cluster member to execute on other cluster members. Providing a
custom scheduler instance also enables EJB Timers to be maintained in the same database as other
scheduled tasks. Selecting this choice locks out the Use Internal EJB Timer Service Scheduler Instance
option

Data source JNDI Name:

Specifies the Java Naming and Directory Interface (JNDI) name of the data source where persistent EJB
Timers are stored for this EJB container. Any data source available in the name space can be used for
EJB Timers. Multiple EJB containers can share a single data source while using different tables by
specifying a table prefix.

Data type String
Default jdbc/DefaultEJBTimerDataSource

Data source alias:

Authentication alias to a user name and password used to access the data source.

Data type String

Table prefix:

A string prepended to the EJB Timer Service table names (TASK, TREG, LMGR and LMPR). These tables
are created during server start if they do not already exist. See help on the Scheduler Service for
information about manually creating these tables. Multiple independent EJB Timer Services can share the
same database if each instance specifies a different prefix string.

Data type String
Default EJBTIMER_

Poll interval:

The interval at which the EJB Timer Service daemon polls the database. Each poll operation can be
expensive. If the interval is extremely small and there are many scheduled tasks, polling can consume a
large portion of system resources. New Timers set to expire sooner than this interval might not execute
until the interval ends. If this value is too large, a potentially large number of timer events might be read
into memory, because all the timer events occurring in the next poll interval are read in each time.

160 Developing and deploying applications



Data type Integer

Units seconds
Default 300
Range 3 -- 1800

Number of timer threads:

The number of threads used to execute concurrent EJB Timer tasks. Setting the number of Timer Threads
to zero disables the EJB Timer Service.

Data type Integer
Default 1
Range 0 -- 500
Scheduler JNDI name:

This field is only used when the Use Custom Scheduler Instance choice is made. It specifies the JNDI
name of a custom Scheduler instance to use for managing and persisting EJB Timers. Internal EJB Timer
Service Scheduler Instance configuration information is not applied to the specified Scheduler instance.

Data type String

Developing Enterprise JavaBeans 2.1 for the timer service

In WebSphere Application Server, the EJB Timer Service implements EJB Timers as a new kind of
Scheduler Service task. By default, an internal (or pre-configured) scheduler instance is used to manage
those tasks, and they are persisted to a Cloudscape database associated with the server process.

However, you can perform some basic customization to the internal scheduler instance. For information
about how to do this customization, see [‘Configuring a Timer Service” on page 157

Creation and cancellation of Timer objects are transactional and persistent. That is, if a Timer object is
created within a transaction and that transaction is later rolled back, the Timer object’s creation is rolled
back as well. Similar rules apply to the cancellation of a Timer object. Timer objects also survive across
application server shutdowns and restarts.

1. Write your enterprise bean to implement the javax.ejb. TimedObject interface, including the
ejbTimeout() method. The bean calls the EJBContext.getTimerService() method to get an instance of
the TimerServiceobject. The bean calls the TimerService method to create a Timer. This Timer is now
associated with that bean.

2. After you create it, you can pass the Timer instance to other Java code as a local object.

Note: For WebSphere Application Server Version 6, no assembly tooling supports the Enterprise
JavaBeans timedObject. To set the ejbTimeout method transaction attribute you must manually
enter the attributes in the deployment descriptor. See ['EJB Timer Service settings” on page 159|
for more information.

Clustered environment considerations for timer service

In a single server environment, it is clear which server instance should invoke the ejbTimeout() method on

a given bean. In a multi-server clustered environment there are two possibilities.

» Separate timer service database per server process or cluster member. This is the default configuration.
Only the server instance or cluster member that created the Timer can access the Timer and run the
ejbTimeout() method. If the server instance is unavailable, the Timer does not run at the specified time,
and does not run until the server is restarted. Also, if an enterprise bean calls the findTimers() method,
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only those timers created on the server instance are found. This can cause unexpected behavior if the
enterprise bean attempts to cancel all timers associated with it; for example, when the enterprise bean
is removed. This configuration is NOT recommended for production level systems.

» Shared or common timer service database for the cluster. Timers can be created and accessed on any
server process or cluster member. Timers created in one server process are found by the findTimers()
method on other server processes in the cluster. When an entity bean is removed, all timers, no matter
where created, are cancelled. However, all timers are executed on a single server in the cluster, that is,
the ejbTimeout() method is run for all timers on a single server. Which server executes the timers varies
depending on which server process obtains a lock on the common database tables. If the server
executing timers becomes unavailable, then another server or cluster member takes over and begins
executing all timers at their scheduled time. This is the recommended configuration for all production
level systems.

* A note about deadlock and access intent: When using the EJB Timer service in an application using
multi-threaded database access, application flow can introduce deadlock problems. To avoid this, use
the wsPessimisticUpdate This access intent causes the finder method in your application
to run a select for update statement instead of a generic select. This in turn prevents the lock escalation
deadlock when multiple threads try to escalate their locks to perform an update.

See [‘Configuring a Timer Service” on page 157 for information on how to configure the data source
(database) to be used for each server process timer service. Note that once the data source for the timer
service is changed to point to a different database, the server process automatically attempts to create the
required tables in that database on the next server start. If the userid associated with the start of the
server process is not authorized to create database tables in the configured timer service database, then
the tables must be created manually. For more information, see Creating scheduler tables using DDL files.

Timer service commands:

Information about EJB timers is generally specific to the application that creates the timers, and the timers
are not visible outside of the creating application. Therefore, management of EJB timers should be
performed by the application that contains the enterprise bean and that creates the EJB timer.

However, you can use the following commands during application development. They provide some basic
EJB timer management functions. These commands are not available on client only installs.

findEJBTimers
This command displays information about existing EJB timers based on specified filter criteria.

The syntax for this command is:

findEJBTimers server filter [options]
filter: -all | -timer | -app [-mod [-bean ]]
-all
-timer timer id
-app application name
-mod  module name
-bean bean name

options: -host host name
-port portnumber
-conntype connector type
-user userid
-password password
-quiet
-logfile filename
-replacelog
-trace
-help

162 Developing and deploying applications



where :

server the name of the server process where the EJB timers are located

-all find all EJB timers associated with the server process

timer id
EJB Timer ID that uniquely identifies the timer

application name
find all EJB timers associated with the application

module name
find all EJB timers associated with the module

bean name
find all EJB timers associated with the enterprise bean

host name
host name of the server process

portnumber
port of the server process

connector type
type of connection. For example, SOAP, RMI, or NONE.

userid user to use when connecting to the server process

password
password to use when connecting to the server process

quiet disable output
logfile directs output to a file

replacelog
clears the existing log before executing the command

trace enable trace

help  provides command-specific help

Note: If the server you specify is configured to use a scheduler instance that is shared by multiple
servers, then EJB timers created in any of the server processes might be found.

For an example of the findEJBTimers command, see[‘Example: FindEJBTimers command” on page 164.|

cancelEJBTimers

This command cancels and removes from persistent storage EJB timers based on the specified filter

criteria.

The syntax for this command is:

cancelEJBTimers server filter [options]
filter: -all | -timer | -app [-mod [-bean ]]
-all
-timer timer id
-app application name
-mod  module name
-bean bean name

options: -host host name
-port portnumber
-conntype connector type
-user userid
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-password password

-quiet

-logfile filename

-replacelog

-trace

-help
where :
server the name of the server process where the EJB timers are located
-all find all EJB timers associated with the server process

timer id
EJB Timer ID that uniquely identifies the timer

application name
find all EJB timers associated with the application

module name
find all EJB timers associated with the module

bean name
find all EJB timers associated with the enterprise bean

host name
host name of the server process

porthumber
port of the server process

connector type
type of connection. For example, SOAP, RMI, or NONE.

userid user to use when connecting to the server process

password
password to use when connecting to the server process

quiet disable output
logfile directs output to a file

replacelog
clears the existing log before executing the command

trace enable trace
help provides command-specific help

Note: If the server you specify is configured to use a scheduler instance that is shared by multiple
servers, then EJB timers created in any of the server processes might be cancelled.

For an example of the cancelEJBTimers command, see |“Example: CancelEJBTimers command” on pagel

Example: FindEJBTimers command:

The following examples illustrate how to use the command to find EJB timers and explain the output
statement.

To use the findEJBTimers command to find all Enterprise JavaBeans (EJB) timers on a server called
serverl:

findEJBTimers serverl -all
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To find all EJB timers on server1, associated with the Increment bean in the DefaultApplication:
findEJBTimers serverl -app DefaultApplication.ear -mod Increment.jar -bean Increment

When EJB timers matching the filter criteria are found, the output appears similar to this:

EJB Timer : 25 Expiration: Mon Feb 09 13:36:47 CST 2004 Repeating
EJB : DefaultApplication.ear Increment.jar Increment
EJB Key: 8
Info : Increment Counter

EJB Timer : 26 Expiration: Mon Feb 09 13:36:47 CST 2004 Single
EJB : DefaultApplication.ear Increment.jar Increment
EJB Key: 8
Info : Decrement Counter

2 EJB Timers found

In this output:

* The EJB Timer is the unique identifier of the timer.

» Expiration is the next time the timer is expected to execute.

* Repeating or Single indicates whether the EJB timer is single action or repeating.

* EJB Key is the toString() method output of the primary key for the Entity enterprise bean (not present
for other EJB types).

* Infois the toString() method output of the object passed by the application when the EJB timer was
created.

Only the first 40 bytes of toString() output are displayed for the Primary Key and Timer Info. This
information is only useful if the application overrides the toString() method for these objects.

Increment in the DefaultApplication does not implement the TimedObject interface, and so could not
actually have associated EJB Timers. Increment is used merely for illustrative purposes in this example.

Example: CancelEJBTimers command:
The following examples illustrate how to use the command to cancel EJB timers.

To use the cancelEJBTimer command to cancel all EJB timers on a server called serveri:
cancelEJBTimers serverl -all

To cancel all EJB timers on server1, associated with the Increment bean in the DefaultApplication:
cancelEJBTimers serverl -app DefaultApplication.ear -mod Increment.jar -bean Increment

To cancel a specific EJB timer identified through the FindEJBTimers command or from a system log entry
indicating a problem or failure:

cancelEJBTimers serverl -id 25

Increment in the DefaultApplication does not implement the TimedObject interface, and so could not
actually have associated EJB Timers. Increment is used merely for illustrative purposes in this example.

Web service support

WebSphere Application Server Version 6.0 complies with the Java 2 platform, Enterprise Edition (J2EE)
Enterprise JavaBeans (EJB) 2.1 specification by enabling you to expose an EJB stateless session bean as
Web service.

You can do this by simply declaring a link between the desired Endpoint name in the Web service

deployment descriptor of the EJB module. During deployment and installation of the bean into the
Application Server environment, the bean is linked to the specified Web service endpoint.
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If you are writing a stateless session bean to implement a preexisting Web Services Description Language
(WSDL) interface, you must remember to implement in your bean all of the methods defined on the WSDL
interface.

For more information, see [‘Developing a Web service from an enterprise bean” on page 439

Binding Web modules to virtual hosts

Web modules must be bound to specific virtual hosts. By associating a Web module to a specific host, you
are specifying that all requests that match this virtual host must be handled by the Web application
containing the binding.

1. Start the Application Server Toolkit.

2. Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open Perspective
> Other > J2EE.

In the J2EE view, select the Web module to open its deployment descriptor.
On the Overview page, find the WebSphere bindings section.

Specify the virtual host name.

Save the deployment descriptor.
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Binding EJB and resource references

Follow these steps to bind an enterprise bean local reference (or nickname) to a Java Naming and
Directory Interface (JNDI) name.

1. Start the Application Server Toolkit.

2. Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open Perspective
> Other > J2EE.

In the J2EE view, select the EJB module to open its deployment descriptor.
Switch to the References page.

Expand the tree under your chosen bean and select the appropriate reference.
In the WebSphere bindings section, specify the JNDI name.

Repeat these steps for all the references in the EJB module.

Save the deployment descriptor.
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Note: Reference bindings can be defined or overridden at deployment time in the administrative
console for all modules except for application clients. For those, you must use the Application
Server Toolkit.

Defining data sources for entity beans

Before an application that is installed on an application server can start, all enterprise bean (EJB)
references and resource references defined in the application must be bound to the actual artifacts
(enterprise beans or resources) defined in the application server.

Create a data source or JDBC resource and give it a Java Naming and Directory Interface (JNDI) name.

For more information, see [‘Application bindings” on page 1392

The following steps assume that the entity beans in your application are container-managed persistence
(CMP) enterprise beans. The EJB container handles the persistence of the bean attributes in the
underlying persistent store. You must specify which data store is used. You do this by binding an EJB
module or individual EJB to a data source.

If you bind an EJB module to a data source, all beans in that module use the same data source for
persistence. If you specify the data source at the bean level, then that data source is used instead.
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1. Start the Application Server Toolkit.

2. Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open Perspective
> Other > J2EE.

3. In the J2EE view, select the EJB module or individual EJB to open its deployment descriptor.

4. Find the WebSphere bindings section.

5. In the JNDI name field, enter the name of the data source or JDBC resource you want to use.

6. Specify whether the authentication is handled at the container or application level.

7. Save the deployment descriptor.

Lightweight local operational mode for entity beans

WebSphere Application Server provides a special operational mode called lightweight local mode, which
can improve the performance of entity bean methods. You can decide which entity beans in your
application to run in this mode.

In lightweight local mode, the container streamlines the processing that it performs before and after every
method on the local home interface and local business interface of the bean. This streamlining can result
in improved performance when entity bean operations are called locally from within an application.
Because some processing is skipped when running in lightweight local mode, this mode can be used in
certain scenarios only.

Lightweight local mode is patterned somewhat after the [Plain Old Java Object (POJO)| entity model
introduced in the Enterprise JavaBeans (EJB) 3.0 specification. Using lightweight local mode, you can
obtain some of the performance advantages of the POJO entity model without having to convert your
existing EJB 2.x application code to the new POJO model. You can apply lightweight local mode to both
container-managed persistence (CMP) and bean-managed persistence (BMP) entity types that meet the
specific criteria.

For more information about EJB containers, see [‘Enterprise beans: Resources for learning” on page 139

When to use the lightweight local mode

Lightweight local mode is designed for entity beans that are created, found, and called using the Session
Facade pattern. Under this pattern, entity bean local home and local business methods are called from
within methods of a stateless session bean or stateful session bean. The session bean methods, which
can be called remotely or locally, provide security control and transaction demarcation for the entity beans
that are accessed by the session bean.

You can apply lightweight local mode only to an entity bean that meets the following criteria:

* The bean implements an EJB local interface.

* No security authorization is defined on the entity bean local home or local business interface methods.

* No run-as security attribute is defined on the local home or local business methods.

* The classes for the calling bean and the called entity bean are loaded by the same Java classloader.

* The entity bean methods do not call the WebSphere Application Server-specific Internationalization
Service or Work Area Service.

The first criterion prevents CMP 1.x beans from supporting lightweight local mode, because the 1.x beans
cannot have local interfaces.

In addition, lightweight local mode provides its fullest performance benefits only to entity bean methods

that do not need to start a global transaction. This condition is true if you ensure that your entity bean also

meets the following criteria:

* A global transaction is already in effect when the entity bean home or business method is called.
Typically, this transaction is started by the calling session bean.
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* The local business interface methods and the local home methods of the entity bean use the following
transaction attributes only: REQUIRED, SUPPORTS, or MANDATORY.

If an entity bean method that is running in lightweight local mode must start a global transaction, the bean
still functions normally but only a partial performance benefit is realized.

You can mark an entity bean that defines a remote interface or a TimedObiject interface, in addition to the
local interface, for lightweight local mode. However, the performance benefit is apparent only when the
bean is called through its local interface.

Applying lightweight local mode to an entity bean

WebSphere Application Server provides a special operational mode called lightweight local mode, which
can improve the performance of entity bean methods. You can decide which entity beans in your
application to run in this mode.

You can apply lightweight local mode to specific EntityBean types within your application in two ways. You
can use application server tooling, or the Marker interface technique.

Using Application Server Tooling

Start the Application Server Toolkit.

Select the EJB deployment descriptor of the entity bean that you want to work with.
In the property pane, select the WebSphere Extension tab.

Check the box labeled Use Lightweight Local mode .

Select OK.

Save your changes.
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Marker interface technique

Use the marker interface technique when a group of beans within the application is related through a
common inheritance hierarchy, and all the beans in the hierarchy are to be marked. For an application with
a large number of beans in a hierarchy, this technique is the most efficient.

To use a marker interface, code your bean implementation class to implement the
com.ibm.websphere.ejbcontainer.LightweightLocal interface. The bean implementation class does not
need to directly implement the interface; any parent class or interface can also implement it. For details,
see the com.ibm.websphere.ejbcontainer package in the|API documentation section of the information
center.

Using access intent policies

You can use access intent policies to help the product runtime environment manage various aspects of
Enterprise JavaBeans (EJB) persistence.

You apply access intent policies to EJB Version 2.0 (and later) entity beans and their methods by using an

application assembly tool. A set of default access intent policies comes with theIAppIication Server Toolkid

(AST) .

1. Apply default access intent to CMP entity beans. For more information, see the online help available
with the Application Server Toolkit.

2. IAppIy access intent policies to methodsl of CMP entity beans.

Access intent policies

An access intent policy is a named set of properties (access intents) that governs data access for
Enterprise JavaBeans (EJB) persistence. You can assign policies to an entity bean and to individual
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methods on an entity bean’s home, remote, or local interfaces during assembly. You can set access
intents only within EJB Version 2.x-compliant modules for entity beans with CMP Version 2.x.

This product supplies a number of access intent policies that specify permutations of read intent and
concurrency control; the pessimistic/update policy can be qualified further. The selected policy determines
the appropriate isolation level and locking strategy used by the run time environment.

transition: Access intent policies are specifically designed to supplant the use of isolation level and
access intent method-level modifiers found in the extended deployment descriptor for EJB
version 1.1 enterprise beans. You cannot specify isolation level and read-only modifiers for
EJB version 2.x enterprise beans.

Access intent policies configured on an entity basis define the default access intent for that entity. The
default access intent controls the entity unless you specify a different access intent policy based on either
method-level configuration or application profiling.

Note: Method level access intent has been deprecated for Version 6.

You can use application profiling or method level access intent policies to control access intent more
precisely. Method-level access intent policies are named and defined at the module level. A module can
have one or many such policies. Policies are assigned, and apply, to individual methods of the declared
interfaces of entity beans and their associated home interfaces. A method-based policy is acted upon by
the combination of the EJB container and persistence manager when the method causes the entity to
load.

For entity beans that are backed by tables with nullable columns, use an optimistic policy with caution. The
top down default mapping excludes nullable fields. You can override this when doing a meet-in-middle
mapping. The fields used in overqualified updates are specified in the ejb-rdb mapping. If nullable columns
are selected as overqualified columns, then partial update should also be selected.

Note: When using DB2 for z/OS Version 8, nullable OCC columns create no problems. This is true for
JDBC and SQLJ deploy options, and partial and full update.

An entity that is configured with a read-only policy that causes a bean to be activated can cause problems
if updates are attempted within the same transaction. Those changes are not committed, and the process
throws an exception because data integrity might be compromised.

Concurrency control

Concurrency control is the management of contention for data resources. A concurrency control scheme is
considered pessimistic when it locks a given resource early in the data-access transaction and does not
release it until the transaction is closed. A concurrency control scheme is considered optimistic when locks
are acquired and released over a very short period of time at the end of a transaction.

The objective of optimistic concurrency is to minimize the time over which a given resource would be
unavailable for use by other transactions. This is especially important with long-running transactions, which
under a pessimistic scheme would lock up a resource for unacceptably long periods of time.

Under an optimistic scheme, locks are obtained immediately before a read operation and released
immediately afterwards. Update locks are obtained immediately before an update operation and held until
the end of the transaction.

To enable optimistic concurrency, this product uses an overqualified update scheme to test whether the
underlying data source has been updated by another transaction since the beginning of the current
transaction. With this scheme, the columns marked for update and their original values are added explicitly
through a WHERE clause in the UPDATE statement so that the statement fails if the underlying column
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values have been changed. As a result, this scheme can provide column-level concurrency control;
pessimistic schemes can control concurrency at the row level only.

Optimistic schemes typically perform this type of test only at the end of a transaction. If the underlying
columns have not been updated since the beginning of the transaction, pending updates to
container-managed persistence fields are committed and the locks are released. If locks cannot be
acquired or if some other transaction has updated the columns since the beginning of the current
transaction, the transaction is rolled back: All work performed within the transaction is lost.

Pessimistic and optimistic concurrency schemes require different transaction isolation levels. Enterprise
beans that participate in the same transaction and require different concurrency control schemes cannot
operate on the same underlying data connection.

best-practices: Whether or not to use optimistic concurrency depends on the type of transaction.
Transactions with a high penalty for failure might be better managed with a pessimistic
scheme. (A high-penalty transaction is one for which recovery would be risky or
resource-intensive.) For low-penalty transactions, it is often worth the risk of failure to
gain efficiency through the use of an optimistic scheme. In general, optimistic
concurrency is more efficient when update collisions are expected to be infrequent;
pessimistic concurrency is more efficient when update collisions are expected to occur
often.

Read-ahead hints

Read-ahead schemes enable applications to minimize the number of database round trips by retrieving a
working set of container-managed persistence (CMP) beans for the transaction within one query.
Read-ahead involves activating the requested CMP beans and caching the data for their related beans,
which ensures that data is present for the beans that an application most likely needs next. A read-ahead
hint is a representation of the related beans to read. The hint is associated with the findByPrimaryKey
method for the requested bean type, which must be an EJB 2.x-compliant CMP entity bean.

A read-ahead hint takes the form of a character string. You do not have to provide the string; the wizard
generates it for you based on the container-managed relationships (CMRs) that are defined for the bean.
The following example is provided as supplemental information only. Suppose a CMP bean type A has a
finder method that returns instances of bean A. A read-ahead hint for this method is specified using the
following notation: RelB.RelC; RelD

Interpret the preceding notation as follows:
* Bean type A has a CMR with bean types B and D.
* Bean type B has a CMR with bean type C.

For each bean of type A that is retrieved from the database, its directly-related B and D beans and its
indirectly-related C beans are also retrieved. The order of the retrieved bean data columns in each row of
the result set is the same as the order in the read-ahead hint: an A bean, a B bean (or null), a C bean (or
null), a D bean (or null). For hints in which the same relationship is mentioned more than once (for
example, RelB.RelC;RelB.RelE), the data columns for a bean occur only once in the result set, at the
position the bean first occupies in the hint.

The tokens shown in the notation (RelB and so on) must be CMR field names for the relationships, as
defined in the deployment descriptor for the bean. In indirect relationships such as RelB.RelC, RelC is a
CMR field name that is defined in the deployment descriptor for bean type B.

A single read-ahead hint cannot refer to the same bean type in more than one relationship. For example, if

a Department bean has an employees relationship with the Employee bean and also has a manager
relationship with the Employee bean, the read-ahead hint cannot specify both employees and manager.
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For more information about how to set read-ahead hints, see the documentation for the Rational
Application Developer product.

Run-time behaviors of read-ahead hints

When developing your read-ahead hints, consider the following tips and limitations:

* Read-ahead hints on long or complex paths can result in a query that is too complex to be useful.
Read-ahead hints on root or leaf inheritance mappings need particular care. Add up the number of
tables that potentially comprise a read-ahead preload to gauge the complexity of the join operations that
are required. Consider if the resulting statement constitutes a reasonable query on your target
database.

* Read-ahead hints do not work in the following cases:
— Preload paths across M:N relationships
— Preload paths across recursive enterprise bean relationships or recursive fk relationships

— When a read-head hint applies to a SELECT FOR UPDATE statement that requires a table join in a
database that does not support the combination of those two operations.

Generally, the persistence manager issues a SELECT FOR UPDATE statement for a bean only if the
bean has an access intent that enforces strict locking policies. Strict locking policies require SELECT
FOR UPDATE statements for database select queries. If the database table design requires a join
operation to fulfill the statement, many databases issue exceptions because these databases do not
support table joins with SELECT FOR UPDATE statements. In those cases, WebSphere Application
Server does not implement a read-ahead hint. If the database does provide that support, Application
Server implements the read-ahead hints that you configure.

DB2 Universal Database V8.2 supports SELECT FOR UPDATE statements with table joins.
— When a read-ahead hint contains a table join

Different access intents can result in requiring a SELECT FOR UPDATE statement. Check the matrix
on the JDBC driver and SELECT FOR UPDATE support to see if readAhead is enabled.

Database deadlocks caused by lock upgrades

To avoid databse deadlocks caused by lock upgrades, you can change the access intent policy for entity
beans from the default of wsPessimisticUpdate-WeakestLockAtLoad to wsPessimisticUpdate or can use
an optimistic locking approach.

When accessing data in a database concurrently, an application must be aware of and prepared for
database locking that must occur to insure the integrity of the data.

If an entity bean performs a findByPrimaryKey (which by default obtains a 'Read’ lock in the database),
and the entity bean is updated within the same transaction, then a lock upgrade (to 'Exclusive’) occurs.

If this scenario occurs on multiple threads concurrently, then a deadlock can happen. This is because
multiple 'Read’ locks can be obtained concurrently, but one 'Exclusive’ lock can be obtained only when all
other locks have been dropped. Because all transactions are attempting the lock upgrade in this scenario,
this one 'Exclusive’ lock can never be obtained .

To avoid this problem, you can change the access intent policy for the entity bean from the default of
wsPessimisticUpdate-WeakestLockAtLoad to wsPessimisticUpdate. This change in access intent enables
the application to inform WebSphere and the database that the transaction will update the enterprise bean,
and so an 'Update’ lock is obtained immediately on the findByPrimaryKey. This avoids the lock upgrade
when the update is performed later.

The preferred technique to define access intent policies is to change the access intent for the entire entity
bean. You can change the access intent for the findByPrimaryKey method, but this is deprecated in
Version 6.0. (You might want to change the access intent for an individual method if, for example, the
entity bean is involved in some transactions that are read only.)
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An alternative technique is to use an optimistic approach, where the findByPrimaryKey method does not
hold a 'Read’ lock, so there is no lock upgrade. However, this requires that the application is coded for
this, to handle rollbacks that could occur. Optimistic locking is really intended for applications that do not
expect database contention on a regular basis.

To change the access intent policy for an entity bean, you can use the assembly tool to set the "Default
Access Intent for Entities 2.x (Bean Level)” on the Access tab of the EJB Deployment Descriptor, as
described in I‘Applying access intent policies to beans” on page 174.|

Access intent assembly settings
Access intent policies contain data-access settings for use by the persistence manager. Default access
intent policies are configured on the entity bean.

These settings are applicable only for EJB 2.x-compliant entity beans that are packaged in EJB
2.x-compliant modules. Connection sharing between beans with bean-managed persistence and those with
container-managed persistence is possible if they all use the same access intent policy.

Name:

Specifies a name for a mapping between an access intent policy and one or more methods.

Description:

Contains text that describes the mapping.

Methods - Name:

Specifies the name of an enterprise bean method, or the asterisk character (*). The asterisk is used to
denote all of the methods of an enterprise bean’s remote and home interfaces.

Methods - Enterprise bean:
Specifies which enterprise bean contains the methods indicated in the Name setting.
Methods - Type:

Used to distinguish between a method with the same signature that is defined in both the home and
remote interface. Use Unspecified if an access intent policy applies to all methods of the bean.

Data type String
Range Valid values are Home, Remote,Local, LocalHome or
Unspecified

Methods - Parameters:

Contains a list of fully qualified Java type names of the method parameters. This setting is used to identify
a single method among multiple methods with an overloaded method name.

Applied access intent:

Specifies how the container must manage data access for persistence. Configurable both as a default
access intent for an entity and as part of a method-level access intent policy.

Data type String
Default wsPessimisticUpdate-WeakestLockAtLoad. With Oracle,
this is the same as wsPessimisticUpdate.
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Range Valid settings are wsPessimisticUpdate,

wsPessimisticUpdate-NoCollision, wsPessimisticUpdate-
Exclusive, wsPessimisticUpdate-WeakestLockAtLoad,
wsPessimisticRead, wsOptimisticUpdate, or
wsOptimisticRead. Only wsPessimisticRead and
wsOptimisticRead are valid when class-level caching is
enabled in the EJB container.

This product supports lazy collections. For each segment of a collection, iterating through the collection
(next()) does not trigger a remote method call to retrieve the next remote reference. Two policies
(wsPessimisticUpdate and wsPessimisticUpdate-Exclusive) are extremely lazy; the collection increment
size is set to 1 to avoid overlocking the application. The other policies have a collection increment size of

25.

If an entity is not configured with an access intent policy, the run-time environment typically uses
wsPessimisticUpdate-WeakestLockAtLoad by default. If, however, the Lifetime in cache property is set on
the bean, the default value of Applied access intent is wsOptimisticRead; updates are not permitted.

Additional information about valid settings follows:

Profile name Concurrency control Access type Transaction isolation

wsPessimisticRead (Note 1) pessimistic read For Oracle, read committed.
Otherwise, repeatable read

wsPessimisticUpdate (Note pessimistic update For Oracle, read committed.

2) Otherwise, repeatable read

wsPessimisticUpdate- pessimistic update serializable

Exclusive (Note 3)

wsPessimisticUpdate- pessimistic update read committed

NoCollision (Note 4)

wsPessimisticUpdate- pessimistic update Repeatable read

WeakestLockAtLoad (Note

5)

wsOptimisticRead optimistic read read committed

wsOptimisticUpdate (Note  optimistic update read committed

6)

Notes:

1. Read locks are held for the duration of the transaction.

2. The generated SELECT FOR UPDATE query grabs locks at the beginning of the transaction.

3. SELECT FOR UPDATE is generated; locks are held for the duration of the transaction.

4. A plain SELECT query is generated. No locks are held, but updates are permitted. Use cautiously. This intent
enables execution without concurrency control.

5. Where supported by the backend, the generated SELECT query does not include FOR UPDATE; locks are
escalated by the persistent store at storage time if updates were made. Otherwise, the same as
wsPessimisticUpdate.

6. Generated overqualified-update query forces failure if CMP column values have changed since the beginning of

the transaction.

Be sure to review the rules for forming overqualified-update query predicates. Certain column types (for example,
BLOB) are ineligible for inclusion in the overqualified-update query predicate and might affect your design.
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Access intent for both entity bean types

Container-managed persistence (CMP) developers can use access intent to provide hints on how the
application server run time should manage the details of persistence without having to explicitly manage
any of the persistence logic from within their application.

Using the access intent service is also an option for programmers who develop bean-managed persistence
(BMP) entity beans. Because the only meaningful difference between BMP and CMP components is the
mechanism that provides the persistence logic, BMP beans leverage access intent hints in the same
manner as the EJB container manages accent intent for CMP beans. This ability becomes especially
important when BMP entities and CMP entities want to share connections. BMP beans configured with the
same concurrency as the CMP beans and implemented to the same isolation level mapping as the CMP
can share connections.

Developers can apply access intent policies to BMP entity beans as well as to CMP entity beans. It is
expected that BMP developers use only those access intent attributes that are important to a particular
BMP bean. The access intent service interface is bound into the java:comp namespace for each particular
BMP bean. The access intent policy retrieved from the access intent service is current from the time that
the ejbLoad process is called until the time that the ejbStore process completes its invocation.

Applying access intent policies to beans
You can apply an access intent policy to an application’s entity beans through the assembly tool.

Note: This is the preferred technique to define access intent policies. Method-level access intent is
deprecated in Version 6.0.

1. Start the Application Server Toolkit.

2. Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open
Perspective > Other > J2EE.

3. Optional: Open the Project Explorer view. Click Window > Show View > Project Explorer. Another
helpful view is the Navigator view (Window > Show View > Navigator).

4. Create a new application EAR file or edit an existing one.

For example, to change attributes of an existing application, use the import wizard to import an EAR
file. To start the import wizard:

a. Select File > Import > EAR file > Next
b. Select the EAR file.

c. Create a WebSphere Application Server v6.0 type of Server Runtime. Select New to open the
New Server Runtime Wizard and follow the instructions.

d. Inthe Target server field, select WebSphere Application Server v6.0 type of Server Runtime.
e. Select Finish

5. In the Project Explorer view of the J2EE perspective, right-click Deployment Descriptor: EJB
Module Name under the EJB module for the bean instance, then select Open With > Deployment
Descriptor Editor. A property dialog notebook for the EJB project is displayed in the property pane.

6. Select the Access tab.
7. In the Access Intent for Entities 2.x (Bean Level) panel, select the name of the bean.

8. On the right side of the Access Intent for Entities 2.x (Method Level) panel, select Add. The Add
Access Intent panel displays.

9. In the Access intent name field, select wsPessimisticUpdate from the drop-down list.
10. Optional: Enter a Description to help you remember what this policy does.
11. Optional: Change the Persistence Option setting

12. Click Finish. The access intent policy for the entity bean is shown in the Access Intent for Entities
2.x (Bean Level) panel
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Configuring read-read consistency checking with the assembly tools

Read-read consistency checking only applies to LifeTimelnCache beans whose data is read from another
transaction. For the Access Intents that are for repeatable read (RR), this means the product checks that
the data is consistent with that in the data store, and ensures that no one updates it after the checking.

For the Access Intents that are for read committed (RC), this means the product checks that the data is
consistent at the point of checking, it does not guarantee that the data does not change after the
checking. This makes the behavior of the LifeTimelnCache bean the same as non-LifeTimelnCache beans.

To perform this checking, you need to configure CMP entity beans with read-read consistency checking.
You can do this using the Application Server Toolkit.

1. Start the Application Server Toolkit.

2. In the Project Explorer view of the J2EE perspective, right-click the Deployment Descriptor: EJB
Module Name under the EJB module for the bean instance, then select Open With > Deployment
Descriptor Editor. A property dialog notebook for the EJB project is displayed in the property pane.

3. Select the Access tab. The Add Access Intent window appears. There are two areas of the panel that
deal with adding access intent:

» Default Access Intent for Entities 2.x (Bean Level)
* Access Intent for Entities 2.x (Method Level)

4. Select the Bean or Method level. Another access intent window appears where you can set the
properties you wish to use.

Use the dropdown list to select the Access intent name.
Optional: Enter a description.

Check the Persistence Option box.

Check the Verify Read Only Data box.

Use the dropdown list to select your choice for read-read consistency checking. You have three
options:

© © N o

NONE No read-read checking is done.

AT_TRAN_BEGIN
During ejbLoad, if the data is from cache, check the database to ensure that the data of the
bean (with proper locking based on access intent’s concurrency control attribute) has not
changed since the last load.

AT_TRAN_END
At the end of transaction, if the bean is not changed and did not load by the current
transaction, check the database to ensure that the data of the bean has not changed from
last load (with proper locking based on access intent’s concurrency control attribute.) If the
data has changed, fail the transaction.

10. Select Finish.

Examples: read-read consistency checking
Read-read consistency checking only applies to LifeTimelnCache beans whose data is read from another
transaction.

Usage scenario

For the Access Intents that are for repeatable read (RR), this means the product checks that the data is
consistent with that in the data store and ensures that no one updates it after the checking. For the Access
Intents that are for read committed (RC), this means the product checks that the data is consistent at the
point of checking, but it does not guarantee that the data does not change after the checking. This makes
the behavior of the LifeTimelnCache bean the same as non-LifeTimelnCache beans.
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You have three options for setting consistency checking, as shown in the following scenarios concerning
the calculation of interest in "Ann’s” bank account. In each case, the data store is shared by this EJB CMP
application (to calculate the interest) and other applications, such as EJB BMP, JDBC, or legacy
applications. Also in each case, the EJB Account is configured as a “long-lifetime” bean.

NONE
¢ The server is started.

* User 1 in Transaction 1 calls Account.findByPrimaryKey("10001"), account data for Ann is read from the
database, with a balance of $100.

* Ann’s record is cached by the persistence manager (PM) on the server.
» User 2 writes a JDBC call and changes the balance to $120.

» User 3 in Transaction 2 calls Account.findByPrimaryKey() for account "10001", Ann’s data is read from
cache, with a balance of $100.

» Calculate Ann’s interest, but the result might not be correct because of the data integrity issue.

Read-read checking AT_TRAN_BEGIN
e The server is started.

* User 1 in Transaction 1 calls Account.findByPrimaryKey("10001"), account data for Ann is read from the
database, with a balance of $100.

* Ann’s record is cached by the persistence manager (PM) on the server.
» User 2 writes a JDBC call and changes the balance to $120.

* User 3 in Transaction 2 calls Account.findByPrimaryKey() for account "10001", Ann’s data is read from
cache, with a balance of $100.

* PM performs read-read check on Ann’s account and finds that the balance of 100 is changed. It issues
a database query to retrieve balance of $120, and Ann’s data in the cache is refreshed.

» Calculate Ann’s interest, proceed with the transaction because data integrity is protected.

Read-read checking AT_TRAN_END
e The server is started.

* User 1 in Transaction 1 calls Account.findByPrimaryKey("10001"), account data for Ann is read from the
database, with a balance of $100.

* Ann’s record is cached by the persistence manager (PM) on the server.
» User 2 writes a JDBC call and changes the balance to $120.

» User 3 in Transaction 2 calls Account.findByPrimaryKey() for account "10001", Ann’s data is read from
database, with balance of $100.

e Calculate Ann’s interest.

» During end of transaction 2, PM performs read-read check on Ann’s account and finds that the balance
of 100 is changed.

* PM rolls back the transaction and invalidates the cache. The transaction fails and again data integrity is
protected.

Access intent service

Access intent is a WebSphere Application Server runtime service that enables you to more precisely
manage an application’s persistence.

The access intent service defines a set of declarative annotations used by the Enterprise JavaBeans (EJB)

container and its agents to make performance optimizations for entity bean access. These annotations are
organized into sets called access intent policies.
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Access intent policies contain a set of annotations considered as hints by the EJB container and its
agents. Most access intent policies are hints representing high-level abstractions that can be mapped to a
specific back end resource manager. It is the responsibility of the EJB persistence machinery to ensure the
necessary concurrency control, connection, and cache management when carrying out the persistence
details. The EJB persistence manager can use access intent hints to make better performance decisions
when carrying out its assigned task. A smaller number of access intents are hints to the EJB container,
influencing the management of EJB collections.

Generally you configure bean level access intent for your applications. You can also apply access intent
policies to beans within the scope of application profiles. Consequently, you can configure beans with
multiple and opposing access intent policies. The application profiling documentation explains in more
detail how to configure an application to apply a particular access intent policy to a bean for one request,
then apply another access intent policy to the same bean for a different request.

Support for applying access intent policies at the method level is deprecated in WebSphere Application
Server Version 6.0. In this practice of configuring access intent, you apply a policy to methods within the
scope of an EJB module so that the policy becomes the default access intent for all requests upon those
methods.

Access intent with BMP entity beans

Access intent’s declarative functionality provides great power to you as a CMP entity bean developer. You
can provide hints on how WebSphere Application Server is to manage the details of persistence without
having to explicity manage any of the persistence logic from within the application.

There are situations, however, in which you might need to develop BMP entity beans. Because the only
meaningful difference between BMP and CMP components is who provides the persistence logic, BMP
entity beans should be able to leverage access intent hints just as WebSphere Application Server does on
behalf of CMP entity beans. BMP entity beans that use the access intent service participate in application
profiling; that is, the value of the access intent attributes can differ from request to request, allowing the
BMP entity bean to seamlessly modify its persistence strategy.

You can apply access intent policies to BMP entity bean methods as well as CMP entity bean methods.
Because access intent hints are not contractual in nature, there is no obligation for a BMP entity bean to
exploit them. BMP entity beans are expected to use only those access intent attributes that are important
to that particular bean.

The current access intent policy is bound into the java:comp namespace for a particular BMP entity bean.
That policy is current only for the duration of the method call during which the access intent policy was
retrieved. In a typical scenario, you would cache the access type during invocation of the ejbLoad()
method so that appropriate actions can be taken during invocation of the ejbStore() method.

Access intent design considerations

Use the access intent service to solve clear performance problems. Identify usage patterns that lead to
poor application performance and apply appropriate access intent policies.

best-practices: Refrain from over-tuning an application. You can introduce errors by incorrectly using the
access intent service. For example, misuse of the wsPessimisticUpdate-NoCollision policy
can result in lost updates; inappropriately setting the collection increment value can
introduce performance issues; and problem determination is more difficult when an
application is confusingly configured with multiple access intent policies.

Note: Clarity and simplicity should be your guiding principles when using the access intent service. This is
even more important when applying access intent polices within the scope of application profiles.

Even though access intent policies can be configured on any method of an entity bean, some attributes of
a policy can only be leveraged by the runtime environment under certain conditions. For example,
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concurrency and access intent are only used for CMP entity beans when the ejbLoad() method is driven to
open a connection to, and read data from, a given resource; that data is cached and used to drive the
proper queries during invocation of the ejbStore() method. Read-ahead hints are only used during the
execution of a finder for a bean. Finally, the collection increment and resource manager prefetch increment
are only used on multi-object finders. Configuring policies on methods that will not use the policy is not an
error (only certain attributes of any policy are used, even when the policy is appropriately applied to a
method). However, configuring policies unnecessarily throughout an application obscures the design of the
application and complicates the maintenance of the application.

Applying access intent policies to methods

You apply an access intent policy to a method, or set of methods, in an application’s entity beans through
the assembly tool.

Note: Method-level access intent is deprecated in Version 6.0.
1. Start the Application Server Toolkit.

2. Optional: Open the J2EE perspective to work with J2EE projects. Click Window > Open
Perspective > Other > J2EE.

3. Optional: Open the Project Explorer view. Click Window > Show View > Project Explorer. Another
helpful view is the Navigator view (Window > Show View > Navigator).

4. Create a new application EAR file or edit an existing one.

For example, to change attributes of an existing application, use the import wizard to import an EAR
file. To start the import wizard:

a. Select File > Import > EAR file > Next
b. Select the EAR file.

c. Create a WebSphere Application Server v6.0 type of Server Runtime. Select New to open the
New Server Runtime Wizard and follow the instructions.

d. In the Target server field, select WebSphere Application Server v6.0 type of Server Runtime.
e. Select Finish

5. In the Project Explorer view of the J2EE perspective, right-click the Deployment Descriptor: EJB
Module Name under the EJB module for the bean instance, then select Open With > Deployment
Descriptor Editor. A property dialog notebook for the EJB project is displayed in the property pane.

6. Select the Access tab.

7. On the right side of the Access Intent for Entities 2.x (Method Level) panel, select Add. The Add
Access Intent panel displays.

8. Specify the Name for your new intent policy.
9. Select the Access intent name from the drop-down list.
10. Enter a Description to help you remember what this policy does.

11. Optional: Select Read Ahead Hint. A single access intent read ahead hint might not refer to the
same bean type in more than one relationship. For example, if a Department enterprise bean has a
relationship employees with the Employee enterprise bean, and also has a relationship manager with
the Employee enterprise bean, then a read ahead hint cannot specify both employees and manager.

12. Click Next. The next Add Access Intent panel displays, with optional attributes.

13. Optional: Decide whether or not to overwrite these optional access intent attributes. Click on those
you want to change.

14. Click Next. The next Add Access Intent panel, with a list of Enterprise Beans, displays.
15. Select one or more Enterprise Beans from the list.

Note: If you selected Read Ahead Hint in an earlier step, you can only select ONE bean at this
step.

16. Click Next. The next Add Access Intent panel, with a list of methods, displays.
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17. Select the methods you want to use.

18. If you DID NOT select Read Ahead Hint in an earlier step, click Finish. If you DID select the Read
Ahead Hint option, you can click Next to specify your Read Ahead Hint for the specified bean. The
next Add Access Intent panel, with a list of EJB preload paths, displays.

19. Edit the EJB preload path by selecting relationship roles from the Relationship roles: window.
20. Click Finish. A new entry is created in the Access Intent for Entities 2.x (Method Level) panel

Using the Accesslintent API

This task describes how to programmatically retrieve and call the Accessintent API during the execution of
BMP entity bean methods.

1. Look up the current access intent in the namespace. For example:

InitialContext ic = new InitialContext();
AccessIntent ai = ic.lookup("java:comp/websphere/AppProfile/AccessIntent");

2. Call the necessary get() methods. For example:

int concurrency = ai.getConcurrencyControl();
int accessType = ai.getAccessType();
if ( (concurrency == AccessIntent.CONCURRENCY_ CONTROL_PESSIMISTIC)
&& (accessType == AccessIntent.ACCESS_TYPE_UPDATE) ) {
int exclusive = ai.getPessimisticUpdateLockHint();

/...
}
/...

Note: The access intent object reference retrieved from the java:comp lookup is current for the duration of
the method in which the reference was looked up. Depending on how you configured the
application profile, subsequent calls of the same method might not retrieve the same access intent
reference. You can only look up the object reference during the call of a BMP entity bean’s method,;
the reference does not exist during a request on a CMP entity bean. Therefore, access intent object
references should not be cached beyond, or used outside of, the scope of the execution of any
given BMP method.

Accesslintent interface
The Accessintent interface is available to BMP entity beans.

The following JNDI lookup allows BMP entity beans to access the Accesslintent interface:
java:comp/websphere/AppProfile/AccessIntent

Accessintent interface
package com.ibm.websphere.appprofile.accessintent;

[**

* This interface defines the essential access intents
* available at run time.

*/

public interface AccessIntent {

[*%

* Returns the concurrency control intent, which indicates
* the application prefers either pessimistic or optimistic
* concurrency control when accessing the current component
* in the context of the current transaction.

*

/

public int getConcurrencyControl();

public final int CONCURRENCY_CONTROL_PESSIMISTIC = 1;
public final int CONCURRENCY_CONTROL_OPTIMISTIC = 2;

[x%
* Returns access type intent, which indicates the application
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* intends either update or read access of the current component
* in the context of the current transaction.

*/

public int getAccessType();

public final int ACCESS_TYPE_UPDATE= 1;

public final int ACCESS_TYPE_READ = 2;

[ **

* Returns an integer value that indicates that the run time should

* assume that there will be no collision on retrieved rows.

*

/

public int getPessimisticUpdateLockHint();

public final static int PESSIMISTIC_UPDATE_LOCK_HINT_NOCOLLISION = 1;

public final static int PESSIMISTIC_UPDATE_LOCK HINT WEAKEST LOCK_ AT LOAD = 2;
public final static int PESSIMISTIC UPDATE_LOCK HINT_NONE = 3;

public final static int PESSIMISTIC_UPDATE_LOCK_HINT_EXCLUSIVE = 4;

/*
* Returns an integer value that indicates that the run time should
* assume that there will be collisions on retrieved rows.
*
/
public int getPessimisticUpdateLockHint();
public final static int PESSIMISTIC_UPDATE_LOCK_HINT_NOCOLLISION = 1;
public final static int PESSIMISTIC UPDATE_LOCK HINT WEAKEST LOCK AT LOAD = 2;
public final static int PESSIMISTIC_UPDATE_LOCK HINT NONE = 3;
public final static int PESSIMISTIC_UPDATE_LOCK_HINT_EXCLUSIVE = 4;

[ **
* Returns the collection access intent, which indicates the

* application intends to access the objects returned by the

* currently executing finder in either serial or random fashion.
*

/

public int getCollectionAccess();

pubTic final int COLLECTION_ACCESS_RANDOM
public final int COLLECTION_ACCESS_SERIAL

1;
2;

[x%

* Returns the collection scope, which indicates the maximum
* lifespan of a lazy collection.

*

/

public int getCollectionScope();

public final int COLLECTION_SCOPE_TRANSACTION = 1;

public final int COLLECTION_SCOPE_ACTIVITYSESSION = 2;
public final int COLLECTION_SCOPE_TIMEOUT = 3;

[x*

* Returns the timeout value in seconds when collectionScope is Timeout.
*/

public int getCollectionTimeout();

[x%

* Returns the number of elements the application requests be contained
* in each segment of the element collection returned by the currently
* executing finder.

*/

public int getCollectionIncrement();

[x*

* Returns the ReadAheadHint requested by the application for the currently
* executing finder.

*/

public ReadAheadHint getReadAheadHint();

[ **

* Returns the number of elements the application requests be contained in
* each segment of a query made on a database.
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*/

public int getResourceManagerPreFetchIncrement();

}

Access intent exceptions

The exceptions thrown in response to the application of access intent policies are listed.

com.ibm.ws.ejbpersistence.utilpm.PersistenceManagerException
If the method that drives the ejbLoad() method is configured to be read-only but updates are then
made within the transaction that loaded the bean’s state, an exception is thrown during invocation
of the ejbStore() method, and the transaction is rolled back. Likewise, the ejpRemove() method
cannot succeed in a transaction that is set as read-only. If an update hint is applied to methods of
entity beans with bean-managed persistence, the same behavior and exception results. The
forwarded exception object contains the message string PMGR1103E: update instance level read
only bean beanName

This exception is also thrown if the applied access intent policy cannot be honored because a
finder, ejbSelect, or container-managed relationship (CMR) accessor method returns an inherently
read-only result. The forwarded exception object contains the message string PMGR1001: No such
DataAccessSpec - methodName

The most common occurrence of this error is when a custom finder that contains a read-only EJB
Query Language (EJB QL) statement is called with an applied access intent of
wsPessimisticUpdate or wsPessimisticUpdate-Exclusive. These policies require the use of a USE
AND KEEP UPDATE LOCKS clause on the SQL SELECT statement to be executed, but a
read-only query cannot support USE AND KEEP UPDATE LOCKS. Other examples of read-only
queries include joins; the use of ORDER BY, GROUP BY, and DISTINCT keywords.

To eliminate the exception, edit the EJB query so that it does not return an inherently read-only
result or change the access intent policy being applied.
» If an update access is required, change the applied access intent setting to
wsPessimisticUpdate-WeakestLockAtLoad or wsOptimisticUpdate.
 If update access is not truly required, use wsPessimisticRead or wsOptimisticRead.
 If connection sharing between entity beans is required, use wsPessimisticUpdate-
WeakestLockAtLoad or wsPessimisticRead.
com.ibm.websphere.ejb.container.CollectionCannotBeFurtherAccessed
If a lazy collection is driven after it is no longer in scope, and beyond what has already been
locally buffered, a CollectionCannotBeFurtherAccessed exception is thrown.
com.ibm.ws.exception.RuntimeWarning
If an application is configured incorrectly, a run-time warning exception is thrown as the application
starts; startup is ended. You can validate an application’s configuration by choosing the verify
function. Some examples of misconfiguration include:
* A method configured with two different access intent policies
* A method configured with an undefined access intent policy

Access intent best practices

When applying access intent policies to Enterprise JavaBeans (EJB) methods, consider the following

issues.

+ Start by configuring the default access intent policy for an entity. After your application is built and
running, you can more finely tune certain access paths in your application using application profiling or
method-level access intent.

* Don’t mix access types. Avoid using both pessimistic and optimistic policies in the same transaction.
For most databases, pessimistic and optimistic policies use different isolation levels. This can result in
multiple database connections, which prevents you from taking advantage of the performance benefits
possible through connection sharing.
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» Take care when applying wsPessimisticUpdate-NoCollision. This policy does not ensure data
integrity. No database locks are held, so concurrent transactions can overwrite each other’s updates.
Use this policy only if you can be sure that only one transaction will attempt to update persistent store
at any given time.

Frequently asked questions: Access intent
The following frequently asked questions involving access intent are answered.

| have not applied any access intent policies at all. My application runs just fine with a DB2
database, but it fails with an Oracle database with the following message:
com.ibm.ws.ejbpersistence.utilpm.PersistenceManagerException: PMGR1001E: No such
DataAccessSpec :FindAllICustomers. The backend datastore does not support the SQLStatement
needed by this Accessintent: (pessimistic update-weakestLockAtLoad)(collections: transaction/25)
(resource manager prefetch: 0) (Accessintentimpl@d23690a). Why?

If you have not configured access intent, all of your data is accessed under the default access intent policy
(wsPessimisticUpdate-WeakestLockAtLoad). On DB2 the weakest lock is share. On Oracle databases,
however, the weakest lock is update; this means that the SQL query must contain a FOR UPDATE clause.
To avoid this problem, try to apply an access intent policy that supports optimistic concurrency.

| am calling a finder method and | get an InconsistentAccessintentException at run time. Why?

This can occur when you use method-level access intent policies to apply more control over how a bean
instance is loaded. This exception indicates that the entity bean was previously loaded in the same
transaction. This could happen if you called a multifinder method that returned the bean instance with
access intent policy X applied; you are now trying to load the second bean again by calling its
findByPrimaryKey method with access intent Y applied. Both methods must have the same access intent
policy applied.

Likewise, if the entity was loaded once in the transaction using an access intent policy configured on a
finder, you might have called a container-managed relationship (CMR) accessor method that returned the
entity bean configured to load using that entity’s default access intent.

To avoid this problem, ensure that your code does not load the same bean instance twice within the same
transaction with different access intent policies applied. Avoid the use of method-level access intent unless
absolutely necessary.

| have two beans in a container-managed relationship. | call findByPrimaryKey() on the first bean
and then call getBean2( ), a CMR accessor method, on the returned instance. At that point, | get an
InconsistentAccessintentException. Why?

You are probably using read-ahead. When you loaded the first bean, you caused the second bean to be
loaded under the access intent policy applied to the finder method for the first bean. However, you have
configured your CMR accessor method from the first bean to the second with a different access intent
policy. CMR accessor methods are really finder methods in disguise; the run-time environment behaves as
if you were trying to change the access intent for an instance you have already read from persistent store.

To avoid this problem, beans configured in a read-ahead hint are all driven to load with the same access
intent policy as the bean to which the read-ahead hint is applied.

| have a bean with a one-to-many relationship to a second bean. The first bean has a

pessimistic-update intent policy applied. When | try to add an instance of the second bean to the
first bean’s collection, | get an UpdateCannotProceedWithintegrityException. Why?
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The second bean probably has a read intent policy applied. When you add the second bean to the first
bean’s collection, you are not updating the first bean’s state, you are implicitly modifying the second
bean’s state. (The second bean contains a foreign key to the first bean, which is modified.)

To avoid this problem, ensure that both ends of the relationship have an update intent policy applied if you
expect to change the relationship at run time.

Assembling EJB modules

An enterprise bean is a Java component that can be combined with other resources to create Java 2
Platform, Enterprise Edition (J2EE) applications.

This topic assumes that you have created and unit tested an |enterprise bean| (EJB file) that you want to
assemble in an [enterprise application|and deploy onto an application server.

Assemble an Enterprise JavaBeans (EJB) module to contain enterprise beans and related code artifacts.
Group Web components, client code, and resource adapter code in separate modules. After assembling
an EJB module, you can install it as a standalone application or combine it with other modules into an
enterprise application.

Use ansuch as the Application Server Toolkit (AST) or Rational Application Developer to
assemble an EJB module in any of the following ways:

* Import an existing EJB module (EJB JAR file).

* Create a new EJB module.

* Copy code artifacts (such as entity beans) from one EJB module into a new EJB module.

For information on assembling EJB modules, refer to the online documentation or the information center
for your assembly tool. This topic points you to AST documentation. The Application Server Toolkit
information center accompanies this WebSphere Application Server information center.

1. Start an assembly tool.

2. If you have not done so already, configure the assembly tool for work on J2EE modules. Ensure that
J2EE and EJB capabilities are enabled.

3. Migrate enterprise bean (JAR) files created with the Assembly Toolkit, Application Assembly Tool (AAT)
or a different tool to an assembly tool. To migrate files, import your enterprise bean files to the
assembly tool.

4. Create a new EJB module.
5. Copy code artifacts (such as entity beans) from one EJB module into a new EJB module.

An EJB module is migrated or created, reflecting the J2EE folder structure that specifies the location of
enterprise bean content files, class files, class paths, the deployment descriptor, and supporting metadata.
Files for the EJB module are shown in the Project Explorer view under Enterprise Applications and EJB
Projects.

After you finish assembling your EJB module, you are ready to [deploy your module]

You can generate EJB deployment code and deploy the module to a target server in one step. In the
Project Explorer view, right-click on the EJB project and click Deploy.

Container transactions

Container transaction properties specify how an EJB container is to manage transaction scopes for the
enterprise bean’s method invocations. A transaction attribute is mapped to one or more methods.
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Defining container transactions for EJB modules

Some container transaction settings are not available for all enterprise beans. Also, some methods are not
available for particular transaction settings and beans. These rules have been implemented in the Add
Container Transaction wizard based on the EJB 1.1 and EJB 2.x specifications.

To add a container transaction to an enterprise bean:

1. In the Project Explorer view of the J2EE perspective, right-click the Deployment Descriptor for your
EJB project and select Open With > Deployment Descriptor Editor to open the deployment
descriptor editor.

2. On the Assembly page of the editor, click Add in the Container Transactions section.
3. Select one or more enterprise beans from the list of beans found.
4. Select a container transaction type from the following choices:

NotSupported - Directs the container to invoke bean methods without a transaction context. If a
client calls a bean method from within a transaction context, the container suspends the association
between the transaction and the current thread before invoking the method on the enterprise bean
instance. The container then resumes the suspended association when the method invocation
returns. The suspended transaction context is not passed to any enterprise bean objects or
resources that are used by this bean method.

Supports - Directs the container to invoke the bean method within a transaction context if the client
calls the bean method within a transaction . If the client calls the bean method without a transaction
context, the container calls the bean method without a transaction context. The transaction context
is passed to any enterprise bean objects or resources that are used by this bean method.

Required - Directs the container to invoke the bean method within a transaction context. If a client
calls a bean method from within a transaction context, the container calls the bean method within
the client transaction context. If a client calls a bean method outside a transaction context, the
container creates a new transaction context and calls the bean method from within that context. The
transaction context is passed to any enterprise bean objects or resources that are used by this bean
method.

RequiresNew - Directs the container to always invoke the bean method within a new transaction
context, regardless of whether the client calls the method within or outside a transaction context.
The transaction context is passed to any enterprise bean objects or resources that are used by this
bean method.

Mandatory - Directs the container to always invoke the bean method within the transaction context
associated with the client. If the client attempts to invoke the bean method without a transaction
context, the container throws the javax.jts.TransactiononRequiredException exception to the client.
The transaction context is passed to any EJB object or resource accessed by an enterprise bean
method. EJB clients that access these entity beans must do so within an existing transaction . For
other enterprise beans, the enterprise bean or bean method must implement the Bean Managed
value or use the Required or Requires New value. For non-enterprise bean EJB clients, the client
must invoke a transaction by using the javax.transaction.UserTransaction interface.

Never - Directs the container to invoke bean methods without a transaction context. If the client
calls a bean method from within a transaction context, the container throws the
java.rmi.RemoteException exception. If the client calls a bean method from outside a transaction
context, the container behaves in the same way as if the Not Supported transaction attribute was
set. The client must call the method without a transaction context

5. Select one or more methods elements from the list.
6. Click Finish.

The container transaction is added and displayed in the Container Transactions section, where the
container transactions are listed by container transaction type.

After you define container transactions, you can use the deployment descriptor editor to work with them.
Information about the editor can be found in the WebSphere Application Server Express documentation.
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* To edit a container transaction, select it from the Container Transactions list and click Edit.
e To delete a container transaction, select from the list and click Remove.

» To take multiple container transactions that are the same container transaction type and combine them
into a single container transaction definition, click Combine.

Method extensions
Method extensions are IBM extensions to the standard deployment descriptors for enterprise beans.

Method extension properties are used to define transaction isolation levels for methods, to control the
delegation of a principal’s credentials, and to define custom finder methods.

Method permissions

A method permission is a mapping between one or more security roles and one or more methods that a
member of the role can call.

References

References are logical names used to locate external resources for enterprise applications. References
are defined in the application’s deployment descriptor file. At deployment, the references are bound to the
physical location (global JNDI name) of the resource in the target operational environment.

This product supports the following types of references:
* An EJB reference is a logical name used to locate the home interface of an enterprise bean.
* A resource reference is a logical name used to locate a connection factory object.

These objects define connections to external resources such as databases and messaging systems. The
container makes references available in a JNDI naming subcontext. By convention, references are
organized as follows:
» EJB references are made available in the java:comp/env/ejb subcontext.
* Resource references are made available as follows:

— JDBC DataSource references are declared in the java:comp/env/jdbc subcontext.

— JMS connection factories are declared in the java:comp/env/jms subcontext.

— JavaMail connection factories are declared in the java:comp/env/mail subcontext.

— URL connection factories are declared in the java:comp/env/url subcontext.

EJB references
Use this page to view and modify the Enterprise JavaBeans (EJB) references to the enterprise beans.

To view this administrative console page, click Applications > Enterprise Applications >
application_name > EJB references .

Module:

Specifies the name of the Enterprise JavaBeans module used by your application.
EJB:

Specifies the name of an enterprise bean that is contained by the module.

URI:

Specifies location of the module relative to the root of the application EAR file.

Reference binding:
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Specifies the name of the EJB reference that is used in the enterprise bean, if applicable, and declared in
the deployment descriptor of the application module.

Class:

Specifies the name of a Java class associated with this enterprise bean.

JNDI name:

Specifies the Java Naming and Directory Interface (JNDI) name of the enterprise bean.

This is a data entry field. To modify the JNDI name bound to this bean, type the new name in this field,
then select OK.

Data type String

EJB JNDI names for beans

Use this page to view and modify the Java Naming and Directory Interface (JNDI) names of
non-message-driven enterprise beans in your application or module.

To view this administrative console page, click Applications > Enterprise Applications >
application_name > EJB JNDI Names .

EJB module:

Specifies the name of the Enterprise Javabeans module used by your application.
EJB:

Specifies the name of an enterprise bean that is contained by the module.

URI:

The Uniform Resource Identifier (URI) specifies the location of the module archive relative to the root of
the application EAR.

JNDI name:
Specifies the Java Naming and Directory Interface (JNDI) name of the enterprise bean.

This is a data entry field. To modify the JNDI name bound to this bean, type the new name in this field,
then select OK.

Data type String

Sequence grouping for container-managed persistence

After assembling an Enterprise JavaBeans (EJB) module that contains container-managed persistence
(CMP) beans, you can prevent certain types of database-related exceptions from occurring during
application run time. Using sequence grouping, you can specify the order in which entity beans update
relational database tables.
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Eliminate exceptions resulting from referential integrity (Rl) violations

Sequence grouping is particularly useful for preventing violations of database referential integrity (RI). A
database RI policy prescribes rules for how data is written to and deleted from the database tables to
maintain relational consistency. Run-time requirements for managing bean persistence, however, can
cause an EJB application to violate RI rules, which can cause database exceptions. These run-time
requirements mandate that:

» Entity bean create and remove operations correlate to the database immediately upon method
invocation.

« Entity bean changes are cached by the EJB container until either a finder method is called, or the
transaction ends.

Consequently, the order in which entity beans update the database is unpredictable. That randomness
translates into high risk of the application violating database RI. Although caching the operations for batch
processing overrides these run-time requirements, it does not guarantee a bean persistence sequence that
follows any given RI policy.

The only way to guarantee a persistence sequence that honors database RI is to designate the sequence,
which you do in the EJB deployment descriptor editor of the assembly tool. Through the sequence
grouping feature, you assign beans to CMP groups. Within each group you specify the order in which the
persistence manager inserts bean data into the database to accomplish updates without violating RI.

See the [‘Setting the run time for CMP sequence groups’|topic for detailed instructions on designating
sequence groups. Consult your database administrator about the RI policy with which you need to
synchronize.

Minimize exception risk for optimistic concurrency control schemes

Sequence grouping can also reduce the risk of transaction rollback exceptions for entity beans that are
configured for foptimistic concurrency controll In these concurrency control schemes, database locks are
held for minimal amounts of time so that a maximum number of transactions consistently have access to
the data. The relatively unrestricted state of the database can lead to transaction rollback exceptions for
two common reasons:

* When concurrent transactions attempt to lock the same table row, database deadlock occurs.
» Transactions can occur in an order that violates application logic.

Use the sequence grouping feature to order bean persistence so that these scenarios are less likely to
occur.

Setting the run time for CMP sequence groups

By designating CMP sequence groups for entity beans, you can prevent certain types of database-related
exceptions from occurring during the run time of your EJB application. Within each group you specify the
order in which the beans update your relational database tables.

When you define a sequence group, you designate it as one of two types:

* RI_INSERT, for setting a bean persistence sequence to prevent database |referential integrit)d (R
violations

* UPDATE_LOCK, for setting a bean persistence sequence to minimize exceptions resulting from
optimistic concurrency control

Both types of sequence groups must be created after you have assembled the beans into an EJB module,
prior to installing your application on the product. If you need to edit sequence groups, you must uninstall
the application, make your changes using the following steps as a guide, and then reinstall your
application.
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Note: If you already selected or plan to use top-down mapping for mapping your enterprise beans to back
end data, you do not need to create a sequence group with an RI_INSERT type. The product does
not generate an RI policy for the database schema that it creates when you select top-down
mapping.

1. Start an assembly tool. Refer to Starting WebSphere Application Server Toolkit in the Application
Server Toolkit documentation.
2. Open the J2EE perspective. Click Window > Open perspective > J2EE.

3. In a J2EE hierarchy view (Window > Show view > J2EE hierarchy), right-click the EJB module
containing beans that require sequence grouping, and click Open with > EJB deployment
descriptor editor. The EJB deployment descriptor editor for the module is displayed in a view.

4. Click the Overview tab.

5. In the EJB CMP sequence groups section, click Add. The EJB CMP Sequence Group wizard
panel is displayed.

6. Type a name for your sequence group.
7. Type your group type designation in all capital letters: RI_INSERT or UPDATE_LOCK

8. In the Available Beans list, highlight the first bean that you want to place in the group. Click the
arrow pointing toward the Selected beans list. The bean name is removed from the Available beans
list and is displayed in the Selected beans list.

9. Repeat the previous step until you complete your sequence group. You must add each bean in the
order that you want the persistence manager to handle it. In the case of delete operations for an
RI_INSERT group, the persistence manager reverses the order that you designate and deletes the
beans and their corresponding database rows accordingly. If you need to alter the sequence of your
group, select a bean and click the arrow to move the bean one position vertically.

10. Save your changes to the deployment descriptor.
a. Close the EJB deployment descriptor editor.
b. When prompted, click Yes to indicate that you want to save changes to the deployment
descriptor.

You also can save changes to deployment descriptors at any time by pressing Ctrl+S.

You are now ready to|deploy your EJB module| or combine it with other modules into a J2EE application]

Deploying EJB modules

When you deploy an EJB module, you install that module on a server that has been configured to support
deployed modules.

Assemble one or more EJB modules, [assemble one or more Web modules| and [assemble them into a
J2EE application|

1. |Prepare the deployment environment

2. Update the configuration for each EJB module as needed for the deployment environment. See the
AST information center for more information about modifying deployment descriptors.

3. |Deploy the application

If you specify that EJB deploy be run during application installation and the installation fails with a
NameNotFoundException message, ensure that the input JAR or EAR file does not contain source files.
Either remove the source files or include all dependent classes and resource files on the class path. If
there are source files in the input JAR or EAR file, the EJB deployment tools runs a rebuild before
generating the deployment code.

If the module deploys successfully, test and |debug the moduIe|.
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Troubleshooting tips for EJIBDEPLOY relationships

This article provides troubleshooting information for EJBDEPLOY problems.

The converter that is defined for the primary key is not invoked on its foreign key
value

The mapping for primary key fields to database columns may use a converter to transform the key values.
If a container-managed persistence (CMP) bean uses a converter to map its primary key, and that bean
has a relationship where the bean at the other end holds a foreign key, the mapping for the foreign key will
not use the converter.

The following errors might occur, indicating that the converter defined for the primary key is not invoked on
its foreign key value. During the run of the ejbDeploy command , you receive the following message:

No type mapping defined for Java datatypel to Database datatype2
During run time, the application does not find the CMP bean at the other end of the relationship.

To work around this limitation, define your own foreign key in the database table, and create a mapping
that uses the same converter as defined for the primary key on the enterprise beans at the other end of its
relationship.

EJB module settings
Use this page to configure and manage a specific deployed EJB module.

Note: You cannot start or stop an individual EJB module for modification. You must start or stop the
appropriate application entirely.

To view this administrative console page, click Applications > Enterprise Applications >
applicationName > Manage Modules > moduleName.

URI

Specifies location of the module relative to the root of the application EAR file. The URI must match the
URI of a ModuleRef URI in the deployment descriptor of the deployed application (EAR).

Alternate deployment descriptor
Specifies an alternate deployment descriptor for the module as defined in the application deployment
descriptor according to the J2EE specification.

Starting weight
Specifies the order in which modules are started when the server starts. The module with the lowest
starting weight is started first.

Data type Integer
Default 5000
Range Greater than 0

EJB deployment tool

Before you can successfully run your enterprise beans on either a test or production server, you need to
generate deployment code for the enterprise beans. The EJB deployment tool provides a command-line
interface that you can use to generate enterprise bean deployment code. The tool employs this
command-line environment that enables you to run a build process overnight and have the deployment
tool automatically invoked to generate your deployment code in batch mode.
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The EJB deployment tool is invoked from the command line using the ejbdeploy command, which accepts
an input EJB JAR or EAR file that contains one or more enterprise beans. It then generates an output,
deployed JAR file or EAR file that contains deployment code in the form of .class files.

For a complete description of all of the options available to the ejbdeploy, see the related reference
lejpdeploy command|

The EJB deployment tool supports EJB single and multiple table inheritance. It supports the use of
converters, which translate a database representation to a Java™ object type, and composers, which are
used to map a single, complex bean field to multiple database columns. The EJB deployment tool
supports the following levels of access intent (where Accessintent is a WebSphere® extension):

wsPessimisticUpdateWeakestLockAtLoad
wsPessimisticUpdate
wsPessimisticUpdate-NoCollision
wsPessimisticUpdate-Exclusive
wsPessimisticRead

wsOptimisticUpdate

wsOptimisticRead

No o prwbdRE

For more information on these access intents, see the related topic Access intent and isolation level.

In addition to these values, an access intent can also contain an optional read ahead hint.

Note: The read ahead hint indicates how deeply to read ahead in an EJB relationship graph.

2.0 EJB projects only: Mapping to multiple back-end databases is also supported. The schemas and the
generated data definition language (DDL) file are stored in the following directory
of the JAR or EAR file:

META-INF\backends\backend_id\databasename.dbm

META-INF\backends\backend_ic\Table.ddl

If multiple backends exist and you did not set the current back-end ID in the EJB deployment descriptor,

the EJB deployment tool will default to the first back-end ID that appears as a folder in the respective

META-INF\backends directory as described earlier. If you map to a single backend database, then the

generated DDL file will appear both in the directory as described above and also in the META-INF folder.

You can perform the following tasks with the EJB deployment tool:
* |Generating deployment code for enterprise beans from the command line|
+ [Implementing finders for CMP entity beans|

Also refer to |Message format for EJB validationl to understand the format used for messages generated by
the EJB validator.

Generating deployment code for enterprise beans from the command line

The EJB deployment tool provides a command-line interface that you can use to generate enterprise bean
deployment code. Before you can successfully run your enterprise beans on either a test or production
server, you need to generate deployment code for the enterprise beans.

You generate EJB deployment code by running the ejbdeploy command.

Running the EJB deployment tool from the command line:
1. Open a command prompt.
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2. Type the following at the prompt:
B ejbdeploy in.ear tmp out.ear
BT cjbdeploy.sh in.ear tmp out.ear

This generates a EAR file called out.ear.

The following activities occur when you run the ejbdeploy command:
Code is imported from the input JAR or EAR file.

A top-down mapping is created if one does not exist.
Deployment code is generated.

The deployment code is compiled.

Remote Method Invocation Compiler (RMIC) is run.

Code is exported to the output JAR or EAR file.

o 0k whPE

Note: For CMP entity beans, a data definition language (DDL) file is generated that can be used to create
corresponding database tables that are mapped to CMP fields. The DDL file is contained within the
META-INF\backends\backend_id directory and entitled Table.ddI

The ejbdeploy command

Before you can successfully run your enterprise beans on either a test or production server, you need to
generate deployment code for the enterprise beans. This reference topic describes what is the syntax,
expected behavior, and descriptions of each of the parameters for running the ejbdeploy command from a
command line.

Syntax

Use the following command and the optional parameters, when the schema and map are provided in the
input EAR or JAR file:

ejbdeploy input_EAR name|input_JAR name working directory output_EAR_name|output_JAR_name
[-bindear "options"] [-cp classpath] [-codegen] [-debug] [-keep] [-ignoreErrors] [-quiet]
[-nowarn] [-noinform] [-rmic "options"][-trace] [-sqlj] [-outer] [-compliancelevel "1.4"|"5.0"]

Use the following command and the optional parameters, when the schema and map are not available in
the input EAR or JAR file, and a top-down mapping approach is needed:

ejbdeploy input_EAR name|input_JAR name working directory output_ EAR_name|output_JAR name
[-bindear "options"] [-cp classpath] [-codegen] [-dbname "name"] [-dbschema "name"] [-dbvendor
name] [-debug] [-keep] [-ignoreErrors] [-quiet] [-nowarn] [-noinform] [-rmic "options"][-trace]
[-sq1j]1[-0CCColumn] [-outer] [-compliancelevel "1.4"|"5.0"]

The -dbschema, -dbname, -dbvendor, and -OCCColumn options are only used when creating a database
definition in the top-down mode of operation. The database information is then saved in the schema
document in the JAR or EAR file, which means that the options do not need to be specified again. It also
means that when a JAR or EAR is generated, the correct database must be defined at that point because
it cannot be changed later.

Behaviour
If your input JAR or EAR file contains CMP beans, the EJB deployment tool looks for an existing schema

and map to use when generating deployment code. If no existing schema and map are found, a schema
and map are created using top-down mapping rules.
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In the top-down mapping approach, you already have existing enterprise beans and their design
determines the database design. The generated schema contains one table for each CMP entity bean. In
these tables, each column corresponds to a CMP field of the enterprise bean, and the generated mapping
maps the field to the column.

If the -dbvendor option is not set, the default database backend is DB2UDB_V82. If you want to set a
different database backend, use the -dbname, -dbschema, and -dbvendor options to specify your choice. A
data definition language (DDL) file, Table.ddl, is created for the database backend set in the -dbvendor
option, when you run the ejbdeploy command. However, you can specify only one backend at a time using
the -dbvendor option.

If the -dbvendor option is specified for mapped jars, for example the JAR file already contains a DB2®
backend and you specify -dbvendor ORACLE on the command line; in previous releases of the product,
rather than getting a second backend, the database vendor specification was ignored. Starting in
WebSphere Application Server v6.0.2, the following changes were made for the scenario where the
-dbvendor option is specified for a mapped jar:

For 2.x CMP beans where multiple mappings to different database vendors are supported:

 If the value for the -dbvendor option is different from the existing maps, then a new top-down map is
generated, and that becomes the current backend.

 If the value for the -dbvendor option is the same as one of the existing maps, then that map becomes
the current backend, and the following message is issued:

A mapping to the database vendor, database vendor, already exists. Setting the current
backend id to backend id.

For 1.1 CMP beans that can only be mapped once:

 If the value for the -dbvendor option is the same as the existing map, then the following message is
issued and deployment continues:

A mapping to the database vendor, database_vendor, already exists. Using the existing map to continue
 If the value for the -dbvendor option is different as the existing map, the following exception is thrown
and deployment stops:

A mapping already exists for a different database vendor.
Action: If you want to generate deployment code against this existing map, for the -dbvendor argument

Another general behavior of the ejbdeploy command is if the abstract fields or bean name for CMP entity
beans use any SQL reserved keywords, the top-down mapping adds a numeric suffix to the column name
when generating the data definition language file (Table.ddl). This is to avoid SQL command conflicts when
SQL reserved words are used as column names. For a list of SQL reserved words, see the topic SQL
reserved keywords.

Parameters

ejbdeploy
The command to generate deployment code. If run without any arguments, the ejbdepToy command
displays a list of arguments that can be run with the command.

input_JAR_name or input_EAR_name
The fully qualified name of the input JAR or EAR file that contains the enterprise beans for which you
want to generate deployment code; for example, c:\ejb\inputJARs\myEJBs.jar. (This argument is
required.)

The ejbdeploy command no longer uses what is specified on the system class path. Instead, the
dependent classes need to be contained in a JAR file or included in the command processing using
the -cp option. You must ensure that the .class files of each enterprise bean’s home and remote
classes are packaged in the input JAR or EAR file.
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You should not include source files in the input JAR or EAR file. If there are source files in the input
JAR or EAR file, the EJBDeploy tools runs a rebuild before generating the deployment code.
Recommendation: Either remove the source files, or include all dependent classes and resource files
on the class path. Otherwise, this might cause problems during rebuild of your application on the
server.

working_directory
The name of the directory where temporary files that are required for code generation are stored. (This
argument is required.) If the working directory that you specify already exists prior to running the
ejbdeploy command, the temporary files are generated into the working directory (as an Eclipse
workspace). However, if the working directory does not already exist prior to running the command,
the directory is created and the Eclipse workspace is generated into it. In both cases, the workspace
and all of its files are automatically removed when the deployment code generation is complete unless
you specify the -keep option. (Retaining the workspace is useful for problem determination.)

output_JAR_name or output EAR_name
The fully qualified name of the output JAR or EAR file that is created by the ejbdeploy command and
that contains the generated classes required for deployment; for example: c:\ejb\outputJARS\
myEJBs.jar. (This argument is required.) The directories specified in the fully-qualified name must
already exist before you run the ejbdeploy command. (Note that when you specify a hame for the
output JAR or EAR file and then run the ejbdeploy command, any existing output JAR or EAR file of
the same name will be overwritten without warning.)

-cp classpath
If you intend to run the ejbdeploy command against JAR or EAR files that have dependencies on other
zipped or JAR files, you can use the -cp option to specify the class path of the other JAR or zipped
files. Using the -cp option, you can specify multiple zipped and JAR files as arguments. However, the
zipped and JAR file names must be fully qualified, separated by semicolons, and enclosed in double
quotation marks. For example: -cp "path\myJdarl.jar;path\myJar2.jar; path\myJar3.jar”

Tip: If you specfied the -sqlj option, you need to specify the location of the SQLJ translator classes,
sqlj.zip. The default path for this file is x}\java, where x is the installation directory of DB2, for
example, d:\sqllib\java\sglj.zip on Windows®.

-codegen
Restricts the ejbdeploy command to just (a) importing code from the input JAR or EAR file (b)
generating the deployment code, and (c) exporting code to the output JAR or EAR file. It will not
compile the generated deployment code or run remote method invocation compiler (RMIC). Since Java
source code is not usually exported in the output EAR or JAR, this is the only way to save the
generated code.

-bindear "options”
Enables you to populate an EAR file with bindings. This argument applies only to EAR files. You can
also use this command without specifying any options. The options must be separated by a space and
enclosed in double quotation marks. For example: -bindear "xx yy zz" For more information on these
options, see the WebSphere Application Server documentation.

-dbname "name”
The name of the database you want to define in the data definition language (DDL) file that gets
generated. If the name of the database contains any spaces, the entire name must be enclosed in
double quotes. For example: -dbname "my database”

-dbschema "name”
The name of the schema you want to create. If the name of the schema contains any spaces, the
entire name must be enclosed in double quotes. For example: -dbschema "my schema”

-dbvendor name
The name of the database vendor, which is used to determine database column types, mapping
information, Table.dd|, and other information. The valid database vendor names are:
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DB2UDB_V81
DB2 Universal database V8.1 for Linux®, UNIX®, and Windows

DB2UDB_V82
DB2 Universal database V8.2 for Linux, UNIX, and Windows

DB2UDBOS390 V7
DB2 Universal Database™ for z/OS®, V7

DB2UDBOS390 V8
DB2 Universal Database for z/OS, V8

DB2UDBOS390 NEWFN_V8
DB2 Universal Database for z/OS, V8

Additional to the DB2UDBOS390_V8 option, this option includes the generated data model
that has all the new catalog features of DB2 Universal Database for z/OS v8 specified in the
new function mode. Use this option if you plan to work with the generated data model
available in the WebSphere Application Server Toolkit or IBM® Rational® Software
Development Platform products.

DB2UDBISERIES V53
DB2 Universal Database for iSeries™, V5R3

DB2UDBISERIES V54
DB2 Universal Database for iSeries, V5R4

DERBY_V10
IBM Cloudscape™, V10.1

ORACLE_V9l
Oracle, V9i

ORACLE_V10G
Oracle, V10g

INFORMIX_V93
Informix® Dynamic Server, V9.3

INFORMIX_V94
Informix Dynamic Server, V9.4

INFORMIX_V100
Informix Dynamic Server, VV10.0

SYBASE_V1250
Sybase Adaptive Server Enterprise, V12.5

SYBASE_V1i5
Sybase Adaptive Server Enterprise, V15.0

MSSQLSERVER_2000
Microsoft® SQL Server 2000

MSSQLSERVER_2005
Microsoft SQL Server 2005
The following backend ids are deprecated:
SQL92 (1992 SQL Standard)
SQL99 (1999 SQL Standard)
Although SQL92 and SQL99 are deprecated, the SQL92 and SQL99 options remain available. If you
choose to use the deprecated SQL92 or SQL99 backend id, see the topic EJB query to SQL syntax to

help determine what backend you should use, in the near future, when the deprecated SQL92 and
SQL99 backends are no longer available.
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If you want to use an unsupported database, see the topic EJB query to SQL syntax to help choose a
valid database vendor backend id that matches closely to your unsupported deployment environment.

Note:
* The default is DB2UDB_V82 (DB2 for Windows, V8.2 and UNIX)

» If -sqlj is specified, it supports DB2UDB_V82 (DB2 for Windows, V8.2 and UNIX),
DB2UDB_V81 (DB2 for Windows, V8.1 and UNIX), DB2UDBOS390_V8 (DB2 for z/OS, V8)
and DB2UDBOS390_V7(DB2 for z/OS, V7).

-debug
Specifies that deployment code will be compiled with debug information.

-keep
Controls the disposition of the temporary files that are created (that is, the Eclipse workspace) when
the ejbdepToy command has run. Without this option, the Eclipse workspace is deleted when the
command has completed.

-ignoreErrors
Specifies that processing should continue even if validation errors are detected.

-quiet
During validation, suppresses status messages (but does not suppress error messages).

-nowarn
During validation, suppresses warning and informational messages.

-noinform
During validation, suppresses informational messages.

-rmic "options”
Enables you to pass RMIC options to RMIC. The options, which are described in Sun’'s RMI Tools
documentation, must be separated by a space and enclosed in double quotation marks. For example:

n

-rmic "-nowarn -verbose"
-trace

Generates additional progress messages to the console.
-sqlj

Note: This option is valid only on enterprise beans compliant with the 2.0 specification.

Enables you to use SQLJ instead of JDBC to make calls to a DB2 database. With the -sqlj option
specified, the EJB deployment tool generates SQLJ code for your CMP beans to use SQLJ to access
the database. It also automatically invokes the SQLJ translator to translate the SQLJ source files.
Finally, an Ant script will be created by the EJB deployment tool to help you to customize the SQLJ
profiles easily. You can run the Ant script against the profile to produce a DB2 package. These DB2
packages can be used at runtime to avoid extensive runtime checking. Once you have generated the
deployment code for SQLJ using the EJB deployment tool, you will need to run the DB2 SQLJ profile
customizer, db2sqljcustomize, against the generated .ser file, which is found in the subfolder of the
websphere_deploy folder associated with the DB2 backend. Consult the DB2 documentation for more
information on running the DB2 SQLJ profile customizer, or visit www7b.boulder.ibm.com/dmdd/zones/|
liava/bigpicture.html| (section SQLJ supporf).

-OCCColumn

Note: This option is valid only on EJB 2.x CMP entity beans when generating top-down mapping.
Enables you to add a column to your relational database table for collision detection. The collision
detection column is the additional database column reserved to determine if a record has been
updated. Adding a column for collision detection is an alternative optimistic concurrency control
scheme of including attributes in a predicate for optimistic access intents. To manage the collision
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detection column, you will need to provide your own database trigger implementation. The following
are the result of adding a column for collision detection:

* The data type of the collision detection column is a 64 bit integer.
» The naming convention of the collision detection column has the following format: OCC_bean_name

* The top-down mapping generates an extra relational column. This column can not be mapped to the
enterprise bean.

-outer
This is an optional parameter and is only supported for deploying J2EE 1.3 applications. It specifies to
use OUTER semantics for path expressions in EJB query language queries. If this parameter is not
specified, the default setting is INNER semantics.

Note: If you specify this parameter for deploying a J2EE 1.4 application, this option is ignored
because the specification for J2EE 1.4 defines the INNER semantics be used for J2EE 1.4
applications.

-complianceLevel "1.4 " | "5.0"
Specify the Java Development Kit (JDK) compiler compliance level to either 1.4 or 5.0, if you have
included application source files for compilation. If this parameter is not specified, the default setting is
JDK v1.4. If your application is using new functionality defined in JDK v5.0 or you have included
source files (which is not recommended) then you must specify the parameter value as "5.0".

Example
ejbdeploy AceEmp.ear d:\deploydir AceEmp_sqlj.ear -dbvendor DB2UDB_V82 -keep -sqlj -cp "e:\sqllib\java\ssqlj.zip"

Explanation:
We have DB2 Universal database (version 8.2 for Windows and UNIX) installed in e:\sqllib.

The ejbdeploy command takes the AceEmp.ear file (which has enterprise beans that are

compliant with the EJB 2.0 specification) as input and produces the AceEmp_sqlj.ear as output.
Since the -sql1j option is used, SQLJ is used instead of JDBC in the generated code to make calls to
DB2.

When ejbdeploy runs, it creates an Eclipse workspace in the directory that you specify as the working
directory: d:\deploydir. When it has completed running, it deletes this workspace. However, the -keep
option causes ejbdeploy to end without deleting the workspace.

Implementing query methods in home interfaces for CMP entity beans
EJB 2.x provides a query syntax called EJB QL for both finder and select methods of CMP entity beans.

Finder methods obtain one or more entity bean instances from a database, and are defined in the home
interface. Select methods are defined on the abstract bean class and can return entity beans (any entity
bean type defined in the EJB JAR file) or CMP field values.

The <query> element is used to define the query for the finder method in the deployment descriptor, for
every finder method except findByPrimaryKey(key). Queries specified in the deployment descriptor are
translated into SQL during deployment. The query statement is contained in the <ejb-ql> element of the
<query> element:

<query>

<query-method>

<method-name>findA11</method-name>

<method-params>

<method-param></method-param>

</method-params>
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</query-method>
<result-type-mapping></result-type-mapping>
<ejb-ql>select object(o) from Employee o</ejb-ql>
</query>

Where to find additional information about the EJB query language
Detailed information on how to structure EJB queries is found in Chapter 11 of the EJB 2.x specification

available atIjava.sun.com/products/ejb/docs.html. However, the WebSphere documentation contains Sun’s
information along with the WebSphere extensions.
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Chapter 8. Client applications

Using application clients

An application client module is a Java Archive (JAR) file that contains a client for accessing a Java
application.

Complete the following steps for developing different types of application clients.
1. |Decide on a type of application client|
2. Develop the application client code.
a. |Develop ActiveX application client code.|
b. [Develop J2EE application client code
c. [Develop pluggable application client code.|
d. |Develop thin application client code.|
3. Assemble the application client using the Application Server Toolkit.
4. Deploy the application client.
Deploy the application client on Windows systems.|
5. [Run the application client]

View the Application Clients Samples Gallery for more information. To access these samples, install
Application Clients, and retrieve the samples from your local file system as the following command
indicates:

dopp_server rooth/samples/index.html
Application Client for WebSphere Application Server

In a traditional client-server environment, the client requests a service and the server fulfills the request.
Multiple clients use a single server. Clients can also access several different servers. This model persists
for Java clients except that now these requests use a client runtime environment.

WebSphere Application Server Version 6.1 supports the pluggable client.

In this model, the client application requires a servlet to communicate with the enterprise bean, and the
servlet must reside on the same machine as the WebSphere Application Server.

The Application Client for WebSphere Application Server Version 6 (Application Client) consists of the
following client applications:

» J2EE application client application (Uses services provided by the J2EE Client Container)

* Thin application client application (Does not use services provided by the J2EE Client Container)

» Applet application client application

» ActiveX to EJB Bridge application client application (Windows only)

The Application Client is packaged with the following components:
» Java Runtime Environment (JRE) (or an optional full Software Development Kit) that IBM provides.

* WebSphere Application Server run time for J2EE application client applications or Thin application client
applications

- B An ActiveX to EJB Bridge run time for ActiveX to EJB Bridge application client applications
(Windows only)

- I 1BM plug-in for Java platforms for Applet client applications (Windows only)
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Note: The Pluggable application client is a kind of Thin application client. However, the Pluggable
application client uses a Sun JRE and Software Development Kit instead of the JRE and
Software Development Kit that IBM provides.

The ActiveX application client model, uses the Java Native Interface (JNI) architecture to programmatically
access the Java virtual machine (JVM) API. Therefore the JVM code exists in the same process space as
the ActiveX application (Visual Basic, VBScript, or Active Server Pages (ASP) files) and remains attached

to the process until that process terminates.

In the Applet client model, a Java applet embeds in a HyperText Markup Language (HTML) document
residing on a remote client machine from the WebSphere Application Server. With this type of client, the
user accesses an enterprise bean in the WebSphere Application Server through the Java applet in the
HTML document.

The J2EE application client is a Java application program that accesses enterprise beans, Java DataBase
Connectivity (JDBC) APIs, and Java Message Service message queues. The J2EE application client
program runs on client machines. This program follows the same Java programming model as other Java
programs; however, the J2EE application client depends on the Application Client run time to configure its
execution environment, and uses the Java Naming and Directory Interface (JNDI) name space to access
resources.

The Pluggable and Thin application clients provide a lightweight Java client programming model. These
clients are useful in situations where a Java client application exists but the application needs
enhancements to use enterprise beans, or where the client application requires a thinner, more lightweight
environment than the one offered by the J2EE application client. The difference between the Thin
application client and the Pluggable application client is that the Thin application client includes a Java
virtual machine (JVM) API, and the Pluggable application client requires the user to provide this code. The
Pluggable application client uses the Sun Java Development Kit, and the Thin application client uses the
IBM Developer Kit for the Java platform.

The J2EE application client programming model provides the benefits of the J2EE platform for the Java
client application. Use the J2EE application client to develop, assemble, deploy and launch a client
application. The tooling provided with the WebSphere platform supports the seamless integration of these
stages to help the developer create a client application from start to finish.

When you develop a client application using and adhering to the J2EE platform, you can put the client
application code from one J2EE platform implementation to another. The client application package can
require redeployment using each J2EE platform deployment tool, but the code that comprises the client
application remains the same.

The Application Client run time supplies a container that provides access to system services for the client
application code. The client application code must contain a main method. The Application Client run time
invokes this main method after the environment initializes and runs until the Java virtual machine code
terminates.

The J2EE platform supports the Application Client use of nicknames or short names, defined within the
client application deployment descriptor. These deployment descriptors identify enterprise beans or local
resources (JDBC, Java Message Service (JMS), JavaMail and URL APIs) for simplified resolution through
JNDI. This simplified resolution to the enterprise bean reference and local resource reference also
eliminates changes to the client application code, when the underlying object or resource either changes
or moves to a different server. When these changes occur, the Application Client can require
redeployment.

The Application Client also provides initialization of the run-time environment for the client application. The
deployment descriptor defines this unique initialization for each client application. The Application Client
run time also provides support for security authentication to enterprise beans and local resources.
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The Application Client uses the Java Remote Method Invocation-Internet InterORB Protocol (RMI-1IOP).
Using this protocol enables the client application to access enterprise bean references and to use
Common Object Request Broker Architecture (CORBA) services provided by the J2EE platform
implementation. Use of the RMI-IIOP protocol and the accessibility of CORBA services assist users in
developing a client application that requires access to both enterprise bean references and CORBA object

references.

When you combine the J2EE and CORBA environments or programming models in one client application,
you must understand the differences between the two programming models to use and manage each

appropriately.

View the [Samples gallery| for more information about the Application Client.

Application client functions
This topic provides information about available functions in the different types of clients.

Use the following table to identify the available functions in the different types of clients.

beans and other Java classes
through Visual Basic, VBScript,
and Active Server Pages (ASP)
code

Available functions ActiveX client Applet client J2EE Pluggable client Thin client
client

Provides all the benefits of a Yes No Yes No No

J2EE platform

Portable across all J2EE No No Yes No No

platforms

Provides the necessary run-time  Yes Yes Yes Yes Yes

support for communication

between a client and a server

Supports the use of nicknames in Yes No Yes No No

the deployment descriptor files.

Note: Although you can edit

deployment descriptor files, do

not use the administrative

console to modify them.

Supports use of the RMI-IIOP Yes Yes Yes Yes Yes

protocol

Browser-based application No Yes No No No

Enables development of client Yes Yes Yes Yes Yes

applications that can access

enterprise bean references and

CORBA object references

Enables the initialization of the Yes No Yes No No

client application run-time

environment

Supports security authentication  Yes Limited Yes Yes Yes

to enterprise beans

Supports security authentication  Yes No Yes No No

to local resources

Requires distribution of Yes No Yes Yes Yes

application to client machines

Enables access to enterprise Yes No No No No
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Provides a lightweight client No Yes No Yes Yes
suitable for download

Enables access JNDI APIs for Yes Yes Yes Yes Yes
enterprise bean resolution

Runs on client machines that use No No No Yes No
the Sun Java Runtime
Environment

Supports CORBA services (using No No Yes No No
CORBA services can render the

application client code

nonportable)

Supports JMS connections to the No No Yes Yes Yes
default messaging provider

ActiveX application clients
WebSphere Application Server provides an ActiveX to EJB bridge that enables ActiveX programs to
access enterprise beans through a set of ActiveX automation objects.

The bridge accomplishes this access by loading the Java virtual machine (JVM) into any ActiveX
automation container such as Visual Basic, VBScript, and Active Server Pages (ASP).

There are two main environments in which the ActiveX to EJB bridge runs:

» Client applications, such as Visual Basic and VBScript, are programs that a user starts from the
command line, desktop icon, or Start menu shortcut.

» Client services, such as Active Server Pages, are programs started by some automated means like the
Services control panel applet.

The ActiveX to EJB bridge uses the Java Native Interface (JNI) architecture to programmatically access
the JVM code. Therefore the JVM code exists in the same process space as the ActiveX application
(Visual Basic, VBScript, or ASP) and remains attached to the process until that process terminates. To
create JVM code, an ActiveX client program calls the XJBInit() method of the XJB.JClassFactory object.
For more information about creating JVM code for an ActiveX program, see|ActiveX to EJB bridge|
linitializing JVM code}

After an ActiveX client program has initialized the JVM code, the program calls several methods to create
a proxy object for the Java class. When accessing a Java class or object, the real Java object exists in the
JVM code; the automation container contains the proxy for that Java object. The ActiveX program can use
the proxy object to access the Java class, object fields, and methods. For more information about using
Java proxy objects, see ActiveX to EJB bridge, using Java proxy objects| For more information about
calling methods and access fields, see |ActiveX to EJB bridge, calling Java methods| and |ActiveX to EJB|
lridge, accessing Java fields]

The client program performs primitive data type conversion through the COM IDispatch interface (use of
the IUnknown interface is not directly supported). Primitive data types are automatically converted between
native automation types and Java types. All other types are handled automatically by the proxy objects For
more information about data type conversion, see IActiveX to EJB bridge, converting data typesl

Any exceptions thrown in Java code are encapsulated and thrown again as a COM error, from which the
ActiveX program can determine the actual Java exceptions. For more information about handling
exceptions, see|ActiveX to EJB bridge, handling errors|

The ActiveX to EJB bridge supports both free-threaded and apartment-threaded access and implements
the free threaded marshaler (FTM) to work in a hybrid environment such as Active Server Pages. For
more information about the support for threading, see|ActiveX to EJB bridge, using threading]
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Applet clients
The applet client provides a browser-based Java run time capable of interacting with enterprise beans
directly, instead of indirectly through a servlet.

This client is designed to support users who want a browser-based Java client application programming
environment that provides a richer and more robust environment than the one offered by the Applet >
Servlet > enterprise bean model.

The programming model for this client is a hybrid of the Java application thin client and a servlet client.
When accessing enterprise beans from this client, the applet can consider the enterprise bean object
references as CORBA object references.

No tooling support exists for this client to develop, assemble or deploy the applet. You are responsible for
developing the applet, generating the necessary client bindings for the enterprise beans and CORBA
objects, and bundling these pieces together to install or download to the client machine. The Java applet
client provides the necessary run time to support communication between the client and the server. The
applet client run time is provided through the Java applet browser plug-in that you install on the client
machine.

Generate client-side bindings using an such as the Application Server Toolkit (AST) or
Rational Application Developer. An applet can utilize these bindings, or you can generate client-side
bindings using the rmic command. This command is part of the IBM Developer Kit, Java edition that is
installed with the WebSphere Application Server.

The applet client uses the RMI-IIOP protocol. Using this protocol enables the applet to access enterprise
bean references and CORBA object references, but the applet is restricted in using some supported
CORBA services.

If you combine the enterprise bean and CORBA environments in one applet, you must understand the
differences between the two programming models, and you must use and manage each model
appropriately.

The applet environment restricts access to external resources from the browser run-time environment. You
can make some of these resources available to the applet by setting the correct security policy settings in
the WebSphere Application Server client.policy file. If given the correct set of permissions, the applet
client must explicitly create the connection to the resource using the appropriate API. This client does not
perform initialization of any service that the client applet can need. For example, the client application is
responsible for the initialization of the naming service, either through the CosNaming, or the Java Naming
and Directory Interface (JNDI) APIs.

J2EE application clients
The J2EE application client programming model provides the benefits of the Java 2 Platform for
WebSphere Application Server Enterprise product.

The J2EE platform offers the ability to seamlessly develop, assemble, deploy and launch a client
application. The tooling provided with the WebSphere platform supports the seamless integration of these
stages to help the developer create a client application from start to finish.

When you develop a client application using and adhering to the J2EE platform, you can put the client
application code from one J2EE platform implementation to another. The client application package can
require redeployment using each J2EE platform deployment tool, but the code that comprises the client
application does not change.
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The J2EE application client run time supplies a container that provides access to system services for the
application client code. The J2EE application client code must contain a main method. The J2EE
application client run time invokes this main method after the environment initializes and runs until the
Java virtual machine application terminates.

Application clients can use nicknames or short names, defined within the client application deployment
descriptor with the J2EE platform. These deployment descriptors identify enterprise beans or local
resources (JDBC data sources, J2C connection factories, Java Message Service (JMS), JavaMail and
URL APIs) for simplified resolution through JNDI use. This simplified resolution to the enterprise bean
reference and local resource reference also eliminates changes to the application client code, when the
underlying object or resource either changes or moves to a different server. When these changes occur,
the application client can require redeployment. Although you can edit deployment descriptor files, do not
use the administrative console to modify them.

The J2EE application client also provides initialization of the run-time environment for the client application.
The deployment descriptor defines this unique initialization for each client application. The J2EE
application client run time also provides support for security authentication to the enterprise beans and
local resources.

The J2EE application client uses the Java Remote Method Invocation technology run over Internet
Inter-Orb Protocol (RMI-IIOP). Using this protocol enables the client application to access enterprise bean
references and to use Common Object Request Broker Architecture (CORBA) services provided by the
J2EE platform implementation. Use of the RMI-IIOP protocol and the accessibility of CORBA services
assist users in developing a client application that requires access to both enterprise bean references and
CORBA object references.

When you combine the J2EE and the CORBA WebSphere Application Server Enterprise environments or
programming models in one client application, you must understand the differences between the two
programming models to use and manage each appropriately.

Pluggable application clients
The Pluggable application client provides a lightweight, downloadable Java application run time capable of
interacting with enterprise beans.

The Pluggable application client requires that you have previously installed the Sun Java Runtime
Environment (JRE) files. In all other aspects, the Pluggable application client, and the Thin application
client are similar.

Note: The Pluggable application client is only available on the Windows platform.

This client is designed to support those users who want a lightweight Java client application programming
environment, without the overhead of the J2EE platform on the client machine. The programming model
for this client is heavily influenced by the CORBA programming model, but supports access to enterprise
beans.

When accessing enterprise beans from this client, the client application can consider the enterprise beans
object references as CORBA object references.

Tooling does not exist on the client; however, tooling does exists on the server. You are responsible for
developing the client application, generating the necessary client bindings for the enterprise bean and
CORBA objects, and after bundling these pieces together, installing them on the client machine.

The Pluggable application client provides the necessary run time to support the communication needs
between the client and the server.
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The Pluggable application client uses the RMI-IIOP protocol. Using this protocol enables the client
application to access enterprise bean references and CORBA object references and use any supported
CORBA services. Using the RMI-IIOP protocol along with the accessibility of CORBA services can assist a
user in developing a client application that needs to access both enterprise bean references and CORBA
object references.

When you combine the J2EE and CORBA environments in one client application, you must understand the
differences between the two programming models to use and manage each appropriately.

The Pluggable application client run time provides the necessary support for the client application for
object resolution, security, Reliability Availability and Serviceability (RAS), and other services. However,
this client does not support a container that provides easy access to these services. For example, no
support exists for using nicknames for enterprise beans or local resource resolution. When resolving to an
enterprise bean (using either the Java Naming and Directory Interface (JNDI) API or CosNaming) sources,
the client application must know the location of the name server and the fully qualified name used when
the reference was bound into the name space.

When resolving to a local resource, the client application cannot resolve to the resource through a JNDI
lookup. Instead the client application must explicitly create the connection to the resource using the
appropriate API (JDBC, Java Message Service (JMS), and so on). This client does not perform
initialization of any of the services that the client application might require. For example, the client
application is responsible for the initialization of the naming service, either through CosNaming or JNDI
APls.

The Pluggable application client offers access to most of the available client services in the J2EE

application client. However, you cannot access the services in the Pluggable application client as easily as

you can in the J2EE application client. The J2EE client has the advantage of performing a simple Java

Naming and Directory Interface (JNDI) name space lookup to access the desired service or resource. The

Pluggable application client must code explicitly for each resource in the client application. For example,

looking up an enterprise bean Home object requires the following code in a J2EE application client:
java.lang.Object ejbHome = initialContext.lookup("java:/comp/env/ejb/MyEJBHome"

)3 MyEJBHome = (MyEJBHome)javax.rmi.PortableRemoteObject.narrow(ejbHome,

MyEJBHome.class);

However, you need more explicit code in a Pluggable application client for Java:

java.lang.Object ejbHome = initialContext.lookup("the/fully/qualified
/path/to/actual/home/in/namespace/MyEJBHome") ;
MyEJBHome = (MyEJBHome)javax.rmi.PortableRemoteObject.narrow(ejbHome,
MyEJBHome.class);

In this example, the J2EE application client accesses a logical name from the java:/comp name space.
The J2EE client run time resolves that name to the physical location and returns the reference to the client
application. The pluggable client must know the fully qualified physical location of the enterprise bean
Home object in the name space. If this location changes, the pluggable client application must also change
the value placed on the lookup() statement.

In the J2EE client, the client application is protected from these changes because it uses the logical name.
A change can require a redeployment of the EAR file, but the actual client application code remains the
same.

The Pluggable application client is a traditional Java application that contains a main function. The
WebSphere Pluggable application client provides run-time support for accessing remote enterprise beans,
and provides the implementation for various services (security, Workload Management (WLM), and
others). This client can also access CORBA objects and CORBA-based services. When using both
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environments in one client application, you need to understand the differences between the enterprise
bean and the CORBA programming models to manage both environments.

For instance, the CORBA programming model requires the CORBA CosNaming name service for object
resolution in a name space. The enterprise beans programming model requires the JNDI name service.
The client application must initialize and properly manage these two naming services.

Another difference applies to the enterprise bean model. Use the Java Naming and Directory Interface
(JNDI) implementation in the enterprise bean model to initialize the Object Request Broker (ORB). The
client application is unaware that an ORB is present. The CORBA model, however, requires the client

application to explicitly initialize the ORB through the ORB.init() static method.

The Pluggable application client provides a batch command that you can use to set the CLASSPATH and
JAVA_HOME environment variables to enable the Pluggable application client run time.

Thin application clients
The thin application client provides a lightweight, downloadable Java application run time capable of
interacting with enterprise beans.

WebSphere Application Server Version 6.1 supports the pluggable client.

The thin client is designed to support those users who want a lightweight Java client application
programming environment, without the overhead of the J2EE platform on the client machine. The
programming model for this client is heavily influenced by the CORBA programming model, but supports
access to enterprise beans.

When accessing enterprise beans from this client, the client application can consider the enterprise beans
object references as CORBA object references.

Tooling does not exist on the client, it exists on the server. You are responsible for developing the client
application, generating the necessary client bindings for the enterprise bean and CORBA objects, and
bundling these pieces together to install on the client machine.

The thin application client provides the necessary runtime to support the communication needs between
the client and the server.

The thin application client uses the RMI-IIOP protocol. Using this protocol enables the client application to
access not only enterprise bean references and CORBA object references, but also allows the client
application to use any supported CORBA services. Using the RMI-IIOP protocol along with the accessibility
of CORBA services can assist a user in developing a client application that needs to access both
enterprise bean references and CORBA object references.

When you combine the J2EE and CORBA environments in one client application, you must understand the
differences between the two programming models, to use and manage each appropriately.

The thin application client run time provides the necessary support for the client application for object
resolution, security, Reliability Availability and Servicability (RAS), and other services. However, this client
does not support a container that provides easy access to these services. For example, no support exists
for using nicknames for enterprise beans or local resource resolution. When resolving to an enterprise
bean (using either Java Naming and Directory Interface (JNDI) or CosNaming) sources, the client
application must know the location of the name server and the fully qualified name used when the
reference was bound into the name space. When resolving to a local resource, the client application
cannot resolve to the resource through a JNDI lookup. Instead the client application must explicitly create
the connection to the resource using the appropriate APl (JDBC, Java Message Service (JMS), and so
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on). This client does not perform initialization of any of the services that the client application might
require. For example, the client application is responsible for the initialization of the naming service, either
through CosNaming or JNDI APIs.

The thin application client offers access to most of the available client services in the J2EE application
client. However, you cannot access the services in the thin client as easily as you can in the J2EE
application client. The J2EE client has the advantage of performing a simple Java Naming and Directory
Interface (JNDI) name space lookup to access the desired service or resource. The thin client must code
explicitly for each resource in the client application. For example, looking up an enterprise bean Home
requires the following code in a J2EE application client:

java.lang.Object ejbHome = initialContext.lookup("java:/comp/env/ejb/MyEJBHome");
MyEJBHome = (MyEJBHome)javax.rmi.PortableRemoteObject.narrow(ejbHome, MyEJBHome.class);

However, you need more explicit code in a Java thin application client:

java.lang.0Object ejbHome =
initialContext.lookup("the/fully/qualified/path/to/actual/home/in/namespace/MyEJBHome");
MyEJBHome = (MyEJBHome)javax.rmi.PortableRemoteObject.narrow(ejbHome, MyEJBHome.class);

In this example, the J2EE application client accesses a logical name from the java:/comp name space.
The J2EE client run time resolves that name to the physical location and returns the reference to the client
application. The thin client must know the fully qualified physical location of the enterprise bean Home in
the name space. If this location changes, the thin client application must also change the value placed on
the lookup() statement.

In the J2EE client, the client application is protected from these changes because it uses the logical name.
A change might require a redeployment of the EAR file, but the actual client application code remains the
same.

The thin application client is a traditional Java application that contains a main function. The WebSphere
thin application client provides run-time support for accessing remote enterprise beans, and provides the
implementation for various services (security, Workload Management (WLM), and others). This client can
also access CORBA objects and CORBA based services. When using both environments in one client
application, you need to understand the differences between the enterprise bean and CORBA
programming models to manage both environments.

For instance, the CORBA programming model requires the CORBA CosNaming name service for object
resolution in a name space. The enterprise beans programming model requires the JNDI name service.
The client application must initialize and properly manage these two naming services.

Another difference applies to the enterprise bean model. Use the Java Naming and Directory Interface
(JNDI) implementation in the enterprise bean model to initialize the Object Request Broker (ORB). The
client application is unaware that an ORB is present. The CORBA model, however, requires the client
application to explicitly initialize the ORB through the ORB.init() static method.

The thin application client provides a batch command that you can use to set the CLASSPATH and
JAVA_HOME environment variables to enable the thin application client run time.

Application client troubleshooting tips

This topic provides debugging tips for resolving common Java 2 Platform Enterprise Edition (J2EE)
application client problems. To use this troubleshooting guide, review the trace entries for one of the J2EE
application client exceptions, and then locate the exception in the guide.

Some of the errors in the guide are samples, and the actual error you receive can be different than what is

shown here. You might find it useful to rerun the TaunchCTient command specifying the -CCverbose=true
option. This option provides additional information when the J2EE application client run time is initializing.
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Error: java.lang.NoClassDefFoundError

Explanation
Possible causes

Recommended
response

This exception is thrown when Java code cannot load the specified class.

 Invalid or non-existent class

» Class path problem

* Manifest problem

Check to determine if the specified class exists in a Java Archive (JAR) file within your
Enterprise Archive (EAR) file. If it does, make sure the path for the class is correct. For
example, if you get the exception:

java.lang.NoClassDefFoundError:
WebSphereSamples.HelToEJB.HelToHome

verify that the HelloHome class exists in one of the JAR files in your EAR file. If it exists,
verify that the path for the class is WebSphereSamples.HelloEJB.

If both the class and path are correct, then it is a class path issue. Most likely, you do not

have the failing class JAR file specified in the client JAR file manifest. To verify this situation,

perform the following steps:

1. Open your EAR file with the Application Server Toolkit or the Rational Web Developer
assembly tool, and select the Application Client.

2. Add the names of the other JAR files in the EAR file to the Classpath field.

This exception is generally caused by a missing Enterprise Java Beans (EJB) module name
from the Classpath field.

If you have multiple JAR files to enter in the Classpath field, be sure to separate the JAR
names with spaces.

If you still have the problem, you have a situation where a class is loaded from the file
system instead of the EAR file. This error is difficult to debug because the offending class is
not the one specified in the exception. Instead, another class is loaded from the file system
before the one specified in the exception. To correct this error, review the class paths
specified with the -CCclasspath option and the class paths configured with the Application
Client Resource Configuration Tool. Look for classes that also exist in the EAR file. You must
resolve the situation where one of the classes is found on the file system instead of in the
.ear file. Remove entries from the classpaths, or include the .jar files and classes in the
.ear file instead of referencing them from the file system.

If you use the -CCclasspath parameter or resource classpaths in the Application Client
Resource Configuration Tool, and you have configured multiple JAR files or classes, verify
they are separated with the correct character for your operating system. Unlike the Classpath
field, these class path fields use platform-specific separator characters, usually a colon (on
operating systems such as AIX or Linux) or a semi-colon (on Windows systems).

Note: The system class path is not used by the Application Client run time if you use the
launchClient batch or shell files. In this case, the system class path would not cause this
problem. However, if you load the launchClient class directly, you do have to search through
the system class path as well.
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Error: com.ibm.websphere.naming.CannotinstantiateObjectException: Exception
occurred while attempting to get an instance of the object for the specified
reference object. [Root exception is javax.naming.NameNotFoundException:

XXXXXXXXXX]

Explanation

Possible causes

Recommended response

This exception occurs when you perform a lookup on an
object that is not installed on the host server. Your
program can look up the name in the local client Java
Naming and Directory Interface (JNDI) name space, but
received a NameNotFoundException exception because it
is not located on the host server. One typical example is
looking up an EJB component that is not installed on the
host server that you access. This exception might also
occur if the INDI name you configured in your Application
Client module does not match the actual JNDI name of
the resource on the host server.

* Incorrect host server invoked

* Resource is not defined

* Resource is not installed

» Application server is not started

* Invalid JNDI configuration

If you are accessing the wrong host server, run the
TaunchCTient command again with the -CCBootstrapHost
parameter specifying the correct host server name. If you
are accessing the correct host server, use the product
dumpnamespace command line tool to see a listing of the
host server JNDI name space. If you do not see the failing
object name, the resource is either not installed on the
host server or the appropriate application server is not
started. If you determine the resource is already installed
and started, your JNDI name in your client application
does not match the global JNDI name on the host server.
Use the Application Server Toolkit to compare the JNDI
bindings value of the failing object name in the client
application to the JNDI bindings value of the object in the
host server application. The values must match.

Error: javax.naming.ServiceUnavailableException: A communication failure
occurred while attempting to obtain an initial context using the provider url:
"iiop://[invalidhostname]’. Make sure that the host and port information is correct
and that the server identified by the provider URL is a running name server. If no
port number is specified, the default port number 2809 is used. Other possible
causes include the network environment or workstation network configuration.
Root exception is org.omg.CORBA.INTERNAL: JORBOO50E: In
Profile.getiPAddress(), InetAddress.getByName[invalidhostname] threw an
UnknownHostException. minor code: 4942F5B6 completed: Maybe

Explanation
Possible causes

Recommended response

This exception occurs when you specify an invalid host
server name.

* Incorrect host server invoked

* Invalid host server name

Run the TaunchClient command again and specify the
correct name of your host server with the
-CCBootstrapHost parameter.
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Error: javax.naming.CommunicationException: Could not obtain an initial context
due to a communication failure. Since no provider URL was specified, either the
bootrap host and port of an existing ORB was used, or a new ORB instance was
created and initialized with the default bootstrap host of "localhost” and the
default bootstrap port of 2809. Make sure the ORB bootstrap host and port resolve
to a running name server. Root exception is org.omg.CORBA.COMM_FAILURE:
WRITE_ERROR_SEND_1 minor code: 49421050 completed: No

Explanation This exception occurs when you run the TaunchClient
command to a host server that does not have the
Application Server started. You also receive this exception
when you specify an invalid host server name. This
situation might occur if you do not specify a host server
name when you run the launchClient tool. The default
behavior is for the launchClient tool to run to the local
host, because WebSphere Application Server does not
know the name of your host server. This default behavior
only works when you are running the client on the same
machine with WebSphere Application Server is installed.

Possible causes * Incorrect host server invoked
* Invalid host server name
 Invalid reference to Tocalhost
» Application server is not started
 Invalid bootstrap port

Recommended response If you are not running to the correct host server, run the
TaunchClient command again and specify the name of
your host server with the -CCBootstrapHost parameter.
Otherwise, start the Application Server on the host server
and run the TaunchClient command again.

Error: javax.naming.NameNotFoundException: Name comp/env/ejb not found in
context "java:”

Explanation This exception is thrown when the Java code cannot
locate the specified name in the local INDI name space.
Possible causes * No binding information for the specified name

* Binding information for the specified name is incorrect
* Wrong class loader was used to load one of the
program classes
* A resource reference does not include any client
configuration information
» Aclient container on the deployment manager is trying
to use enterprise extensions (hot supported)
Recommended response Open the EAR file with the Application Server Toolkit, and
check the hindings for the failing name. Ensure this
information is correct. If you are using Resource
References, [open the EAR file with the Application Client]
|[Resource Configuration Tool, and verify that the Resource
Reference has client configuration information and the
name of the Resource Reference exactly matches the
JNDI name of the client configuration. If the values are
correct, you might have a class loader error.
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Error: java.lang.ClassCastException: Unable to load class:
org.omg.stub.WebSphereSamples.HelloEJB._HelloHome_Stub at
com.ibm.rmi.javax.rmi.PortableRemoteObject.narrow(portableRemoteObject.java:269)

Explanation This exception occurs when the application program
attempts to narrow to the EJB home class and the class
loaders cannot find the EJB client side bindings.

Possible causes * The files, *_Stub.class and _Tie.class, are not in the
EJB .jar file
* Class loader could not find the classes
Recommended response Look at the EJB . jar file located in the .ear file and verify

the class contains the Enterprise Java Beans (EJB) client
side bindings. These are class files with file names that
end in _Stub and _Tie. If the binding classes are in the
EJB .jar file, then you might have a class loader error.

Error: WSCLO0210E: The Enterprise archive file [EAR file name] could not be found.
com.ibm.websphere.client.applicationclient.ClientContainerException:
com.ibm.etools.archive.exception.OpenFailureException

Explanation This error occurs when the application client run time
cannot read the Enterprise Archive (EAR) file.
Possible causes The most likely cause of this error is that the system

cannot find the EAR file cannot be found in the path
specified on the TaunchClient command.

Recommended response Verify that the path and file name specified on the
TaunchcTient command are correct. If you are running on
the Windows operating system and the path and file name
are correct, use a short version of the path and file name
(8 character file name and 3 character extension).

The launchClient command appears to hang and does not return to the command
line when the client application has finished.

Explanation When running your application client using the
TaunchClient command the WebSphere Application
Server run time might need to display the security login
dialog. To display this dialog, WebSphere Application
Server run time creates an Abstract Window Toolkit (AWT)
thread. When your application returns from its main
method to the application client run time, the application
client run time attempts to return to the operating system
and end the Java virtual machine (JVM) code. However,
since there is an AWT thread, the JVM code will not end
until System.exit is called.

Possible causes The JVM code does not end because there is an AWT
thread. Java code requires that System.exit() be called
to end AWT threads.

Recommended response * Modify your application to call System.exit(0) as the

last statement.
» Use the -CCexitVM=true parameter when you call the
TaunchClient command.
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The applet client application client fails to launch an HTML browser in Internet

Explorer

Explanation

Possible causes

Recommended response

Applet client applications run only on Windows systems.
When the applet client application runs, the application
output data is displayed in a browser window. If you are
using Internet Explorer with the Windows XP operating
system for Service Pack 2 , then you might get errors
when trying to display output data.

The Windows XP operating system for Service Pack 2 has

a security feature that blocks pop-up browser windows

from appearing.

» Locate the information bar found under the URL
Address bar in the Internet Explorer pop-up browser
that has been blocked.

* Click the Information Bar to display options that disable
the operating system security feature.

» Select Allow blocked content. You are prompted with
a security window asking you to confirm your selection
to allow blocked content.

» Click Yes.

* The applet client application runs successfully, and the
browser information is displayed appropriately.

Installing the Developer Kit feature downgrades the JRE files from Version 6.0.1 or

Version 6.0.2 to Version 6.0

Explanation

Possible causes

Recommended response

If you select the Developer Kit feature on the Application
Client Version 6.0.0 installer, all the files are installed
under the <client_install_root>/java directory, instead of
leaving the Java Runtime Environment (JRE) files intact.
The JRE files are unexpectedly downgraded to the
Version 6.0.0 level.

Selecting the Developer Kit feature on the Application
Client 6.0.0 installer will actually install all files under the
<client_install_root>/java directory rather than leave the
JRE files intact. Therefore, the JRE files are unexpected
downgraded to the 6.0.0 level in the above installation
scenario.

Complete the following installation steps to prevent
unexpected downgrading of the JRE files.

IBM Support has documents and tools that can save you time gathering information needed to resolve
problems as described in Troubleshooting help from IBM. Before opening a problem report, see the

Support page:

http://www. ibm.com/software/webservers/appserv/was/support/|

Developing application clients

This topic provides the steps for programming application clients to access resource objects defined on the

Server.

To use application clients to access a remote object on the server, develop your application clients as

described in the following steps:

1. Create an instance of the object that you want to access from the remote server.
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5.
6.
7.

Specify the user ID and password on the connection method, when you create a connection to the
server. Security must be enabled.

Assemble the application client .ear file using anfassembly tool} such as the Application Server Toolkit
(AST) or Rational Application Developer. Assemble the application client .ear file on any development
machine where the [assembly tooI| is installed.

Add the resource to the client deployment descriptor by completing the binding JNDI name for the
resource object on the server.

Distribute the configured .ear file to the client machines.
[Deploy the application client|
[Configure the application client resources|

After you develop the application client code, |run the application clientl

Developing ActiveX application client code

This topic provides an outline for developing an ActiveX Windows program, such as Visual Basic,
VBScript, and Active Server Pages, to use the WebSphere ActiveX to EJB bridge to access enterprise
beans.

This topic assumes that you are familiar with ActiveX programming and developing on the Windows
platform. Consider the information given in ActiveX to EJB bridge as good programming guidelines.

To use the ActiveX to EJB bridge to access a Java class, develop your ActiveX program to complete the
following steps:

1.
2.

Create an instance of the XJB.JClassFactory object.

Create Java virtual machine (JVM) code within the ActiveX program process, by calling the XJBInit()
method of the XJB.JClassFactory object. After the ActiveX program has created an XJB.JClassFactory
object and called the XJBInit() method, the JVM code is initialized and ready for use.

Create a proxy object for the Java class, by using the XJB.JClassFactory FindClass() and
Newlnstance() methods. The ActiveX program can use the proxy object to access the Java class,
object fields, and methods.

Call methods on the Java class, using the Java method invocation syntax, and access Java fields as
required.

Use the helper functions to do the conversion in cases where automatic conversion is not possible.
You can convert between the following data types:

» Java Byte and Visual Basic Byte

* Visual Basic Currency types and Java 64-bit

Implement methods to handle any errors returned from the Java class. In Visual Basic or VBScript, use
the Err.Number and Err.Description fields to determine the actual Java error.

After you develop the ActiveX client code, [start the ActiveX application]

Starting an ActiveX application

To run an ActiveX client application that is to use the ActiveX to Enterprise Java Beans (EJB) bridge, you
must perform some initial configuration to set appropriate environment variables and to enable the ActiveX
to EJB bridge to find its XJB.JAR file and the Java run time. This initial configuration sets up the
environment within which the ActiveX client application can run.

To perform the required configuration, complete one or more of the following tasks:

1.
2.

|Start an ActiveX application and configure service programsl.
[Start an ActiveX application and configuring non-service programs|
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Starting an ActiveX application and configuring service programs

To run an ActiveX service program such as Active Server Page (ASP) that is to use the ActiveX to the
Enterprise Java Bean (EJB) bridge, some initial configuration (to set appropriate environment variables
and to enable the ActiveX to EJB bridge to find its XJB.JAR file and the Java run time) is necessary. This
configuration sets up the environment within which the ActiveX service program can run.

The XJB.JClassFactory must find the Java run time dynamic link library (DLL) when initializing. In a
service program such as Internet Information Server you cannot specify a path for its processes
independently; you must set the process paths in the system PATH variable. This limitation means that you
can only have a single Java virtual machine (JVM) version available on a machine using ASP.

To add the Java Runtime Environment (JRE) directories to your system path, complete one of the
following task.

On Windows 2000 systems, complete the following steps:

1. Open the Control Panel, then double-click the System icon.

2. Click the Advanced tab on the System Properties window.

3. Click Environment Variables.

4. Edit the Path variable in the System Variables window.

5. Add the following information to the beginning of the path that is displayed in the Variable Value field:

C:\WebSphere\AppClient\Java\jre\bin;C:\WebSphere\AppClient\Java\jre\bin\classic;
where C:\WebSphere\AppClient is the directory in which you installed the Java client in the WebSphere
product.

6. Click OK in the Edit System Variable window to apply the changes.

7. Click OK in the Environment Variables window.

8. Click OK in the System Properties window.

9. Restart Windows 2000.

After you change the system PATH variable you must reboot the Internet Information Server machine so
that Internet Information Server can see the change.

Starting an ActiveX application and configuring non-service programs

To run an ActiveX program initiated from an icon or command line (a non-service program) that is to use
the ActiveX to the Enterprise Java Beans (EJB) bridge, you must perform some initial configuration to set
appropriate environment variables and to enable the ActiveX to EJB bridge to find its XJB.JAR file and the
Java run-time environment. This uses a batch file to set up the environment within which the ActiveX
program can run.

To perform the required configuration, complete the following steps:

1. Edit the setupCmdLineXJB.bat file to specify appropriate values for the environment variables required
by the ActiveX to EJB bridge. For more information about these environment variables, see ActiveX to
EJB bridge, environment and configuration. For more information about creating a JVM for an ActiveX
program, see ActiveX to EJB bridge, initializing the Java virtual machine (JVM). After the ActiveX
program has created an XJB.JClassFactory object and called the XJBInit() method, the JVM is
initialized and ready for use.

2. Start the ActiveX client application by using one of the following methods:
» Use the TaunchClientXJB.bat file to start the application. For example:

launchClientXJB MyApplication.exe parml parm2

or

TaunchClientXJB MyApplication.vbp
* Use the setupCmdLineXJB.bat file to create an environment in which to run the application, then start
the application from within that environment.
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setupCmdLineXJB.bat, launchClientXJB.bat and other ActiveX batch files

This topic provides reference information about the aids that client applications and client services can use
to access the ActiveX to EJB bridge. These enable the ActiveX to Enterprise JavaBeans (EJB) bridge to
find its XJB.JAR file and the Java run-time environment.

Location

The include file is located in the was_client_home\aspIncludes directory. You can include the file into your
Active Server Pages (ASP) application with the following syntax in your ASP page:

<-- #include virtual ="/WSASPIncludes/setupASPXJB.inc" -->

This syntax assumes that you have created a virtual directory in Internet Information Server called
WSASPIncludes that points to the was_client _home\aspIncludes directory.

Usage notes

The following batch files are provided for client applications to use the ActiveX to EJB bridge:
* setupCmdLineXJB.bat

Sets the client environment variables.
* launchClientXJB.bat

Calls the setupCmdLineXJB.bat file and launches the application you specify as its arguments; for
example:

TaunchClientXJB.bat myapp.exe parml parm2

or

lTaunchClientXJB MyApplication.vbp
» Active Server Pages (ASP) include file

An include file is provided for ASP users to automatically set the following page-level (local)

environment variables:

— com_ibm_websphere_javahome. Path to the Java run-time directory installed with the WebSphere
advanced server client.

— com_ibm_websphere_washome. Path to the WebSphere advanced server client directory.

— com_ibm_websphere_namingfactory. Sets the Java java.naming.factory.initial system property.

— com_ibm_websphere_computername. (Optional) Name of the computer where the WebSphere
Advanced Server Client is installed. If you intend to talk to a single specific computer, you are
recommended to change this value to become the server name that you intend to access.

+ System settings

To enable the ActiveX to EJB bridge to access the Java run-time dynamic link library (DLL), the
following directories must exist in the system PATH environment variable:

was_client_home\java\jre\binswas client home\java\jre\bin\classic

Where was_client_home is the name of the directory where you installed the WebSphere Application
Server client (for example, C:\WebSphere\AppClient).

Note: This technique enables only one Java run time to activate on a machine, therefore all client
services on that machine must use the same Java run time. Client applications do not have this
limitation because they each have their own private, non-system scope.

JClassProxy and JObjectProxy classes

The majority of tasks for accessing your Java classes and objects are handled with the JClassProxy and
JObjectProxy objects. This topic provides reference information about the object classes of the ActiveX to
Enterprise Java Beans (EJB) bridge.
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JClassFactory is the object used to access the majority of Java Virtual Machine (JVM) features. This
object handles JVM initialization, accesses classes and creates class instances (objects). Use the
JClassProxy and JObjectProxy objects to access the majority of your Java classes and objects:

* XJBInit(String astrJavaParameterArray())

Initializes the JVM environment using an array of strings that represent the command line parameters
you normally send to the java.exe file.

If you have invalid parameters in the XJBInit() string array, the following error is displayed:
Error: 0x6002 "XJBJINI::Init() Failed to create VM" when calling XJBInit()

If you have C++ logging enabled, the activity log displays the invalid parameter.
» JClassProxy FindClass(String strClassName)

Uses the current thread class loader to load the specified fully qualified class name and returns a
JClassProxy object representing the Java Class object.
» JObjectProxy Newlnstance()

Creates a Class instance for the specified JClassProxy object using the parameters supplied to call the
Class constructor. For more information about using the JMethodArgs method, see ActiveX to EJB
bridge, calling Java methods.

JObjectProxy NewInstance(JClassFactory obj, Variant vArgl, Variant vArg2, Variant vArg3, ...)

JObjectProxy NewInstance(JClassFactory obj, JMethodArgs args)

* JMethodArgs GetArgsContainer()

Returns a JMethodArgs object (Class instance).

You can create a JClassProxy object from the JClassFactory.FindClass() method and from any Java
method call that normally return a Java Class object. You can use this object as if you had direct access
to the Java Class object. All of the class static methods and fields are accessible as are the
java.lang.Class methods. In case of a clash between static method names of the reflected user class
and those of the java.lang.Class (for example, getName()), the reflected static methods would execute
first.

For example, the following is a static method called getName(). The java.lang.Class object also has a
method called getName():
— InJava:

class foof{
foo(){};
public static String getName(){return "abcdef";}
public static String getName2(){return "ghijk1";}
public String toString2(){return "xyz";}
}
— In Visual Basic:

Dim cI1sFoo as Object
set clsFoo = oXJB.FindClass("foo")
clsFoo.getName() ' Returns "abcdef" from the static foo class
clsFoo.getName2() ' Returns "ghijkl" from the static foo class
clsFoo.toString() ' Returns "class foo" from the java.lang.Class object.
oFoo = oXJB.NewInstance(clsFoo)
oFoo.toString() ' Returns some text from the java.lang.Object's
" toString() method which foo inherits from.
oFoo.toString2() ' Returns "xyz" from the foo class instance
You can create a JObjectProxy object from the JClassFactory.NewInstance() method, and can be
created from any Java method call that normally returns a Class instance object. You can use this
object as if you had direct access to the Java object and can access all the static methods and fields
of the object. All of object instance methods and fields are accessible (including those accessible

through inheritance).

The JMethodArgs object is created from the JClassFactory.GetArgsContainer() method. Use this
object as a container for method and constructor arguments. You must use this object when
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overriding the object type when calling a method (for example, when sending a java.lang.String
JProxyObiject type to a constructor that normally takes a java.lang.Object type).

You can use two groups of methods to add arguments to the collection: Add and Set. You can use
Add to add arguments in the order that they are declared. Alternatively, you can use Set to set an
argument based on its position in the argument list (where the first argument is in position 1).

For example, if you had a Java Object Foo that took a constructor of Foo (int, String, Object), you

could use a JMethodArgs object as shown in the following code extract:

Dim oArgs as Object
set 0Args = oXJB.GetArgsContainer()

0Args.AddInt(CLng(12345))
0Args.AddString("Apples")
oArgs.AddObject ("java.lang.Object", oSomeJObjectProxy)

Dim clsFoo as Object

Dim oFoo as Object

set clsFoo = oXJB.FindClass("com.mypackage.foo")
set oFoo = oXJB.NewInstance(clsFoo, oArgs)

' To reuse the oArgs object, just clear it and use the add method

' again, or alternatively, use the Set method to reset the parameters
' Here, we will use Set

oArgs.SetInt(1, CLng(22222))

oArgs.SetString(2, "Bananas")

oArgs.SetObject (3, "java.lang.Object", oSomeOtherJObjectProxy)

Dim oFoo2 as Object
set 0Fo02 = oXJB.NewInstance(clsFoo, oArgs)

AddObiject (String strObjectTypeName, Object 0Arg)

Adds an arbitrary object to the argument container in the next available position, casting the object to
the class name specified in the first parameter. Arrays are specified using the traditional [] syntax; for

example:
AddObject("java.lang.0Object[][]", oMy2DArrayOfFooObjects)

or

AddObject ("int[]", oMyArrayOflInts)
AddByte (Byte byteArg)

Adds a primitive byte value to the argument container in the next available position.
AddBoolean (Boolean bArg)

Adds a primitive boolean value to the argument container in the next available position.
AddShort (Integer iArg)

Adds a primitive short value to the argument container in the next available position.
Addint (Long IArg)

Adds a primitive int value to the argument container in the next available position.
AddLong (Currency cyArg)

Adds a primitive long value to the argument container in the next available position.
AddFloat (Single fArg)

Adds a primitive float value to the argument container in the next available position.
AddDouble (Double dArg)

Adds a primitive double value to the argument container in the next available position.
AddChar (String strArg)

Adds a primitive char value to the argument container in the next available position.
AddString (String strArg)

Adds the argument in string form to the argument container in the next available position.
SetObiject (Integer iArgPosition, String strObjectTypeName, Object 0Arg)
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Adds an arbitrary object to the argument container in the specified position casting it to the class name
or primitive type name specified in the second parameter. Arrays are specified using the traditional []
syntax; for example:

SetObject (1, "java.lang.Object[][]", oMy2DArrayOfFooObjects)

or

SetObject (2, "int[]", MyArrayOfInts)
SetByte (Integer iArgPosition, Byte byteArg)

Sets a primitive byte value to the argument container in the position specified.
SetBoolean (Integer iArgPosition, Boolean bArg)

Sets a primitive boolean value to the argument container in the position specified.
SetShort (Integer iArgPosition, Integer iArg)

Sets a primitive short value to the argument container in the position specified.
Setint (Integer iArgPosition, Long IArg)

Sets a primitive int value to the argument container in the position specified.
SetLong (Integer iArgPosition, Currency cyArg)

Sets a primitive long value to the argument container in the position specified.
SetFloat (Integer iArgPosition, Single fArg)

Sets a primitive float value to the argument container in the position specified.
SetDouble (Integer iArgPosition, Double dArg)

Sets a primitive double value to the argument container in the position specified.
SetChar (Integer iArgPosition, String strArg)

Sets a primitive char value to the argument container in the position specified.
SetString (Integer iArgPosition, String strArg)

Sets a java.lang.String value to the argument container in the position specified.
Object Item(Integer iArgPosition)

Returns the value of an argument at a specific argument position.
Clear()

Removes all arguments from the container and resets the next available position to one.
Long Count()

Returns the number of arguments in the container.

Java virtual machine initialization tips

Initialize the Java virtual machine (JVM) code with the ActiveX to Enterprise Java Beans (EJB) bridge. For
an ActiveX client program (Visual Basic, VBScript, or ASP) to access Java classes or objects, the first step
that the program must do is to create Java virtual machine (JVM) code within its process.

To create JVM code, the ActiveX program calls the XJBInit() method of the XJB.JClassFactory object.
When an XJB.JClassFactory object is created and the XJBInit() method called, the JVM is initialized and
ready to use.

To enable the XJB.JClassFactory to find the Java run-time description definition language (DLL) when
initializing, the Java Runtime Environment (JRE) bin and bin\classic directories must exist in the
system path environment variable.

The XJBInit() method accepts only one parameter: an array of strings. Each string in the array
represents a command line argument that for a Java program you would normally specify on the
Java.exe command line. This string interface is used to set the class path, stack size, heap size and
debug settings. You can get a listing of these parameters by typing java -? from the command line.

If you set a parameter incorrectly, you receive a 0x6002 "Failed to initialize VM" error message.
Due to the current limitations of Java Native Interface (JNI), you cannot unload or reinitialize the JVM
code after it has loaded. Therefore, after the XJBInit() method has been called once, subsequent calls
have no effect other than to create a duplicate JClassFactory object for you to access. It is best to store
your XJB.JClassFactory object globally and continue to reuse that object.
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The following Visual Basic extract shows an example of initializing JVM code:

Dim oXJB as Object

set oXJB = CreateObject("XJB.JClassFactory")

Dim astrJavalnitProps(0) as String

astrdavalnitProps(0) = _
"-Djava.class.path=.;c:\myjavaclasses;c:\myjars\myjar.jar"

0XJB.XJBInit(astrdavalnitProps)

Example: Developing an ActiveX application client to enterprise beans

This reference topic provides an example of using Java proxy objects with the ActiveX to Enterprise
JavaBeans (EJB) bridge.

To use Java proxy objects with the ActiveX to Enterprise JavaBeans (EJB) bridge:

After an ActiveX client program (Visual Basic, VBScript, or Active Server Pages (ASP)) has initialized
the XJB.JClassFactory object and thereby, the Java virtual machine (JVM), the client program can
access Java classes and initialize Java objects. To complete this action, the client program uses the
XJB.JClassFactory FindClass() and Newlnstance() methods.

In Java programming, two ways exists to access Java classes: direct invocation through the Java
compiler and through the Java Reflection interface. Because the ActiveX to Java bridge needs no
compilation and is a complete run-time interface to the Java code, the bridge depends on the latter
Reflection interface to access its classes, objects, methods and fields. The XJB.JClassFactory
FindClass() and Newlnstance() methods behave very similarly to the Java Class.forName() and the
Method.invoke() and Field.invoke() methods.

XJB.JClassFactory.FindClass() takes the fully qualified class name as its only parameter and returns a
Proxy Object (JClassProxy). You can use the returned Proxy object like a normal Java Class object and
call static methods and access static fields. You can also create a Class Instance (or object), as
described below. For example, the following Visual Basic code extract returns a Proxy object for the
java.lang.Integer Java class:

Dim cTsMyString as Object

Set clsMyString = oXJB.FindClass("java.lang.Integer")

After the proxy is created, you can access its static information directly. For example, you can use the
following code extract to convert a decimal integer to its hexadecimal representation:

Dim strHexValue as String
strHexValue = clsMyString.toHexString(CLng(255))

The equivalent Java syntax is: static String toHexString(int i). Because ints units in Java
programming are really 32-bit (which translates to Long in Visual Basic), the CLng() function converts
the value from the default int to a long. Also, even though the toHexString() function returns a
java.lang.String, the code extract does not return an Object proxy. Instead, the returned java.lang.String
is automatically converted to a native Visual Basic string.

To create an object from a class, you use the JClassFactory.Newlnstance() method. This method
creates an Object instance and takes whatever parameters your class constructor needs. Once the
object is created, you have access to all of its public instance methods and fields. For example, you can
use the following Visual Basic code extract to create an instance of the java.lang.Integer string:

Dim oMyInteger as Object
set oMyInteger = oXJB.NewInstance(CLng(255))

Dim strMyInteger as String
strMyInteger = oMyInteger.toString

Example: Calling Java methods in the ActiveX to enterprise beans

In the ActiveX to Enterprise Java Beans (EJB) bridge, methods are called using the native language
method invocation syntax.
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The following differences between Java invocation and ActiveX Automation invocation exist:

Unlike Java methods, ActiveX does not support method (and constructor) polymorphism; that is, you
cannot have two methods in the same class with the same name.

Java methods are case-sensitive, but ActiveX Automation is not case-sensitive.

To compensate for Java polymorphic behavior, give the exact parameter types to the method call. The
parameter types determine the correct method to invoke. For a listing of correct types to use, see
ActiveX to EJB bridge, converting data types.

For example, the following Visual Basic code fails if the CLng() method was not present or the
toHexString syntax was incorrectly typed as ToHexString:

Dim strHexValue as String
strHexValue = cTsMyString.toHexString(CLng(255))

Sometimes it is difficult to force some development environments to leave the case of your method calls
unchanged. For example, in Visual Basic if you want to call a method close() (lowercase), the Visual
Basic code capitalizes it "Close()”. In Visual Basic, the only way to effectively work around this behavior
is to use the CallByName() method. For example:

0.Close(123) "Incorrect...
Cal1ByName(o, "close", vbMethod, 123) 'Correct...

or in VBScript, use the Eval function:

0.Close(123) "Incorrect...

Eval("o.Close(123)") 'Correct...

The return value of a function is always converted dynamically to the correct type. However, you must
take care to use the set keyword in Visual Basic. If you expect a non-primitive data type to return, you
must use set. (If you expect a primitive data type to return, you do not need to use set.) See the
following example for more explanation:

Set oMyObject = o.getObject

iMyInt = o.getInt

In some cases, you might not know the type of object returning from a method call, because wrapper
classes are converted automatically to primitives (for example, java.lang.Integer returns an ActiveX
Automation Long). In such cases, you might need to use your language built-in exception handling
techniques to try to coerce the returned type (for example, On Error and Err.Number in Visual Basic).
Methods with character arguments

Because ActiveX Automation does not natively support character types supported by Java methods, the
ActiveX to EJB bridge uses strings (byte or VT _I1 do not work because characters have multiple bytes
in Java code). If you try to call a method that takes a char or java.lang.Character type you must use the
JMethodArgs argument container to pass character values to methods or constructors. For more
information about how this argument container is used, see Methods with "Object” Type as Argument
and Abstract Arguments.

Methods with "Object” Type as Argument and Abstract Arguments

Because of the polymorphic nature of Java programming, the ActiveX to Java bridge uses direct
argument type mapping to find a method. This method works well in most cases, but sometimes
methods are declared with a Parent or Abstract class as an argument type (for example,
java.lang.Object). You need the ability to send an object of arbitrary type to a method. To acquire this
ability, you must use the XJB.JMethodArgs object to coerce your parameters to match the parameters
on your method. You can get a JMethodArgs instance by using the JClassFactory.GetArgsContainer()
method.

The JMethodArgs object is a container for method parameters or arguments. This container enables
you to add parameters to it one-by-one and then you can send the JMethodArgs object to your method
call. The JClassProxy and JObjectProxy objects recognize the JMethodArgs object and attempt to find
the correct method and let the Java language coerce your parameters appropriately.

For example, to add an element to a Hashtable object the method syntax is Object put(Object key,
Object value). In Visual Basic, the method usage looks like the following example code:
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Dim oMyHashtable as Object
Set oMyHashtable = _
oXJB.NewInstance(oXJB.FindClass("java.utility.Hashtable"))

" This Tine will not work. The ActiveX to EJB bridge cannot find a method
" called "put" that has a short and String as a parameter:
oMyHashtable.put 100, "Dogs"

oMyHashtable.put 200, "Cats"

" You must use a XJB.JMethodArgs object instead:

Dim oMyHashtableArgs as Object

Set oMyHashtableArgs = oXJB.GetArgsContainer
oMyHashtableArgs.AddObject ("java.lang.0Object", 100)
oMyHashtableArgs.AddObject ("java.lang.0Object", "Dogs")

oMyHashtable.put oMyHashTableArgs

' Reuse the same JMethodArgs object by clearing it.
oMyHashtableArgs.Clear

oMyHashtableArgs.AddObject ("java.lang.0Object", 200)
oMyHashtableArgs.AddObject ("java.lang.0Object", "Cats")

oMyHashtable.put oMyHashTableArgs

Java field programming tips

Using the ActiveX to Enterprise JavaBeans (EJB) bridge to access Java fields has the same case
sensitivity issue that it has when invoking methods. Field names must use the same case as the Java field
syntax.

Visual Basic code has the same problem with unsolicited case changing on fields as it does with methods.
(For more information about this problem, see ActiveX to EJB bridge, calling Java methods). You might
use the CallByName() function to set a field in the same way that you call a method in some cases. For
fields, use VBLet for primitive types and VBSet for objects. For example:

0.MyField = 123 "Incorrect...
Cal1ByName(o, "MyField", vblLet, 123) '"Correct...

or in VBScript:

0.MyField = 123 "Incorrect...
Eval("o.myField = 123") 'Correct...

ActiveX to Java primitive data type conversion values

All primitive Java data types are automatically converted to native ActiveX Automation types. However, not
all Automation data types are converted to Java types (for example, VT_DATE). Variant data types are
used for data conversion.

Variant data types are a requirement of any Automation interface, and are used automatically by Visual
Basic and VBScript. The tables below provide details about how primitive data types are converted
between Automation types and Java types.

Table 7. ActiveX to Java primitive data type conversion

Visual Basic Type Variant Type Java Type Notes

Byte VT_I1 byte Byte in Visual Basic is
unsigned, but is signed in
Java data type.

Boolean VT_BOOL boolean
Integer VT_I2 short
Long VT_l4 int
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Table 7. ActiveX to Java primitive data type conversion (continued)

Visual Basic Type Variant Type Java Type Notes
Currency VT_CY long

Single VT_R4 float

Double VT_R8 double

String VT_BSTR java.lang.String

String VT_BSTR char

Date VT_DATE n/a

Example: Using helper methods for data type conversion

Generally, data type conversion between ActiveX (Visual Basic and VBScript) and Java methods occurs
automatically, as described in ActiveX to EJB bridge, converting data types. However, the byte helper
function and currency helper function are provided for cases where automatic conversion is not possible:
* Byte helper function

Because the Java Byte data type is signed (-127 through 128) and the Visual Basic Byte data type is
unsigned (0 through 255), convert unsigned Bytes to a Visual Basic Integers, which look like the Java
signed byte. To make this conversion, you can use the following helper function:

Private Function GetIntFromJavaByte(Byte jByte) as Integer
GetIntFromJavaByte = (CInt(jByte) + 128) Mod 256 - 128
End Function

* Currency helper function

Visual Basic 6.0 cannot properly handle 64-bit integers like Java methods can (as the Long data type).
Therefore, Visual Basic uses the Currency type, which is intrinsically a 64-bit data type. The only side
effect of using the Currency type (the Variant type VT_CY) is that a decimal point is inserted into the
type. To extract and manipulate the 64-bit Long value in Visual Basic, use code like the following
example. For more details on this technique for converting Currency data types, see Q189862,
"HOWTO: Do 64-bit Arithmetic in VBA”, on the Microsoft Knowledge Base.

" Currency Helper Types

Private Type MungeCurr
Value As Currency

End Type

Private Type MungeZlong
LoValue As Long
HiValue As Long

End Type

" Currency Helper Functions
Private Function CurrToText(ByVal Value As Currency) As String
Dim Temp As String, L As Long
Temp = Format$(Value, "#.0000")
L = Len(Temp)
Temp = Left§(Temp, L - 5) & Right$(Temp, 4)
Do While Len(Temp) > 1 And Left$(Temp, 1) = "0"
Temp = Mid§(Temp, 2)

Loop

Do While Len(Temp) > 2 And Left$(Temp, 2) = "-0"
Temp = "-" & Mid$(Temp, 3)

Loop

CurrToText = Temp
End Function

Private Function TextToCurr(ByVal Value As String) As Currency
Dim L As Long, Negative As Boolean
Value = Trim$(Value)
If Left$(Value, 1) = "-" Then
Negative = True
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Value = Mid§(value, 2)

End If
L = Len(Value)
If L <4 Then
TextToCurr = CCur(IIf(Negative, "-0.", "0.") & _
Right$("0000" & Value, 4))
Else
TextToCurr = CCur(IIf(Negative, "-", "") & _
Left§(value, L - 4) & "." & Right$(Value, 4))
End If

End Function

' Java Long as Currency Usage Example
Dim LC As MungeCurr
Dim L2 As Munge2lLong

' Assign a Currency Value (really a Java Long)
' to the MungeCurr type variable
LC.Value = cyTestIn

' Coerce the value to the Munge2long type variable
LSet L2 = LC

' Perform some operation on the value, now that we
' have it available in two 32-bit chunks
L2.LoValue = L2.LoValue + 1

' Coerce the Munge value back into a currency value
LSet LC = L2
cyTestIn = LC.Value

Array tips for ActiveX application clients

Arrays are very similar between Java and Automation containers like Visual Basic and VBScript. This topic
provides some important points to consider when passing arrays back and forth between these containers.

Here are some important points to consider when passing arrays back and forth between these containers:

Java arrays cannot mix types. All Java arrays contain a single type, so when passing arrays of variants
to a Java array, you must make sure that all of the elements in the variant array are of the same base
type. For example, in Visual Basic code:

Dim VariantArray(1) as Variant

VariantArray(0) = CLng(123)

VariantArray(1l) = CDb1(123.4)
oMyJavaObject.foo(VariantArray) ' I11egal!

VariantArray(0) = CLng(123)
VariantArray(1) = CLng(1234)
oMyJavaObject.foo(VariantArray) ' This works

Arrays of primitive types are converted using the rules defined in primitive data type conversion.
Arrays of Java objects are handled through arrays of JObjectProxy objects.

Arrays of JObjectProxy objects must be fully initialized and of the correct associated Java type. When
initializing an array in Visual Basic (for example, Dim oJavaObjects(1) as Object), you must set each
object to a JObjectProxy object before you send the array to a Java object. The bridge is unable to
determine the type of null or empty object values.

When receiving an array from a Java method, the lower-bound is always zero. Java methods only
support zero-based arrays.

Nested or multidimensional arrays are treated as zero-based multidimensional arrays in Visual Basic
and VBScript containers.

Uninitialized arrays or Array Types are unsupported. When calling a Java method that takes an array of
objects as a parameter, you must fully initialize the array of JObjectProxy objects.
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Error handling codes for ActiveX application clients

All exceptions thrown in Java code are encapsulated and thrown again as a COM error through the
ISupportErrorinfo interface and the EXCEPINFO structure of IDispatch::Invoke(), the Err object in Visual
Basic and VBScript. Because there are no error numbers associated with Java exceptions, whenever a
Java exception is thrown, the entire stack trace is stored in the error description text and the error number
assigned is 0x6003.

In Visual Basic or VBScript, you need to use the Err.Number and Err.Description fields to determine the
actual Java error. Non-Java errors are thrown as you would expect via the IDispatch interface; for
example, if a method cannot be found, then error 438 "Object doesn’t support this property or method” is
thrown.

Error number Description

0x6001 Java Native Interface (JNI) error

0x6002 Initialization error

0x6003 Java exception. Error description is the Java Stack Trace.
OX6FFF General Internal Failure

Threading tips

The ActiveX to Enterprise JavaBeans (EJB) bridge supports both free-threaded and apartment-threaded
access and implements the Free Threaded Marshaler to work in a hybrid environment such as Active
Server Pages (ASP). Each thread created in the ActiveX process is mirrored in the Java environment
when the thread communicates through the ActiveX to EJB bridge.

Once all references to Java objects (there are no JObjectProxy or JClassProxy objects) are loaded in an
ActiveX thread, the ActiveX to EJB bridge detaches the thread from the Java virtual machine (JVM) code.
Therefore, you must be careful that any Java code that you access from a multithreaded Windows
application is thread safe. Visual Basic code and VBScript applications are both essentially single
threaded. Therefore, Visual Basic and VBScript applications do not have threading issues in the Java
programs they access. Active Server Pages and multithreaded C and C++ programs can have issues.

Consider the following scenario:

1. A multithreaded Windows Automation Container (our ActiveX Process) starts. It exists on Thread A.

2. The ActiveX Process initializes the ActiveX to EJB bridge, which starts the JVM code. The JVM
attaches to the same thread and internally calls it Thread 1.

3. The ActiveX Process starts two threads: B and C.

4. Thread B in the ActiveX Process uses the ActiveX to EJB bridge to access an object that was created
in Thread A. The JVM attaches to thread B and calls it Thread 2.

5. Thread C in the ActiveX Process never talks to the JVM code, so the JVM never needs to attach to it.
This is a case where the JVM code does not have a one-to-one relationship between ActiveX threads
and Java threads.

6. Thread B later releases all of the JObjectProxy and JClassProxy objects that it used. The Java Thread
2 is detached.

7. Thread B again uses the ActiveX to EJB bridge to access an object that was created in Thread A. The
JVM code attaches again to the thread and calls it Thread 3.

ActiveX process JVM access by ActiveX process
Thread A - Created in 1 Thread 1 - Attached in 2
Thread B - Created in 4 Thread 2 - Attached in 4, detached in 6 Thread 3 -

Attached in 7

Thread C - Created in 4
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Threads and Active Server Pages

Active Server Pages (ASP) in Microsoft Internet Information Server is a multithreaded environment. When
you create the XJB.JClassFactory object, you can store it in the Application collection as an
Application-global object. All threads within your ASP environment can now access the same ActiveX to
EJB bridge object. Active Server Pages by default creates 10 Apartment Threads per ASP process per
CPU. This means that when your ActiveX to EJB bridge object is initialized any of the 10 threads can call
this object, not just the thread that created it.

If you need to simulate single-apartment behavior, you can create a Single-Apartment Threaded ActiveX
dynamic link library (DLL) in Visual Basic code and encapsulate the ActiveX to the EJB bridge object. This
encapsulation guarantees that all access to the JVM object is on the same thread. You need to use the
<OBJECT> tag to assign the XJB.JClassFactory to an Application object and must be aware of the
consequences of introducing single-threaded behavior to a Web application.

The Microsoft KnowlegeBase has several articles about ASP and threads, including:

* Q243543 INFO: Do Not Store STA Objects in Session or Application

* Q243544 INFO: Component Threading Model Summary Under Active Server Pages
* Q243548 INFO: Design Guidelines for VB Components Under ASP

Example: Viewing a System.out message

The ActiveX to Enterprise JavaBeans (EJB) bridge does not have a console available to view Java
System.out messages. To view these messages when running a stand-alone client program (such as
Visual Basic), redirect the output to a file.

This example redirects output to a file:

launchClientXJB.bat MyProgram.exe > output.txt
» To view the System.out messages when running a Service program such as Active Server Pages, you
need to override the Java System.out OutputStream object to FileOutputStream. For example, in
VBScript:
'Redirect system.out to a file
" Assume that oXJB is an initialized XJB.JClassFactory object
Dim cTsSystem
Dim o0S
Dim oPS
Dim oArgs

' Get the System class
Set clsSystem = oXJB.FindClass("java.lang.System")

Create a FileOutputStream object

Create a PrintStream object and assign to it our FileQutputStream

Set oArgs = oXJB.GetArgsContainer o0Args.AddObject "java.io.OutputStream", 00S
Set oPS = oXJB.NewInstance(oXJB.FindClass("java.io.PrintStream"), oArgs)

Set our System QutputStream to our file
clsSystem.setOut oPS

Example: Enabling logging and tracing for application clients

The ActiveX to EJB bridge provides two logging and tracing formats: Windows Application Event Log and
Java Trace Log.
* Windows Event Log

The Windows Application Event Log shows JNI errors, Java console error messages, and XJB
initialization messages. This log is most useful for determining XJBInit() errors and any unusual
exceptions that do not come from the Java environment. By default, critical error logging will be enabled
and debug and event logging is disabled.
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To enable or disable logging of certain event types to the Windows Event Log, specify one or more
parameters to XJBInit (). If more than one parameter is set, they will be processed in the order in which
they appear in the input string array to the XJBInit() method. Once the XJBInit() method is initialized,
these parameters can no longer be set/reset for the life of the process. Using Java
java.lang.System.setProperty() to set these values also has no effect.

— -Dcom.ibm.ws.c]1ent.ij.nat1’ve.1ogging.debug=enab1ed|d1’sab1ed

Enables or disables debug level messages from displaying in the Windows operating system event
log. This level of logging is most useful and shows most internal errors, user programming issues or
configuration problems.

— -Dcom.ibm.ws.c]1'ent.ij.native.1ogging.event=enab1ed|d1’sab1ed

Enables or disables event level messages from appearing in the Windows operating system event
log.

- —Dcom.ibm.ws.c]1'ent.ij.native.1ogg1'ng.*=enab1ed|disab]ed
Enables or disables both event and debug level messages from appearing in the Windows operating
system event log. It is not possible to disable some critical error messages from being displayed in
the error log. Only debug and event level messages can be disabled.

Viewing the Windows application event log with the event viewer:

To open the event viewer in the Windows operating system:
1. Click Start > Settings > Control Panel.

2. Double-click Administrative Tools.

3. Double-click Event Viewer.

All ActiveX to EJB bridge events display the text WebSphere XJB in the source column and in the
application log. For information about using Event Viewer, click the Action menu in Event Viewer, and
then click Help.

To open the even viewer in the Windows operating system, click Start > Programs > Administrative
Tools > Event Viewer. All ActiveX to EJB bridge events have the text WebSphere XJB in the source
column and display in the application log. For information about using Event Viewer, click the Help
menu in Event Viewer.

» Java trace log

The Java trace log displays information that you can use to debug method calls, class lookups, and
argument coercion problems. Since the Java portion of the bridge mirrors the function of the COM
IDispatch interface, the information in the trace log is similar to what you have come to expect from an
IDispatch interface. To understand the trace log, you need a fundamental understanding of IDispatch.

To enable user-logging, add the following parameters to the XJBInit() input string array:

"-DtraceString=com.ibm.ws.client.xjb.*=event=enabled"
"-DtraceFile=C:\MyTrace.txt"

ActiveX client programming best practices

The best way to access Java components is to use the Java language. It is recommended that you do as
much programming as possible in the Java language and use a small simple interface between your COM
Automation container (for example, Visual Basic) and the Java code. This interface avoids any overhead
and performance problems that can occur when moving across the interface.

best-practices: The following topics are covered:
* Visual Basic guidelines
» CScript and Windows Scripting Host
» Active Server Pages guidelines
* J2EE guidelines

Visual Basic guidelines

The following guidelines are intended to help optimize your use of the ActiveX to EJB bridge with Visual
Basic:
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* Launch the Visual Basic replication through the TaunchClientXJB.bat file. If you want to run your Visual
Basic application through the Visual Basic debugger, run the Visual Basic integrated development
environment (IDE) within the ActiveX to EJB bridge environment. After you create your Visual Basic
project, you can launch it from a command line; for example, TaunchClientXJB MyApplication.vbp. You
can also launch the Visual Basic application alone in the ActiveX to EJB environment, by changing the
Visual Basic shortcut on the Windows Start menu so that the TaunchCTientXJB.bat file precedes the call
to the VB6.EXE file.

» Exit the Visual Basic IDE before debugging programs.

Because the Java virtual machine (JVM) code attaches to the running process, you must exit the Visual
Basic editor before debugging your program. If you run the process, then exit your program within the
Visual Basic IDE, the JVM code continues to run and you reattach the same JVM code when XJBInit()
is called by the debugger. This causes problems if you try to update XJBInit() arguments (for example,
classpath) because the changes are not be applied until you restart the Visual Basic program.

» Store the XJB.JClassFactory object globally.

Because you cannot unload or reinitialize the JVM code, cache the resulting XJB.JClassFactory object
as a global variable. The overhead of treating this object as a global variable or passing a single
reference around is much less than recreating a new XJB.JClassFactory object and calling the XJBInit()
argument more than once.

CScript and Windows Scripting Host

The following guidelines intend to help optimize your use of the ActiveX to EJB bridge with CScript and
Windows Scripting Host (WSH):
* Launch in ActiveX to EJB environment.

Launch the VBScript files in the ActiveX to EJB bridge environment, to run VBScript files in .vbs files.
Two common ways exist to launch your script:

— TaunchClientXJB MyScript.vbs

— TlaunchClientXJB cscript MyScript.vbs

Active Server Pages guidelines

The following guidelines intend to help optimize your use of the ActiveX to EJB bridge with Active Server
Pages software:
* Use the ActiveX to EJB Helper functions from the Active Server Pages Application.

Because Active Server Pages (ASP) code typically use VBScript, you can use the included helper
functions in any VBScript environment with minor changes. For more information about these helper
functions, see Helper functions for data type conversion. To run outside of the ASP environment,
remove or change all references to the Server, Request, Response, Application and Session objects; for
example, change Server.CreateObject to CreateObject.

» Set JRE path globally in system.

The XJB.JClassFactory object must be able to find the Java run time dynamic link library (DLL) when
initializing. In Internet Information Server, you cannot specify a path for its processes independently; you
must set the process paths in the system PATH variable. You can only have a single JVM version
available on a machine using the ASP application. Also, remember that after you change the system
PATH variable you must reboot the Internet Information Server machine so that the Internet Information
Server can see the change.

» Set the system TEMP environment variable.

If the system TEMP environment variable is not set, Internet Information Server stores all temporary
files in the WINNT directory, which is usually not desired.
* Use high isolation or an isolated process.

When using the ActiveX to Java bridge with Active Server Pages software, creating your Web
application in its own process is recommended. You can only load one JVM instruction in a single
process and if you want to have more than one application running with different JVM environment
options (for example, different classpaths), then you need to have separate processes.

Chapter 8. Client applications 227



» Use the Application Unload option.

When debugging your application, use Unload when viewing your ASP application properties in the
Internet Information Server administration console to unload the process from memory and thereby
unload the JVM code.

* Run one process per application.

Use only one ASP application per J2EE application or JVM environment, in your ASP environment. If
you need separate class paths or JVM settings, you need separate ASP applications (virtual directories
with high isolation or an isolated process).

» Store the XJB.JClassFactory object in application scope.

Because of the one-to-one relationship required between a JVM instruction and a process, and because
the JVM code can never detach or shut down from a process independently, cache the
XJB.JClassFactory object at application scope and call the XJBInit() method only once.

Because the ActiveX to EJB bridge employs a free-threaded marshaler, take advantage of the
multi-threaded nature of Internet Information Server and the ASP environment. If you choose to
reinitialize the XJB.JClassFactory object at Page scope (local variables), then the XJBInit() method can
only initialize your local XJB.JClassFactory variable. It is more efficient to use the XJBInit() method
once.

» Use VBScript conversion functions.

Because VBScript code only supports variant data types, use the CStr(), CByte(), CBool(), CCur(),
CInt(), CIng(), CSng() and CDbI() functions to tell the activeX to EJB bridge which data type you are
using; for example oMyObject.Foo(CDb1(1.234)).

J2EE guidelines

The following guidelines are intended to help optimize your use of the ActiveX to EJB bridge with the J2EE
environment;
» Store client container objects globally.

Because you can only have one JVM instruction per process, and a single J2EE client container
(com.ibm.websphere.client.applicationclient.launchClient) per JVM instruction, initialize your J2EE client
container only once and reuse it. For ASP applications, store the J2EE client container in an application
level variable and initialize it only once (either on the Application_OnStart() event in the global.asa file
or by checking to see if it ISEmpty()).

A side effect to storing the client container object globally is that you cannot change the client container
parameters without destroying the object and creating a new one. These parameters include the EAR
file, BootstrapHost, class path, and so on. If you run a Visual Basic application and want to change the
client container parameters, you must end the application and restart it. If you run an Active Server
Pages application, you must first unload the application from Internet Information Server (see "Use the
Application Unload Button” under Active Server Pages guidelines). Then load the Active Server Pages
application with the different client container parameters. The parameters set the first time the Active
Server Pages application loads. Since the client container is stored on the Internet Information Server,
all the browser clients share the parameters using the Active Server Pages application. This behavior is
normal for Active Server Pages code, but can be confusing when you try to run to different WebSphere
Application Servers using the same Active Server Pages application, which is not supported.

* Reuse custom temporary directory for EAR file extraction.

By default, the client container launches and extracts the application .ear file to your temp directory and
then sets up the thread class loader to use the extracted EAR file directory and the JAR files included in
the client JAR manifest. This process is time consuming and because of some limitations with JVM
shutdown through Java Native Interface (JNI) and file locking, these files are never cleaned up.

Specifically, each time the client container launch() method is called, it extracts the EAR file to a random
directory name in your temporary directory on your hard drive. The current Java thread class loader is
then changed to point to this extracted directory which in turn locks the files within. In a normal J2EE
Java client, these files automatically clean up after the application exits. This cleanup occurs when the
client container shutdown hook is called (which never happens in the ActiveX to EJB bridge), which
leaves the temporary directory there.
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To avoid these problems, you can specify a directory to extract the EAR file by setting the
com.ibm.websphere.client.applicationclient.archivedir Java system property before calling the client
container launch() method. If the directory does not exist or is empty, you extract the EAR file normally.
If the EAR file was previously extracted, the directory is reused. This feature is particularly important for
server processes (for example, ASP), which can stop and restart, potentially calling the launchClient()
method several times.

If you need to update your EAR file, delete the temporary directory first. The next time you create the
client container object, it extracts the new EAR file to the temporary directory. If you do not delete the
temporary directory or change the system property value to point to a different temporary directory, the
client container reuses the currently extracted EAR file, and does not use your changed EAR file.

Note: When specifying the com.ibm.websphere.client.applicationclient.archivedir property, ensure that
the directory you specify is unique for each EAR file you use. For example, do not point
MyEarl.ear and MyEar2.ear files to the same directory.

If you choose not to use this system property, go regularly to your Windows temp directory and delete
the WSTMP* subdirectories. Over a relatively short period of time, these subdirectories can waste a
significant amount of space on the hard drive.

Developing applet client code

Applet clients are capable of communicating over the HTTP protocol and the RMI-IIOP protocol.

Applet clients have the following setup requirements:

* These clients are available on the Windows platforms. Check the prerequisites page for information on
platform support and product prerequisites.

* The browser installation precedes the client code installation.

Unlike typical applets that reside on either Web servers or WebSphere Application Servers and can only
communicate using the HTTP protocol, applet clients are capable of communicating over the HTTP
protocol and the RMI-IIOP protocol. This additional capability gives the applet direct access to enterprise
beans.

1. Install the Application Client for WebSphere Application Server.
2. Select the applet client feature.
3. From the IBM Control Panel for Java, enter the following code:

-Djava.security.policy=<app_client_root>\properties\client.policy
-Dwas.install.root=<app_client_root>
-Djava.ext.dirs=<app_client_root>\java\jre\lib\ext;

<app_client_root>\1ib;

<app_client_root>\plugins;

<app_client_root>\1ib\ext;

<app_client_root>\1ib\WMQ\java\lib"

-Dcom. ibm.CORBA.ConfigURL=file:<app_client root>\properties\sas.client.props
-Dcom.ibm.SSL.ConfigURL=file:<app_client_root>\properties\ssl.client.props
-classpath <app_client_root>\properties

Note: The previous entries are automatically placed into the WebSphere Application Server control
panel for the Java plug-in user who installed the WebSphere Application Server Application
Client. If this sample is being run by a user other than the person who installed the client, the
user must enter the entries.

* The Java Run-Time Parameters field is similar to the command prompt when using command line
options. Therefore, you can enter most options available from the command prompt (for example,
-cp, classpath, and others) in this field as well.

* Access the IBM Control Panel for Java from the Start menu. Click Start > Control panel > select
the IBM Control Panel for Java.
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e The applet container is the Web browser and the Java plug-in combination. You must first install the
Applet client feature from the Application Client for WebSphere Application Server so that the
browser recognizes the IBM product Java plug-in.

View the [Samples gallery| for more information about application clients.

Accessing secure resources using SSL and applet clients

By default, the applet client is configured to have security enabled. If you have administrative security
turned on at the server from which you are accessing resources, then you can use secure sockets layer
(SSL) when needed.

If you decide that the security requirements for the applet differ from other application client types, then
create a new version of the sas.client.props and ss1.client.props files.

1. Make a copy of the following files so that you can use them for an applet:
* dapp client rootp\properties\sas.client.props
e <dapp client rootp\properties\ssl.client.props
2. Edit the copies of the sas.client.props and ss1.client.props files that you made with your changes.
3. Click Start > Control panel > select the product Java plug-in to open the Java control panel. To use
the files you created in step 1, modify the following values:
. -Dcom.1bm.CORBA.ConfigURL=f11e:45pp client rootF\properties\sas.c]1ent.props
. -Dcom.1bm.SSL.ConfigURL=f11e:{gpp client rootF\properties\ss].c11ent.props

For more information on the sas.client.props and ssl.client.props files and WebSphere Application
Server security, see the section of the information center.

Applet client security requirements

When code is loaded, it is assigned permissions based on the security policy in effect. This policy
specifies the permissions that are available for code from various locations. You can initialize this policy
from an external policy file.

By default, the client uses the dapp server rootp/properties/client.policy file. You must update this file
with the following permission:

SocketPermission grants permission to open a port and make a connection to a host machine, which is
your WebSphere Application Server. In the following example, yourserver.yourcompany.com is the
complete host name of your WebSphere Application Server:

permission java.util.PropertyPermission "*", "read";
permission java.net.SocketPermission "yourserver.yourcompany.com ,"connect";

Applet client tag requirements

Standard applets require the HTML <APPLET> tag to identify the applet to the browser. The <APPLET> tag
invokes the Java virtual machine (JVM) of the browser. It can also be replaced by <OBJECT> and <EMBED>
tags.

The following code example illustrates the applet code using the <APPLET> tag.

<APPLET code="MyAppletClass.class" archive="Applet.jar, EJB.jar" width="600" height="500" >
</APPLET>

The following code example illustrates the applet code using the <OBJECT> and <EMBED> tags.

<OBJECT classid="cl1sid: 8AD9C840-044E-11D1-B3E9-00805F499D93"
width="600" height="500">

<PARAM NAME=CODE VALUE=MyAppletClass.class>

<PARAM NAME="archive" VALUE='Applet.jar, EJB.jar'>

<PARAM TYPE="application/x-java-applet;version=1.5.0">
<PARAM NAME="scriptable" VALUE="false">

<PARAM NAME="cache-option" VALUE="PTugin">

<PARAM NAME="cache-archive" VALUE="Applet.jar, EJB.jar">
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<COMMENT>

<EMBED type="application/x-java-applet;version=1.5.0" CODE=MyAppletClass.class
ARCHIVE="Applet.jar, EJB.jar" WIDTH="600" HEIGHT="500"

scriptable="false">

<NOEMBED>

</COMMENT>

</NOEMBED>WebSphere Java Application/Applet Thin Client for

Windows is required.

</EMBED>

</0BJECT>

Note: The classid and type values changed from WebSphere Application Server version 6.0.2 for version
6.1. Prior to version 6.1, the classid value was c1sid:8AE2D840-EC04-11D4-AC77-006094334AA9 and
the type value was application/x-websphere-client. In order to successfully invoke the applet
client in WebSphere Application Server version 6.1, these values need to be changed to those in
the preceding example.

For more information about the applet client tag, see the Sun Microsystems article, |http://java.sun.com/|
i2se/1.5.0/docs/guide/plugin/developer guide/using tags.html|

Applet client code requirements

The code used by an applet to talk to an enterprise bean is the same as that used by a stand-alone Java
program or a servlet, except for one additional property called java.naming.applet. This property informs
the InitialContext and the Object Request Broker (ORB) that this client is an applet rather than a
stand-alone Java application or servlet.

When you initialize an instance of the InitialContext class, the first two lines in this code snippet illustrate
what both a stand-alone Java program and a servlet issue to specify the computer name, domain, and
port. In this example, <yourserver.yourdomain.com> is the computer name and domain where WebSphere
Application Server resides, and 900 is the configured port. After the bootstrap values
(<yourserver.yourdomain.com>:900) are defined, the client to server communications occur within the
underlying infrastructure. In addition to the first two lines for applets, you must add the highlighted third line
to your code. That highlighted line identifies this program as an applet, for example:
prop.put(Context.INITIAL_CONTEXT_FACTORY, "com.ibm.websphere.naming.WsnInitialContextFactory");

prop.put(Context.PROVIDER URL, "iiop://<yourserver.yourdomain.com>:900)
prop.put(Context.APPLET, this);

Developing J2EE application client code

This topic provides the steps required to develop J2EE application client code.

A J2EE application client program operates similarly to a standard J2EE program in that it runs its own
Java virtual machine (JVM) code and is invoked at its main method.

The Java Virtual Machine application client program differs from a standard Java program because it uses
the Java Naming and Directory Interface (JNDI) namespace to access resources. In a standard Java
program, the resource information is coded in the program.

Storing the resource information separately from the client application program makes the client application
program portable and more flexible.

1. Write the client application program. Write the J2EE application client program on any development
machine. At this stage, you do not require access to the WebSphere Application Server.

Using the javax.naming.InitialContext class, the client application program uses the look-up
operation to access the Java Naming and Directory Interface (JNDI) namespace. The InitialContext
class provides the Tookup method to locate resources.

The following example illustrates how a client application program uses the InitialContext class:
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import javax.naming.=

public class myAppClient

{

public static void main(String argv[])

{
InitialContext initCtx = new InitialContext();
Object homeObject = initCtx.lookup("java:comp/env/ejb/BasicCalculator");
BasicCalculatorHome bcHome = (BasicCalculatorHome)
javax.rmi.PortableRemoteObject.narrow(homeObject, BasicCalculatorHome.class);
BasicCalculatorHome bc = bcHome.create();

In this example, the program looks up an enterprise bean called BasicCalculator. The
BasicCalculator EJB reference is located in the client JNDI namespace at java:comp/env/ejb/
BasicCalculator . Since the actual Enterprise Java Bean run on the server, the application client run
time returns a reference to the BasicCalculator home interface.

If the client application program lookup was for a resource reference or an environment entry, then the
look up function returns an instance of the configured type as defined by the client application
deployment descriptor. For example, if the program lookup was a JDBC data source, the lookup would
return an instance of javax.sql.DataSource. Although you can edit deployment descriptor files, do not
use the administrative console to modify them.

Assemble the application client using an such as the Application Server Toolkit (AST) or
Rational Application Developer.

The JNDI namespace knows what to return on a lookup because of the information assembled by the
assembly tool.

Assemble the J2EE application client on any development machine with the assembly tool installed.

When you assemble your application client, provide the application client run time with the required
information to initialize the execution environment for your client application program. Refer to the
Application Server Toolkit (AST) or Rational Application Developer for implementation details.

Remember following when you configure resources used by your client application program:

* Resource environment references are different than resource references. Resource environment
references allow your application client to use a logical name to look-up a resource bound into the
server JNDI namespace. A resource reference allows your application to use a logical name to look
up a local J2EE resource. The J2EE specification does not specify a particular implementation of a
resource. The following table contains supported resource types and identifies the resources to
which the WebSphere Application Server provides a client implementation.

Resource Type Client Configuration Notes Client implementation

provided by WebSphere
Application Server

javax.sgl.DataSource Supports specification of any No

data source implementation
class

java.net.URL Supports specification of Provided by Java Runtime

custom protocol handlers Environment files

javax.mail.Session Supports custom protocol Yes - POP3, SMTP, IMAP

configuration

javax.jms.QueueConnectionFactory, Supports configuration of Yes - WebSphere embedded
javax.jms.TopicConnectionFactory, javax.jms.Queue, = WebSphere embedded messaging
javax.jms.Topic messaging, IBM MQ Series

and other JMS providers

3. Assemble the Enterprise Archive (EAR) file.

The application is contained in an enterprise archive or .ear file. The .ear file is composed of:
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* Enterprise bean, application client, and user-defined modules or .jar files
* Web applications or .war files
* Metadata describing the applications or application .xm1 files

You must assemble the .ear file on the server machine.
4. Distribute the EAR file.
The client machines configured to run this client must have access to the .ear file.

If all the machines in your environment share the same image and platform, run the Application Client
Resource Configuration Tool (ACRCT) on one machine to configure the external resources, and then
distribute the configured .ear file to the other machines.

If your environment is set up with a variety of client installations and platforms, run the ACRCT for
each unique configuration.

You can either distribute the .ear files to the correct client machines, or make them available on a
network drive.

Distributing the .ear files is the responsibility of the system and network administrator.
5. [Deploy the application client
6. |Configure the application client resources|

If the client application defines the local resources, run the ACRCT (clientConfig command) on the
local machine to reconfigure the .ear file. Use the ACRCT to change the configuration. For example,
the .ear file can contain a DB2 resource, configured as C:\DB2. If, however, you installed DB2 in the
D:\Program Files\DB2 directory, use the ACRCT to create a local version of the .ear file.

After developing the J2EE application client code, [launch the application client}

J2EE application client class loading

When you run your J2EE application client, a hierarchy of class loaders is created to load classes used by
your application.

The following list describes the hierarchy of class loaders:

* The Application Client for WebSphere Application Server (Application Client) run time sets this value to
the WAS_LOGGING environment variable.

* The extensions class loader class loader is a child to the bootstrap class loader. This class loader
contains JAR files in the java/jre/1ib/ext directory or those JAR files defined by the -Djava.ext.dirs
parameter on the Java command. The Application Client client run time does not set -Djava.ext.dirs
parameters. So it uses the JAR files in the java/jre/1ib/ext directory.

* The system class loader class loader contains JAR files and classes that are defined by the -classpath
parameter on the Java command. The Application Client run time sets this parameter to the
WAS_CLASSPATH environment variable.

* The WebSphere class loader class loader loads the Application Client client run time and any classes
placed in the Application Client user directories. The directories used by this class loader are defined by
the WAS_EXT_DIRS environment variable. The WAS BOOTCLASSPATH, WAS_CLASSPATH, and the WAS_EXT_DIRS
environment variables are set in the |app server root)/bin/setupCmdLine script for WebSphere
Application Server installations, or in the |app_server_root|/b1’n/setupC] jent script for client installations.

As the J2EE application client run time initializes, additional class loaders are created as children of the
WebSphere class loader. If your client application uses resources such as Java DataBase Connectivity
(JDBC) API, Java Message Service (JMS) API, or Uniform Resource Locator (URL), a different class
loader is created to load each of those resources. Finally, the Application Client run time sets the
WebSphere class loader to load classes within the .ear file by processing the client JAR manifest
repeatedly. The system class path, defined by the CLASSPATH environment variable is never used and is
not part of the hierarchy of class loaders.
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To package your client application correctly, you must understand which class loader loads your classes.
When the Java code loads a class, the class loader used to load that class is assigned to it. Any classes
subsequently loaded by that class will use that class loader or any of its parents, but it will not use children
class loaders.

In some cases the Application Client run time can detect when your client application class is loaded by a
different class loader from the one created for it by the Application Client run time. When this detection
occurs, you see the following message:

WSCLO205W: The incorrect class loader was used to Toad [0]

This message occurs when your client application class is loaded by one of the parent class loaders in the
hierarchy. This situation is typically caused by having the same classes in the .ear file and on the hard
drive. If one of the parent class loaders locates a class, that class loader loads it before the Application
Client run time class loader. In some cases, your client application still functions correctly. In most cases,
however, you receive "class not found” exceptions.

Configuring the classpath fields

When packaging your J2EE client application, you must configure various class path fields. Ideally, you
should package everything required by your application into your .ear file. This is the easiest way to
distribute your J2EE client application to your clients. However, you should not package such resources as
JDBC APIs, JMS APIs, or URLSs. In the case of these resources, use class path references to access
those classes on the hard drive. You might also have other classes installed on your client machines that
you do not need to redistribute. In this case, you also want to use classpath references to access the
classes on the hard drive, as described below.

Referencing classes within the EAR file

WebSphere product J2EE applications do not use the system class path. Use the MANIFEST Class path
entry to refer to other JAR files within the .ear file. Configure these values using an such as
the Application Server Toolkit (AST) or Rational Application Developer. For example, if your client
application needs to access the path of the EJB JAR file, add the deployed enterprise bean module name
to your application client class path. The format of the Class path field for each of the different modules
(Application Client, EJB, Web) is the same:

* The values must refer to .jar and .class files that are contained within the .ear file.

* The values must be relative to the root of the .ear file.

* The values cannot refer to absolute paths in the file systems.

* Multiple values must be separated by spaces, not colons or semicolons.

Note: This is the Java method for allowing applications to function platform independent.

Typically, you add modules (. jar files) to the root of the .ear file. In this case, you only need to specify
the name of the module (.jar file) in the Class path field. If you choose to add a module with a path, you
need to specify the path relative to the root of the .ear file.

For referencing .class files, you must specify the directory relative to the root of the .ear file. With the
Application Server Toolkit (AST) or Rational Web Developer, you can add individual class files to the .ear
file. It is recommended that these additional class files are packaged in a . jar file. Add this .jar file to the
module Class path fields. If you add .class files to the root of the .ear file, add ./ to the module Class
path fields.

Consider the following example directory structure in which the file myapp.ear contains an application
client JAR file named myclient.jar and a mybeans.jar EJB module. Additional classes reside in classl.jar
and utility/class2.zip files. A class named xyz.class is not packaged in a JAR file but is in the root of the
EAR file. Specify ./ mybeans.jar utility/class2.zip class1.jar as the value of the Classpath property. The
search order is: myapp.ear/myclient.jar myapp.ear/xyz.class myapp.ear/mybeans.jar
myapp.ear/utility/class2.zip myapp.ear/classl.jar
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Referencing classes that are not in the EAR file

Use the launchClient -CCclasspath parameter. This parameter is specified at run time and takes
platform-specific class path values, which means multiple values are separated by semi-colons or colons.
The client and the server are similar in this respect.

Resource class paths

When you configure resources used by your client application using the Application Client Resource
Configuration Tool, you can specify class paths that are required by the resource. For example, if your
application is using a JDBC to a DB2 database, add db2java.zip to the class path field of the database
provider. These class path values are platform-specific and require semi-colons or colons to separate
multiple values.

On WebSphere Application Server for i5/0S, if you use the IBM Developer Kit for Java JDBC provider to
access DB2/400, you do not have to add the db2_classes.jar file to the class path. However, if you use
the IBM Toolbox for Java JDBC provider, specify the location of the jt400.jar file.

Using the launchClient API
If you use the launchClient command, the WebSphere class loader hierarchy is created for you. However,

if you use the TaunchClient API, you must perform this setup yourself. Copy the TaunchClient shell
command in defining the Java system properties.

Assembling application clients

Application client projects contain programs that run on networked client systems. An application client
project is deployed as a JAR file.

Assemble a client module to contain fapplication client|code. Group enterprise beans, Web components,
and resource adapter code in separate modules.

Use an Application Server Toolkit (AST) or Rational Application Developer to assemble an
application client module in any of the following ways:

* Import an existing application client JAR file.

Create a new application client module.

1. Start an assembly tool.

2. If you have not done so already, configure the assembly tool for work on J2EE modules. Ensure that
J2EE capability is enabled.

3. Migrate application client JAR files created with the Assembly Toolkit, Application Assembly Tool (AAT)
or a different tool to an assembly tool. To migrate files, import your application client JAR files to the
assembly tool.

4. Create a new application client.
5. Verify the contents of the new application client in either of the following ways:
* In the Project Explorer view, expand Application Client Projects and view the new module.

« Click Window > Show View > Navigator to see the associated files for the application client
module in a Navigator view.

After you finish assembling all of your application’s modules, you are ready to deploy your application.

B To deploy your application on Windows, refer to[‘Deploying J2EE application clients on|
lv_vorkstation platforms” on page 238.|
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For more information, see the online help for the assembly tool. Similar information is in the Application
Server Toolkit information center available with this information center. Click Application Server Toolkit
> J2EE applications > application_clients_topic.

Developing Pluggable application client code

This topic provides steps to install and use the Pluggable application client.
WebSphere Application Server Version 6.1 supports the pluggable client.

As you prepare to install the pluggable application client, remember that pluggable clients are only
available on Windows systems.

Both J2EE application clients and thin application clients can access JMS resources provided by the
default messaging provider.

1. Install the pluggable application client by selecting option Pluggable Application Client from the
Custom client installation panel.

2. Set the Java application pluggable client environment by using the setupClient shell, located in:

AppC] ient\bin\setupClient.bat

3. Add your specific Java client application JAR files to the CLASSPATH and start your Java client
application from this environment, after setting the environment variables.

4. Run a Java command to invoke your client application.

"%JAVA_HOME%\bin\java" %WAS_LOGGING% -Djava.security.auth.login.config="%WAS_HOME%\properties\wsjaas_client.conf"
-classpath "%WAS_CLASSPATH%;<list of your application jars and classes>
-Djava.ext.dirs="%JAVA_JRE%\1ib\ext;%WAS_EXT_DIRS%;%WAS_HOME%\plugins;%WAS_HOME%\1ib\WMQ\java\lib"
-Djava.naming.provider.url=iiop://<your WebSphere server machine name>
-Djava.naming.factory.initial=com.ibm.websphere.naming.WsnInitialContextFactory
-Djava.endorsed.dirs="%WAS_ENDORSED_DIRS%"

%SERVER_ROOT% %CLIENTSAS% %CLIENTSSL% <fully qualified class name to run>

View the [Samples Gallery|for more information about the Application Client.

Developing Thin application client code

You can develop and run Java thin client applications on machines installed with either a client or a server.
The client provides a setup command shell which sets up your environment for either a thin client
application or a J2EE client application. The server provides a command shell which sets up your
environment for J2EE application clients only.

Both J2EE application clients and thin application clients can access JMS resources provided by the
default messaging provider.

WebSphere Application Server Version 6.1 supports the pluggable client.

Note: Thin clients are not packaged with JDBC provider classes. For example, the WebSphere
Application Server Version 6.1 thin client is not packaged with Cloudscape version 10.1 classes.
Likewise, the version 6.02 thin client is not packaged with Cloudscape Version 5.1 or Cloudscape
Version 10.0 classes. Therefore, to utilize the JDBC provider classes (such as Cloudscape, Oracle,
DB2, Informix, or Sybase) on a thin client, you must:

1. Add the classes to your thin client environment.
2. Make the classes visible to the thin client application. To do this, add the path to the classes in
the client classpath within the script that launched the client program.

Otherwise, any attempt to load a database class (such as through the JNDI lookup of a datasource)
results in a ClassNotFoundException.
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The Java invocation to run a thin application client varies between a client and a server. If your thin client

application needs to run on both a client installation and a server installation, follow the steps for

[developing thin application clients on a server machinel

1. Install the Java application thin client by selecting option J2EE and Thin application client from the
Application Client for WebSphere Application Server installation.

2. Perform one of the following:
« |Develop Thin application client code for a client machine |
» [Develop Thin application client code for a server machine.l

View the [Samples gallery| for more information about the Application Client.

Developing Thin application client code on a client machine
This topic provides the steps necessary to develop Thin application client code on a client machine.

You must install the Thin application client from the Application Client for WebSphere Application Server
installation before performing this task. For more information, see [Developing thin application client code]

1. Set the Java application thin client environment.
Use the setupClient shell.

[ Windows |
AppClient\bin\setupClient.bat

2. Compile your client application.

EIM Run the following Java compilation command.
"%JAVA_HOME%\bin\javac" -classpath "%WAS_CLASSPATH%;

<list of your application jars and classes> " -extdirs %WAS_EXT DIRS%
<your application class>.java

3. Invoke your client application.

Run the following Java command: B

"%JAVA _HOME%\bin\java" %WAS_LOGGING% -Djava.security.auth.login.config="%WAS _HOME%\properties\wsjaas_client.conf"
-classpath "%WAS_CLASSPATH%;<list of your application jars and classes>"

-Djava.ext.dirs="%JAVA JRE%\1ib\ext;%WAS EXT DIRS%;%WAS HOME%\plugins;%WAS HOME%\1ib\WMQ\java\lib"
-Djava.naming.provider.url=iiop://<your WebSphere server machine name>
-Djava.naming.factory.initial=com.ibm.websphere.naming.WsnInitialContextFactory

"%SERVER_ROOT%" "%CLIENTSAS%" "%CLISENTSSL%" <fully qualified class name to run>

For more information on IIOP and corbaloc URLS, see [Developing applications that use JNDI|.

View the [Samples gallery] for more information about the Application Client.

Developing Thin application client code on a server machine
This topic provides the steps necessary to develop Thin application client code on a server machine.

You must install WebSphere Application Server before performing this task.
1. Set up the Thin application client environment.

Use the setupCmdLine shell, located in: BRI
bin\setupCmdLine.bat

2. Compile your client application.

"%JAVA_HOME%\bin\javac" -classpath "%WAS_CLASSPATH%;
<list of your application jars and classes> " -extdirs %WAS_EXT_DIRS%
<your application class>.java

3. Run the application client. Perform one of the following methods.
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* Use Java code to call your main class directly:

"%JAVA _HOME%\bin\java" %WAS_ LOGGING%"
-Djava.security.auth.login.config="%WAS_HOME%\properties\wsjaas_client.conf"
-Djava.ext.dirs="%JAVA_HOME%\jre\lib\ext;%WAS_EXT_DIRS%%;%WAS_HOME%\plugins;%WAS_HOME%\1ib\WMQ\java\lib"
-Djava.naming.provider.url=<an IIOP URL or a corbaloc URL to your

WebSphere server machine name>
-Djava.naming.factory.initial=com.ibm.websphere.naming.WsnInitialContextFactory
-Dserver.root="%WAS_HOME%" "%CLIENTSAS%" "%CLIENTSSL%" %USER_INSTALL_PROP%

-classpath "%WAS_CLASSPATH%;<list of your application jars and classes>"

<fully qualified class name to run><your application parameters>

* Use the WebSphere Application Server launcher.

BT Enter:

"%JAVA_HOME%\bin\java" %WAS_LOGGING%
-Djava.security.auth.login.config="%WAS_HOME%\properties\wsjaas_client.conf"
-classpath "%WAS_CLASSPATH%;<list of your application jars and classes>
-Djava.ext.dirs="%WAS_EXT_DIRS%;%WAS_HOME%\plugins"
-Djava.endorsed.dirs="%WAS_ENDORSED DIRS%
-Djava.naming.provider.url=iiop://<your WebSphere server machine name>
-Djava.naming.factory.initial=com.ibm.websphere.naming.WsnInitialContextFactory
%SERVER_ROOT% %CLIENTSAS% %CLISENTSSL% <fully qualified class name to run>

For more information on IIOP and corbaloc URLSs, see |Developing applications that use JNDI|

View the [Samples gallery] for more information about the Application Client.

Deploying J2EE application clients on workstation platforms

You can deploy the J2EE application clients on workstation platforms using the methods described in this
topic.

After developing an application client, deploy this application on client machines. Deployment consists of
pulling together the various artifacts that the application client requires.

The Application Client Resource Configuration Tool (ACRCT) defines resources for the application client.
These configurations are stored in the client . jar file within the application .ear file. The application client
run time uses these configurations for resolving and creating an instance of the resources for the
application client.

Note: This task only applies to J2EE application clients. Only perform this task if you configured your
J2EE application client to use resource references.

[Start the ACRCT and open an EAR file |
[Configure new data source providers)
Configure mail providers and sessions.|
[Configure URL providers and sessions.|
‘Configure Java messaging resources.l
Configure new environment entries.
Optional) Remove application client resources |
Save the EAR file.
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Resource Adapters for the client

A resource adapter is a system-level software driver that a Java application uses to connect to an
enterprise information system (EIS). A resource adapter plugs into an application client and provides
connectivity between the EIS and the enterprise application.
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The resource adapter support for the J2EE client applications is a subset of the support for the server. For
any resource adapter installed using the clientRAR tool, the client resource adapter is used in a
non-managed environment and must conform to the J2EE Connector Architecture Specification Version 1.5
or higher. Only outbound connections to the EIS are supported through the ManagedConnectionFactory
interfaces. The inbound messaging support (from the EIS), life cycle management, and work management
aspects of the specification are not supported on the client.

For a client application to use a resource adapter, it must be installed in the directory specified by the
environment variable, CLIENT_CONNECTOR_INSTALL_ROOT, defined when the setupCmdLine script
runs. The launchClient tool, Application Client Resource Configuration Tool (ACRCT) and clientRAR tool all
use this variable to find the default location of all installed resource adapters. To install a resource adapter
in the client, use the clientRAR tool. Once the resource adapter is installed, it must be configured using
the ACRCT. The client configuration tool adds the resource adapter configuration to the EAR file. Then,
connection factories and administered objects are defined.

When running J2EE application clients, the TaunchClient script specifies a system property called
com.ibm.ws.client.installedConnector, which is set to the same value as the

CLIENT CONNECTOR INSTALL_ROOT variable. This is the default location for installed resource adapters and
can be overridden for each TaunchClient call by specifying the -CCD parameter. When the client container
is activated, all resource adapter subdirectories under the specified default location for the resource
adapters directory are added to the classpath. This action allows the client application to use the resource
adapters without using the ACRCT to specify any of the client resources.

Using resource adapters is a new mechanism for easily extending client applications.

Configuring resource adapters
Use the Application Client Resource Configuration Tool (ACRCT) to configure resource adapters.
1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure new resource adapters. The EAR file contents
display in a tree view.

Select the JAR file in which you want to configure the new resource adapters from the tree.
Expand the JAR file to view its contents.

Right-click the Resource Adapters folder, and click New.

Configure the resource adapter settings in the resulting property dialog.

Click OK.

Click File > Save on the menu bar to save your changes.

clientRAR tool
This topic describes the command line syntax for the client resource adapter installation tool.

© N o gk w

If this tool is used to add or delete resource adapters on the server, then only the client can use the
resource adapter. If the resource adapter is installed on the server using the wsadmin tool or the
administrative console, then do not use the clientRAR tool remove it. Only resource adapters that are
installed using the clientRAR tool should be removed using the clientRAR tool.

The command line invocation syntax for the clientRAR tool follows:
clientRAR [-help | -?] [-CRDcom.ibm.ws.client.installedConnectors=<dir>] <task> <archive>

where

-help, -7

Print the usage information.
-CRDcom.ibm.ws.client.installedConnectors

The directory where resource adapters are installed.
This will override the system property of the same name
(com.ibm.ws.client.installedConnectors).
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<task>
The task to perform: add - install, delete - uninstall.

<archive>
if task=add then this is the fully qualified name of the resource adapter archive file.
If task=delete then this is the filename of the resource adapter archive to be uninstalled.

The following examples demonstrate correct syntax.

On the Windows operating systems:
» clientRAR add c:\rars\myrar.rar
* clientRAR delete myrar.rar

On the UNIX operating systems:
* /clientRAR add /usr/rars/myrar.rar
» ./clientRAR delete myrar.rar

Configuring new connection factories for resource adapters
Use the Application Client Resource Configuration Tool (ACRCT) to configure new connection factories for
resource adapters.

Complete this task to configure new connection factories for resource adapters.
1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure new connection factories. The EAR file contents
display in a tree view.

Select the JAR file in which you want to configure the new connection factories from the tree.
Expand the JAR file to view its contents.

Click the Resource Adapters folder.

Expand the resource adapter for which you want to create connection factories.

Right-click the Connection Factories folder and click New.

Configure the connection factory properties in the resulting property dialog.

Click OK.

10. Click File > Save on the menu bar to save your changes.
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Resource adapter connection factory settings:

Use this panel to view or change the configuration properties of the selected resource adapter connection
factory.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Resource Adapters. Right-click the
Connection Factories folder, and click New. The following fields appear on the General tab.

Name:
The name by which this connection factory is known for administrative purposes within WebSphere

Application Server. The name must be unique within the resource adapter connection factories across the
product administrative domain.

Data type String
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Description:

An optional description of this connection factory for administrative purposes within IBM WebSphere
Application Server.

Data type String

JNDI Name:

The JNDI name that is used to match this resource adapter connection factory definition to the deployment
descriptor. This entry should be a resource-ref name.

Data type String

User Name:

The User Name used, with the Password property, for authentication if the calling application does not
provide a userid and password explicitly when getting a connection. If this field is used, then the Properties
field UserName is ignored.

If you specify a value for the User Name property, you must also specify a value for the Password
property.

The connection factory User Name and Password properties are used if the calling application does not
provide a userid and password explicitly when getting a connection.

Data type String

Password:

Specifies an encrypted password. If you complete this field, then the Password field in the Properties box
is ignored.

If you specify a value for the UserName property, you must also specify a value for the Password
property.

Data type String

Re-Enter Password:
Confirms the password.
Type:

A drop-down list of all the connectionFactoryInterfaces as defined for the factories in the Resource
Adapter Archive.

For each Type, there is a set of properties specified in the Properties box. This set of properties is
constructed by retrieving the properties from each connection definition object. For any existing connection
factories that are displayed for updating, this list of properties is overlaid with the properties specified for
the objects. When the Type field is changed, the properties also change to reflect the correct properties for
that type.

Data type String
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Configuring administered objects

Before you configure new administered objects, you must complete the following prerequisites:

1. Install the Resource Adapter Archive file (RAR) using the|clientRAR tool

2. |Configure the resource adapted for the .ear file, using the Application Client Resource Configuration
Tool (ACRCT) tool.

Complete this task to configure new administered objects for installed resource adapters.
1. |Start the Application Client Resource Configuration Tool (ACRCT)|.

2. Open the EAR file for which you want to configure new administered objects. The EAR file contents
display in a tree view.

Select the JAR file in which you want to configure the new administered objects from the tree.
Expand the JAR file to view its contents.

Click the Resource Adapters folder.

Expand the resource adapter for which you want to create administered objects.

Right-click the Administered Objects folder and click New.

Configure the administered object properties in the resulting property dialog.

Click OK.

10. Click File > Save on the menu bar to save your changes.
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Administered objects settings:

Use this panel to view or change the configuration properties of the selected administered objects.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Resource Adapters >
resource_adapter_instance. Right-click Administered Objects and click New. The following fields appear
on the General tab.

The settings for administered objects are handled similarly to connection factories. When updating
administered objects, use the same panels that you used to create administered objects.

Name:
The name by which this administered object is known for administrative purposes within IBM WebSphere

Application Server. The name must be unique within the resource adapter administered objects across the
product administrative domain.

Data type String

Description:

An optional description of this connection factory for administrative purposes within IBM WebSphere
Application Server.
Data type String

JNDI Name:
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This entry is a resource-env-ref name, a message-destination-ref name (if the message-destination-
ref has no link), or a message-destination link.

Data type String

Type:

A drop-down list of all the administered object class-interface pairs as defined for the admin objects in the
Resource Adapter Archive (RAR) file.

For each Type, there is a set of properties specified in the Properties box. This set of properties is
constructed by retrieving the properties from each administered object definition. For any existing
administered objects that are displayed for updating, this list of properties is overlaid with the properties
specified for the objects. When the Type field is changed, the properties also change to reflect the correct
properties for that type.

Data type String

Resource adapter settings

Use this panel to view or change the configuration properties of the resource adapter. These configuration
properties control how resource adapters are created.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Resource Adapter. Right-click
Resource Adapter and click New. The following fields appear on the General tab.

Name

The name by which this Resource Adapter is known for administrative purposes within IBM WebSphere
Application Server. The hame must be unique within the Resource Adapters across the product
administrative domain.

Data type String

Description
A description of this resource adapter for administrative purposes within IBM WebSphere Application
Server.

Data type String

Class Path

Any additional class path. The path to the resource adapter directory is automatically added.
Data type String

Default The path to your Resource Adapter directory.
Native Path

The native path where the Resource Adapter is located. Enter any additional native class path here.

Data type String
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Resource Adapter Name

A mandatory field that points to an installed resource adapter subdirectory. The entry does not represent
the full directory name for the resource adapter. The full directory name is the installed resource adapter
path, plus the resource adapter name.

Data type String

Installed Resource Adapter Path
The directory where resource adapters are installed. If you do not complete this field, then the default
takes effect.

If you specify the value, ${CONNECTOR_INSTALL ROOT}, then this value replaces the value of the

CLIENT _CONNECTOR INSTALL_ROOT variable on the machine on which the client application runs. This action
allows the application to run easily on different machines, where the client installation might be in different
locations.

Data type String
Default ${CONNECTOR_INSTALL_ROOT}

Starting the Application Client Resource Configuration Tool and
opening an EAR file

You can perform many tasks by starting the Application Client Resource Configuration Tool (ACRCT).
Many of these tasks also involve then opening an EAR file.

Note: This task only applies to J2EE application clients.

Use these steps to start the Application Client Resource Configuration Tool. When you start the tool, one
of the most common tasks that you perform is opening and modifying the components of EAR files.
1. Open a command prompt and change to the[app server root|\bin directory.
2. Run the clientConfig.bat file for a Windows system or the clientConfig.sh file for a UNIX system.
3. Open an EAR file within the Application Client Resource Configuration Tool (ACRCT):

» Click File > Open.

» Select the file and click Open.
4. Save your changes to the file and close the tool:

¢ Click File > Save.
¢ Click File > Exit.

Data sources for the Application Client

WebSphere Application Server and the Application Client for WebSphere Application Server do not provide
client database drivers to be used directly from a J2EE application client. If your application client
accesses a database directly, you must provide the database drivers on the client machine.

You can contact your database vendor to acquire client database driver code and licenses. In addition,
data sources configured on the server and looked up on the client do not participate in global transactions.
Instead of accessing the database directly, it is recommended that your client application use an enterprise
bean. Accessing a database through an enterprise bean eliminates the need to have database drivers on
the client machine, since the database access is handled by the enterprise bean running on WebSphere
Application Server. For a current list of providers that are supported on WebSphere Application Server visit
the [Supported hardware, software, and APIs| Web site:

Data source properties for application clients
Use this page to create or modify the data sources.
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To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Data Source Providers > Data source
provider instance. Right-click Data Sources and click New. The following fields are displayed on the
General tab:

Name
Specifies the display name of this data source.

Data type String

Description
Specifies a text description of the data source.

Data type String

JNDI Name
The application client run time uses this field to retrieve configuration information.

Database Name
The name of the database to which you want to connect.

User
Use the user ID with the Password property, for authentication if the calling application does not provide a
user ID and password explicitly.

If you specify a value for the User ID property, then you must also specify a value for the Password
property. The connection factory User ID and Password properties are used if the calling application does
not provide a user ID and password explicitly.

Password
Use the password with the User ID property, for authentication if the calling application does not provide a
user ID and password explicitly.

If you specify a value for the Password property, then you must also specify a value for the User ID
property.

Re-Enter Password
Confirms the password.

Custom Properties

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Configuring new data source providers (JDBC providers) for
application clients

You can create new data source providers, also known as JDBC providers, for your application client using
the Application Client Resource Configuration Tool (ACRCT) .

During this task, you create new data source providers, also known as JDBC providers, for your
application client. In a separate administrative task, install the Java code for the required data source
provider on the client machine on which the application client resides.
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Use this task to connect application clients to relational databases.

1. Start the Application Client Resource Configuration Tool (ACRCT) and open the EAR file for which you
want to configure the new data source provider. The EAR file contents display in a tree view.

2. Select the JAR file in which you want to configure the new data source provider from the tree.
3. Expand the JAR file to view its contents.

4. Click the Data Source Providers folder. Do one of the following:
* Right-click the folder and click New Provider.
* Click Edit > New on the menu bar.

5. Configure the data source provider properties in the resulting property dialog.
6. Click OK when you finish.
7. Click File > Save on the menu bar to save your changes.

Example: Configuring data source provider and data source settings
You can configure data source provider and data source settings.

The purpose of this article is to help you to configure data source provider and data source settings.
* Required fields:
— Data Source Provider Properties page: name
— Data Source Properties page: name, jndiName
* Special cases:
— The user name and password fields have no equivalent XMI tags. You must specify these fields in
the custom properties.
— The password is encrypted when you use the Application Client Resource Configuration Tool
(ACRCT). If you do not use the ACRCT the field cannot be encrypted.
* Example:

<resources.jdbc:JDBCProvider xmi:id="JDBCProvider_1" name="jdbcProvider:name"
description="jdbcProvider:description" implementationClassName="jdbcProvider:
ImplementationClass">

<classpath>jdbcProvider:classPath</classpath>

<factories xmi:type="resources.jdbc:WAS40DataSource" xmi:id="WAS40DataSource 1"
name="jdbcFactory:name" jndiName="jdbcFactory:jndiName"
description="jdbcFactory:description" databaseName="jdbcFactory:databasename">
<propertySet xmi:id="J2EEResourcePropertySet 13">

<resourceProperties xmi:id="J2EEResourceProperty 13" name="jdbcFactory:customName"
value="jdbcFactory:customValue"/>

<resourceProperties xmi:id="J2EEResourceProperty 14" name="user"
value="jdbcFactory:user"/>

<resourceProperties xmi:id="J2EEResourceProperty 15" name="password"
value="{xor}NTs9PBk+PCswLSZ1MT4y0g=="/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet 14">

<resourceProperties xmi:id="J2EEResourceProperty 16" name="jdbcProvider:customName"
value="jdbcProvider:customeValue"/>

</propertySet>

</resources.jdbc:JDBCProvider>

Data source provider settings for application clients
Use this page to create a data source under a JDBC provider which provides the specific JDBC driver
implementation class.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right-click Data Source Providers >
and click New. The following fields appear on the General tab:

Name:

Specifies the display name for the data source.
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For example you can set this field to Test Data Source.

Data type String

Description:

Specifies a text description for the resource.

Data type String

Class Path:
A list of paths or . jar file names which together form the location for the resource provider classes.
Implementation class:

Use this setting to perform database specific functions.

Data type String
Default Dependent on JDBC driver implementation class

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Configuring new data sources for application clients
During this task, you create new data sources for your application client.

1. Click the data source provider for which you want to create a data source in the tree. Take one of the
following actions as needed:
« |Configure a new data source provider
» Click an existing data source provider.

2. Expand the data source provider to view its Data Sources folder.

3. Click the data source folder. Take one of the following actions as needed:
* Right click the data source folder and click New Factory.
* Click Edit > New on the menu bar.

4. Configure the data source properties in the displayed fields.
5. Click OK when you finish.
6. Click File > Save on the menu bar to save your changes.

Configuring mail providers and sessions for application clients

You can edit the configurations of JavaMail sessions and providers for your application clients using the
Application Client Resource Configuration Tool (ACRCT).

Use the Application Client Resource Configuration Tool (ACRCT) to edit the configurations of JavaMail
sessions and providers for your application clients to use.

1. [Start the ACRCT]
2. Open an EAR file.
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3. Locate the JavaMail objects in the tree that displays. For example, if your file contains JavaMail
sessions, expand Resources > application.jar > Mail Providers > java_mail_provider_instance >
Mail Sessions.

In this example, java_mail_provider_instance is a particular JavaMail provider.

The JavaMail session instances are located in the JavaMail Sessions folder.

Mail provider settings for application clients
Use this page to implement the JavaMail APl and create mail sessions.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right-click Mail Providers > and click
New. The following fields appear on the General tab:

Name:

The name of the JavaMail resource provider.

Description:

An optional description for the resource provider.

Class Path:

Specifies a list of paths or JAR file names which together form the location for the resource provider
classes.

Protocol:
Specifies the name of the protocol.
Classname:

Specifies the name of the class implementing the protocol. Leave this field blank if you want to use the
default implementation.

Type:
This menu contains the following two values: TRANSPORT or STORE.
Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Mail session settings for application clients
Use this page to configure mail session properties.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Mail Providers > mail provider
instance. Right-click Mail Sessions and click New. The following fields appear on the General tab:

Name:

248 Developing and deploying applications



Represents the administrative name of the JavaMail session object.
Description:

Provides an optional description for your administrative records.

JNDI Name:

The application client run time uses this field to retrieve configuration information.
Mail Transport Host:

Specifies the server to connect to when sending mail.

Mail Transport Protocol:

Specifies the transport protocol to use when sending mail.

Mail Transport User:

Specifies the user ID to use when the mail transport host requires authentication.
Mail Transport Password:

Specifies the password to use when the mail transport host requires authentication.
Enable strict Internet address parsing:

Specifies whether the recipient addresses must be parsed strictly in compliance with RFC 822, which is a
specifications document issued by the Internet Architecture Board.

This setting is not generally used for most mail applications. RFC 822 syntax for parsing addresses
effectively enforces a strict definition of a valid e-mail address. If you select this setting, JavaMail will
adhere to RFC 822 syntax and reject recipient addresses that do not parse into valid e-mail addresses (as
defined by the specification). If you do not select this setting, JavaMail will not adhere to RFC 822 syntax
and will accept recipient addresses that do not comply with the specification. By default, this setting is
deselected. You can view the RFC 822 specification at the following URL for the World Wide Web
Consortium (W3C): http://www.w3.org/Protocols/rfc822/.

Re-Enter Password:

Confirms the password.

Mail From:

Specifies the mail originator.

Mail Store Host:

Specifies the mail account host (or “"domain”) name.

Mail Store User:

Specifies the user ID of the mail account.

Mail Store Password:

Chapter 8. Client applications 249



Specifies the password of the mail account.

Re-Enter Password:

Confirms the password.

Mail Store Protocol:

Specifies the protocol to be used when receiving mail.
Mail Debug:

When true, JavaMail interaction with mail servers, along with these mail session properties are printed to
the stdout file.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Example: Configuring JavaMail provider and JavaMail session settings for
application clients

You can configure JavaMail provider and JavaMail session settings. This topic provides the required fields,
special cases, and an example.

The purpose of this article is to help you configure JavaMail provider and JavaMail session settings.
* Required fields:
— JavaMail Provider Properties page: name, and at least one protocol provider
— JavaMail Session Properties page: name, jndiName, mail transport protocol, mail store protocol
* Special cases:
— The password is encrypted when using the ACRCT tool. Without the tool, you cannot encrypt this
field.
* Example:

<resources.mail:MailProvider xmi:id="MailProvider_1" name="Default Mail Provider"
description="IBM JavaMail Implementation">
<classpath>mailProvider:classpath</classpath>

<factories xmi:type="resources.mail:MailSession" xmi:id="MailSession_1"
name="mailSession:name" jndiName="mailSession:jndiName"
description="mailSession:description" mailTransportHost="mailSession:mailTransportHost"
mailTransportUser="mailSession:mailTransportUser"
mailTransportPassword="{xor}Mj42Mww6LCw2MDF1MT4y0g=="
mailFrom="mailSession:mailFrom" mailStoreHost="mailSession:mailStoreHost"
mailStoreUser="mailSession:mailStoreUser"
mailStorePassword="{xor}Mj42Mww6LCw2MDF1MT4y0g==" debug="true"
mailTransportProtocol="ProtocolProvider_ 1" mailStoreProvider="ProtocolProvider_1">
<propertySet xmi:id="J2EEResourcePropertySet 1">

<resourceProperties xmi:id="J2EEResourceProperty 1"

name="mailSession:customName" value="mailSession:customValue"/>

</propertySet>

</factories>

<propertySet xmi:id="J2EEResourcePropertySet_2">

<resourceProperties xmi:id="J2EEResourceProperty 2" name="mailProvider:customName"
value="mailProvider:customValue"/>

</propertySet>

<protocolProviders xmi:id="ProtocolProvider_1" protocol="smtp"
classname="smtp:className"/>
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<protocolProviders xmi:id="ProtocolProvider_ 2" protocol="pop3"
classname="pop3:className"/>

<protocolProviders xmi:id="ProtocolProvider 3" protocol="imap"
classname="imap:className"/>

</resources.mail:MailProvider>

Configuring new mail sessions for application clients

You can use the Application Client Resource Configuration Tool (ACRCT) to configure new mail sessions
for your application client.

During this task, you configure new mail sessions for your application client. The mail sessions are
associated with the pre-configured default mail provider supplied by the product.

1. |Start the Application Client Resource Configuration Tool (ACRCT) and open the EAR filel The EAR file
contents are displayed in a tree view.

2. Select the JAR file in which you want to configure the new JavaMail session.
3. Expand the JAR file to view its contents.

4. Click Mail Providers > Mail Provider > Mail Sessions. Complete one of the following actions:
* Right click the Mail Sessions folder and select New Factory.
* Click Edit > New on the menu bar.

5. Configure the Mail Session properties in the displayed fields.
6. Click OK.
7. Click File > Save on the menu bar to save your changes.

URLs for application clients

A Uniform Resource Locator (URL) is an identifier that points to an electronically accessible resource, such
as a directory file on a machine in a network, or a document stored in a database.

URLs appear in the format scheme:scheme_information.

You can represent a scheme as http, ftp, file, or another term that identifies the type of resource and
the mechanism by which you can access the resource.

In a World Wide Web browser location or address box, a URL for a file available using HyperText Transfer
Protocol (HTTP) starts with http:. An example is http://www.ibm.com. Files available using File Transfer
Protocol (FTP) start with ftp:. Files available locally start with file:.

The scheme_information commonly identifies the Internet machine making a resource available, the path
to that resource, and the resource name. The scheme_information for HTTP, FTP and File generally starts
with two slashes (//), then provides the Internet address separated from the resource path name with one
slash (/). For example,

http://www-4.ibm.com/software/webservers/appserv/library.html.

For HTTP and FTP, the path name ends in a slash when the URL points to a directory. In such cases, the
server generally returns the default index for the directory.

URL providers for the Application Client Resource Configuration Tool

A URL provider implements the function for a particular URL protocol, such as Hyper Text Transfer
Protocol (HTTP). This provider, comprised of a pair of classes, extends the java.net.URLStreamHandler
and java.net.URLConnection classes.
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Configuring new URL providers for application clients

You can create URL providers and URLs for your client application using the Application Client Resource
Configuration Tool (ACRCT).

During this task, you create URL providers and URLs for your client application. In a separate
administrative task, you must install the Java code for the required URL provider on the client machine on
which the client application resides.

1. |Start the Application Client Resource Configuration Tool (ACRCT)|

2. Open the EAR file for which you want to configure the new URL provider. The EAR file contents
display in a tree view.

3. Select the JAR file in which you want to configure the new URL provider from the tree.
4. Expand the JAR file to view the contents.

5. Click the folder called URL Providers. Complete one of the following actions:
* Right click the folder and select New.
* Click Edit > New on the menu bar.

6. Configure the URL provider properties in the resulting property dialog.
7. Click OK.
8. Click File > Save on the menu bar to save your changes.

Configuring URL providers and sessions using the Application Client Resource
Configuration Tool

You can edit the configurations of URL providers and URLSs to be used by your application clients using
the Application Client Resource Configuration Tool (ACRCT).

Use the Application Client Resource Configuration Tool (ACRCT) to edit the configurations of URL
providers and URLs to be used by your application clients.

1. [Start the ACRCT]
2. Open an EAR file.

3. Locate the URL objects in the tree that displays. For example, if your file contains URL providers and
URLs, expand Resources -> application.jar -> URL Providers -> url_provider_instance

where url_provider_instance is a particular URL provider.

4. If you expand the tree further, you will also see the URLs folders containing the URL instances for
each URL provider instance.

URL settings for application clients:

Use this page to implement the function for a particular URL protocol, such as Hyper Text Transfer
Protocol (HTTP).

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > URL Providers > URL provider
instance. Right-click URLs and click New. The following fields appear on the General tab.

This provider, comprised of classes, extends the java.net.URLStreamHandler and java.net.URLConnection
classes.

Name:
The administrative name for the URL.
Description:

This is an optional description of the URL for your administrative records.
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JNDI Name:
The application client run time uses this field to retrieve configuration information.
URL:

A Uniform Resource Locator (URL) name that points to an Internet or intranet resource. For example:
http://www.ibm.com.

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.
URL provider settings for application clients:

Use this page create new URL providers.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right click URL Providers, and click
New. The following fields appear on the General tab.

A URL provider implements the function for a particular URL protocol, such as Hyper Text Transfer
Protocol (HTTP). This provider, comprised of classes, extends the java.net.URLStreamHandTer and
java.net.URLConnection classes.

Name:

Administrative name for the URL.

Description:

Optional description of the URL, for your administrative records.

Class Path:

A list of paths or JAR file names which together form the location for the resource provider classes.
Protocol:

Protocol supported by this stream handler. For example, nntp, smtp, ftp, and so on.

To use the default protocol, leave this field blank.

Stream handler class:

Fully qualified name of a User-defined Java class that extends the java.net.URLStreamHandler for a
particular URL protocol, such as FTP.

To use the default stream handler, leave this field blank.

Custom Properties:
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Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a
string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.

Example: Configuring URL and URL provider settings for application clients
You can configure URL and URL provider settings. This topic provides the required fields and an example.

The purpose of this article is to help you to configure URL and URL provider settings.
* Required fields:

— URL Properties page: name, jndiName, url

— URL Provider Properties page: name
* Example:
<resources.url:URLProvider xmi:id="URLProvider_1" name="urlProvider:name"
description="urlProvider:description"
streamHandlerClassName="urlProvider:streamHandlerClass"
protocol="urlProvider:protocol">
<classpath>urlProvider:classpath</classpath>
<factories xmi:type="resources.url:URL" xmi:id="URL_1" name="urlFactory:name"
jndiName="urlFactory:jndiName" description="urlFactory:description"
spec="urlFactory:url">
<propertySet xmi:id="J2EEResourcePropertySet 18">
<resourceProperties xmi:id="J2EEResourceProperty 20" name="urlFactory:customName"
value="urlFactory:customValue"/>
</propertySet>
</factories>
<propertySet xmi:id="J2EEResourcePropertySet 19">
<resourceProperties xmi:id="J2EEResourceProperty 21" name="urlProvider:customName"
value="url1Provider:customValue"/>
</propertySet>
</resources.url:URLProvider>

Configuring new URLs with the Application Client Resource
Configuration Tool

You can use URLs for your client application using the Application Client Resource Configuration Tool
(ACRCT).

During this task, you create URLs for your client application.

1. Click the URL provider for which you want to create a URL in the tree. Complete one of the following:
« |Configure a new URL provider,
* Click an existing URL provider.

2. Expand the URL provider to view the URLs folder.

3. Click the URL folder. Complete one of the following actions:
* Right click the folder and click New.
* Click Edit -> New on the menu bar.

4. Configure the URL properties in the displayed fields.
5. Click OK when you finish.
6. Click File > Save in the menu bar to save your changes.

Asynchronous messaging in WebSphere Application Server using JMS

WebSphere Application Server supports asynchronous messaging as a method of communication based
on the Java Message Service (JMS) programming interface. The JMS interface provides a common way
for Java programs (clients and J2EE applications) to create, send, receive, and read asynchronous
requests as JMS messages.
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This topic provides a generic overview of asynchronous messaging using the JMS support provided by
WebSphere Application Server.

The base support for asynchronous messaging using the JMS API provides the common set of JMS
interfaces and associated semantics that define how a JMS client can access the facilities of a IMS
provider. This support enables WebSphere product J2EE applications, as JMS clients, to exchange
messages asynchronously with other JMS clients, by using JMS destinations (queues or topics). A J2EE
application can use JMS queue destinations for point-to-point messaging and JMS topic destinations for
Publisher and Subscriber messaging. A J2EE application can explicitly poll for messages on a destination,
and then retrieve messages for processing by business logic beans (enterprise beans).

With the base JMS and XA support, the J2EE application uses standard JMS calls to process messages,
including any responses or outbound messaging. An enterprise bean can handle responses acting as a
sender bean, or within the enterprise bean that receives the incoming messages. Optionally, this process
can use two-phase commit within the scope of a transaction. This level of function for asynchronous
messaging is called bean-managed messaging, and gives an enterprise bean complete control over the
messaging infrastructure, for example, connection and session pool management. The common container
has no role in bean-managed messaging.

WebSphere Application Server also supports automatic asynchronous messaging using message-driven
beans (a type of enterprise bean defined in the EJB 2.0 specification) and JMS listeners (part of the JMS
application server facilities). Messages are automatically retrieved from JMS destinations, optionally within
a transaction, then sent to the message-driven bean in a J2EE application, without the application having
to explicitly poll JMS destinations.

Java Message Service (JMS) providers for clients

This topic describes the different ways that client applications can use JMS providers with WebSphere
Application Server. A JMS provider enables use of the Java Message Service (JMS) and other message
resources in WebSphere Application Server.

IBM WebSphere Application Server supports asynchronous messaging through the use of a JMS provider
and its related messaging system. JMS providers must conform to the JMS specification version 1.1. To
use message-driven beans the JMS provider must support the optional Application Server Facility (ASF)
function defined within that specification, or support an inbound resource adapter as defined in the JCA
specification version 1.5.

The service integration technologies of IBM WebSphere Application Server can act as a messaging
system when you have configured a service integration bus that is accessed through the default
messaging provider. This support is installed as part of WebSphere Application Server, administered
through the administrative console, and is fully integrated with the WebSphere Application Server runtime.

WebSphere Application Server also includes support for the following JMS providers:

WebSphere MQ
Provided for use with supported versions of WebSphere MQ.

Generic
Provided for use with any 3rd party messaging system which supports ASF.

For backwards compatibility with earlier releases, WebSphere Application Server also includes support for
the V5 default messaging provider which enables you to configure resources for use with the WebSphere
Application Server version 5 Embedded Messaging system. The V5 default messaging provider can also
be used with a service integration bus.

WebSphere applications can use messaging resources provided by any of these JMS providers. However
the choice of provider is most often dictated by requirements to use or integrate with an existing
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messaging system. For example, you may already have a messaging infrastructure based on WebSphere
MQ. In this case you may either connect directly using the included support for WebSphere MQ as a JMS
provider, or configure a service integration bus with links to a WebSphere MQ network and then access
the bus through the default messaging provider.

The service integration bus also provides access to a default messaging provider. This is a J2EE 1.4
compliant JIMS messaging provider which is fully integrated with WebSphere Application Server. You can
use it in multiple server configurations for messaging interactions with a WebSphere MQ network.

Configuring Java messaging client resources

To configure Java messaging client resources, you create new JMS provider configurations for your
application client. The application client can use a messaging service through the Java Message Service
APIs. A JMS provider provides two kinds of J2EE factories. One is a JMS connection factory, and the
other is a JMS destination factory.

In a separate administrative task, install the Java Message Service (JMS) client on the client machine
where the application client resides. The messaging product vendor must provide an implementation of the
JMS client. For more information, see your messaging product documentation.

Note: When completing this task, you can either create a new messaging provider, or you can use an
existing one.

1. Start the Application Client Resource Configuration Tool (ACRCT).

2. Open the EAR file for which you want to configure the new JMS provider. The EAR file contents are in
the displayed tree view.

3. Select the JAR file in which you want to configure the new JMS provider from the tree.
4. Expand the JAR file to view its contents.

5. Optionally right-click Messaging Providers and select New, if you want to create and use a new
messaging provider.

6. Configure the JMS provider properties in the resulting property dialog.
7. Click OK.
8. Click File > Save.

Configuring new JMS providers with the Application Client Resource
Configuration Tool

You can create new Java Message Service (JMS) provider configurations for the Application Client. The
Application Client makes use of a messaging service through the JMS interfaces.

During this task, you create new Java Message Service (JMS) provider configurations for the Application
Client. The Application Client makes use of a messaging service through the JMS interfaces. A JMS
provider provides two kinds of J2EE resources. One is a JMS connection factory, and the other is a JIMS
destination.

In a separate administrative task, you must install the JMS client on the client machine where your

particular application client resides. The messaging product vendor must provide an implementation of the

JMS client. For more information, see your messaging product documentation.

1. |Start the Application Client Resource Configuration Tool and open the EAR fiIe| for which you want to
configure the new JMS provider. The EAR file contents are displayed in a tree view.

2. From the tree, select the JAR file in which you want to configure the new JMS provider.
3. Expand the JAR file to view its contents.

4. Right-click Messaging Providers. Complete one of the following actions:
* Right click the folder and select New.
e On the menu bar, click Edit > New.
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5. In the resulting property dialog, configure the JMS provider properties.
6. Click OK when finished.
7. Click File -> Save on the menu bar to save your changes.

JMS provider settings for application clients

Use this page to configure properties of the Java Message Service (JMS) provider, if you want to use a
JMS provider other than the default messaging provider or the WebSphere MQ as a JMS provider.

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file. Right click Messaging Providers, and
click New. The following fields appear on the General tab.

Name:

The name by which the JMS provider is known for administrative purposes.

Data type String

Description:

A description of the JMS provider, for administrative purposes.

Data type String

Class Path:

A list of paths or . jar file names which together form the location for the resource provider classes.
Context factory class:

The Java class name of the initial context factory for the JMS provider.

For example, for an LDAP service provider the value has the form: com.sun.jndi.1dap.LdapCtxFactory.

Data type String

Provider URL:
The JMS provider URL for external JNDI lookups.

For example, an LDAP URL for a JMS provider has the form: 1dap://hostname.company.com/contextName.

Data type String

Custom Properties:

Specifies name-value pairs for setting additional properties on the object that is created at run time for this
resource.

You must enter a name that is a public property on the object and a value that can be converted from a

string to the type required by the set method of the property. The acceptable properties and values depend
on the object that is created. Refer to the object documentation for a list of valid properties and values.
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Default Provider connection factory settings

Use this panel to view or change the configuration properties of the selected JMS connection factory for
use with the internal product Java Message Service (JMS) provider that is installed with WebSphere
Application Server. These configuration properties control how connections are created between the JIMS
provider and the service integration bus that it uses

To view this Application Client Resource Configuration Tool (ACRCT) page, click File > Open. After you
browse for an EAR file, click Open. Expand the selected JAR file > Messaging Providers > Default
Provider. Right-click Connection Factories and click New. The following fields appear on the General
tab.

Settings that have a default value display the appropriate value. Any settings that have fixed values have a
drop down menu.

Name:

The name of the connection factory.

Data type String

Description:

A description of this connection factory for administrative purposes within IBM WebSphere Application
Server.

Data type String

JNDI Name:

The JNDI name that is used to match this Resource Adapter connection factory definition to the
deployment descriptor. This entry is a resource-ref name.

Data type String

User Name:
The User Name used with the Password property for connecting to an application.

If you specify a value for the User Name property, you must also specify a value for the Password
property.
The connection factory User ID and Password properties are used if the calling application does not

provide a userid and password explicitly. If a user name and password are specified, then an
authentication alias is created for the factory where the password is encrypted.

Data type String

Password:
The password used to authenticate connection to an application.
If you specify a value for the User Name property, you must also specify a value for the Password

property.
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Data type

Re-Enter Password:
Confirms the password.

Bus Name:

String

The name of the bus to which the connection factory connects.

Data type

Client Identifier:

String

The name of the client. Required for durable topic subscriptions.

Data type

Nonpersistent Messaging Reliability:

String

The reliability applied to nonpersistent JMS messages sent using this connection factory.

If you want different reliability delivery options for individual JMS destinations, you can set this property to
As bus destination. The reliability is then defined by the Reliability property of the bus destination to which

the JMS destination is assigned.

Default
Range

ReliablePersistent

None There is no message reliability for nonpersistent
messages. If a nonpersistent message cannot be
delivered, it is discarded.

Best effort nonpersistent
Messages are never written to disk, and are
thrown away if memory cache overruns.

Express nonpersistent
Messages are written asynchronously to
persistent storage if memory cache overruns, but
are not kept over server restarts.

Reliable nonpersistent
Messages can be lost if a messaging engine
fails, and can be lost under normal operating
conditions.

Reliable persistent
Messages can be lost if a messaging engine
fails, but are not lost under normal operating
conditions.

Assured persistent
Highest degree of reliability where assured
message delivery is supported.

As Bus destination
Use the delivery option configured for the bus
destination.

Chapter 8. Client applications 259



Persistent Message Reliability:
The reliability applied to persistent IMS messages sent using this connection factory.

If you want different reliability delivery options for individual JMS destinations, you can set this property to
As bus destination. The reliability is then defined by the Reliability property of the bus destination to
which the JMS destination is assigned.

Default ReliablePersistent

Range . - .
9 None There is no message reliability for nonpersistent

messages. If a nonpersistent message cannot be
delivered, it is discarded.

Best effort nonper